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1.  Introduction 
 

1.1 New in RFEM 5  
RFEM, the FEA program used to calculate plates, walls, shells, solids and frameworks, is a pow-
erful tool to meet various challenges occurring in modern civil engineering. The program rep-
resents the basis for DLUBAL's analysis software composed of various design modules: RFEM  
determines internal forces, deformations and support reactions of general plate and shell 
models with our without member and solid elements. 

The program version RFEM 5 offers you several useful features and options emphasizing user-
friendliness and easy program handling when working on structural analysis projects. Once 
again, we would like to thank our customers for their valuable ideas and remarks. 

Please find the most important innovations in RFEM 5 listed below: 

• Graphical user interface in French, Italian, Polish, Portuguese, Russian, Spanish 

• Direct setting of different types for openings 

• Member eccentricities from cross-section dimensions 

• Working diagrams and extended criteria for nonlinear nodal supports and releases 

• Orthotropic properties for quadrangle and membrane surfaces as well as solids 

• Input option for hybrid timber cross-sections 

• Filter in cross-section library with favorites 

• Solid modeling due to extrusion of surfaces in relation to plane or point, also with tapered 
sides 

• Intersections of solids with Boolean operators 

• Inserting a member to existing member 

• Import of files from Bentley ISM, Ansys Apdl and Scia Engineer 

• Import of 3D objects 

• Graphical assignment of member properties 

• Color symbols in tables for cross-sections, surfaces, solids, types of surfaces and members 

• Selection with ellipse, annulus or intersection line 

• Work planes defined by three points or line, member and surface axes 

• Color management for types of surfaces, stiffnesses, members and solids 

• Input of inclination and precamber in absolute values 

• Specification of surface size and weight in input table 

• Automatic creation of load and result combinations according to standard specification 

• Gradual refinement of FE mesh in boundary areas of surfaces 

• Large deformation analysis calculating according to NEWTON-RAPHSON, PICARD or as dynamic 
relaxation 

• Output of load distribution, strains, member coefficients and member slendernesses 

• Smooth ranges for evaluation of singularities 

• User-defined settings for lighting 

• Results evaluation by means of clipping plane 

• Views navigator for user-defined and generated visibilities and angles of view 

• Configuration Manager for display properties, toolbars, printout report headers etc. 

• Mail merge of graphics 

• PDF export of printout report 

We hope you will enjoy working with RFEM 5. 

Your team from DLUBAL SOFTWARE GMBH 
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1.2 Program Capacities  
The following values represent the upper limits in the RFEM data structure. Please note that 
complex structures require powerful hardware. 

Model data 
99,999 objects of each category (nodes, lines, surfaces, cross-sections etc.) 

Load data 
99,999 objects of each type of load per load case 

Load cases and combinations 

Load cases (linear calculation) 9,999 

Load combinations (nonlinear calculation) 9,999 

Result combinations 9,999 

Table 1.1: Program limits of RFEM 

1.3 Company Profile 
Since its beginnings in 1987, DLUBAL SOFTWARE GMBH has been involved in the development of 
both powerful and user-friendly programs for structural and dynamic analysis. In 1990, the 
company moved into its current location to Tiefenbach in Eastern Bavaria. A local branch exists 
since 2010 in Leipzig. 

When looking at our programs you can feel the enthusiasm of everybody involved in the soft-
ware development and you will notice the underlying philosophy of all our applications, which 
can be expressed in one word: user-friendliness. These two points combined with our exper-
tise in engineering are forming the base for the ever-growing success of our products. 

The software has been designed in such a way that even users with basic computer skills can 
handle the software successfully after a short while. With considerable pride, we now number 
more than 7,000 engineering offices as well as construction companies from a variety of fields 
and places of higher education among our satisfied customers all over the world. To remain 
true to our objectives, there are more than 150 internal and external employees working con-
tinuously on the development and improvement of DLUBAL applications. For general questions 
and problems, our customers can always rely on our qualified fax and email hotline. 

The perfect balance between price and performance combined with excellent customer ser-
vice provided by experienced civil engineers make DLUBAL programs an essential tool for any-
one working in the areas of structural engineering, dynamics and design. 
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1.4 RFEM Team 
The following people were involved in the development of RFEM 5: 

Program coordination 
Dipl.-Ing. Georg Dlubal 
Ing. Pavel Bartoš 
Ing. Pavol Červeňák 

Dipl.-Ing. (FH) Younes El Frem 
Dipl.-Ing. Frank Faulstich 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 

Programming 
RNDr. Miroslav Šejna, CSc 
Ing. Radek Brettschneider 
Jan Brnušák 
Ing. Martin Budáč 
Ing. Michal Búzik 
Dipl.-Ing. Georg Dlubal 
Jan Fenár 
Ing. Jan Gregor 
Ing. Jiři Kubíček  
Dr.-Ing. Jaroslav Lain 
Ing. Jan Miléř 
Ing. Daniel Molnár 
Ing. Petr Novák 
Ing. Jan Otradovec 
Mgr. Petr Oulehle 

Mgr. Jiří Patrák 
Mgr. Andor Patho 
Mgr. Petr Pitka 
Bc. Ondřej Planý 
Ing. Jan Rybín, Ph.D. 
Ing. Fatjon Sakiqi 
Ing. Pavel Spilka 
Ing. Roman Svoboda 
RNDr. Stanislav Škovran 
Dis. Jiří Šmerák 
Ing. Jan Štalmach 
Lukáš Tůma 
RNDr. Miroslav Valeček 
Ing. Vítězslav Zajíc 
Michal Zelenka 

Programming - analysis core 
Doc. Ing. CSc. Ivan Němec 
Ing. Jiří Buček 
Ing. Jiří Doležal 
Ing. Petr Horák 
Ing. Jaromir Kabeláč 

Ing. Ph.D. Radoslav Rusina 
Ing. CSc. Ivan Ševčík 
Ing. CSc. Zbyněk Vlk 
Ing. Lukáš Weis 
RNDr. Milan Zeiner 

Program design, dialog figures, icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Zdeněk Ballák 
Ing. Jan Miléř 

Blocks 
Ing. Tommy Brtek 
Ing. Dmitry Bystrov 

Ing. Evžen Haluzík 

Program supervision 
Ing. Alexandra Bayrak 
Marian Bocek 
Ing. Tommy Brtek 
Ing. Ondřej Šašinka 
Ing. Tomáš Ferencz 
Ing. Vladimír Gajdoš 
Ing. Jakub Harazín 
Ing. Martin Hlavačká 
Ing. Iva Horčičková 
Karel Kolář 
Ing. František Knobloch 

Ing. Ctirad Martinec 
Pavla Novotná 
Ing. Vladimír Pátý 
Ing. Evgeni Pirianov 
Ing. Václav Rek 
Ing. Jan Rybín, Ph.D. 
Mgr. Ph.D. Vítězslav Stembera 
Ing. Ondřej Šupčík 
Ing. Martin Vasek 
Marek Ženuch 
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Localization, manual 
Ing. Fabio Borriello 
Ing. Dmitry Bystrov 
Eng.º Rafael Duarte 
Ing. Jana Duníková 
Ing. Lara Freyer 
Alessandra Grosso 
Bc. Chelsea Jennings 
Jan Jeřábek 
Ing. Ladislav Kábrt 
Ing. Aleksandra Kociołek 
Mgr. Michaela Kryšková 
Dipl.-Ing. Tingting Ling 

Ing. Roberto Lombino 
Eng.º Nilton Lopes 
Mgr. Ing. Hana Macková 
Ing. Téc. Ind. José Martínez 
MA SKT Anton Mitleider 
Dipl.-Ü. Gundel Pietzcker 
Mgr. Petra Pokorná 
Ing. Zoja Rendlová 
Dipl.-Ing. Jing Sun 
Ing. Marcela Svitáková 
Dipl.-Ing. (FH) Robert Vogl 
Ing. Marcin Wardyn 

Technical support, quality management 
M.Eng. Cosme Asseya 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. Moritz Bertram 
M.Sc. Sonja von Bloh 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Stefan Frenzel 
Dipl.-Ing. (FH) Walter Fröhlich 
Dipl.-Ing. Thomas Günthel 
Dipl.-Ing. (FH) Sebastian Hawranke 
Dipl.-Ing. Wieland Götzler 
Dipl.-Ing. (FH) Andreas Hörold 

Dipl.-Ing. (FH) Paul Kieloch 
Dipl.-Ing. (FH) Bastian Kuhn 
Dipl.-Ing. (FH) Ulrich Lex 
Dipl.-Ing. (BA) Sandy Matula 
Dipl.-Ing. (FH) Alexander Meierhofer 
M.Eng. Dipl.-Ing. (BA) Andreas Niemeier 
Dipl.-Ing. (FH) Gerhard Rehm 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Lukas Sühnel 
Dipl.-Ing. (FH) Robert Vogl 

1.5 Using the Manual 
Many roads lead to Rome – this policy also applies to working with RFEM: graphics, tables and 
navigators are on an equal footing. The descriptions in this manual follow the sequence and 
structure of the tables provided for model, load and results data. The individual tables are de-
scribed in detail column by column. Instead of presenting general Windows features, the 
manual often focuses on practical hints and tips. 

If you are new to the program, you should work with the introductory example first, describing 
step by step how to enter data. Please find the PDF document available for download on our 
website www.dlubal.com/downloading-manuals.aspx. In this way, you can get quickly familiar 
with the most important features of RFEM. Advanced program users may try our detailed tuto-
rial also available for download. Both examples can also be performed within the restrictions of 
the demo versions. 

The text of the manual shows the described buttons in square brackets, for example [Apply]. 
At the same time, they are shown in the left margin. In addition, expressions used in dialog 
boxes, tables and menus are set in italics to clarify the explanations. 

The index at the end of the manual helps you to find specific terms and subjects. However, if 
you do not find what you are looking for, please check our blogs at www.dlubal.de/blog/en 
where you can browse the articles to find a solution. 

 

 

http://www.dlubal.com/downloading-manuals.aspx
http://www.dlubal.de/blog/en
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2.  Installation 
 

2.1 System Requirements 
In order to use RFEM without any difficulties, the following system requirements are recom-
mended: 

• Operating system Windows Vista/7/8 

• x86 CPU with 2 GHz 

• 2 GB RAM 

• DVD-ROM drive for installation (alternatively a network installation is possible) 

• 10 GB hard disk capacity, including approximately 2 GB required for installation 

• Graphic card with OpenGL acceleration and resolution of 1024 x 768 pixels. Onboard  
solutions and shared-memory-technologies are not recommended. 

RFEM is not supported by Windows 95/98/Me/NT/2000/XP, Linux, Mac OS or server operating 
systems. 

No product recommendations are made, with the exception of the operating system, as RFEM 
basically runs on all systems that fulfill the system requirements mentioned above. If RFEM is 
used for intensive calculations, the guiding principle 'more is better' applies. 

When complex structural systems are calculated, huge amounts of data are produced. As soon 
as the main memory is not sufficient for taking the data, the hard drive will take over. This can 
slow down the computer significantly. Therefore, upgrading the main memory will usually 
speed up the calculation more than a faster processor. 

As the RFEM analysis core supports several processor kernels, you can completely exploit the 
potential of the 64-bit operating system. For 32-bit systems the memory size used by the pro-
cessor is limited to 2 gigabytes. Therefore, more memory can be used with the 64-bit technol-
ogy. If you work with a computer having sufficient RAM memory using a 64-bit operating sys-
tem, the fast and direct equation solving method can be applied even to bigger models. 

To calculate complex structural systems, we recommend the following configuration: 

• Quad-core processor 

• Windows 7/8 64-bit 

• 8 GB RAM 

2.2 Installation Process 
The program family RFEM is delivered on DVD. In addition to the main program RFEM, the 
DVD contains all additional modules that belong to the RFEM program family, for example  
RF-CONCRETE, RF-STEEL, RF-STABILITY etc. 

Before you install RFEM, close all applications running in the background.  

Please make sure that you are logged on as administrator or to have administrator rights for 
installing the programs. When working with RFEM, user rights will be sufficient. Please find  
detailed instructions shown in the User Rights video and the User Rights document available 
on our website. 

 

 

 

http://download.dlubal.com/?file=videos/allgemein/User_Rights.avi
http://ng.dlubal.de/files/106774.pdf
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Select installation 

2.2.1 Installation from DVD  
On the back side of the DVD case you can find instructions for installation. 

• Insert the DVD into your DVD-ROM drive. 

• The installation process starts automatically. If it does not start, the autorun function 
may be inactive. In this case, start the file setup.exe from the DVD either in the Explorer 
or by entering the command ’D’:\setup.exe in the input field of the Start menu (’D’ refers 
to the drive letter of your DVD drive). 

• In the start dialog box, select the language. 

 
Figure 2.1: Select language 

• In the next dialog box, define the program version (64-bit or 32-bit). 

• Follow the instructions of the Installation Wizard. 

Connect the dongle to a USB port of your computer only after the installation is complete. The 
dongle driver will be installed automatically. 

The DVD also contains instructions for installation and the RFEM manual in PDF format. To look 
at the manual, you need the Acrobat Reader that you can install from the DVD. 

RFEM as full or trial version 
When you start the program for the first time after the installation has been completed suc-
cessfully, you have to decide if you want to use RFEM as a full version or as a trial version run-
ning for 30 days. 

To run the program as a full version, you need a dongle (hardlock) and an authorization file 
(Author.ini). The dongle is a plug to be plugged in a USB port of your computer. The authoriza-
tion file contains coded information about your license(s). Usually, we send you the Author.ini 
file by e-mail. Also the Extranet to which you log in on our website www.dlubal.com provides 
access to your authorization file. Save the Author.ini file on your computer, a USB flash drive or 
in the network. 

Each work station requires the authorization file. The file can be copied as many times as you 
want. However, if the content will be changed, it cannot be used anymore for authorization. 

It is also possible to run the RFEM full version with a Software Licence without dongle. 
 

http://www.dlubal.com/extra/loginpage.aspx
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2.2.2 Network Installation 
Local licenses 

The installation can be started from any drive of your computer or server. First, copy the con-
tents of the DVD to the relevant folder. Then, start the file setup.exe from the client. The follow-
ing steps do not differ from the DVD installation. 

Network licenses 

When you have network licenses, install the program on the work stations as described. Then, 
the licenses will be approved by the SRM network dongle. Find detailed information about in-
stalling the network dongle in the instructions available on our website. 

2.2.3 Installing Updates and Other Modules 
The DVD contains the complete program package including all add-on modules. When pur-
chasing a new add-on module, you will not necessarily receive a new DVD but always a new 
authorization file Author.ini. To update the authorization without reinstallation, select Load  
Authorization File on the Help menu in RFEM. 

Old program files are removed and replaced by new ones when updating the program within 
one series of a version (for example 5.02.xxxx). Of course, your project data is preserved! When 
updating the program to the next series (for example 5.03.xxxx), the new version will be in-
stalled parallel to the old version (see below). 

If you use printout report headers that you have defined yourself, save them before installing 
the update. The headers are usually stored in the file DlubalProtocolConfigNew.cfg that you 
find in the general master data folder C:\ProgramData\Dlubal\Global\General Data. The file 
won’t be overwritten during the update. Nevertheless, saving a backup file may be useful. 

We also recommend to save your report templates before you install the update. They are 
stored in the file RfemProtocolConfig.cfg in the folder C:\ProgramData\Dlubal\RFEM 5.xx\ 
General Data. 

The projects linked in the Project Manager are managed in the ASCII file PRO.DLP which can 
normally be found in the folder C:\ProgramData\Dlubal\Global\Project Manager (see Figure 
12.21, page 553). If you want to uninstall RFEM before installing the update, you should save 
this file, too. 

2.2.4 Parallel Installation of RFEM Versions 
RFEM 4 and the individual series of version RFEM 5 can be run parallel on the computer since 
the program files are stored in different directories. The default folders are the following for a 
64-bit operating system: 

• RFEM 4: C:\Programs (x86)\Dlubal\RFEM4 

• RFEM 5.01: C:\Programs\Dlubal\RFEM 5.01 

• RFEM 5.02: C:\Programs\Dlubal\RFEM 5.02 

• RFEM 5.03: C:\Programs\Dlubal\RFEM 5.03   etc. 

All models created with the previous version RFEM 4 can be opened and edited in RFEM 5. 

Models from RFEM 4 won’t be overwritten when saving them in RFEM 5 as both programs use 
different file endings: RFEM 4 saves model data in the format *.rf4, RFEM in *.rf5. 

Model files of RFEM 5 are downward compatible with certain restrictions. When you open an 
RFEM 5 model file in a previous version, a message appears telling you for example that com-
patibility problems for members with unsymmetric cross-sections may occur. 

 

http://ng.dlubal.de/files/53217.pdf
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3.  Graphical User Interface 
 

3.1 Overview 
When you open one of the examples included in RFEM, the screen should look like the figure 
below (Figure 3.1). The graphical user interface corresponds to usual Windows standards. 

The following figure shows the most important areas of the program interface. 

 
Figure 3.1: RFEM user interface 
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3.2 Terminology 
This chapter explains important terms used in this manual relating to the user interface pro-
vided by Windows. 

Different terms are used to describe the elements of the user interface. This manual uses Eng-
lish expressions often referring to the Microsoft Manual of Style for Technical Publications. 
Some terms are summarized if their differentiation is not essential for the operation of RFEM. 

The following table describes frequently used terms. 

Term Figure Synonym Explanation 

Menu 

 

Pull down 
menu 

Commands and 
functions below 
the title bar 

Context 
menu 

 

Pop-up 
menu 

Open the context 
menu by clicking 
an object with 
the right mouse 
button. 

Contains useful 
commands and 
functions for the 
selected object. 

Toolbar 

 

Button bar Collection of but-
tons below the 
menu bar 

Dialog 
box 

 

 Window used for 
data input in the 
main window 

Tabs 

 

Register Large dialog box-
es are subdivided 
into several tabs. 

Click a tab to 
open the corre-
sponding index 
card. 
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List button of toolbar 

Section 

 

Group, 
frame 

Elements in a 
dialog box that 
belong together 
logically 

Button 

 

Icon Click a button to 
start an action 
(for example to 
open a dialog box 
or to change da-
ta). 

The toolbar con-
tains list buttons: 
Click [] to open 
a list with similar 
functions. The 
recently selected 
button is dis-
played at top. 

Input 
field 

 

Text box, 
input box 

Field for entering 
text or numerical 
values 

Spin box 

 

Spin button Two tiny buttons 
next to an input 
field 

Numerical values 
can be changed 
gradually. 
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List 

 

List box,  
combo box 

Options for input 
fields 

Sometimes user-
defined specifi-
cations can be 
added. 

Check 
box 

 

Check box Yes/No decision 
by ticking or 
clearing the 
check box 

Selection 
field 

 

Option but-
ton 

Only one of the 
options can be 
selected. 

Table 3.1: Terms of user interface 
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3.3 Special Terms in RFEM 
This chapter explains some important terms specific to RFEM. 

Term Explanation 

Node In the 3D model, a node is defined by its coordinates (X/Y/Z). Nodes are 
used to model the geometry of a structure. 

Line Nodes are connected by lines. Lines can be straight, bent or user-defined, 
for example arcs and splines. 

Member A member represents the property of a line. By properties for material and 
cross-section a certain stiffness is assigned to the member. A member is a 
1D element. 

Set of members Members can be combined in a set of members. Continuous members 
join members continuously like in a continuous beam. A group of mem-
bers, consisting of connected members, can join more than two members 
on a single node. 

Surface A surface is limited by boundary lines. By its material and thickness prop-
erties, a certain stiffness is assigned to the surface. Surfaces are 2D ele-
ments. 

Solid A solid is surrounded by boundary surfaces (usually type Null). The stiff-
ness is defined by its material properties. Solids are 3D elements. 

Nodal support The degrees of freedom are limited for the node. 

Line support The degrees of freedom are limited for all nodes on the line. 

Nodal load Force or moment applied to a node. 

Line load A line is loaded by a concentrated load, a uniform or linearly variable load. 
The load acts as force or moment. 

Member load A member is loaded by a linear or single load. The load diagram can be 
either uniform or trapezoidal. In addition to forces and moments, temper-
ature actions and prestresses are possible. 

Surface load A surface is loaded by a uniform or linearly variable load. In addition to 
forces, temperature loads and imposed deformations can act on the sur-
face. 

Solid load A solid is loaded by effects of temperature or imposed deformations. 

Load case 
LC 

The loads from an action are managed in a load case, for example 'self-
weight' or 'wind'. 

The loads should be defined as characteristic loads (thus without factors). 
Partial safety factors can be considered in load or result combinations. 

Usually, a load case is calculated according to linear static analysis, but a 
calculation according to second-order or large deformation analysis is also 
possible. 



3  Graphical User Interface 

 

 

20 Program RFEM © 2013 Dlubal Software GmbH 

 
 

List button of toolbar 

Load combina-
tion 
CO 

A load combination is used to superimpose load cases, that means all 
loads of the load cases in question are summarized. 

Usually, a load combination is calculated according to second-order or 
large deformation analysis, but a calculation according to linear static 
analysis is also possible. 

Result combina-
tion 
RC 

A result combination sums up the results of the contained load cases. 

It is also possible to determine the extreme internal forces and defor-
mations from different load cases, load or result combinations by an Or 
combination. 

However, the additive principle of superposition does not apply for results 
calculated according to second-order analysis. 

Table 3.2: RFEM-specific terms 

3.4 RFEM User Interface 
This chapter describes the individual operating elements of RFEM (see Figure 3.1, page 15). 
The program follows the general standards for Windows applications. 

3.4.1 Menu Bar 
Below the title bar you see the menu bar. All functions of RFEM can be accessed in the menu 
bar.  The functions are organized in logical blocks. 

Open a menu by a single click on the left mouse button. You can also use the keyboard by 
holding down the [Alt] key in combination with the underlined letter of the menu title. Then, 
the menu opens and you can see its menu items. Select the entries by mouse-click or by press-
ing the underlined letter. You can also select an item by using the cursor keys [↑] and [↓] and 
finally pressing the [↵] key. 

When a menu list is opened, you can switch between the menus or subentries by using the 
[→] and [←] keys. 

For some menu items a keyboard shortcut is additionally shown. These key combinations fol-
low the Windows standards. Use shortcuts to start the functions directly with keyboard keys 
(for example [Ctrl] + [S] saves data). 

3.4.2 Toolbars 
Below the menu bar you see the toolbars with various buttons. Use these buttons to access the 
most important functions directly by mouse-click. A short information of the button function 
appears when you point to a button using the mouse pointer (ToolTip, ScreenTip). 

Some buttons provide subentries like a menu: These list buttons contain topic-related functions. 
Click [] next to the button symbol to access the functions. The recently selected button is pre-
set at the top of the list. 

To change the position of a toolbar, grab the bar in its front area with the left mouse-button. 
Then move it to the desired position. 

 
Figure 3.2: Docked position of View toolbar 
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Context menu of a button or 

menu item 

When you drag the toolbar into the workspace, it becomes a “floating” toolbar. 

 
Figure 3.3: Floating position of View toolbar  

To re-dock the floating toolbar, move it to the window frame with the mouse button. You can 
also double-click its headline. 

On the View menu, click Arrange Toolbars Customized to open a dialog box for changing 
the content and look of toolbars. Customizing toolbars follows Windows standards. 

 
Figure 3.4: Customize dialog box, tab Commands 

All commands of RFEM are sorted by Categories. Select an entry of the list to see the buttons  
of all associated Commands to the right. Click a button to get an explanation of the button 
function shown in the dialog section below. All buttons can be moved to any place in the 
toolbar by using the drag-and-drop function. It is recommended to integrate these additional 
buttons into a new toolbar (see Figure 3.6) as the remaining toolbars may be reset to the 
default entries when installing updates. 

To remove a button from the toolbar, the Customize dialog box must be open. Then, you can 
drag and drop the button from the toolbar to the workspace. It is also possible to use its con-
text menu shown on the left to Delete the button. 

In addition to dragging commands into the toolbar, you can shift them into menus. In this way, 
you can create user-defined menus. Menu items can be deleted or adjusted by user specifica-
tions as described for toolbars. 
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The option Button Appearance available in the context menu opens the following dialog box: 

 
Figure 3.5: Dialog box Button Appearance 

The dialog box helps you to change the Text of the button or menu item. Moreover, you can 
replace the default symbol by a user-defined icon. 

All available toolbars are listed in the Toolbars tab of the Customize dialog box. You can switch 
off toolbars or create new ones by using the [New] button. 

 
Figure 3.6: Creating a new toolbar 

Enter the Name of the new toolbar in the Toolbar dialog box and click [OK]. The new bar will 
appear in a floating position on the display. You can shift the toolbar to an appropriate posi-
tion and fill it with buttons by using the Commands tab (see above).  

The button [Reset All User-defined Toolbars] resets the initial toolbar state. When the list con-
tains a customized toolbar, the toolbar will be removed. The default toolbars of RFEM cannot 
be removed, but switched off only. 

In the tab Menu Items, you can create user-defined pull-down menus. Proceed as described for 
creating new toolbars (see above). 
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Use the final dialog tab Options to change the appearance of the RFEM user interface.  
The following Designs can be selected: 

 
Figure 3.7: Available designs for the user interface 

The new setting will be active immediately. 

3.4.3 Project Navigator 
To the left of the work window you see a navigator that looks like the Windows Explorer. To 
display or hide the Project Navigator, open the View menu and select Navigator, or use the 
corresponding toolbar button. 

 
Figure 3.8: Navigator button in the Default toolbar 

The navigator shows the model data of opened files in a tree structure. Click [+] to open a 
branch of the tree, click [-] to close it. You can also double-click the entry. 

Similar to toolbars, you can use the mouse to "grab" the navigator in its title bar and move it to 
the workspace. To dock it again, double-click the title bar or move the navigator to the window 
frame. When moving the navigator, directional buttons shown on the left will additionally ap-
pear, facilitating the docking to one of the four sides of the work window. Drag the navigator  
to the arrow button of your choice and release the left mouse button as soon as the pointer is 
placed on the button. 

If you do not want the navigator to be docked to the window frame, clear the corresponding 
selection in the context menu of the navigator. 

When the menu item Synchronized Selection is ticked, an object marked in the navigator will be 
highlighted with colors also in the model graphic. 

The context menu option Auto Hide allows you to minimize a docked navigator: As soon as you 
click into the work window, the navigator slides to the edge and becomes a thin bar (see 
Figure 3.9). You can also use the pin button on the top right of the navigator to select this 
function (see Figure 3.10, page 24). 

The navigator opens in full size when you move the pointer across the Project Navigator field 
highlighted in the docked navigator bar. 

 

 

 
 

Context menu of navigator 
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Figure 3.9: Navigator, tables and panel in auto hide mode 

At the bottom edge of the navigator you see three tabs (four after calculations). Use the tabs  
to switch between Data, Display, Views and Results navigators. 

  
Figure 3.10: Tabs for Data and Display in Project Navigator 
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Data navigator 
This navigator manages model and load data as well as calculated results. Double-click an en-
try (a “leaf” of the tree structure) to open a dialog box for changing the selected object. When 
you right-click an entry, a context menu appears with helpful functions used to create or modi-
fy the object. 

Incorrectly defined objects are displayed in red, unused objects are displayed in blue letters. 

Display navigator 
This navigator controls the graphic display in the work window. When you clear the check box 
of an entry, the corresponding object will be hidden in the graphics. 

Use the context menu of the navigator shown on the left to save or import user-defined set-
tings. You can also apply saved settings as default for new models. 

  
Figure 3.11: Tabs for Views and Results in Project Navigator 

Views navigator 
The navigator manages user-defined views as well as user-defined and automatically created 
visibilities of objects (used to be "partial views" and "groups" in RFEM 4). Buttons are available 
to create user-defined views, to set visibilities, to integrate objects into user-defined visibilities 
etc. 

Working with views and visibilities is described in chapter 9.9.1 on page 369. 

Results navigator 
With the final navigator you control the results displayed in the graphic. Available entries de-
pend on whether results of RFEM or an add-on module are displayed. 
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3.4.4 Tables 
At the bottom edge of the RFEM window you see tables. To switch the tables on and off, click 
Display on the Table menu, or use the corresponding button. 

 
Figure 3.12: Button Table on/off in the Default toolbar 

There are four groups of tables. To switch between them, use the first four buttons displayed 
in the toolbar of the table, or point to Go To on the Table menu. 

 

 
Table 3.3: Buttons for control of table groups 

The tables manage all model and load data numerically. Several powerful functions allow for 
an efficient data input (see chapter 11.5 on page 480). 

By working through the tables successively RFEM ensures that all data is captured. The tables 
are representing the internal data organization of RFEM. Descriptions of input and output to 
be found in chapters 4, 5, 6 and 8 are based on the structure of these tables. 

Similar to toolbars, you can use the mouse to "grab" tables in their title bar and move them in-
to the workspace. To dock a table, double-click its title bar, or move the table to the window 
frame or one of the directional buttons shown on the left. 

 

Table menu → Go To → Model Data 

Tables for model data 

 

Table menu → Go To → Load Cases and Combinations 

Tables for load cases and 
combinations 

 

Table menu → Go To → Loads 

Tables for loads 

 

Table menu → Go To → Results 

Tables for results 
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Docked tables can be minimized when the context menu option Auto Hide is set. As soon as 
you click into the work window, they slide to the edge (see Figure 3.9, page 24). You can also 
use the pin button on the top right of the table to select the minimize function. The tables 
open in full size again when you move the pointer over the docked bar. 

When selecting a table row by mouse click, related objects are highlighted with colors in the 
graphic. Reciprocally, when an object is selected in the work window, the corresponding table 
row is displayed and highlighted, too. To control the settings for the so-called "synchronization 
of selection", point to Settings on the Table menu. You can also use the table toolbar buttons 
shown on the left (see chapter 11.5.4, page 486). 

3.4.5 Status Bar 
At the bottom of the RFEM work window you see the status bar. To activate or deactivate the 
bar, click Status Bar on the View menu. 

The status bar consists of three areas. 

Left area 

 
Figure 3.13: Left area of status bar 

The displayed text varies depending on the program function that is active. When the pointer 
moves across the work window, information appears about the object indicated by the point-
er. 

If you are an RFEM beginner, keep an eye on this section of the status bar: You may find useful 
hints and descriptions for toolbar buttons and dialog boxes. 

Center area 

 
Figure 3.14: Center area of status bar 

Its functionality is similar to the one of a toolbar, controlling the display of the work window.  

SNAP  

The button enables or disables the snap function of the grid. Use the context menu to access 
the dialog box with specific settings for grid parameters (see chapter 11.3.2, page 437). 
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Figure 3.15: Dialog box Work Plane and Grid/Snap 

GRID 

Click the button to switch the grid on and off. Select Edit in the context menu to open the dia-
log box shown in Figure 3.15. 

In addition, the context menu offers the possibility to maximize or minimize grid spacings 
gradually. 

ORTHO / CARTES / POLAR 

Use this button to select the orthogonal, Cartesian or polar grid. With the context menu you 
can open the dialog box shown in Figure 3.15. In addition, you can enlarge and reduce grid 
spacings gradually. 

OSNAP 

The button activates or deactivates the object snap (see chapter 11.3.3, page 438). 

GLINES 

The button controls the display of guidelines (see chapter 11.3.7, page 448). 

DXF 

Use this button to switch the display of background layers on and off (see chapter 11.3.10, 
page 455). 

Right area 

 
Figure 3.16: Right area of status bar 

The right area of the status bar shows the following information about graphically entered data: 

• Visibility mode (if active) 

• Coordinate system CS 

• Work plane 

• Coordinates of current pointer position 
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3.4.6 Control Panel 
As soon as internal forces or deformations are displayed graphically, the panel appears in the 
work window, offering different possibilities for display and control. To switch the panel on 
and off, 

select Control Panel (Color Scale, Factors, Filter) on the View menu 

or use the button shown on the left. 

Similar to a toolbar, you can use the mouse to "grab" the panel in its title bar and shift it into 
the workspace. To dock the panel, double-click its title bar, or move it to the window frame or 
one of the directional buttons shown on the left. 

The docked panel can be minimized when the context menu option Auto Hide is set. As soon 
as you click into the work window, it slides to the edge (see Figure 3.9, page 24). You can also 
use the pin button on the top right of the panel to select the minimize function. The panel 
opens in full size again when you move the pointer over the docked bar. 

The control panel consists of the following tabs: Color scale, Factors, Filter and Thicknesses, if 
available. 

Color spectrum 

 
Figure 3.17: Control panel, tab Color Spectrum with active Options dialog box 

When a multi-color results display is set, the first tab shows the color spectrum with assigned 
ranges of values. Eleven color zones are set by default, covering the range between extreme 
values in equally spaced intervals. 

To adjust the color spectrum, double click one of the colors. You can also use the [Options] 
button available in the panel. The Options dialog box opens (Figure 3.17) where you can click 
the [Edit] button to access another dialog box for changing the ranges of colors and values. 
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Figure 3.18: Dialog box Edit Isoband Value and Color Spectra 

Use the vertical sliders to the right of the values to reduce the number of color ranges at both 
ends of the color spectrum. 

You can change colors individually by double-clicking a color field. 

Furthermore, you can adjust spectrum values manually. Please take care to follow a strictly as-
cending or descending order. Use the buttons in the dialog section Value Spectrum to assign 
values. The buttons are defined as follows: 

Button Function 

Default The eleven color zones will be set to default. 

Empty All values in the input fields will be deleted. 

Fill 
The values will be equidistantly intercalated between maximum and 
minimum depending on the number of color zones. 

Fill Max/Min 
For a reduced color spectrum, the interpolated values are calculated in 
relation to the absolute or manually entered extreme values. 

Save The value spectrum will be saved as a global sample. 

Table 3.4: Buttons in the dialog section Value Spectrum 

Tick the check box in front of Apply to all result diagrams to use the current color spectrum for 
the results display of all load cases, load and result combinations. The value spectrum remains 
unaffected because a global assignment for deformations, forces, moments and stresses 
would be difficult. Click [Save] to save the modified color spectrum as user-defined. 

Use the [Options] button as shown in Figure 3.17 to select further options in the Options dialog 
box.  
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Figure 3.19: Dialog box Options, option Limits +/- 

The reference to limit values allows you to evaluate results accurately within a defined zone. 
Exceedings of the upper and lower limits are represented by different colors. With the values 
set in Figure 3.19 you can see the moments my displayed in a fine gradation within the range 
of ± 30 kNm/m. Values beyond the defined zone appear in red or blue color. 

Tick the check box for Smooth color transition in the Options dialog box to make the distinct 
color zones disappear. The smoothed color spectrum can be set independently, no matter 
which one of the three reference options is selected for the result values. 

Factors 

 
Figure 3.20: Control panel, tab Factors  

Use the second panel tab to control the scaling factors for the graphic display. Depending on 
the currently set results graphic, you can access input fields for scaling Deformation, Member 
diagrams, Surface diagrams, Section diagrams, Reaction forces and Trajectories. 
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Filter 

 
Figure 3.21: Control panel, tab Filter 

With the Color Spectrum tab you can filter result values in general. Use the Filter tab to select 
different result displays for particular surfaces, members or solids. 

The selection fields below the button row represent the three object categories for which you 
can display result diagrams. You have to enter the numbers of relevant members, surfaces or 
solids into the input field Show diagrams for. Then, with a click on the [Apply] button, you set 
the filter in the graphic. 

It is also possible to take object numbers from the graphic: First, select the members, surfaces 
or solids (multiple selection via window or by holding down the [Ctrl] key). Then, click the but-
ton [Import from Selection]. 

The filter settings of the panel also affect the objects in the results tables: When you restrict the 
results display in the panel to for example two members, table 4.6 Members - Internal Forces 
will list only the results of those two members. 
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3.4.7 Default Buttons 
Buttons are used in many dialog boxes. When you place the pointer on a button, its function 
will be displayed as short description after a moment. 

The following overview describes frequently used default buttons. 

Button Name Function 

 New Opens a dialog box to define an object 

 Edit Opens a dialog box to modify an object 

 Delete Deletes an object or entry 

 Select Graphical selection 

 Apply Import from the current selection 

 Library Opens a collection of stored data 

 Help Opens the help function 

 Use Applies changes without closing the dialog box 

 Settings Opens a dialog box for detailed settings 

 Comments 
Access to default text modules 
 chapter 11.1.4, page 421 

 
Units and  
Decimal Places 

Settings for units and decimal places 
 chapter 11.1.3, page 420 

 Default Restores default dialog settings 

 Set as Default Saves the current settings as default 

 Font Option to set fonts and font sizes 

 Colors Option to set colors 

 Info Displays information about an object 

 Transfer Selection Transfers selected items from one list to another 

 Transfer All Transfers all items from one list to another 

 Save Stores user-defined entries 

 Import Imports stored entries 

 Select Selects certain or all objects 

 Deselect Deletes or cancels all entries 

Table 3.5: Default buttons 
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3.4.8 Keyboard Functions 

Often required functions in tables and graphical user interface can also be accessed with  
the keyboard. 

[F1] Help 

[F2] Next table 

[F3] Previous table 

[F4] Plausibility check for current table 

[F5] Plausibility check for all tables 

[F7] Selection function in tables 

[F8] Copies the table cell above, or shows entire model on screen 

[F9] Calculator 

[F10] Menu bar 

[F12] Saves the model under a new name 

[Alt] Menu bar 

[Ctrl]+[2] Copies a row of the table to the next row 

[Ctrl]+[A] Redo function 

[Ctrl]+[C] Copies to the clipboard 

[Ctrl]+[E] Exports data 

[Ctrl]+[F] Searches within the table 

[Ctrl]+[G] Generates entries in the table 

[Ctrl]+[H] Finds entries in the table and replaces them 

[Ctrl]+[I] Inserts a row in the table, or imports data 

[Ctrl]+[L] Jumps to a specific row number in the table 

[Ctrl]+[N] Creates a new model 

[Ctrl]+[O] Opens an existing model 

[Ctrl]+[P] Prints the graphic 

[Ctrl]+[R] Deletes a row in the table 

[Ctrl]+[S] Saves data 

[Ctrl]+[U] Clears selection in the table 

[Ctrl]+[V] Inserts from the clipboard 

[Ctrl]+[X] Cuts items in the table 

[Ctrl]+[Y] Deletes the content of a row in the table 

[Ctrl]+[Z] Undo function 

[+] [-]  NumPad Zoom 

Table 3.6: Keyboard functions 

Provided that no dialog box is open, the [Enter] key calls up the last used function. Thus, reap-
plication of data is easier, for example placing model or load objects again in the work window.  
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3.4.9 Mouse Functions 
The mouse functions follow general standards for Windows applications. To select an object 
for editing, simply click it with the left mouse button. Double-click the object when you want 
to open its dialog box for editing. You can apply these functions to objects of the work win-
dow as well as to entries in the Data navigator. 

Model and load objects can be shifted in the work window by drag-and-drop. To copy objects, 
hold down the [Ctrl] key additionally. The drag-and-drop function can be switched on and off 
in the general context menu (see Figure 11.53, page 446). 

When you click an object with the right mouse button, its context menu appears, providing 
object-related commands and functions. 

Context menus are available in the graphic, navigator and tables. 

 
Figure 3.22: Context menu of nodal support in the graphic 

By scrolling the wheel button you can maximize or minimize the current model representa-
tion. The pointer position is always assumed as center of the zoom area. 

Press the wheel button to move the model directly within the workspace, which means with-
out previously activating the toolbar button [Move, Zoom]. When you press the [Ctrl] key addi-
tionally, you can rotate the model. Rotating the model is also possible by using the wheel but-
ton and holding down the right button of the mouse. The pointer symbols shown on the left 
are indicating the selected function. 

To rotate the display around a particular node, select the node first. Now, hold down the [Alt] 
key and press the wheel button additionally to rotate the model about the selected node. 

The options offered by a 3D mouse can also be used for working with the graphical user inter-
face of RFEM. 

Furthermore, RFEM offers a useful function to display selected objects quickly in maximized 
view: First, select the objects in the work window. Now, hold down the shift key [] and click 
one of the buttons available in the View toolbar shown on the left. The work window will show 
you a maximized partial view of the object in the selected viewing direction. 
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3.4.10  Configuration Manager 
The Configuration Manager provides access to all settings available for display properties, 
fonts, toolbars, print headers etc. To open the Configuration Manager, select Configuration 
Manager on the Options menu, or use the toolbar button shown on the left. 

 
Figure 3.23: Dialog box Configuration Manager 

Available configurations 
This dialog section lists all configurations that have been user-defined or created during instal-
lation. The setting currently used by the program is shown in bold and indicated as current. 

The Standard configuration is preset, it cannot be deleted. 

The buttons below the dialog section have the following functions: 

Button Function 

 
Sets the entry selected above as new current configuration 

 
Creates a new configuration from current settings ( Figure 3.24) 

 
Renames the selected configuration 

 
Exports the selected configuration in a file 

 
Imports a configuration from a file 

 
Resets the default values 

 
Deletes the selected configuration (not possible for Standard and current) 

Table 3.7: Buttons for Available Configurations 
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Use the [New] button to save the current settings as a new configuration. A dialog box opens 
where you have to enter a Description. An optional Comment makes it easier to select among 
various user-defined configurations later. 

 
Figure 3.24: Dialog box New Configuration 

Settings 
The buttons available in the dialog section Settings provide access to different dialog boxes 
with configuration parameters. They are described in the following table. 

Button Description Function 

 
Display properties Opens the dialog box Display Properties 

 chapter 11.1.2, page 417 

 
Program options Opens the multi-tab dialog box Program Options 

�� chapter 7.3.3, page 274 
 chapter 9.10, page 379 
 chapter 11.1.1, page 416 
 chapter 11.1.4, page 422 

 
Toolbars  
and menus 

Opens the dialog box Customize 
 chapter 3.4.2, page 21 

 
Margins and 
stretch factors 

Opens the dialog box Display Margins and Stretch Factors 
 chapter 11.3.11, page 458 

 
Table colors Opens the dialog box Colors for the table colors 

 chapter 11.5.4, page 486 

 
Table fonts Opens the dialog box Font for the table fonts 

 chapter 11.5.4, page 486 

 
Header and footer 
of printout report 

Opens the dialog box Printout Report Header 
 chapter 10.1.4, page 389 

Table 3.8: Function of buttons in the dialog section Settings 
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4.  Model Data 
Starting RFEM 
To start the program, use the Windows Start menu or the Dlubal icon on the desktop. 

To enter data, a model must be created or opened (see chapter 12.2, page 554). 

RFEM offers different options to enter data: You can define objects in a dialog box, a table 
and often directly in the graphic. All input is interactive, which means that graphical input is 
immediately reflected in the table and vice versa. 

For first steps with RFEM we recommend to try the introductory example that may be helpful 
for beginners. You find the corresponding manual available for download on our website: 
www.dlubal.com/downloading-manuals.aspx 

Open the input dialog box 
You can access the input dialog boxes and the graphical input in different ways. 

Menu Insert 

 

Figure 4.1: Menu Insert → Model Data 

Toolbar Insert 

 
Figure 4.2: Toolbar Insert 

 

http://www.dlubal.com/downloading-manuals.aspx
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Context menu in Data navigator 

 
Figure 4.3: Context menu of model data objects in the Data navigator 

Context menu or double-click in table 

 
Figure 4.4: Context menu in model data tables 

The input dialog box can be accessed by means of the context menu (or by double-click) of the 
row number. 
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Open the edit dialog box 
RFEM provides different possibilities to open a dialog box for editing model objects. 

Menu Edit 

 

Figure 4.5: Menu Edit → Model Data 

Context menu or double-click in graphic 

 
Figure 4.6: Context menu of a node in the work window 
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Context menu or double-click in Data navigator 

 
Figure 4.7: Context menu of model data objects in the Data navigator 

Context menu or double-click in table 

 
Figure 4.8: Context menu in model data tables 

The edit dialog box can be accessed by means of the context menu (or by double-click) of the 
row number. 
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Table input 
Input and modifications carried out in the graphical user interface are immediately shown in 
the tables, and vice versa. To open the model data tables, use the leftmost button in the table 
toolbar shown on the left. 

 
Figure 4.9: Button [Table 1. Model Data] 

Input in the form of spreadsheet data entered in tables can be quickly edited and imported 
(see chapter 11.5, page 480). 

Unused objects are highlighted in blue in the tables and the Data navigator. 

In each dialog box and table, it is possible to add a Comment specifying the object. You can al-
so use predefined comments (see chapter 11.1.4, page 421). Moreover, comments are part of 
ScreenTips for graphical objects. 

 
Figure 4.10: ScreenTip of a nodal support 
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4.1 Nodes 
General description 
The geometry of the model is defined by nodes. They are essential for creating lines, and thus 
members, surfaces and solids. Every node is specified by its coordinates (X,Y,Z). The coordinates 
usually refer to the origin of the global coordinate system, but it is also possible to define them 
in relation to another node. 

 
Figure 4.11: Dialog box New Node 

 
Figure 4.12: Table 1.1 Nodes 

The node number is assigned automatically in the dialog box New Node but can be modified in 
the input field. The order of the node numbering is not important and gaps are permitted. 

To adjust the order of node numbers subsequently, select Renumber on the Tools menu (see 
chapter 11.4.18, page 478). 

Furthermore, RFEM provides a special function to create a node on the connection line of two 
nodes already existing (see chapter 11.4.12, page 473). 
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Node type 

Default 

This type of node is most frequently used. Standard nodes can be placed graphically in the 
work plane or anywhere in the workspace by coordinate specification. When you enter lines or 
rotated surfaces graphically, standard nodes will be created. 

Standard nodes are displayed in red in the graphic. 

On Line 

Use this type of node to avoid that a line is divided into two lines. The complete line remains 
unchanged. The nodal parameter δ describes the relative distance to the start node of the line. 

By creating nodes on lines it is possible to apply nodal loads anywhere on the line or to force 
an FE node. 

 

Figure 4.13: Node on line 

Nodes on lines are displayed in light blue by default. 

On Surface 

It is difficult for quadrangle surfaces to determine the coordinates of nodes placed on the 
curved surface. With the node type Node on Surface you can place a node directly on a quad-
rangle surface displayed in the graphic. The nodal parameters δ1 and δ2 refer to the four corner 
nodes of the surface. 

By creating nodes on surfaces it is possible to apply nodal loads anywhere on the curved sur-
face or to force an FE node. 

 

Figure 4.14: Node on surface 

Coordinates in the table are stored in the Cartesian coordinate system. Nodes on surfaces are 
graphically displayed in light blue by default. 

If you work with plane surfaces, use standard nodes. 
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Trajectory 

This type of node is created when you define a spiral trajectory curve (see chapter 4.2, page 
58). The nodal parameter δ describes the relative distance to the start node of the line. 

 

Figure 4.15: Trajectory 

Trajectory nodes in the graphic are displayed in dark green by default. 

Reference node 
In general, coordinates of a node refer to the origin of the global coordinate system. You do 
not need to define the node (0/0/0) because RFEM recognizes the origin automatically. 

Any node may serve as reference node. Even a node with a higher number is allowed to be 
used as reference node. Referring to another node may be useful to define for example a new 
node in a certain distance to an already known position. The table list with its option "Previous 
node" is especially useful in this case. 

In the dialog box New Node, you can enter the reference node directly, select it from the list or 
define it graphically by using the [] button. 

Coordinate system 
The coordinates of a node always refer to a coordinate system that describes the position of 
the node in the workspace. Depending on the model geometry you can select between differ-
ent coordinate systems. All coordinate systems are clockwise-oriented. 

Cartesian 

The global axes X, Y and Z describe a translational expansion (linear). All directions of coordi-
nates are on an equal footing. 

 
Figure 4.16: Cartesian coordinate system 

In most cases, nodes can be defined in the Cartesian coordinate system. 
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X-cylindrical 

The X-axis describes a translational expansion. The radius R defines the distance of the node to 
the X-axis. The angle θ defines the rotation of the coordinates about the X-axis. 

The X-cylindrical coordinate system will be applied to represent for example tubular models 
whose central axis is the X-axis. 

 

Figure 4.17: X-cylindrical coordinate system 

Y-cylindrical 

This coordinate system is similar to the X-cylindrical system, but now the longitudinal axis is 
represented by the Y-axis. 

 

Figure 4.18: Y-cylindrical coordinate system 

Z-cylindrical 

The coordinate system is similar to the X-cylindrical system, but now the longitudinal axis is 
represented by the Z-axis. 

 

Figure 4.19: Z-cylindrical coordinate system 

Polar 

In the polar coordinate system, the node position is described by a radius defining the distance 
to the point of origin and the angles θ and Φ. 

 

Figure 4.20: Polar coordinate system 
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If possible, organize the model input with regard to the global coordinate system in such a 
way that the X-, Y-, and Z-axes of the coordinate system are in line with the principal directions 
of the modeled framework. This allows for an easier definition of coordinates, conditions and 
loads. 

To define nodes directly in the workspace, open the floating dialog box New Node for graphical 
input. Usually, nodes snap on grid points which are aligned with the active user-defined or 
global coordinate system (CS). 

 
Figure 4.21: Floating dialog box New Node 

For more information about user-defined coordinate systems, see chapter 11.3.4 page 442. 

When the coordinate system is changed in the table, it is possible to convert node coordinates 
automatically to the new system. The following query will be displayed. 

 
Figure 4.22: RFEM query 

In the same way, you can convert node coordinates with the Previous reference node in rela-
tion to the origin. 

Node coordinates 
Node coordinates are defined in the coordinate system that you have previously set. When 
you model a 3D structure, the node is clearly defined by the coordinates X, Y and Z or the radi-
us and angles. Coordinate parameters and table column titles are changing depending on the 
coordinate system. 

When the model type is restricted to a 2D plate or wall, it is not possible to access all three input 
fields or columns. 

To adjust Lengths and Angles, select Units and Decimal Places on the Edit menu, or use the 
corresponding button in the dialog box.  
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With the following procedure you can check if all nodes of a surface are placed in one plane: 
Select the relevant nodes and double click one of them to open the dialog box Edit Node.  
Coordinates data is filled only in those input fields whose values are conform for all selected 
nodes. If this is not the case, you can assign a uniform plane coordinate to the selected nodes 
now. 

It is possible to import node coordinates from Excel spreadsheets (see chapter 11.5.6, page 
488). Furthermore, you can determine node coordinates with the Formula Editor of RFEM (see 
chapter 11.6, page 491). In addition, you can take advantage of several model generators facili-
tating the input (see chapter 11.7.2, page 506). 

To enter accurate, unrounded coordinates, select Full Precision in the dialog box New Node. 

 
Figure 4.23: Context menu in the dialog box New Node and dialog box Full Precision 

Comment 
You can enter user-defined notes. Use the button [Apply Comment] to import saved comments 
(see chapter 11.1.4, page 421). 

The comment Generated is displayed for nodes that are generated by RFEM when creating an 
intersection or a rotated surface. Click the button shown on the left, available in the dialog box 
and table, to “unlock” generated nodes, to make them accessible for modifications. 
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4.2 Lines 
General description 
The geometry of the model is defined by lines. They are essential for creating members, sur-
faces and solids. Every line is defined by a start and an end node. To define complex types of 
lines, intermediate nodes are additionally required. 

 
Figure 4.24: Dialog box New Line 

 
Figure 4.25: Table 1.2 Lines 

The line number is assigned automatically in the dialog box New Line but can be changed in 
the input field. The order of the line numbering is not important. 

To adjust the order of line numbers subsequently, select Renumber on the Tools menu (see 
chapter 11.4.18, page 478). 
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Line type 
The following line types are available for selection on the menu as well as in the table list. 

• Single line 

• Polyline 

• Arc 

• Circle 

• Ellipse 

• Elliptical Arc  

• Parabola 

• Hyperbola 

• Spline 

• NURBS 

• Trajectory 

• On Surface 

The different types of lines are described on the following pages. 

Nodes 
Every line is geometrically defined by a start and an end node. They define the orientation of a 
line that also affects the position of the line coordinate system. The nodes can be entered 
manually, graphically selected or redefined (see chapter 4.1, page 43). If a line requires control 
points or intermediate nodes, they are also included in the nodes list. 

The display of line orientations can be activated in the Display navigator. 

 

Figure 4.26: Activating Line Orientations in the Display navigator 

The line orientation can be changed quickly in the graphic: Right-click the line and select  
Reverse Line Orientation in the context menu. The numbers of the start and end node will be  
interchanged. 

The coordinate systems of lines can be activated in the Display navigator: Select Model and 
Lines, and tick Line Axis Systems x, y, z including Indexes (see Figure 4.96, page 101). 
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Line length 
This table column shows the total length of the line. 

Position 
Table column D informs you about the global axis running parallel to the line or indicates the 
plane spanned by global axes where the line is lying. If there is no entry, the line is in an arbi-
trary spatial position. 

Comment 
You can enter user-defined notes. Use the button [Apply Comment] to import saved com-
ments (see chapter 11.1.4, page 421). The comment Generated appears for lines created by 
RFEM (for example a pipe). 

Line / Polyline 

 
Figure 4.27: Graphical input dialog box New Line 

Selecting the line entry in the pull-down menu opens the dialog box New Line shown in Figure 
4.24 on page 49.  The figure above shows the general dialog box for entering lines graphically. 
Use the list button in the toolbar to open it. 

A “real” line is defined by only one start and only one end node. Such a line represents a direct 
connection between both nodes. 

A polyline is a polygonal chain consisting of several straight line sections. Therefore, the inter-
mediate nodes are listed in the dialog box (see Figure 4.24) in addition to the numbers of the 
start and end nodes. For reasons of simplified line management, “real” lines are handled as 
polylines. 

When entering polylines graphically, already existing nodes, grid points or snap objects can be 
selected as definition nodes. It is also possible to set nodes freely into the work plane. 

For example, if line loads or line supports are effective only for sections of a polyline, you can 
split the polyline into "real" lines subsequently: Right-click the polyline and select Explode Poly-
line in the context menu. You can also open the Edit menu where you point to Model Data and 
Lines, and then select Explode Polyline. 
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Figure 4.28: Dialog box New Line, tab Rotation 

In the second tab of the dialog box you can define a Rotation of the line. Specify either an Angle 
β or a Help node to which the line axis y or z is aligned. The help node can be selected in the list 
or defined graphically. It is also possible to create a new node. 

A rotation of the line may facilitate the input of line loads acting in local line direction. Line ro-
tations do not affect surfaces or members because they have their own coordinate system. 

The local line axis systems are shown in Figure 4.96 on page 101. 

Arc 

 
Figure 4.29: Dialog box New Line, tab Arc 
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An arc can be defined by the following parameters: 

• three nodes 

• center node, edge node and opening angle 

• edge nodes and radius, opening angle or rise 

• tangents and radius 

In the dialog section Nodes at Arc, you can define the start, intermediate and end node directly 
or select them graphically. You can also create new nodes. The node order is shown in the 
small dialog graphic. 

Based on these three nodes, RFEM determines the Arc Parameters specified in the dialog sec-
tion below. It is possible to change the radius r, the rise h and the opening angle α. The node 
coordinates will be adjusted accordingly. 

The coordinates of the arc center resulting from the arc nodes or parameters are displayed in 
the dialog section Center of Arc. When you change data manually or select nodes graphically 
with the [] button, the coordinates of nodes will be adjusted as well. 

In the list Subsequent adjustment by displacing node at you can define the node for which you 
want to change the coordinates. 

When you define the arc graphically by using the toolbar button Arc via Three Nodes, you can 
select or create the nodes directly in the graphic. 

If you select one of the other input options shown in Figure 4.30 and Figure 4.31 on the left, 
you have to select two nodes first. Then, when the second node is defined, another dialog box 
appears (shown on the right) where you define the arc parameters. 

 
Figure 4.30: Dialog box New Arc, definition type Arc via Center Node, Edge Node and Angle 

In the dialog section Options (in Figure 4.30 and Figure 4.31 on the right), you can select the 
plane of the arc from the list. Define the Included Angle α directly in the graphic or enter the 
angle manually and then click the [Apply] button. 

To adjust an already defined arc, double-click its arc line. The dialog box Edit Line opens where 
you can modify entries in the dialog tab Arc - Three Nodes (see Figure 4.29, page 52). 
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Figure 4.31: Dialog box New Arc, definition type Arc via Edge Nodes and Radius, Angle or Rise 

In the dialog section Definition Type (right box), select the appropriate arc parameter from the 
list. Then, set the arc directly into the graphic, or enter it manually and click the [Apply] button. 

In the input field Step you can enter the spacing by which the pointer snaps on when dragging 
the arc radius, angle or rise. 

The orientation of the circular arc can be adjusted by ticking the check box Reverse orientation, 
determining whether the arc is placed to the “right” or “left” of both nodes. 

Circle 
A circle can be defined by the following parameters: 

• three nodes 
• center point and radius. 

 
Figure 4.32: Dialog box New Line, tab Circle - Normal 
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You can enter the Circle Radius and the coordinates for the Center of Circle manually or graph-
ically by using the [] button. The Point of Normal to Circle Plane determines the plane in which 
the circle is generated. Use the three buttons of the dialog section to select one of the global 
axes. 

 
Figure 4.33: Dialog box New Circle, definition type Center and Radius 

When you define the circle graphically by using one of the toolbar buttons, you can select or 
create the three nodes as well as the center and radius directly in the graphic. 

Ellipse 
To define an ellipse, three nodes are required. 

 
Figure 4.34: Dialog box New Line, tab Ellipse 

The ellipse is generated by the Nodes on Ellipse: The largest distance between the three en-
tered nodes is assumed to be the principal axis of the ellipse. 

When you use the toolbar button to define the ellipse graphically, you can set it directly by  
selecting three nodes in the work plane. 
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Elliptical arc / parabola / hyperbola 
The following curves of conic sections can be defined: 

• Elliptical arc 

• Parabola 

• Hyperbola 

 
Figure 4.35: Dialog box New Line, tab Hyperbola 

Enter the curve parameters (focus, angle, axis rotation etc.) manually in the corresponding tab 
of the dialog box New Line. You can also define them graphically. 

When you enter line data graphically by using one of the toolbar buttons, you can define the 
curve parameters directly in the graphic. 
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Spline 
Splines are used to model any kind of curves. Enter a spline line graphically by selecting  
determinant nodes of the curved line one after the other, or create nodes by mouse-click. 

 
Figure 4.36: Dialog box New Line - line type Spline 

NURBS 
NURBS (Non-Uniform Rational B-Splines) are required for modeling free form surfaces. NURBS 
are splines whose control points are not placed on the curve itself. Usually, these lines are en-
tered graphically by selecting control points one after the other or by generating points by 
mouse-click. 

 
Figure 4.37: Dialog box New Line - line type NURBS 
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Trajectory curve 
Use trajectory curves to create helical lines. Usually, they are entered graphically by using the 
toolbar button shown on the left. The following dialog box appears: 

 
Figure 4.38: Dialog box New Trajectory Curve 

First, define the Coordinates of the line start. Then, the dialog section Parameters is enabled 
where you can specify the total Rotation of the helix. 

Define the Coordinates of the line end graphically, or enter them manually and click the [Apply] 
button. Alternatively, you can use the input field Length. Finally, the coordinates of the line end 
will be determined considering the specified rotation in the work plane. 

To adjust an already defined trajectory curve, double-click its trajectory line. The dialog box  
Edit Line opens where you can modify entries in the dialog tab Trajectory. 

Line on surface 
In general, lines in plane surfaces are recognized automatically as integrated objects so that 
the line type Polyline is usually sufficient. However, to set a line on a curved surface, use the line 
type Line On Surface. You can also use this option to insert lines in plane surfaces which are not 
defined parallel to the global axes - without creating a new user-defined coordinate system. 

The input dialog box is similar to the box of a polyline (see Figure 4.24, page 49). 

Enter the start and end nodes of the line in the dialog box or select them graphically. To set 
nodes directly on a curved surface, use the floating dialog box New Line of Type 'On Surface', 
but take care that the surface has been previously selected and the model display option Solid 
or Solid Transparent is active. RFEM will generate nodes of the type On Surface. 

The surface where the line is integrated is defined in the second tab On Surface of the New Line 
dialog box. You can also check the parameters δ1 and δ2 of the start and end node (see Figure 
4.14, page 44), but it is not possible to change them. 
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Figure 4.39: Dialog box New Line, tab On Surface 

If you choose the graphical line input, using the toolbar button [Line on Surface], you can 
place the nodes directly on the curved surfaces. Please note that the display option Wireframe 
Display Model is not appropriate for the input.  
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4.3 Materials 
General description 
Materials are required to define surfaces, cross-sections and solids. The material properties af-
fect the stiffnesses of model objects. 

A Color is assigned to each material. Colors are used by default in the rendered model for the 
representation of objects (see chapter 11.1.9, page 427). 

For new models RFEM presets the two materials that were last used. 

 
Figure 4.40: Dialog box New Material 

 
Figure 4.41: Table 1.2 Materials 

Material description 
Any name can be chosen as Description of the material. When the entered name corresponds 
to an entry of the library, RFEM will import the material properties. The import of materials 
from the library is described later. 

Modulus of elasticity E 
The modulus of elasticity describes the ratio between normal stress and strain. 

To adjust the settings for Materials, click Units and Decimal Places on the Edit menu, or use 
the corresponding button.  
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Shear modulus G 
The shear modulus G is the second parameter used to describe the elastic behavior of a linear, 
isotropic and homogenous material. 

The shear modulus of the materials listed in the library is calculated according to Equation 4.1 
from the modulus of elasticity E and the Poisson's ratio ν. Thus, a symmetrical stiffness matrix is 
ensured for isotropic materials. The shear modulus values determined in this way may slightly 
deviate from the specifications in the Eurocodes. 

Poisson's ratio ν 
The following relation exists between elastic and shear modulus and the Poisson's ratio ν. 

( )ν+= 1G2E  

Equation 4.1 

When you define the properties of an isotropic material manually, RFEM will determine auto-
matically the Poisson's ratio from the values of elastic and shear modulus (respectively shear 
modulus from modulus of elasticity and Poisson's ratio). 

Generally, the Poisson's ratio of isotropic materials is between 0.0 and 0.5. Therefore, for a value 
higher than 0.5 (for example rubber) we assume that the material is not isotropic. Before the 
calculation starts, a query appears asking if you want to use an orthotropic material model. 

Specific weight γ 
The specific weight γ describes the weight of the material per volume unit. 

The specification is especially important for the load type 'self-weight'. The automatic self-
weight of the model is determined by the specific weight and the cross-sectional areas of the 
used members or surfaces and solids. 

Coefficient of thermal expansion α 
The coefficient describes the linear correlation between changes in temperature and axial 
strains (elongation due to heating, shortening due to cooling). 

The value is important for the load types 'temperature change' and 'temperature differential'. 

Partial safety factor γM 

The value describes the safety factor for the material resistance. Therefore the index M is used. 
Use the factor γM to reduce the stiffness for calculations according to second-order and large 
deformation analysis (see chapter 7.3.1, page 267). 

Do not confuse the factor γM with the safety factors for the determination of design internal 
forces. The partial safety factors γ on the action side take part in combining load cases for load 
and result combinations. 
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Material model 
Nine material models are available for selection in the list. Use the [Details] button in the dia-
log box or table to access dialog boxes where you can define the parameters of the selected 
model. 

If the add-on module RF-MAT NL is not licensed, you can use only the material models Isotropic 
Linear Elastic and Orthotropic Elastic 2D/3D. 

Isotropic linear elastic 

The linear-elastic stiffness properties of the material do not depend on directions. They can be 
described according to Equation 4.1. The following conditions apply: 

• E > 0 

• G > 0 

• –1 ≤ ν < 0.5 (only for surfaces and solids, not bounded above for members) 

The elasticity matrix (inverse of stiffness matrix) for surfaces is the following: 
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Equation 4.2 

Isotropic plastic 1D 

If you have set the 3D model type (see Figure 12.23, page 554), you can define the plastic 
properties of the isotropic material in a dialog box. RFEM will take into account these proper-
ties for member elements, for example for plastic calculations of a kinematic chain. 

Only if a sufficient number of FE nodes is created on the member, the nonlinear material be-
havior will be determined correctly in the calculation. The following possibilities are available: 

• Dialog box Divide Member Using n Intermediate Nodes (see Figure 11.91, page 469), meth-
od of division: without dividing it 

• Dialog box FE Mesh Settings (see Figure 7.10, page 258), option Use division for straight 
members with a Minimum number of member divisions of 10 

 
Figure 4.42: Dialog box Material Model - Isotropic Plastic 1D 
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Define the parameters of the ideally or bilinearly plastic material. You can also define a stress-
strain Diagram to represent the material behavior close to reality. 

 
Figure 4.43: Dialog box Material Model - Isotropic Plastic 1D, stress-strain diagram 

The material properties can be defined separately for the Positive and the Negative Zone. The 
Number of steps determines the number of definition points respectively available. Enter the 
strains ε and the corresponding normal stresses σ in the two lists. 

You have several options for the Diagram after last step: Tearing for material failure when ex-
ceeding a certain stress, Yielding for restricting the transfer of a maximum stress, Continuous as 
in the last step or Stop for restricting to a maximum allowable deformation. 

It is also possible to import parameters from an [Excel] worksheet. 

Watch the dynamic graphic to the right to check the material properties. The dialog field Ei  
below the graphic shows the modulus of elasticity for the current definition point. 

Use the [Save As] button in the dialog box to store the stress-strain diagram so that you can 
apply it to different models. To import user-defined diagrams, click the [Load] button (see fig-
ure below). 

The check box Activate shear stiffness of members (cross-sectional areas Ay, Az) in the dialog box 
Calculation Parameters (see Figure 7.22, page 271) is without effect for members with isotropic 
elastic-plastic material properties. This material model uses the beam theory according to EU-

LER BERNOULLI where shear distortions are neglected. 
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Figure 4.44: Dialog box Load Dialog Box Data 

Isotropic plastic 2D/3D 

This material model shows an isotropic material behavior in the elastic zone. The plastic zone is 
based on the yielding according to VON MISES (J2 plasticity) with a user-defined Yield strength of 
the equivalent stress for surfaces and solids. 

 
Figure 4.45: Dialog box Material Model - Isotropic Plastic - von Mises 2D/3D 

Define the parameters of the ideally or bilinearly plastic material. You can also define a stress-
strain Diagram to represent the material behavior close to reality (see Figure 4.43). The same 
relations apply for tension and compression. 

The yielding is the following: 
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( ) ( ) ( ) ( )2
yz

2
xz

2
xy

2
zx

2
zy

2
yxv 6

2

1
τ+τ+τ+σ−σ+σ−σ+σ−σ=σ

   for 3D elements 

Equation 4.4 

For plastic material properties calculations are carried out iteratively and with load increments 
(see chapter 7.3, page 274). If the stress is exceeded in a finite element, the modulus of elastici-
ty will be reduced there and a new calculation run starts. The process is repeated until a con-
vergence is reached. When the calculation is done, stiffness reductions can be checked also 
graphically (see chapter 9.3.2, page 349). 
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When evaluating results, it is recommended to use the smoothing option Constant on Elements 
(see Figure 9.31, page 363). The setting ensures that the defined stress limit is displayed as 
maximum in the results panel. Plastic effects can be considered only element by element in 
the calculation. For the remaining smoothing options, however, RFEM interpolates or extra-
polates the results. This may lead to distortions that are more or less distinct depending on the 
mesh. 

Isotropic nonlinear elastic 2D 

This material model is similar to the model Isotropic Plastic 2D/3D described above but no en-
ergy is delivered to the model (conservative analysis). As the same stress-strain relations apply 
for loading and relief of load, no permanent plastic distortions are available after a relief. 

 
Figure 4.46: Dialog box Material Model - Isotropic Nonlinear Elastic 2D 

The elasticity matrix is damped isotropically in order that the stress-strain relations of the 
equivalent stresses and distortions according to VON MISES are fulfilled. They are defined by 
the following conditions: 
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Equation 4.5 

In the Diagram, it is possible to define the stress-strain relations separately for the tension and 
the compression zone (see Figure 4.43). 

Generally, many iterations are required for this material model until convergence is reached. 
Therefore, it is recommended to specify a minimum value of 300 as the Maximum number of  
iterations among the calculation parameters (see chapter 7.3.3, page 271). 
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Orthotropic elastic 2D 

You can define stiffness properties that appear differently in both surface directions x and y.  
In this way, you can model for example ribbed floors or stress directions of reinforced ceilings. 
The surface axes x and y are perpendicular to each other in the surface plane (see Figure 4.73, 
page 83). 

The RFEM 4 material models Orthotropic and Orthotropic Extra are converted into this model. 

 
Figure 4.47: Dialog box Material Model - Orthotropic Elastic 2D 

With this material model you can assign an orthotropic property globally to all surfaces con-
sisting of a particular material. Alternatively, it is possible to define the parameters for each  
surface individually (see chapter 4.12 Orthotropic Surfaces, page 112). 

An orthotropic elastic material is characterized by the moduli of elasticity Ex and Ey, the shear 
moduli Gyz, Gxz and Gxy as well as the Poisson's ratios νxy and νyx. The elasticity matrix (inverse of 
stiffness matrix) is defined as follows: 
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Equation 4.6 

The following correlation exists between principal Poisson's ratio νxy and secondary Poisson's 
ratio νyx: 
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Equation 4.7 

The following conditions must be met for a positively definite stiffness matrix: 

• Ex > 0;   Ey > 0 

• Gyz > 0;   Gxz > 0;   Gxy > 0 
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Orthotropic elastic 3D 

In a three-dimensional material model, you can define elastic stiffnesses separately in all direc-
tions of the solid. In this way, you can represent for example strength properties of wood-based 
materials. 

 
Figure 4.48: Dialog box Material Model - Orthotropic Elastic 3D 

The elasticity matrix is defined as follows: 
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Equation 4.8 

The following correlations exist between the principal Poisson's ratios νyz, νxz, νxy and the  
secondary Poisson's ratios νzy, νzx, νyx: 
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Equation 4.9 

The following conditions must be met for a positively definite stiffness matrix: 

• Ex > 0;   Ey > 0;   Ez > 0 

• Gyz > 0;   Gxz > 0;   Gxy > 0 
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Orthotropic plastic 3D 

The material model according to TSAI-WU unifies plastic with orthotropic properties. In this 
way, you can enter special modelings of materials with anisotropic characteristics like plastics 
or timber. When the material is yielding, stresses remain constant. A redistribution is carried 
out according to the stiffnesses available in the individual directions. 

 
Figure 4.49: Dialog box Material Model - Orthotropic Plastic - Tsai-Wu 3D 

The elastic zone corresponds to the material model Orthotropic Elastic 3D (see above). For the 
plastic zone the yielding according to TSAI-WU applies: 
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where ft,x, ft,y, ft,z Plastic ultimate tensile strength in direction x, y or z 
 fc,x, fc,y, fc,z Plastic ultimate compressive strength in direction x, y or z 
 fv,yz, fv,xz, fv,xy Plastic shear strength in direction yz, xz or xy 

Equation 4.10 

All strengths must be defined positively. 

The stress criteria can be imagined as a surface in the shape of an ellipse within a six-dimensional 
space of stresses. If one of the three stress components is applied as constant value, the surface 
can be projected on a three-dimensional stress space (see figure below): 

 

Figure 4.50: Projection of yielding surfaces for normal stresses according to TSAI-WU 
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When the value for fy(σ) according to Equation 4.10 is lower than 1, stresses lie in the elastic 
zone. The plastic zone is reached as soon as fy(σ) = 1. Values higher than 1 are not allowed.  
The model behavior is ideal-plastic, which means no strengthening takes place. 

Equation 4.10 is only valid for the local FE coordinate system. If it is not conform to the solid's 
coordinate system used for the stress output in RFEM, the values must be transformed accord-
ingly. 

Isotropic thermal-elastic 

Temperature-dependent stress-strain properties of an elastic isotropic material can be defined 
in a diagram or imported from [Excel]. These properties will be considered for member and 
surface elements subjected to thermal load (changes or differences in temperature). 

 
Figure 4.51: Dialog box Material Model - Isotropic Thermal-Elastic 

The Reference temperature defines stiffnesses for the members or surfaces that have no tem-
perature loads. For example, when a reference temperature of 300 °C is set, RFEM applies the 
reduced elastic modulus of this point of the temperature curve to all members and surfaces. 

With the setting in the dialog section Options you decide if identical Poisson's ratios are applied 
to the complete temperature diagram. Remove the checkmark to access the table column 
Poisson's Ratio when you want to enter individual entries. 

Use the [Load] button to import predefined temperature diagrams for different ferrous alloys 
(see Figure 4.44, page 64). 

Click the [Save] button to save user-defined temperature diagrams so that you can use them 
for other models. 
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Isotropic masonry 2D 

Use this material model to take into account masonry walls not able to bear tension forces but 
reacting with crack formation. 

 
Figure 4.52: Dialog box Material Model - Isotropic Masonry 2D 

The dialog box allows for the definition of the Limit tension stresses in direction of the surface 
axes x and y, which means parallel and perpendicular to the interstices of support. Then, when 
calculating data, RFEM finds out by several iterations which finite elements become stress-free 
due to the failure criterion. 

When the limit tension stress is set to zero, RFEM applies a limit value of 10-11 N/mm2 in calcu-
lations for reasons of stability. Thus, minor tensile stresses are not completely excluded. 

If numerical problems occur during the calculation, you can try to reach convergence by in-
creasing the Hardening factor CH. 

If the masonry material has already been defined in the library before you open the dialog box 
Material Model, the following limit values are preset: 

Standard σx,limit σy,limit 

DIN 1053-100 

 

fx2 

tensile strength parallel to interstice 
of support 

0 

 

EN 1996-1-1 

 

fxk2 

tensile strength parallel to interstice 
of support 

fxk1 

tensile strength perpendicular to 
interstice of support 

Table 4.1: Limit tension stresses according to masonry standards 

Material Library 
The properties of many materials are stored in a comprehensive database that can be extended. 

Open the library 

To access the library, click the [Material Library] button (cf. Figure 4.40, page 60) in the dialog 
box New Material. You can open the database also in table 1.3 Materials (cf. Figure 4.41, page 
60): Place the cursor into table column A and click the button [...] shown on the left, or use the 
function key [F7] on the keyboard. 
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Figure 4.53: Dialog box Material Library 

Select a material from the list Material to Select and check the corresponding parameters in the 
lower part of the dialog box. Click [OK] or [↵] to accept it for the previous dialog box or the table. 

Library filter 

As the material library is very large, you find various selection options available in the dialog 
section Filter. You can filter the material list according to Material category group, Material  
category, Standard group and Standard. In this way, you can reduce offered data. 

  

Figure 4.54: Filter for Material category group and Material category 
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Create favorites 

Often, the use of a few materials is already sufficient for daily engineering work. You can mark 
these materials as your favorites. Use the button [Edit Favorites] (see Figure 4.56) to open the 
dialog box for defining preferred materials. 

 
Figure 4.55: Dialog box Material Library - Favorites (dialog section) 

The dialog box looks like the material library. You can use the filter options described above. In 
the dialog section Material Library - Favorites, you can select your preferred materials by ticking 
their check boxes. To change the sequence of materials, use the buttons [] and []. 

After closing the dialog box, the material library presents a clear favorites overview as soon as 
you activate the option Favorites only. 

 
Figure 4.56: Dialog box Material Library with option Favorites only 
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With the option Include invalid in the Filter dialog section you can integrate also materials of 
'old' standards into the library. 

Complete library  

The Material Library can be extended. When a new material is added, it can be used for all 
available models. 

Click the [New] button in the library (to the right of the [Favorites] button, see Figure 4.56). The 
dialog box New Material opens. You can see that parameters of the entry selected in the list 
Material to Select are preset. So creating a new material is easier when you choose a material 
with similar properties before you access the dialog box. 

 
Figure 4.57: Dialog box New Material 

Enter the Material Description, define the Material Properties, and assign the material to the  
appropriate categories for Filter functions. 

Use the buttons shown on the left to create and edit categories. 

 
Figure 4.58: Dialog box Edit Material Category 
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To adjust the sequence of entries, use the buttons [] and []. 

Saving user-defined materials 

If you use customized materials, you should save the file Materialien_User.dbd before in-
stalling an update. The file can be found in the master data folder of RFEM 5 C:\ProgramData\ 
Dlubal\RFEM 5.xx\General Data. 

4.4 Surfaces 
General description 

In addition to structure geometry, surfaces describe the stiffness resulting from material and 
thickness properties. When generating the FE mesh, 2D elements are created on surfaces. For 
detailed information on used elements, see chapter 7.2.1 on page 256. 

The stiffness type Null is to be used for geometry descriptions of solids. 

 
Figure 4.59: Dialog box New Surface 

 
Figure 4.60: Table 1.4 Surfaces 

Different Geometry and Stiffness properties are available for structure modeling. It is possible  
to combine entries of both Surface Type lists or table columns − within type-specific limits and 
conditions. 
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Color symbols help you to assign various types for Geometry and Stiffness. You can use the  
colors in the model to represent individual surface types. Colors are controlled in the Display 
navigator with the option Colors in Rendering According to (see chapter 11.1.9, page 427). 

Surface type - geometry 

Plane surface 

Plane surfaces can be defined graphically by drawing a rectangle, parallelogram, circle, annu-
lus, polygon etc. Use the menu or the list button in the toolbar shown on the left to access dif-
ferent shapes of plane surfaces. 

The following dialog box appears when you enter surface data by using one of the toolbar 
buttons. 

 
Figure 4.61: Dialog box New Polygonal Surface 

First, enter the parameters for Material, Thickness and Stiffness in addition to the surface number. 
Click [OK], and then define the boundary lines of the surface in the work window by selecting 
relevant corner points. 

With the menu option [Select Boundary Lines] you can select existing lines graphically. The 
lines must be arranged in a polygonal chain lying in one plane. The line types are described in 
chapter 4.2, page 52. 

 
Figure 4.62: Selecting boundary lines in the graphic 

RFEM recognizes the surfaces automatically as soon as a sufficient number of boundary lines 
has been defined. 
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Quadrangle surface 

This type of surface represents a general quadrilateral surface. In addition to straight lines, you 
can use arcs, polylines and splines as boundary lines. Use this surface type to model shells as 
boundary lines do not have to be arranged in one plane. 

 
Figure 4.63: Dialog box New Quadrangle Surface 

You can select the boundary lines graphically after clicking [OK]. 

Rotated surface 

A rotated surface is created by rotating a line about a fixed axis. The surface results from the 
start and end position of the line as well as the line's rotated definition points. 

The dialog box New Rotated Surface consists of two tabs. Define Material, Thickness and Stiff-
ness of the surface in the General dialog tab (cf. Figure 4.64). A variable surface thickness is not 
allowed. 

 
Figure 4.64: Dialog box New Rotated Surface, tab Rotated 
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In the Rotated tab, specify the Angle of rotation α. Both points of the Rotation Axis can be de-
fined either by entering their coordinates or by using the [] function. Click [OK], and then  
define the boundary line for rotation in the work window. 

Moreover, rotated surfaces can be created from generated lines. 

Pipe 

A pipe surface is created by rotating the center line of the pipe about the center axis in a dis-
tance of a specific radius. 

 
Figure 4.65: Dialog box New Pipe, tab Pipe 

The dialog box New Pipe has two tabs. In the General tab, you enter the parameters for Material, 
Thickness and Stiffness of the surface. In the Pipe tab, you specify the Center line and Radius r. 
You can define the center line also graphically. 

Use this type of surface to create two circles and a polyline that is parallel to the pipe axis. 
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B-Spline surface 

A B-Spline surface is similar to a quadrangle surface (see Figure 4.63) but help nodes are created 
additionally on the surface. The surface shape can be influenced by adjusting the coordinates of 
help nodes subsequently. 

The input dialog box has two tabs. In the General tab, you define the parameters for Material, 
Thickness and Stiffness of the surface. A variable surface thickness is not allowed. 

 
Figure 4.66: Dialog box New Surface of type 'B-Spline', tab B-Spline 

In the B-Spline tab, you enter the number of help nodes into the input field Order of matrix:  
For example, if you enter "3", you create a grid of 3 x 3 help nodes placed across the surface. 
The selection field Order of spline specifies whether a polynomial of the third or fourth degree 
is used for the calculation of the surface. 

NURBS surface 

NURBS surfaces are defined by four connected NURBS lines (see chapter 4.2, page 57). By using 
NURBS surfaces you can model almost any free form surface. 

When entering boundary lines, make sure that opposite pairs of NURBS lines are "compatible" 
with each other. Only if the number of control points is equal, opposing NURBS lines are ar-
ranged in the same order. 
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Figure 4.67: Dialog box New NURBS Surface 

Trajectory surface 

Use this type of surface to create a spatially curved surface from a certain start profile in relation 
to any trajectory. 

The dialog box New Trajectory Surface has two tabs. In the General tab, you define the parame-
ters for Material, Thickness and Stiffness of the surface. 

 
Figure 4.68: Dialog box New Trajectory Surface, tab Trajectory 

In the Trajectory tab, enter the number of the Guide Line representing the reference line of the 
surface. You can select it also graphically. Then, determine the Start Profile in the graphic. If 
necessary, define a second line as End Profile. The Angle β describes the rotation of the parallel 
boundary line generated in relation to the trajectory. 
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Component 

This entry appears in the table column and navigator only if an intersection of surfaces has 
been created (see chapter 4.22, page 160). The editing functions for components of inter-
section surfaces provided by RFEM are the same as for "normal" surfaces. So it is possible to 
modify properties of surface components quickly without creating an intersection again. 

The original surface of a component is indicated in the Component tab of the Edit Surface  
dialog box. 

 
Figure 4.69: Dialog box Edit Surface, tab Component 

Use the button [Go to Parent Surface] to access the edit dialog box of the original surface. 

Surface type - stiffness{ 
The list available in the dialog box and table provides several stiffness models which you can 
select to model the structure more close to reality. 

Standard 

The surface transfers moments and axial forces. The approach describes the general behavior 
of a homogeneous and isotropic material. The stiffness properties of the surface do not de-
pend on directions. 

Without tension 

Moments and membrane forces are transferred. For axial forces causing tension, however, a 
failure of affected surface elements occurs (example: hole bearing). 

Orthotropic 

Set this type of stiffness for surfaces with different stiffnesses in both surface directions (see 
chapter 4.12, page 112). Use the [Edit] button to define the parameters. 

Alternatively, you can assign an orthotropic property to the material (see chapter 4.3, page 66). 
In this way, you can avoid defining properties for each single surface. 

Glass 

This type of stiffness is required for the add-on module RF-GLASS. Moments and membrane 
forces are transferred, but stresses are not determined in RFEM. The actual stress calculation is 
carried out later in the add-on module RF-GLASS. 

Laminate 

This stiffness type transfers moments and axial forces. The add-on module RF-LAMINATE is re-
quired to calculate the laminate model. Corresponding stresses are not included in the results 
output of RFEM, you need the module for stress calculation. 

Rigid 

Use this type of stiffness to generate very stiff surfaces creating a rigid connection between ad-
jacent objects. 
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Membrane 

The surface has a uniform stiffness in all directions. Only membrane forces are transferred. 

Membrane orthotropic 

Only membrane forces are transferred. Stiffnesses are different in both surface directions 
(chapter 4.12, page 112). Use the [Edit] button to define the parameters. 

Null 

Null surfaces are required for the definition of solids (see chapter 4.5, page 85). 

Boundary lines No. 
The boundary lines of a surface are listed in the corresponding input field or table column. 
They must form a polygonal chain. 

When rotated surfaces were generated, generation parameters are displayed in the table col-
umn. 

Material No. 
You can choose an entry from the list of materials that have already been created. Material 
colors make the assignment easier. 

 
Table 4.70: Buttons in the dialog section Material 

In the dialog box New Surface, you can see three buttons below the list. Use the buttons to ac-
cess the material library or to create and edit materials. 

For more detailed information on materials, see chapter 4.3 on page 60. 

Thickness 

Type 

You can select between two types of surface thickness. 

• Constant 
The surface has the same thickness everywhere. 

• Variable 
The thickness of the surface is linearly variable (see chapter 4.11, page 111). Use the [Edit] 
button to define the parameters. 

Thickness d 

Specify the surface thickness d unless a variable thickness or a Null surface has been defined. 
The thickness is used to determine self-weight and stiffness for the stiffness types Standard, 
Without tension, Glass and Membrane isotropic. For the Orthotropic stiffness this value is only 
used for self-weight calculation (stiffnesses must be defined separately for orthotropic surfac-
es). 

Surface thicknesses can be visualized with different colors in the model: In the Display navigator, 
select Model and Surfaces, and then tick the check box for Color Scale of Thicknesses in Panel (see 
figure below). 
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Figure 4.71: Display navigator: Surfaces → Color Scale of Thicknesses in Panel 

Eccentricity 
The plane in the surface center represents the reference surface for the thickness assumed to 
be in equal parts on both sides of the "centroidal plane". To check the center, set the Display 
navigator and select the options Rendering, Model, Solid Model, Surface and Filled incl. thickness 
(see Figure 4.110, page 112). 

By specifying an Eccentricity ez you can define an offset of height for the surface. In this way, you 
can create uniform top or bottom edges for adjoining surfaces that have different thicknesses. 

The eccentricity in the form of additional moments has an influence on the surface's internal 
forces. 

Integrated objects 
In general, RFEM recognizes automatically all objects lying on a surface but are not used for 
surface definition. In the table columns or input fields of the dialog box, all numbers of nodes, 
lines and openings are displayed. 

 
Figure 4.72: Dialog box Edit Surface, tab Integrated 

If an object is not recognized, it is possible to integrate it manually: Double-click the surface to 
open the dialog box Edit Surface. Then, in the Integrated tab, deactivate the option Automatic 
object detection. The input fields of the dialog sections to the left will be enabled for access. 
Use the [] button to select the objects graphically. 
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Area 
The area of each surface is shown in the table column so that you can check the surface data. 
Areas of openings are not taken into account, thus the value represents the net area. 

Weight 
The mass of each surface is indicated. It is determined from the area and the material's specific 
weight. 

Comment 
Enter a user-defined note or select an entry from the list. 

Axis system 
Each surface has a local coordinate system. The axis system of the surface is significant for var-
ious input parameters such as orthotropic and foundation properties or directions of surface 
loads. The base internal forces are also related to a surface axis system. 

RFEM shows you the coordinate systems as soon as you move the pointer across a surface.  
You can also use the context menu of a surface to switch them on and off. 

 

Figure 4.73: Surface context menu 

If required, you can adjust the local surface axes: 

• Context menu option Reverse Local Axis System 

 The orientation of the local z-axis is reversed, the remaining axes are aligned according  
to the right-hand rule. As a result, foundations are put on the other side of the surface, or 
the "top" and "bottom" reinforcement layers for the reinforced concrete design change 
surface sides. 

• Dialog box Edit Surface 

To open the dialog box Edit Surface, double-click the surface. In the Axes tab, you can  
adjust the local surface Axes for Input as well as for Results (see figure below). 
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Figure 4.74: Dialog box Edit Surface, tab Axes 

In the two sub-tabs, it is possible to direct the local surface axis x or y to a line, a point or a  
customized coordinate system (see chapter 11.3.4, page 443). 
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4.5 Solids 
General description 

In RFEM, 3D objects are described by solids. When generating the FE mesh, 3D elements are 
created. You can use solids to model also orthotropic properties or contact problems between 
surfaces. In addition, solids can have gas properties. 

In general, boundary surfaces of solids are defined with the stiffness type Null (see chapter 4.4, 
page 81). However, if no other solid is connected to a model representing the contact between 
two surfaces, both contact surfaces have to be characterized with a stiffness. 

In the graphic, solids can be created quickly from surfaces. Corresponding generation functions 
are described in chapters 11.7.1.3 and 11.7.1.4 on page 500. 

FE mesh refinements for 3D elements can be specified as well. 

Reinforced concrete designs are currently not implemented for solids. 

 
Figure 4.75: Dialog box New Solid 

 
Figure 4.76: Table 1.5 Solids 
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Solid type 
In the table as well as the list available in the dialog box, several stiffness types can be selected 
to model structures more close to reality. Each type has its own color that can be used in the 
model to differentiate solids. Colors are controlled in the Display navigator with the option 
Colors in Rendering According to (see chapter 11.1.9, page 427). 

Material 

The standard model is represented by a 3D object with the solid-specific properties of a ho-
mogeneous and isotropic material. Therefore, boundary surfaces should be defined by the 
stiffness type Null. 

If the solid has orthotropic properties, stiffnesses are derived from the material characteristics, 
too. Define the elastic stiffnesses of the three-dimensional material model in the dialog box 
Material Model - Orthotropic Elastic 3D (see Figure 4.48, page 67). 

Gas 

Use this option to model solids with properties of an ideal gas. The gas parameters have to be 
defined in a separate tab of the dialog box (see Figure 4.79). 

Gas between two surfaces 

It is recommended to form a solid with properties of an ideal gas as an object that is relatively 
thin (for example gas layer in insulating glass). With this option RFEM creates exactly two finite 
elements between cover and base area of the solid so that calculations converge faster than 
for the Gas type. The parameters have to be defined in a separate tab of the dialog box (see 
Figure 4.79). However, for general situations (for example container, bouncing castle) use the 
type Gas. 

Contact 

This solid type is appropriate for modeling contact properties between two surfaces. The pa-
rameters have to be defined in a separate tab of the dialog box (see Figure 4.80). 

Null 

Neither a Null solid nor its loads will be considered for the calculation. Null solids are used to 
analyze for example changes in the model's structural behavior if a solid is not effective. You 
do not need to delete the solid, the loading will be kept as well. 

Boundary surfaces 
A solid is defined by surfaces completely enclosing a certain space. Enter the numbers of the 
surfaces into the input field, or select them in the graphic by using the [] function. 

When you have defined all boundary surfaces in the dialog box New Solid, you can click the 
button [Show Figure or Rendering] below the graphic to see a preview of the solid. 

Material 
You can choose an entry from the list of materials that have already been created. Material 
colors make the assignment easier. 

 
Table 4.77: Buttons in the dialog section Material 
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In the dialog box New Solid, you can see three buttons below the list. Use the buttons to access 
the material library or to create and edit materials. 

For more detailed information on materials, see chapter 4.3, page 60. 

Compound solids 
When an intersection of solids has been created, you can see this column displayed in the ta-
ble. 

In addition to surfaces, you can generate intersections for solids. RFEM determines the inter-
section lines of intersecting solids and creates 3D solid objects as a union, a section or as pure 
intersecting set. In this way, a new solid is generated from two original objects. 

Determining the solid intersection is time-consuming and computationally intensive. Each 
time the model is changed, a recalculation of geometry is required. 

Creating an intersection 

You can create intersections of solids quickly in the graphic: Select two solids by drawing a se-
lection window across the objects, or use the multiple selection by holding down the [Ctrl] key. 
Then, right-click one of the solids to open its context menu where you  

point to Solid and select New Compound Solid. 

The dialog box New Solid opens. With the settings in the dialog tab Compound Solids you speci-
fy how both solids are combined. 

 
Figure 4.78: Dialog box New Solid, tab Compound Solids 

The numbers of the two selected solids are entered into the input fields. Use the list or the [] 
function to change the entries. 

Boolean operation 

You have three possibilities to combine solids in a new object: 

• Unite: Solids A and B are merged to a unit. 

• Subtract: Solid B is cut out of solid A. 

• Intersect: RFEM determines the area shared by solids A and B. 
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The dialog graphic to the right demonstrates the principle of combinations. Use the button 
[Show Figure or Rendering] to switch between scheme and model display. 

In the dialog section Option, you decide how parts that were cut are displayed in the graphic of 
the work window. 

Click [OK] to create the combined solid. As a result, intersections of surfaces are generated (see 
chapter 4.22, page 160) with active or inactive surface components (see chapter 4.4, page 80). 
At the same time, RFEM sets the original solids to the type Null. 

Volume V 
The table column shows the volume of each solid. 

Weight W 
The mass of each solid is indicated. It is determined from the volume and the material's specif-
ic weight. 

Gas 
This dialog tab is available if you have selected the solid type Gas in the dialog tab General. 

You have to define the Gas Parameters pressure pp and temperature Tp (see Figure 4.79). 

Gas between two surfaces 
This dialog tab is available if you have selected the solid type Gas between two surfaces in the 
dialog tab General. With the tab settings you can model gas-specific contact solids represent-
ing the effect of pressure on two opposite surfaces (for example insulating glass). 

 
Figure 4.79: Dialog box New Solid, tab Gas 

In addition to the Gas Parameters pressure pp and temperature Tp, you have to specify two  
surfaces enclosing the gas layer. Surface A can be selected in the list or defined graphically by 
using the [] function. The parallel Surface B will be entered automatically. 

 

 

 

 



4  Model Data 

 89 Program RFEM © 2013 Dlubal Software GmbH 

 

Contact 
This dialog tab is available if the solid type Contact has been previously selected in the dialog 
tab General. 

 
Figure 4.80: Dialog box New Solid, tab Contact 

The following items must be observed when entering a contact solid: 

• Both contact surfaces must be arranged parallel and created identically. It is recom-
mended to create the second contact surface by copying. 

• Each lateral connecting surface existing between the contact surfaces must created as  
a simple surface consisting of four boundary lines. Splitting a connecting surface, for 
example into two surface components at half of the height, is not allowed. 

• When modeling curved contact surfaces, you have to split the contact solid into several 
simple parts. 

• RFEM generates undivided 3D elements (parallel "columns") between the finite elements 
of the contact surfaces, creating a direct connection. Therefore, the FE division of the 
surface needs to be adjusted to the spacing of the contact surfaces. 

• Polygonal solids are to be preferred to triangular solids. 

RFEM tries to find the contact surfaces automatically. In the dialog section Contact Between 
Two Surfaces, you can change Surface A by using the list. You can also use the [] function to 
select the surface graphically. Automatically, RFEM enters Surface B as a solid surface that is 
parallel to the first one. 

In the dialog section Contact Perpendicular to Surfaces, you can select between three options: 

• Full force transmission 

• No compression transmission 

• No tension transmission 

The failure criteria No compression transmission and No tension transmission are taken into ac-
count in the calculation by the deformations of solid FE mesh nodes. 

The Contact Parallel to Surfaces can be defined independently, regardless of contact properties 
acting perpendicular to the two contact surfaces. 
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Contact Diagram Description 

Full force 
transmission 

 

All forces are transmitted. 

Elastic friction 

 

The "friction" represents an elastic behavior: The 
shear force increases proportionally to the defor-
mation. There is no limit for deformation. 

The spring stiffness C must be entered as parame-
ter (which means the force required to move a 
surface of 1 m2 about 1 m). 

Coulomb  
friction 

 

This type of contact is similar to an elastic friction 
but has nonlinear impact. When a shearing stress 
of σ · fc is reached, the shear stress remains con-
stant even if the deformation increases. The stress 
σ is representing the normal stress in the relevant 
finite element. 

The spring stiffness C and the Coulomb friction 
factor fc must be entered as parameters. 

Coulomb  
friction with 
limit 

 

In contrast to the elastic Coulomb friction, the 
maximum shear stress does not depend on the 
normal stress. Only one defined shear stress can 
be absorbed. 

The spring stiffness C and the shear stress τmax 
must be entered as parameters. 

Rigid friction 

 

This type of nonlinearity is similar to the elastic 
Coulomb friction. As the elastic zone is missing, 
the Coulomb friction is immediately effective. 

The Coulomb friction factor fc must be entered as 
parameter.  

Rigid friction 
with limit 

 

This type of nonlinearity is similar to the elastic 
Coulomb friction with limit. As the elastic zone is 
missing, the limit due to the shear stress is imme-
diately effective. 

The shear stress τmax must be entered as parame-
ter. 

Table 4.2: Contact properties parallel to contact surfaces 
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Axis system 
Each solid has a local coordinate system. The axis system is significant for example for ortho-
tropic properties. Stresses and distortions are related to the local axis system as well. 

RFEM shows you the coordinate systems as soon as you move the pointer across a surface.  
You can also use the context menu of a solid to switch them on and off. 

In the dialog box Edit Solid, you can adjust the solid coordinate system. Double-click the solid 
to open the dialog box. The orientation of the local axes is managed in the dialog tab Axes. 

 
Figure 4.81: Dialog box Edit Solid, tab Axes 

The solid's local axes x and y can be directed parallel to the axes of a boundary surface, a line,  
a surface or in direction of a customize coordinate system (see chapter 11.3.4, page 443). 
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4.6 Openings 
General description 

Openings are used to create cutouts into surfaces. Neither finite elements are generated nor 
surface loads are applied in areas where openings are placed. 

Openings can be set graphically into surfaces. RFEM creates a polygonal chain for various 
types of openings and integrates it into the surface. 

 
Figure 4.82: Dialog box New Opening 

 
Figure 4.83: Table 1.6 Openings 

Boundary lines 
Enter the lines which enclose the opening. They must be defined as polygonal chain. Openings 
on the edge of a surface are allowed, too. 

When you use the graphical selection, click the opening's boundary lines one after the other  
in the graphic. RFEM recognizes the opening automatically as soon as a sufficient number of 
boundary lines has been defined. 

Use the button Select Boundary Lines in the openings menu list to select already defined lines 
graphically. They must form a polygonal chain. 
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Openings can be placed directly into a surface lying in the work plane by using one of the but-
tons shown on the left. The definition types for openings are based on the line types described 
in chapter 4.2, page 49 (for example circle, ellipse). The opening is created as soon as the con-
tour lines have been determined. With this input option it is not necessary to create lines for 
the opening in advance. 

In surface 
For plane surfaces the automatic integration is active by default. For curved surfaces you have 
to integrate the opening manually. In the dialog box Edit Surface, select the tab Integrated and 
enter the number of the opening into the input field (see Figure 4.72, page 82). 

Area 
The table column shows the area of the opening. 

4.7 Nodal Supports 
General description 
Supports are used to transfer loads applied on a structural system into the foundations. With-
out any supports all nodes would be free and could be displaced or rotated. If you want a node 
to act as a support, at least one of its degrees of freedom must be blocked or restricted by a 
spring. In addition, the node must be part of a surface or member. The boundary conditions of 
members must be considered as well in order to exclude double releases on the supported 
nodes. 

Nodal supports are required in order to apply imposed deformations. 

It is possible to provide nodal supports with nonlinear properties (failure criteria for tensile or 
compressive forces, working and stiffness diagrams). 

 
Figure 4.84: Dialog box New Nodal Support 
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Figure 4.85: Table 1.7 Nodal Supports 

To open the following dialog box, open the Insert menu, point to Model Data and Nodal 
Supports, and then select Graphically, or use the toolbar button shown on the left. 

 
Figure 4.86: Dialog box New Nodal Support 

The following support types are predefined and can be selected from the list: 

• Hinged (YYY NNY) 

• Rigid (YYY YYY) 

• Sliding in X‘ (NYY NNY) 

• Sliding in Y‘ (YNY NNY) 

After clicking the [OK] button you can assign the selected support type to nodes in the graphic. 

Use the [New] button to create another type of support. The dialog box shown in Figure 4.84 
appears. 

On nodes 
Singular supports can be defined only on nodes. Enter the node number into the table column 
or the input field of the dialog box. You can select it also graphically.  

 

 



4  Model Data 

 95 Program RFEM © 2013 Dlubal Software GmbH 

 

 

Context menu of nodal support 

Support rotation 
Each nodal support has a local coordinate system which is oriented parallel to the global axes 
X, Y and Z by default. Use the context menu of the nodal support to activate the display for the 
support coordinate systems. 

It is possible to rotate the support's local axis system. First, select the Sequence that determines 
the order of the local support axes X', Y' and Z'. Then, enter the angle of rotation for the global 
axes X, Y and Z into the input fields below Rotated about. You can also use the dialog buttons 
[] to define the support rotation graphically. 

 
Figure 4.87: Dialog box New Nodal Support with options for support rotation 

The entered support rotation is shown in the interactive dialog graphic. 

When the calculation is complete, you can evaluate the support reactions of a rotated nodal 
support in relation to the global as well as the local axis system. 

Column in Z 
Often, real structural conditions are not sufficiently represented by a nodal support, for exam-
ple when the support zone has great dimensions. Such support conditions can be represented 
in RFEM by special column macro elements considering material and geometry of the column. 
RFEM calculates the spring stiffnesses and adjusts the support conditions. Due to the realistic 
modeling you can avoid singularities that would be produced in a single FE node when a rigid 
support is defined. 
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Figure 4.88: Dialog box Edit Column 

Define the column cross-section in the dialog section Column Type. The input fields are chang-
ing according to the selected column type Rectangular, Circular or Cross-section from library. 
Thus, in addition to reinforced concrete columns, you can use steel sections as column cross-
sections. 

Furthermore, the Column height h affects the constants of translational and rotational springs. 
In the dialog section Parameters, you define how columns are modeled in the structure: 

• The Elastic surface foundation represents an internal subsurface (cut out area) of the column 
area which is supported elastically. The foundation coefficients are calculated from the col-
umn geometry and material. 

• The Elastic node support represents also an internal subsurface but is supported only at one 
node. The support is modeled by means of translational and rotational springs which are 
calculated from the column geometry and its material. Internally, the surface thickness is 
duplicated to account for higher bending rigidity within the column area. 

• The Node support with adapted FE mesh corresponds to the elastic nodal support, but no 
springs are applied to the punctiform supports. 

In the add-on module RF-CONCRETE Surfaces, cut-out surfaces cannot be designed for any of 
the three model options. Instead, the internal forces at the column's boundary lines are used. 

When you select Elastic surface foundation or Elastic node support, you have to enter further  
data for the column. Select the Material of column from the list of already defined materials,  
or create a new column material (see chapter 4.3, page 60). 

To determine the spring stiffnesses, specifications to the Support conditions at column head 
and column base are required. If you tick the check box to Activate shear stiffness, the shear 
stiffness will affect also the constants of the Support Springs Due to Column. 

The nodal springs determined from the entered parameters are shown in the dialog section  
to the right. 
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Support or spring 
To define a support, select the corresponding option in the dialog box or table. The check 
mark indicates that the corresponding degree of freedom is blocked and the node displace-
ment in the corresponding direction is not possible. 

If you don't want to define supports, clear the corresponding check box. Then, RFEM sets the 
constant of the translational spring to zero in the Nodal Support dialog box. It is always possi-
ble to modify the spring constant in order to represent an elastic support of the node. In the 
table, enter the constant directly into the table column. 

The spring stiffnesses must be entered as design values. 

Assigning nonlinear support properties is described below. 

Restraint or spring 
Restraints are defined in a similar way as supports. Again, the check mark indicates that the 
corresponding degree of freedom is blocked and the node displacement in the corresponding 
direction is not possible. The constants for rotational springs can be defined as soon as the 
check boxes are cleared. In the table, enter the spring constant directly into the corresponding 
table column. 

The dialog box New Nodal Support (see Figure 4.84, page 93) provides buttons for different 
support types, making the definition of degrees of freedom easier. 

 
Figure 4.89: Buttons in the dialog box New Nodal Support 

The buttons have the following functions used for support properties: 

Button Support type 

 
Rigid 

 
Hinged with restraint about Z' 

 
Sliding in X' and Y' with restraint about Z' 

 
Sliding in X' with restraint about Z' 

 
Sliding in Y' with restraint about Z' 

 
Sliding in Z' and Y' with restraint about Z' 

 
Free 

Table 4.3: Buttons in Nodal Support dialog box 

Nonlinearities 
To control in detail the transfer of internal forces, it is possible to provide nodal supports with 
nonlinear properties. The list of nonlinearities includes the following options: 

• Failure of component if support force or moment is negative or positive 

• Complete failure of support if support force or moment is negative or positive 

• Partial activity 

• Diagram 

• Friction depending on remaining support forces 
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The nonlinear properties can be accessed in the dialog box and table by using the list (see 
Figure 4.84 and Figure 4.85). In this way, you can define for each support's degree of freedom 
whether and which forces or moments are transferred at the supported node. 

Nonlinear effective supports are displayed with a different color in the graphic. In the table, 
support elements having nonlinear properties are indicated by a blue check box. 

Failure if support force/moment is positive or negative 

Both options represent an easy control to decide whether the support can take only positive or 
negative forces/moments: If the internal force (force or moment) acts in the forbidden direc-
tion, the relevant component of the support will fail. The remaining retentions and restraints 
will still be effective. 

The directions positive or negative refer to the forces or moments that are placed in the nodal 
support with regard to the respective axes (they do not refer to the reaction forces of the sup-
port). So signs are resulting from the direction of the global axes. If the global Z-axis is oriented 
downwards, the load case 'Self-weight' results in a positive support force PZ. 

Failure all if support force/moment is positive or negative 

In contrast to the failure of a single component described above, the support fails completely 
as soon as the component is ineffective. 

To access the following dialog boxes, use the buttons [Edit Nonlinearity] or [] to the right of 
the list available in the dialog box and table. 

Partial activity 

 
Figure 4.90: Dialog box Nonlinearity - Partial Activity 

The support's effect can be defined separately for the Positive and Negative Zone. The sign rule 
is described in the previous paragraph. In addition to Complete activity or complete Failure, the 
support can be set to be effective only when it is displaced or rotated to a certain degree. In 
this case, a translational or rotational spring should be defined before. 

Furthermore, Tearing (failure of support when exceeding a certain force or moment) as well  
as Yielding (effective only until force or moment is reached) can be set in combination with a 
Slippage. 

Look at the dynamic dialog graphic called Activity Diagram to check the support properties. 



4  Model Data 

 99 Program RFEM © 2013 Dlubal Software GmbH 

 

 

Diagram 

 
Figure 4.91: Dialog box Nonlinearity - Diagram 

The support's effect can be defined separately for the Positive and Negative Zone. First, define 
the Number of steps (that means definition points) for the working diagram. Then, enter abscis-
sa values of the displacements or rotations with corresponding support forces or moments in-
to the list to the right. 

You find different options for the Diagram after last step: Tearing for support failure when ex-
ceeding, Yielding for restricting the transfer to a maximum allowable support force or moment, 
Continuous as in the last step, or Stop for restricting to a maximum allowable displacement or 
rotation followed by a rigid or restrained support activity. 

Friction depending on support force 

Use the four friction options to set the transferred support forces in relation to the compressive 
forces acting in another direction. Depending on your selection, the friction depends on only 
one support force or on the total force of two support forces acting simultaneously. 

Click the [Edit] dialog button to open a dialog box where you can define the Friction Coefficient 
μ. 

 
Figure 4.92: Dialog box Friction in uX' (dialog section) 

The following relation exists between axial force and friction force of the support: 

forceAxialSupport PP ⋅o=  

Equation 4.11 
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4.8 Line Supports 
General description 

Line supports describe the boundary conditions of all FE nodes available along a line. Displace-
ments and rotations on these internal nodes can be prevented or limited by translational and 
rotational springs. 

You can assign nonlinear properties to displacements of line supports so that supports will be 
ineffective in case of tension or compression. 

 
Figure 4.93: Dialog box New Line Support 

 
Figure 4.94: Table 1.8 Line Supports 
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Context menu of line support 

To open the following dialog box, open the Insert menu, point to Model Data and Line  
Supports, and then select Graphically, or use the toolbar button shown on the left: 

 
Figure 4.95: Dialog box New Line Support 

The support types Hinged (YYY NNN) and Rigid (YYY YYY) are predefined and can be selected 
from the list. After clicking the [OK] button you can assign the selected support type to lines in 
the graphic. 

Use the [New] button to create another type of support. The dialog box shown in Figure 4.93 
appears. 

On lines 
Line supports can be defined only on lines that belong to a surface or a solid. Enter the line 
number into the table column or input field of the dialog box. You can select it also graphically. 

Reference system 
The support parameters can be related to the Local line axes x, y and z or the Global axes X, Y 
and Z. Indexes in the dialog section Support Conditions as well as headlines of table columns E 
to J are changing depending on the selected setting. 

The display of the local axis system of lines including numbering can be set in the Display nav-
igator. You can also use the context menu of a line support. 

 
Figure 4.96: Activating the local line axis systems x,y,z in the Display navigator 

 

 

 



4  Model Data 

 

 

102 Program RFEM © 2013 Dlubal Software GmbH 

Support rotation 
It is possible to rotate the axis system of a local line support. The Rotation about a positive  
angle β rotates the support clockwise around the positive line axis x. 

 
Figure 4.97: Support rotation 

The entered support rotation is shown in the dynamic dialog graphic. 

When the calculation is complete, it is possible to evaluate support reactions of a rotated line 
support in relation to the global and the local axis system. 

Wall in Z 
When a surface is supported by a wall, it is considered as an elastic support that depends on 
the stiffness of the wall. A fixed line support would not represent flexibility properly. For such  
a support type you can define a Wall: RFEM will calculate the constants of translational and ro-
tational springs from the wall's material and geometry. This option is especially useful for 2D 
plates in order to avoid singularities which would occur for a rigidly supported line. 

 
Figure 4.98: Dialog box Edit Wall 

In the dialog section Wall Size, you define the geometry. In addition to the Width t, the Height h 
affects the constants of the translational and rotational springs. 

In the dialog section Parameters, you select the Material of wall from the list of already defined 
materials. You can also create a new wall material (see chapter 4.3, page 60).  

To determine the spring stiffnesses, specifications for Support conditions at wall head and wall 
base are required. If you tick the check box to Allow for shear stiffness, the shear stiffness will al-
so affect the constants of the Support Springs Due to Wall. 

The spring constants determined from the entered parameters are shown in the dialog section 
to the right. 

The widths of the wall are displayed on the supported line in the graphic. 
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Support or spring 
To define a support, select the corresponding option in the dialog box or table. The check 
mark indicates that the relevant degree of freedom is blocked and the line displacement in the 
respective direction is not possible. 

If you don't want to define supports, clear the corresponding check box. RFEM sets the con-
stant of the translational spring to zero in the Line Support dialog box. It is always possible to 
modify the spring constant in order to represent an elastic support of the line. In the table,  
enter the constant directly into the table column. 

The spring stiffnesses are considered as design values. 

Assigning a failure criterion is described below. 

Restraint or spring 
Restraints are defined in a similar way as supports. Again, the check mark indicates that the 
relevant degree of freedom is blocked and the line displacement in the respective direction is 
not possible. The constants for rotational springs can be defined as soon as the check boxes 
are cleared. In the table, enter the spring constant directly into the corresponding table col-
umn. 

The dialog box New Line Support (see Figure 4.93, page 100) provides buttons for different 
support types, making the definition of degrees of freedom easier. 

 
Figure 4.99: Buttons in the dialog box New Line Support 

The buttons have the following functions used for support properties: 

Button Support type 

 
Rigid 

 
Hinged with restraint about Z' 

 
Sliding in X' and Y' with restraint about Z' 

 
Sliding in X' with restraint about Z' 

 
Sliding in Y' with restraint about Z' 

 
Sliding in Z' and Y' with restraint about Z' 

 
Free 

Table 4.4: Buttons in Line Support dialog box 

Nonlinearities 
You can assign the following nonlinear features to the supports or translational springs of a 
line support: 

• Failure if support force is positive 

• Failure if support force is negative 

The nonlinear properties can be accessed in the dialog box and table by using the list (see 
Figure 4.93 and Figure 4.94). Use these settings to define for each element of the support 
whether only positive or negative forces are transferred on the supported line. 
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Positive or negative refers to the forces that are introduced to the support in direction of the  
respective axes (they do not refer to the reaction forces of the line support). So, signs result 
from the direction of the local or global axes. For example, if the local z-axis of a line is directed 
downwards, the load case 'Self-weight' results in a positive support force pZ'. 

Nonlinear effective supports of lines are displayed with a different color in the graphic. In the 
table, you can recognize support elements with a failure criterion by a blue check box. 

4.9 Surface Supports 
Theoretical background 
An elastic surface foundation represents an elastic support of all 2D elements of a surface. 

In the WINKLER foundation model, the soil is assumed to be an ideal liquid upon which the slab 
is floating. This model is based on significant differences between the moduli of elasticity for 
concrete and (linearized) soil, which are typically represented by 1000:1 and more.  Mathemat-
ically, the assumption by Winkler is the following: 

zzz wCp ⋅=  

Equation 4.12 

In each point, the contact pressure pz is put into relation to the displacement wz by means of 
the foundation constant Cz. However, the assumption implies that each point is displaced in-
dependently of all other nodes of the floor plan. Thus, the surrounding soil is irrelevant for the 
deformation of a surface (Figure 4.100a). 

 
Figure 4.100: Correlation between deformation figure and bandwidth of the stiffness matrix 

This rudimentary foundation model does no longer match modern requirements. 

An improved type of modeling elastic foundations is based on the stiffness modulus approach. 
In this model, the soil is considered as an elastic half-space with all its nodes correlating math-
ematically and mechanically. This results in an “infinite“ subsidence basin with damping effects. 
The disadvantage of this foundation soil model is an enormous system matrix (Figure 4.100b). 
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The RFEM algorithm makes use of the effective soil model according to KOLAR / NEMEC, unifying 
the advantages of both models. This foundation soil model is based on the theory of PASTERNAK 

[8]: 

• For the slab that is in contact with the soil, only the mechanical properties of the nonlinear 
elastic or plastic half-space in the contact gap are important. Therefore, the three-dimen-
sional foundation effects are condensed in the contact gap, that means transferred to a 2D 
problem. 

• The WINKLER model carries out the 2D condensation (see Equation 4.12), though it is de-
fective in terms of energy. By including a second coefficient Cv for the shear capacity of 
soil, the coaction of soil beyond the slab's edge is established. A natural subsidence basin 
with limited dimensions is formed, as it can be verified in reality. 

• A two parametric system (Cu, Cv) is created. Cu,z corresponds approximately to the WINKLER 
foundation constant and can be applied in this way in practical calculations. In detail, the 
entire system consists of five parameters: Cu,x, Cu,y, Cu,z, Cv,x, and Cv,y. 

Figure 4.100c shows this soil model in comparison. Numerically, the FE model is as stable as 
the WINKLER model. However, incorporating the soil elements in the subsidence basin results in 
a larger system matrix. 

The KOLAR/NEMEC model has been enhanced as well. Experience has shown that soil elements 
can be eliminated from the system with the help of appropriate measures. The effective soil 
model implemented in RFEM is symbolically shown in Figure 4.100d. Thus, the disadvantage of 
the larger system matrix is eliminated. Find a detailed description of the effective foundation 
soil model in [4]. 

The surrounding soil (“wedge of soil”) is eliminated from the surface model by converting its 
rigidity into an elastic boundary line and corner node support. 

x

y

α = 90°

k [kN/m2]
K [kN/m]

K

K

s0  
Figure 4.101: Converting the surrounding soil into line and corner nodal supports 

In a first approximation, the spring constants k and K of the line and corner node support are 
calculated according to the following equations: 

larperpendicu,vz,u CCk ⋅=  

Equation 4.13: Spring constant of line support 

4

CC
K y,vx,v +
=  

Equation 4.14: Spring constant of corner nodal support 

In Equation 4.13 you have to insert the parameter Cv that acts perpendicular to the border line. 

Equation 4.14 is used for corners with an angle of α = 90° (see [17] for other angle sizes). Angles 
larger than 90° result in smaller values of K. However, if α = 0°, K = 0 as well. 

The springs determined in this way must be arranged, in addition to the elastic foundation of 
the surface, as line and nodal supports in the model.  
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Figure 4.102: Dialog box New Surface Support 

 
Figure 4.103: Table 1.9 Surface Supports 

On surfaces 
Enter the numbers of the surfaces to be supported into the table column or the input field of 
the dialog box. You can select them also graphically. 

Spring constants with RF-SOLIN 
Every soil has more or less distinctive nonlinear elastic or plastic features. To determine foun-
dation coefficients easily, use Dlubal's add-on module RF-SOILIN. The program carries out cal-
culations of settlements which are based on load actions and results of test borings. Then, it 
determines the spring coefficients in each finite element. In the add-on module, different lay-
ers of soil can be considered at several recording points. 

If the option is selected and no results of RF-SOILIN are available, the foundation coefficients 
will be determined before the RFEM calculation is carried out. 
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Supports ux /uy /uz or springs Cu,x / Cu,y / Cu,z 
Directions of supports or springs refer to the surfaces' local axes x, y and z. Use the Display nav-
igator or the context menu of a surface to show them in the graphic (see Figure 4.73, page 83). 

The spring stiffnesses must be entered as design values. 

If the support acts perpendicular to the surface, enter the support or spring constant into the 
input field Cu,z. The parameter is practically equal to the WINKLER modulus of foundation Cz. It 
can be taken from a soil expertise. 

The parameters Cu,x and Cu,y represent translational springs describing the foundation's resis-
tance against displacement in the surface directions x or y. In case of a floor slab, they define 
the (load-independent) resistance in the horizontal directions. 

In the graphic, springs are always placed in direction of the positive surface axis z. If spring 
symbols are on the "wrong" side of the surface, you can change the orientation of the local  
z-axis quickly: Right-click the surface to open the context menu and select Reverse Local Axis 
System. This option is only available for 3D models, not for planar models. When changing set-
tings, please note that the failure criterion will change the action direction as well. 

Rigid supports make it possible, for example for symmetrical solid models, to represent only 
one part of the model. In this way, you can increase the speed of calculation considerably. 

Shear springs Cv,x / Cv,y 
These input fields are used to consider the shear capacity of soil in direction of the surface axes 
x or y. In most cases, the PASTERNAK constant Cv lies between 0.1 · Cz (minor shear capacity) and 
0.5 · Cz (medium shear capacity). Generally, Cv,x = Cv,y can be applied. 

The central idea of the Effective Model is to link the parameters Cu,z and Cv by means of the co-
efficient s according to the following equations. 

2
xz,ux,v sCC ⋅=  

Equation 4.15: Shear spring constant Cv,x 

2
yz,uy,v sCC ⋅=  

Equation 4.16: Shear spring constant Cv,y 

The value s is an analogy of the elastic length for beams with elastic foundation. This empiric 
equation was derived from settlement measurements (see Figure 4.100c, page 104): 

s0 = 4.0 s to 5.0 s Average: s0 = 4.5 s 

Equation 4.17: Subsidence basin s0 

The subsidence basin s0 mentioned in Equation 4.17 is understood rather in an energetic than 
geometric sense of term. In practical construction, s0 is defined as distance from the plate edge 
where settlements fall below 1 % of the foundation edge values. If a reference value for s0 is 
known, s is calculated according to Equation 4.17. As a result, we get the value of Cv according 
to Equation 4.15 and Equation 4.16. If no measurings are available, but determining or estimat-
ing the value of Cv from the soil type is possible, you can derive the value of s as follows: 

z,u

x,v
x C

C
s =

 or z,u

y,v
y C

C
s =

 

Equation 4.18 

The determination of Cv is the main problem when applying the foundation model according 
to PASTERNAK. If Cv approaches zero, this model changes over to the energetic defective WINKLER 
model. If Cv approaches infinity, reaching the subsidence basin s0 becomes endless as well. 
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Then, the energy of the soil's deformation is an infinite expression, settlement changes as well 
as settlements approach zero. Therefore, unrealistically high values of Cv lead to numerical 
problems in the FE algorithm. 

For loose sand for example, Cv approaches zero. For compact types of rock, however, it can be 
assumed near 1.0 · Cu,z. 

KOLAR [17] provides a summarizing table with the following orientation values. Please note that 
they do not substitute the values of a soil expertise. 

Soil consistence Cu,z Shear capacity Cv  

  None Medium High 

 [kN/m³] [kN/m] [kN/m] [kN/m] 

very soft 1,000 0 500 1,000 

medium-dense 10,000 0 5,000 10,000 

compact 100,000 0 50,000 100,000 

Table 4.5: Guide values for Cu,z and Cv 

The dialog box New Surface Support (see Figure 4.102, page 106) provides buttons for different 
support types, making the definition of degrees of freedom easier. 

 
Figure 4.104: Buttons in the dialog box New Surface Support 

The buttons have the following functions used for support properties: 

Button Support type 

 
Rigid 

 
Sliding in x and y 

 
Sliding in x 

 
Sliding in y 

 
Sliding in z 

 
Free 

Table 4.6: Buttons in dialog box Surface Support 

Nonlinearity 
The support can be excluded for positive or negative contact stresses occurring in direction of 
the displacement uZ: The foundation fails for example in case of lifting forces. Specify settings 
by means of the list available in the dialog box or table (see Figure 4.103, page 106). 

Positive or negative refer to the stresses acting in direction (or opposite direction) of the local  
z-axis of the surface: Positive contact stresses are produced when a floor slab is stressed by 
self-weight, and the global axis Z as well as the local axis z are both orientated downwards.  
If the surface axis z was orientated upwards, the contact stress would be negative. 

The display option of the local surface axes is shown in Figure 4.73, page 83. 
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Nonlinear effective surface supports are displayed with a different color in the graphic. In the 
table, characteristic values uz of such supports are shown in blue. 

When a nonlinearity is existent, RFEM calculates the deformations and stresses by several itera-
tions. The program finds out which finite elements become stress-free if the foundation is no 
longer active because of failure. 

Please note that it may happen for result combinations with nonlinear acting supports that re-
sults are combined with locally-different support failure. In those cases, it is recommended to 
use load combinations (see example in Figure 5.28, page 194). 

4.10 Line Releases 
General description 
Surfaces touching each other on one line are rigidly connected on it. With a line release you 
are able to exclude particular degrees of freedom from the transfer. 

Line releases can be arranged on boundary lines of surfaces. In addition, they can be assigned 
to lines integrated in a surface as shown on the left. 

A line release is an attribute of a surface, not of a line. Thus, it must be assigned to a surface.  
To assign the line release graphically, 

select Model Data on the Insert menu, point to Line Releases and click Assign to Lines 
Graphically. 

 
Figure 4.105: Dialog box New Line Release 

 
Figure 4.106: Table 1.10 Line Releases 
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On line 
Enter the number of the line on which you want to define the release. You can also use the list 
or select the line graphically. When you select the surface before you define the settings in the 
dialog box, you can import [All Boundary Lines] of the surface by clicking the blue button. 

On surface 
Assign the line release to a surface. As the release is a surface property, you can adjust it sub-
sequently in the dialog box Edit Surface. 

Side 
The options in the dialog box, respectively the column in the table, are only accessible if the 
line is an integrated object of the surface. The arrangement of the release determines the way 
how the finite elements on the line sides are taken into account for stiffness. 

To allocate the release Left or Right of the line, check the direction of the line ( in the figure 
below) and the direction of the local surface axis z. The following rule illustrates how to assign 
the side correctly: "Stand on the line with surface axis z pointing in direction of your feet. Then 
look in the direction of the line. Left and right are the directions of your arms". 

 

Figure 4.107: Definition of line sides 

The side option is locked for the boundary line of a surface because the side of the line on 
which the release is effective is clearly defined by the assignment to the surface. 

Axial/shear release or spring 
The dialog input fields and table columns control the degrees of freedom for axial and shear 
forces. If a check box is ticked, it means that displacement in the relevant direction is possible, 
and thus the force won't be transferred. It is also possible to enter the constant of a transla-
tional spring. 

The degrees of freedom are based on this definition of the axis system: the x-axis represents 
the direction the line, the y-axis the tangent of the surface plane; z points in the direction of 
the normal of the surface. 

Moment release or spring 
The degrees of freedom for moments refer to the local axis system of the hinge, too (x-axis in 
direction of the line, y-axis as tangent and z-axis as normal to the surface plane). The check 
mark means that the rotation is free so that the internal force is not transferred. It is also possi-
ble to enter the constant of a rotational spring. 

The graphic in the dialog box New Line Release shows the direction of moments. For a "hinge 
joint" between two surfaces, the release type φx is to be applied, for example. Thus, a moment 
hinge about the longitudinal axis of the line is created. 
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4.11 Variable Thicknesses 
General description 
A variable thickness describes a linear decrease or increase of the surface thickness. Use variable 
thicknesses to model tapered surfaces. The variable thickness must be defined on three points 
in order to interpolate linearly between them. 

A variable thickness is not entered directly but set as parameter when defining a surface. When 
you create a surface, define the Thickness as Variable (see chapter 4.4, page 81). Then, the [Edit] 
buttons shown on the left become active in the dialog box and table. 

 
Figure 4.108: Dialog box Edit Variable Thickness 

 
Figure 4.109: Table 1.11 Variable Thicknesses 

Surface 
Variable thicknesses can be used only for plane surfaces. They cannot be applied, for example, 
to curved surfaces. 

Variable thickness at three nodes 
To define a variable thickness, specify three nodes so that RFEM can interpolate linearly be-
tween them. You can select any nodes within the plane of the surface for the thickness defini-
tion. They do not need to belong to the surface, but it is necessary that FE nodes can be gener-
ated on theses definition points. 

Select the three nodes from the list, or use the [] function to select them graphically. It is also 
possible to create [New] nodes. Then, assign the corresponding Thickness d. 

The dialog section Node-Thickness-Assignment represents a short input overview. Node num-
bers and thicknesses are separated by comma, single node-thickness pairs by semicolon. 
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It is possible to display the distribution of surface thicknesses in the rendering mode to check 
data: Select the option Filled incl. thickness in the Display navigator. 

 

Figure 4.110: Display navigator: Rendering → Model → Solid Model → Surface → Filled incl. thickness  

4.12 Orthotropic Surfaces 
General description 

Orthotropic surfaces have different stiffnesses in direction of the local surface axes x and y. Use 
orthotropic surface properties to model for example glued-laminated girders or ribbed floors. 
Orthotropic properties can be set for plane and quadrangle surfaces. 

You can define orthotropic properties by material (material orthotropy with invariable geome-
try), by geometry (irregular shape of surface with isotropic material) or in a combination of both. 

The following figure shows the general stiffness matrix of an orthotropic surface in RFEM. 

Figure 4.111: Matrix with stiffness coefficients 

Orthotropic surfaces can be calculated according to linear static analysis, second-order analysis 
or large deformation analysis. In case of matrices with pure membrane coefficients, only a large 
deformation analysis is possible. 

Please find detailed information about Orthotropy in an English document that you can request 
from DLUBAL SOFTWARE GMBH.  
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An orthotropy is not entered directly but set as parameter when defining a surface. When you 
create a new surface, define the Stiffness as Orthotropic or Membrane orthotropic (see chap-
ter 4.4, page 80). Then, the [Edit] buttons shown on the left become active in the dialog box 
and table. 

 
Figure 4.112: Dialog box Edit Surface Stiffness - Orthotropic 

 
Figure 4.113: Table 1.12 Orthotropic Surfaces 

The dialog box is subdivided into several tabs which depend on the selected Orthotropy Type. 

In the dialog section Stiffness Multiplication Factors, you can reduce stiffnesses either globally 
using the factor K or individually for bending, torsion, shear and membrane stiffness elements 
(see page 116). 

In the Stiffness Matrix tab, the respective elements of the matrix are shown (see Figure 4.114). 

Stiffness matrix elements will be adjusted according to Equation 4.1 during the RFEM 4 import. 

Definition 
You can define orthotropic surfaces by material and geometry parameters or directly by coeffi-
cients of the local stiffness matrix. Depending on your specifications, tabs of the dialog box are 
changing. 

The orthotropy types are described on the following pages. For each definition type you have 
to specify the Thickness that you want to apply for the self-weight determination. 
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Constant thickness 

RFEM uses the orthotropic material properties that have been defined in the dialog box Mate-
rial Model - Orthotropic Elastic 2D (see Figure 4.47, page 66). This type is appropriate only for 
homogenous surfaces of equal thickness whose material has distinctive orthotropic properties. 

Effective thicknesses 

In the dialog tab Effective Thicknesses, you can define different thicknesses in direction x' and y' 
to reproduce unequal stiffness conditions. 

The self-weight is not determined from the thicknesses entered in this dialog box, but RFEM 
uses the surface thickness entered in the dialog box Edit Surface or in table 1.4 Surfaces. 

RFEM shows you the moduli of elasticity and shear for the material that is used (see chapter 
4.3, page 66) so that you can check corresponding data. Alternatively, it would be possible to 
control the orthotropic properties by means of material settings and to define the same thick-
nesses for the directions x' and y'. 

Furthermore, RFEM does not calculate any stresses for orthotropic surfaces: The different stiff-
ness coefficients would cause "blurred" results because they refer to an average value of the 
thickness. These stresses do not correspond to the orthotropy model. 

Stiffness matrix 

The coefficients of the local stiffness matrix can be defined manually. 

With this option you can adjust also generated coefficients (for example a coupling or ribbed 
floor) by user-defined settings. 

 
Figure 4.114: Dialog box Edit Surface Stiffness - Orthotropic, tab Stiffness Matrix 

The [Info] button informs you about the relevance of coefficients in the stiffness matrix. 

If the axes of the orthotropy are not consistent with the axes of the coordinate system of ele-
ments, you have to transform the matrices (see [16], page 305-313). 

Furthermore, appropriate adjustments of coefficients are required if you find out, when check-
ing data before performing calculations, that the stiffness matrix is not positively definite. 
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Coupling 

Use this setting to model connections between surfaces or members which are represented  
by coupling elements consisting of isotropic material. 

In the dialog tab Coupling, enter the parameters coupling thickness dp, coupling spacing a  
and coupling width b according to the scheme. A realistic coupling model is given when the 
distance a is larger than the width b of the coupled elements. 

The effective thickness d* is determined according to the following equation: 

a
b

dd p
* ⋅=  

Equation 4.19 

Unidirectional ribbed plate 

The orthotropic properties of a ribbed floor are based on the principle of an uniaxially stressed 
T-beam ceiling. RFEM determines stiffnesses from the geometry parameters of the slab thick-
ness dp, rib height dr, rib spacing a and rib width b which you have to specify according to the 
scheme shown in the dialog tab Unidirectional Ribbed Plate. 

Please note that crack development (for example state II for concrete) is not taken into account 
when the stiffnesses are determined. Only isotropic materials are allowed. 

Bidirectional ribbed plate 

This type of ceiling is characterized by webs crossing perpendicularly in a uniform grid, subdi-
viding the floor into coffers. The orthotropic properties can be described like for ribbed floors 
by geometry (see above). You need to specify the stiffness parameters for two directions. 

In the dialog tab Bidirectional Ribbed Plate, you specify the parameters for slab thickness dp, rib 
height dr, rib spacing a and rib width b for the directions x' and y' according to the scheme. 

Trapezoidal sheet 

The possibility to reproduce trapezoidal sheets as surfaces with orthotropic properties facili-
tates modeling surfaces considerably. RFEM determines the stiffness coefficients from the  
geometry parameters of the cross-section. Only isotropic materials are allowed. 

In the dialog tab Trapezoidal Sheet, you specify the parameters for the sheet thickness t, total 
profile height h, rib spacing a, top flange width bt and bottom flange width bb according to the 
scheme. 

Only isotropic materials are allowed like for all other geometric orthotropies (effective thick-
nesses, ribbed floor, coffered ceiling, hollow concrete floor). 

Voided slab 

Hollow units built in a ceiling reduce the self-weight but produce orthotropic structural behav-
ior. RFEM determines stiffnesses from the geometry parameters of the slab thickness dp, void 
spacing a and void diameter b which you have to specify according to the scheme shown in 
the dialog tab Voided Slab. 

Please find detailed information about stiffness components determined from geometric spec-
ifications in an English document that you can request from DLUBAL SOFTWARE GMBH. 
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Orthotropy direction β 
The orthotropic direction refers to the surface's local axes x and y. The angle β describes the  
rotation of the x'-axis to the local x-axis of the surface. It is responsible for transforming the 
matrices available in the dialog tab Transformed Stiffnes Matrix. 

Use the Display navigator or the context menu of the surface to display the coordinate systems 
of the surface in the graphic. 

 
Figure 4.115: Surface context menu used to display the local surface axis systems xyz 

The positive angle β is defined clockwise around the positive local z-axis of the surface. 

Stiffness multiplication factors 
You can reduce stiffnesses either globally using the factor K, or individually for bending,  
torsion, shear and membrane elements of the matrix (see Figure 4.111, page 112). 

All stiffness elements 

All coefficients of the stiffness matrix are globally multiplied by a factor. 

Bending stiffness elements 

Use the factor Kb to adjust the coefficients D11, D12, D22 and D33 of the stiffness matrix; they  
represent the bending components. It is allowed to enter factors between 0 (no flexural re-
sistance) and 1 (full flexural resistance). 

Torsion stiffness elements 

With the value entered in the input field K33, you control the factor for torsional rigidity D33 
about the axes x' and y'. The input ranges from 0 (no twisting rigidity) to 1 (full twisting rigidity). 
For example for composite constructions with semi-rigid connections a small value is recom-
mended. 

Shear stiffness elements 

Factors K44 and K55 affect the coefficients D44 and D55 of the matrix (components for shear). 

Membrane stiffness elements 

Use the factor Km to adjust the coefficients D66, D77, D67 and D88 of the stiffness matrix; they  
represent the axial force components. It is allowed to enter factors between 0 (no membrane 
stiffness) and 1 (full membrane stiffness). 
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4.13 Cross-sections 
General description 
Before you can enter a member, a cross-section must be defined. The cross-section properties 
and material characteristics that are assigned determine the stiffness of the member. 

Each cross-section has its own Color that can be used in the model to represent different pro-
files. Colors are controlled in the Display navigator with the option Colors in Rendering Accord-
ing to (see chapter 11.1.9, page 427). 

You do not have to use each defined cross-section for input in the model. Thus, when model-
ing the structure, it is possible to make experiments without deleting cross-sections. Please 
note, however, that the cross-sections cannot be renumbered. 

To represent a tapered beam, you have to define different start and end cross-sections for the 
member. RFEM determines the variable stiffnesses along the member automatically. 

 
Figure 4.116: Dialog box New Cross-Section, tab Cross-Section Properties 

 
Figure 4.117: Table 1.13 Cross-Sections 

You do not need to enter the cross-section properties manually. RFEM provides an extensive 
and extendable cross-section library as well as import options. 
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Cross-section description 
The Cross-Section Description can be selected freely. When the entered cross-section name  
corresponds to an entry of the cross-section library, RFEM will import the cross-section param-
eters. In this case, it is not possible to change the values for the Moments of Inertia and area  
Axial A. For user-defined cross-section descriptions you can enter constants and cross-section 
areas manually. 

The characteristic values of parameterized cross-sections are also imported automatically.  
For example, when you enter "Rectangle 80/140", the cross-section parameters of this cross-
section will appear. The selection of cross-sections from the library is described later. 

It is also possible to use a rigid dummy cross-section to model couplings. RFEM applies stiff-
nesses to this cross-section type like for a coupling member. Enter the name Dummy Rigid as 
description for the cross-section without defining the cross-section values in detail. In this way, 
you can use members with a high degree of stiffness, taking account of releases or other mem-
ber properties. A new variant in RFEM 5 is the member type Rigid Member (see page 139), so 
the definition of a Dummy Rigid is no longer necessary. 

Material 
The cross-section's material can be selected from the list of already defined materials. The as-
signment is made easier by material colors that are used by default for the rendered graphical 
representation. 

In the dialog box New Cross-Section, you can see three buttons below the material list. Use the 
buttons to access the material library, to create a new material or to edit materials. 

For more detailed information about materials, see chapter 4.3, page 60. 

The option Hybrid available in the dialog box for rectangular timber cross-sections can be ac-
cessed only for parameterized timber profiles. Use this option to assign specific material prop-
erties to cross-section elements if different material grades are provided (for example timber of 
low class for webs). 

With a click on the [Edit] button you can open the dialog box Edit Hybrid Material. 

 
Figure 4.118: Dialog box Edit Hybrid Material 

Assign materials to the single cross-section parts according to the graphical scheme. They can 
be selected from the list. One of the materials must be defined as Reference Material used to 
determine the ideal cross-section properties. 
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Moments of inertia 
The moments of inertia are required for the cross-section stiffness: The torsional constant J de-
scribes the stiffness against rotation about the longitudinal axis. The second moments of area 
Iy and Iz describe the stiffnesses against bending about the local axes y and z. Axis y is consid-
ered to be the “strong” axis. The local cross-sectional axes are shown in the dialog graphic of 
the dialog box New Cross-Section. 

The moments of inertia for unsymmetrical sections are displayed about the cross-section's 
principal axes u and v. 

Moments of inertia as well as cross-sectional areas can be adjusted with the help of factors in 
the dialog tab Modify. In the table, you can access the tab with the [...] button that appears 
when you click into the table cell. 

 
Figure 4.119: Dialog box New Cross-Section, tab Modify 

With the specification set in Figure 4.119, RFEM will consider the torsional moment of inertia 
with 5 % only. 

Cross-sectional areas 
The cross-section parameters of the cross-sectional areas are subdivided into the total area  
Axial A and the shear areas Shear Ay and Az. 

Shear area Ay relates to the moment of inertia Iz, shear area Az relates to Iy. Using a correction 
factor κ we see the following correlation existing between the shear areas Ay and Az as well as 
the total area A. 
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where A Total area of cross-section 

   Iz/y Moments of inertia of cross-section 

   Qz/y(x) Statical moments of cross-section at location x 

   t(x) Width of cross-section at location x 
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The shear areas Ay and Az affect the shear deformation which should be taken into account  
especially for short, massive members. When the shear areas are set to zero, the influence of 
shear will not be considered. Those parameters can also be controlled in the dialog tab Global 
Calculation Parameters of the dialog box Calculation Parameters (see Figure 7.22, page 271). If 
extremely low values are set for shear areas, numerical problems may occur because the shear 
areas are contained in the denominator of equations. 

Select the values for cross-section areas realistically. Extreme differences in the cross-sectional 
areas of cross-sections involve significant differences in stiffness that may lead to numerical 
problems when solving the equation system. 

Angle of principal axes α 
The principal axes are described with y and z for symmetrical sections, and with u and v for un-
symmetrical sections (see above). The rotation angle of principal axes α describes the position 
of the principal axes in relation to the standard system of coordinates for symmetrical sections. 
For unsymmetrical sections it is the angle between the y-axis and the u-axis (see graphic above 
shown in the left margin). This angle is defined clockwise as a positive angle. When symmetrical 
cross-sections are set, angle α is 0. The inclination of principal axes for sections from the library 
cannot be edited. 

The angle of rotation for the principal axes is determined by the following equation: 

yz

yz
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I2
2tan

−

⋅
=α  

Equation 4.22 

When you work with 2D models, only 0° and 180° are allowed to be set as cross-sectional angles 
of rotation. 

Cross-section rotation α' 
The angle of rotation α' describes the angle about which the sections of all members using this 
cross-section are rotated. Thus, the angle represents a global cross-sectional angle of rotation. 
In addition, each member can be rotated separately about a member rotation angle β. 

Moreover, the dialog tab Rotation provides the option to Mirror nonsymmetrical cross-sections. 
Use this option for example to put an L-section into the correct position. 

 
Figure 4.120: Dialog box New Cross-Section, tab Rotation 

When you import a cross-section from the cross-section library or the add-on module SHAPE-
THIN, you do not need to take care of the angle α'. RFEM imports this angle in the same way as 
other cross-sectional values. For user-defined sections, however, you have to determine the 
angle of principal axes yourself and to adjust it manually by means of the cross-section rotation. 
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Overall dimensions 
The cross-section’s Width b and Depth h are significant for temperature loads. 

Cross-section Library 
Numerous cross-sections are already available in the cross-section data base. 

Open the library 

In the dialog box New Cross-Section and in table 1.13 Cross-Sections, you have direct access to 
frequently used cross-section tables: 

 
Figure 4.121: Buttons of frequently used cross-sections in table (above) and dialog box (below) 

Use the button [Import Cross-Section from Library] to access the complete cross-section data-
base. When you work in the table, place the cursor into table column A to enable the button 
[...] which you can use like the function key [F7] to open the cross-section library. 

 
Figure 4.122: Cross-Section Library 

The cross-section library is divided into several sections which are described on the following 
pages. 

Rolled cross-sections 

The table values of many rolled cross-sections are stored in a database. 

First, click one of the ten buttons to define the Cross-Section Type. Another dialog box opens 
where you select the Table. Then, select an appropriate Cross-Section. 
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Filter for  
Manufacturer/Standard group 

 
Figure 4.123: Selecting a rolled cross-section 

In the dialog section Filter, you can filter library entries by different criteria: Manufacturer/Stan-
dard group, Manufacturer/Standard, Cross-section shape and Cross-section note. In this way, it is 
easier to overview the offered tables and cross-sections. Displayed data can be sorted by click-
ing the headings of table columns. 

If cross-sections of old standards are needed, tick the checkbox for Include invalid in the dialog 
section Filter to display also such sections. 

Create favorites 
Preferred cross-sections can be set as favorites. To access the dialog box for creating favorite 
cross-sections, use the button [Create New Favorites Group] at the bottom of the Filter dialog 
section. When the name for the new group has been defined, the following dialog box appears: 

 
Figure 4.124: Dialog box Rolled Cross-Sections - I-Sections - Favorites 
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The dialog box looks like the cross-section library. You can use the filter options described 
above. In the dialog sections Select Favorites, you can choose preferred tables and cross-
sections with a check mark. 

After closing the dialog box, the cross-section library presents a clear overview of favorites as 
soon as you activate the option Favorites group. 

In this way, it is possible to create different groups of favorites that are available for selection in 
the list at the bottom of the dialog section Filter. 

Built-up cross-sections 

Rolled cross-sections can be combined by specifying parameters. 

 
Figure 4.125: Dialog box Combined Cross-Sections - I-Sections 

Use the [Save] button to save a combined cross-section. RFEM stores it with its accurate de-
scription (for example 2IK HE B 300 + HE A 340 in the figure above) in the category User-Defined 
from where you can reimport it later. 

Parametric cross-sections - thin 

With the offered input fields you can freely define parameters for a cross-section composed  
of sheets. The cross-section values will be calculated according to the theory for thin-walled 
cross-sections. The theory applies only to cross-sections whose element thickness is clearly 
smaller than the respective element length. If this condition is not fulfilled, define the cross-
section in the Massive category (see Figure 4.127), if possible. 

Parameter a represents the weld root, not the fillet radius (see figure below). 
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Figure 4.126: Input dialog box of a parameterized, thin-walled cross-section 

Use the button shown on the left to import the parameters of a rolled cross-section. By using 
the selection function you can avoid entering lots of parameters. 

Use the [Save] button to save a parametric cross-section with its exact name, for example  
IS 330/160/8/12/0 in the figure above. Click the [Load] button shown on the left to import it. 

Parametric cross-sections - massive 

With the offered input fields you can freely define parameters for massive cross-sections (for 
example reinforced concrete sections). The cross-section values will be calculated according to 
the theory for massive cross-sections provided for elements with distinctive wall thicknesses. 

 
Figure 4.127: Input dialog box of a massive cross-section 
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Parametric cross-sections - timber 

With the offered input fields you can freely define parameters for timber cross-sections. The 
cross-section values of both solid and combined cross-sections will be calculated according to 
the theory for massive cross-sections. 

 
Figure 4.128: Input dialog box of a timber cross-section 

Ticking the option Coefficient of compliance allows you to determine the effective stiffnesses 
for composite structural components from semi-rigidly connected cross-section elements, for 
example according to DIN 1052:2008-12, 8.6.2 (3). In this case, specify the reduction factors γ. 

When you work with a material of the type Hybrid, use the [Edit] button to assign the proper-
ties of the cross-section parts (see Figure 4.118, page 118).  
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User-defined cross-sections 

Import saved cross-section 

Click the [Load] button shown on the left to open a dialog box where all cross-sections created 
with the help of the Save function are displayed. 

 
Figure 4.129: Dialog box Properties of User-Defined Cross-Sections 

Create a user-defined cross-section 

Click the [Create] button shown on the left to create user-defined cross-sections. 

 
Figure 4.130: Dialog box Create User-Defined Cross-Section 

Enter the Table to define the place where the cross-section is managed. Specify also the Name 
to describe the new cross-section. Then, enter the cross-section parameters and define the 
buckling curves. 
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Cross-sections from cross-section program 

It is also possible to import cross-sections from the DLUBAL cross-section programs SHAPE-THIN 
and SHAPE-MASSIVE. 

Please note that the cross-sections must be calculated and saved in the SHAPE modules before 
the cross-sectional values can be imported. 

Import cross-section table from ASCII file 

Use the button in the bottom left corner of the library to import a complete cross-section table 
from a file. The file must be a comma separated values file (CSV). Any Excel file can be saved in 
this format. Make sure that the syntax of the ASCII table corresponds to the definition parame-
ters of the corresponding RFEM cross-section table. 

Example: Import of double symmetrical I-sections 

The cross-sections are managed in the IS table (cf. Figure 4.126). For IS cross-sections, the fol-
lowing parameters are required: h, b, s, t, a. The table in Excel is structured as shown below: 

 
Figure 4.131: Excel spreadsheet with cross-section parameters 

In the import dialog box, specify the directory of the CSV file. Then, use the list to select the 
cross-section table where you want to manage the imported cross-sections. 

 
Figure 4.132: Dialog box Import Cross-Sections from ASCII File 

Finally, you find the imported cross-sections available in the category User-Defined cross-
sections (see Figure 4.129). 

When importing cross-sections, RFEM calculates the cross-section values and stress points  
so that stress designs can be performed as well. 
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4.14 Member End Releases 
General description 
Member releases limit the internal forces transferred from one member to others. Releases are 
assigned only to member ends (nodes). They can never be assigned to other locations, for ex-
ample to the middle of the member. 

Some member types are already provided with releases. A truss, for example, does not transfer 
moments. A cable neither transfers moments nor shear forces. When entering data, keep in 
mind that the assignment of releases is blocked for members of such member types. 

 
Figure 4.133: Dialog box New Member End Release 

 
Figure 4.134: Table 1.14 Member End Releases 
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Member context menu 

Reference system 
A member release can be related to one of the following axis systems: 

• Local member axis system x,y,z 

• Global coordinate system X,Y,Z (only scissors release) 

• Global rotated coordinate system X',Y',Z' (only scissors release) 

Use the Display navigator or the member context menu shown on the left to display the local 
member axes (see Figure 4.158, page 145). 

For detailed information about the orientation of local member axes in the global coordinate 
system X,Y,Z, see chapter 4.17 on page 145. 

Normally, releases are related to the local axis system x,y,z. Scissors releases (see Figure 4.136) 
can only be related to the global coordinate system. Spring constants and nonlinearities must 
be defined in relation to the local member axis system. 

Axial/shear release or spring 
To define an axial or shear force release, set the respective displacement free by ticking the 
relevant check box in the dialog box or table. The check mark means that the axial respectively 
shear force cannot be transferred at the member end because a release has been set. Look at 
the Member End Release dialog box: A zero value is shown for the constant of the translational 
spring in the input field to the right of the check mark. 

You can always change the spring constant to represent for example a semi-rigid connection. 
In the table, enter the constant directly into the table column. The stiffnesses of the springs are 
considered as design values. 

Moment release or spring 
Define releases for torsion and bending moments like releases for forces. Again, the check mark 
means that torsion is free and the internal force won't be transferred. 

Elastic connections can be modeled by means of spring constants that you can enter directly. 
Pay attention not to use extreme stiffness values because otherwise numerical problems may 
occur during the calculation. Instead of very big or small constants, apply rigid connections (no 
check mark) or releases (check mark). 

The option for defining nonlinear release properties is described at the end of this chapter. 

Assign releases graphically 
To assign releases in the work window graphically, 

select Model Data on the Insert menu, point to Member End Releases and select  
Assign to Members Graphically or 

open the Edit menu, point to Model Data and Member End Releases, and then select 
Assign Graphically to Members. 

First, select a release type from the list or create a new one. After clicking [OK], members are 
divided graphically at one-third division points. 

 
Figure 4.135: Assigning member end releases graphically 



4  Model Data 

 

 

130 Program RFEM © 2013 Dlubal Software GmbH 

Now, you can click the member sides to which you want to apply the selected release. To assign 
the release to both member ends, click the member in its center area. 

Scissors release 
With scissors releases you can model crossing of beams. For example: You have four members 
connected in one node. Each of the two member pairs transfers moments in its 'continuous di-
rection', but they do not transfer any moments to the other pair. Only axial and shear forces 
are transferred in the node. 

 
Figure 4.136: Beam crossing 

 
Figure 4.137: Dialog box New Member End Release 

In this case, the release must be assigned either to members 1 and 2 or to members 3 and 4. 
The other crossing member pair will be modeled as bending-resistant without release. 
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Nonlinearities 
Nonlinear properties can be assigned to member end releases. In this way, you can control the 
transfer of internal forces in detail. The list of nonlinearities offers the following options: 

• Fixed if internal force negative 

• Fixed if internal force positive 

• Partial activity 

• Diagram 

 
Figure 4.138: List of nonlinear properties 

In the table, release types with nonlinear properties are marked in blue. 

Fixed if internal force negative or positive 
With these two options you can control the release activity depending on the direction for 
each internal force. For example: An axial force release defined with the nonlinearity Fixed if 
positive N has the effect that tensile forces (positive) can be transferred at the end of the mem-
ber, but no compressive forces (negative). In case of negative axial forces the release wil be  
effective. 

The internal forces are related to the local member axis system xyz. 

The remaining entries of the Nonlinearity list offer detailed modeling options for release prop-
erties. To access the options, use the [Edit] dialog buttons to the right of the list or the button 
[] in the table (see Figure 4.134, page 128). 

Partial activity 

 
Figure 4.139: Dialog box Nonlinearity - Partial Activity 
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The activity of the release can be defined separately for the positive and negative zone. In addi-
tion to full effectiveness or failure, the release can loose its effect when a certain displacement 
or rotation is reached. Then, it begins to act as a fixed or rigid connection. Also Tearing (no in-
ternal force will be transferred anymore after exceeding a certain value) and Yielding (internal 
forces will be transferred only up to a certain value also in case of larger deformations) are pos-
sible in combination with a Slippage. 

The limit values can be defined in the input fields below. In the dialog section Activity Diagram, 
the release properties are shown in a dynamic graphic. 

Diagram 

 
Figure 4.140: Dialog box Nonlinearity - Diagram 

The activity of the release can be defined separately for the Positive and Negative Zone. First,  
enter the Number of steps (that means definition points) represented in the diagram. Then, you 
can enter the abscissa values of the internal forces with the assigned displacements or rotations 
into the list to the right. 

You find different input possibilities for the Diagram after last step: Tearing for the failure of the 
release (no internal force will be transferred any longer), Yielding for restricting the transfer to a 
maximum allowable internal force, Continuous as in the last step or Stop for restricting to a max-
imum allowable displacement or rotation followed by a fixed or rigid release activity. 

In the dialog section Diagram, the release properties are shown in a dynamic graphic. 
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Example: rafter roof 
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Figure 4.141: Rafter roof 

A planar system is used. The release must be defined as follows: 

 
Figure 4.142: Table 1.14 Member End Releases 

Now, the release type can be assigned to the members. 

 
Figure 4.143: Graphic and table 1.17 Members 

 
Figure 4.144: Moment diagram in load case ‘Self-weight’ 
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4.15 Member Eccentricities 
General description 
The length of a member corresponds to the distance between two nodes defined by the 
member line. However, in some modeling situations (connections of cross-sections or down-
stand beams), reality is represented only to a certain degree. With member eccentricities you 
can connect members eccentrically due to special member end sections. In this way, you can 
reduce for example design moments on horizontal beams for frames with big column cross-
sections. Member eccentricities are taken into account by a transformation of the degrees of 
freedom in the local element stiffness matrix. 

To check the entered eccentricities, use the photo-realistic imaging of the 3D rendering. 

 
Figure 4.145: Dialog box New Member Eccentricity 

 
Figure 4.146: Table 1.15 Member Eccentricities 

Reference system 
A member eccentricity can be related to one of the following axis systems: 

• Local member axis system x,y,z 

• Global coordinate system X,Y,Z 

Use the Display navigator or the context menu of the member to display the local member  
axes x,y,z (see Figure 4.158, page 145). 
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Eccentricity for member start/member end 
In the dialog section Absolute Offset, respectively in table columns B to G, you define the ec-
centricities for the Member start i and the Member end j. The distances refer to the selected axis 
system indicated by the upper- and lower-case indexes which are also shown in the dialog 
graphic. 

In the dialog box, you can use the buttons [] and [] to transfer the values from one side to 
the other. 

Cross-section alignment 
In the dialog section Relative Automatically Offset, use the nine selection options to define the 
cross-section point relevant for the determination of the eccentricity. In the table, specify the 
position of the point in columns H and I. The point defines the distance by which the cross-
section is shifted on the start or end node. 

By defining the point in the middle of the top flange, as shown in the picture on the left, you 
can attach for example a horizontal beam with its top edge to a column by flush connection 
(without extension). 

Transverse offset from cross-section of other object 
With a Transverse offset you can arrange a member in a particular distance parallel to an object 
(member in surface, member in same direction). Select the number of the relevant object, a 
Member or a Surface, from the list. You can also use the [] function to select it in the work win-
dow. The eccentricity is determined from the Cross-section alignment defined above and the 
Axis offset (cross-sectional geometry or surface thickness) that you define by selecting one of 
the available nine or three check boxes. In the table, define the axis offset in columns L and M. 

By defining the points on the edge of the top flange and on the bottom side of the surface, as 
shown in the picture on the left, you can arrange for example a steel cross-section on the edge 
under a plate by flush connection. 

Axial offset from adjoining members at 
The last option in the dialog section Relative Automatically Offset allows you to connect easily 
for example a member eccentrically to a flange of a column. The offset can be arranged sepa-
rately for Member start and Member end. The eccentricity is determined automatically from the 
cross-section geometry of the adjacent members. In the table, assign the axial offset in columns 
N and O. 

The dialog graphic Axial Offset is interactive with the input, illustrating the effectiveness of the 
selected check boxes. 

You may prefer the input in the dialog section Relative Automatically Offset because you can  
directly adjust the eccentricities when cross-sections are changed. RFEM takes into account 
modified surface or cross-section dimensions automatically. 

Assign eccentricities graphically 
Furthermore, eccentricities can be assigned to members graphically in the work window.  
To open the corresponding dialog box, 

select Model Data on the Insert menu, point to Member Eccentricities and select  
Assign to Members Graphically or 

open the Edit menu, point to Model Data and Member Eccentricities, and then select 
Assign Graphically to Members. 

First, define the reference system and the eccentricities. 

After clicking [OK], members are divided graphically at one-third division points. Now, you can 
click the member sides to which you want to apply the eccentricity (see Figure 4.135, page 129). 
To assign an eccentric connection to both member ends, click the member in its center area. 
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4.16 Member Divisions 
General description 

Member divisions are used to define points on members for which internal forces and defor-
mations are displayed later in the results tables and the numerical printout. A member division 
has neither influence on the determination of extreme values nor on the graphical results dia-
gram (RFEM internally uses a more refined partition). Therefore, in most cases, member divisions 
are not required. 

Do not confuse member divisions with FE divisions for members. FE nodes on "free" (not be-
longing to a surface) lines with member properties will be generated only if the lines have an 
FE mesh refinement (see chapter 4.23, page 164). 

 
Figure 4.147: Dialog box New Member Division 

 
Figure 4.148: Table 1.16 Member Divisions 

Number of points 
You can enter a maximum number of 99 division points in the dialog box. An entry divides the 
member into the desired number of equidistant points. 

Relative distance of point from member start 
When you create a new division in the dialog box, the distances of three intermediate points 
are preset. They represent the relative distances in the interval of 0 (member start) to 1 (mem-
ber end). 

It is also possible to define irregular divisions for the specified points as you can enter the rela-
tive distances freely. Only make sure that you follow the correct order of intervals: x1 < x2 < x3 ... 
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List button Member 

Moreover, any x-location on the member can specifically evaluated graphically (see chapter 9.5, 
page 356). Thus, in most cases entering member divisions manually with troublesome determi-
nation of relative distances is unnecessary. 

4.17 Members 
General description 

Members are attributes of lines. By assigning a cross-section (by which also a material is de-
fined), the member receives a stiffness. When generating the FE mesh, 1D elements are creat-
ed on members. 

Members can be connected with each other only on nodes. When members cross each other 
without sharing a common node, no connection exists. No internal forces are transferred on 
such crossings. 

Graphically, you can apply members as Single, Continuous or to already existing Lines. The  
option Inserted Member is described in chapter 11.4.13 on page 474. 

 
Figure 4.149: Dialog box New Member, tab General 

 
Figure 4.150: Table 1.17 Members 
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Figure 4.151: Dialog box New Member, tab Options 

Line 
Enter the number of the line with member properties into the input field of the dialog box, re-
spectively the column in the table. In the dialog box New Member, you can select the line also 
graphically. 

The start and end nodes of the line define the member orientation which also affects the posi-
tion of the local coordinate system of the member (see "member rotation" in this chapter). The 
member orientation can be changed quickly in the graphic: Right-click the member and select 
Reverse Member Orientation in the context menu. 

Member type 
With the member type you define the way how internal forces are absorbed or which proper-
ties are assumed for the member. 

Different options are available for selection in the Member Type list. Each member type has its 
own Color that can be used in the model to represent different kinds of members. Colors are 
controlled in the Display navigator with the option Colors in Rendering According to (see chap-
ter 11.1.9, page 427). 

Member type Short description 

Beam Bending-resistant member that can transmit all internal forces. 

Rigid member Coupling member with rigid stiffness 

Rib Downstand beam considering the effective slab width 

Truss Beam with moment releases at both ends 

Truss (only N) Member with stiffness E · A only 

Tension Truss (only N) with failure in case of compression force 

Compression Truss (only N) with failure in case of tension force 

Buckling Truss (only N) with failure in case of compression force > Ncr 
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Cable Member transferring tension forces only. Calculation is performed 
according to large deformation analysis. 

Cable on pulleys Member on polyline, can only be shifted in longitudinal direction, 
absorbing tensile forces only (pulley). 

Result beam Member for integration of surface, solid or member results 

Stiffnesses Member with user-defined stiffnesses 

Coupling rigid-rigid Rigid coupling with bending-resistant connections at both ends 

Coupling rigid-hinge Rigid coupling with bending-resistant connection at member start 
and hinged connection at member end 

Coupling hinge-hinge Rigid coupling with hinged connections at both ends (only axial 
and shear forces are transmitted, but no moments). 

Coupling hinge-rigid Rigid coupling with hinged connection at member start and bend-
ing-resistant connection at member end 

Spring Member with spring stiffness, definable activity zones and damp-
ing coefficients 

Null (dummy member) Member that will be ignored in the calculation. 

Table 4.7: Member types 

Beam 

A beam does not have any releases defined on its member ends. When two beams are con-
nected with each other and no release has been defined for the common node, the connec-
tion is bending-resistant. Beams can be stressed by all types of loads. 

Rigid member 

It couples the displacements of two nodes by a rigid connection. Thus, it corresponds to a 
coupling member in principle (see page 143). Use a rigid member to define members with 
high stiffness taking into account releases which may also have spring constants and nonline-
arities. Hardly any numeric problems will occur as stiffnesses are adjusted to the system. RFEM 
shows internal forces also for rigid members. 

The following stiffnesses are assumed (applies also to couplings and Dummy Rigids): 

• Longitudinal and torsional stiffness E · A = G · IT = 1013 · l (l = member length) 

• Flexural resistance E · I = 1013 · l3 

• Shear stiffness (if activated) GAy = GAz = 1016 · l3  

Due to this type of member it is no longer necessary to define a Dummy Rigid (see page 118) 
which is assigned as cross-section. 

Rib 

Ribs are described in chapter 4.18, page 150. 

Truss (only N) 

This type of a truss member absorbs axial forces in the form of tension and compression. A 
truss member has internal moment releases on its member ends. Therefore, an additional  
release definition is not allowed. RFEM shows you only node internal forces (which are trans-
ferred to the connecting members). The member itself shows a linear distribution of internal 
forces. An exception is the concentrated load on the member, which means that no moment 
diagram will be visible as a result of self-weight or a line load. The boundary moments are zero 
because of the release. A linear distribution is assumed along the member. The nodal forces, 
however, are calculated from the member loads, which guarantees a correct transmission. 
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The reason for special treatment is that a truss girder, as it is commonly understood, transfers 
only axial forces. Moments are not of interest. Therefore, they are deliberately neither shown in 
the output nor calculated as a part of the design. To get and see moments from the member 
loads, use the member type Truss. 

Tension / Compression 

A tension member can absorb only tension forces and a compression member only compres-
sion forces. The calculation of a framework structure with these types of members is carried 
out iteratively. In the first iteration, RFEM determines the internal forces of all members. If ten-
sion members have negative axial forces (compression), or if compression members have posi-
tive axial forces (tension), an additional iteration step is started in which the rigidity of these 
members won't be considered anymore - they have failed. This iteration process continues as 
long as tension or compression members are failing. Depending on modeling and loading, the 
system may become unstable due to failure of tension or compression members. 

A failed tension or compression member can be considered again in the stiffness matrix if it is 
reactivated in a later iteration step due to redistributions in the system. On the Calculate menu, 
select Calculation Parameters to open the dialog box Calculation Parameters where you can 
specify the Global Calculation Parameters. In the dialog section Reactivation of Failing Members 
you can set the Exceptional handling of failing members. Details can be found in chapter page 
7.3 on page 271. 

Buckling 

A buckling member absorbs unlimited quantities of tensile forces. Compressive forces, howev-
er, can be absorbed only until the critical Euler load is reached. 

  where   

Equation 4.23 

With this type of member you can often avoid instabilities occurring in calculations according 
to second order or large deformation analysis due to buckling of truss members. If you replace 
trusses − close to reality − by buckling members, the critical load is increased in many cases. 

Cable 

Cable members absorb only tension forces. They are used to analyze cable chains with longi-
tudinal and transversal forces by iterative calculations taking into account the cable theory 
(large deformation analysis - see chapter 7.3.1, page 264). It is required to define the complete 
cable as cable chain consisting of several cable members. 

To create quickly a catenary, point to Generate Model - Members on the Tools menu and se-
lect Arc (chapter 11.7.2, page 516). The more accurately the starting shape of the catenary cor-
responds to the real cable chain, the more stable and faster you can perform the calculation. 

It is recommended to prestress cable members in order to prevent compression forces result-
ing in failure. Furthermore, cables should be used only if deformations have a considerable 
part in changes of the internal forces, that means when large deformations occur. For simple 
straight riggings like transverse bracings (projecting roof), tension members are completely 
sufficient. 

When evaluating deformations of cable members, set the scaling factor in the control panel 
(see Figure 3.20, page 31) to "1" so that tightening effects are represented realistically. 

Cable on pulleys 

The cable on pulleys absorbs only tensile forces and is calculated according to the cable theory 
(large deformation analysis). In contrast to a cable, it can only be applied to a polyline with at 
least three nodes. This member type is appropriate for pulley systems where axial forces are 
passed on by means of sheaves. 
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In comparison to a normal cable member, only a displacement within the internal nodes in the 
longitudinal direction ux is possible. Therefore, the member must not be stressed by member 
loads acting in the local directions y or z. 

The displacement in longitudinal direction is not allowed to be free at the ends of the cable. 

 
Figure 4.152: System with cable on pulley and cable member - axial forces and support reactions 

It is not important for the internal nodes of the polyline whether a nodal support is available or 
the member is connected to another construction. RFEM analyzes the total model of the cable 
member along the length of the polyline. 

RFEM takes into account only displacements ux and axial forces N for members of the member 
type Cable on Pulleys. 

Result beam 

Like a cut through the model, a result beam can be placed anywhere in the model as virtual 
member. Use it to display the internal forces of surfaces, members and solids in the form of in-
tegrated results. In this way, you can read in the display for example the resulting shear forces 
of a surface used for masonry design. 

The result beam requires neither a support nor a connection to the model. Furthermore, it is 
not possible to apply loads to it. 

The integration parameters must be set in a dialog box (see Figure 4.153) that you open by  
using the [Edit] button. 

In the dialog section Integrate Stresses and Forces, define the result beam's zone of influence. 
The dialog graphic illustrates the parameters relevant for the individual options. 



4  Model Data 

 

 

142 Program RFEM © 2013 Dlubal Software GmbH 

 

 
 

 
Figure 4.153: Dialog box Edit Parameters for Member of Type 'Result Beam' 

The dialog section Include Objects allows for a specific selection of model elements whose  
results should be taken into account for the integration: surfaces, solids, members. 

When the result beam is defined, you can activate and deactivate the display of integration  
areas in the Display navigator (see picture shown on the left). 

Stiffnesses 

The member stiffnesses can be directly specified in a dialog box that you open with the [Edit] 
button. Thus, the assignment of a cross-section is unnecessary. 

 
Figure 4.154: Dialog box Edit Member Stiffnesses 

To look at the definition of the stiffness matrix, use the [Info] button. 
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Coupling 

A coupling member is a virtual, very stiff member with definable rigid or hinged properties.  
It is possible to couple the degrees of freedom of the start and end nodes in four different 
ways. The axial and shear forces, respectively torsional and bending moments, are transferred 
directly from one node to the other. Couplings can be used to model special situations for the 
transfer of forces and moments. 

RFEM calculates stiffnesses of couplings depending on the model in order to exclude numeri-
cal problems. 

With the alternative Rigid member (see page 139) you can define coupling members consider-
ing also springs and nonlinearities of releases. 

To control the display of coupling results, use the Display navigator. 

 
Figure 4.155: Activating the display for results of coupling members in the Display navigator 
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Spring 

If Spring nonlinearities are set, you can open a new dialog box by using the [Edit] dialog button 
or the [...] button in the table. 

 
Figure 4.156: Dialog box Edit Parameters for Member of Type 'Spring' 

Define the spring properties by Parameters or in a Diagram. The spring constant C1,1 describes 
the stiffness of the member in its local x-direction according to the following relation: 

l
AE

k
⋅

=  

Equation 4.24 

The Slippage specifies a zone of the deformation where the spring does not absorb any forces. 

Furthermore, you have two options to define the spring Limits: 

• Deformation: The values umin and umax define the geometric activity zone of the spring.  
The spring will act as a rigid member (stop) for deformations beyond the specified zone. 

• Force: The values Nmin and Nmax define the activity zone for the forces that can be absorbed 
by the spring. If the axial force is beyond the defined limits, the spring fails. 

When the Diagram option is set, you can define spring properties even more precisely. Those 
settings are largely identical with the options available for nonlinear member releases (see 
chapter 4.14, page 132). 

Null 

Neither a dummy nor its loads will be considered for the calculation. Use dummies to analyze, 
for example, changes in structural behavior if certain members are not effective. You do not 
need to delete these members, their loading will be kept as well. 
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Member context menu 

Cross-section at member start and member end 
The two input fields or table columns are used to define the cross-sections for the member 
start and end. The cross-section numbers refer to the entries in table 1.13 Cross-Sections (see 
chapter 4.13, page 117). Assignment is made easier by colors related to different cross-
sections. 

When you enter different numbers for the start and end cross-sections, a taper is created. 
RFEM interpolates the variable stiffnesses along the member according to polynomials of 
higher grade. Input of nonsense like a taper consisting of an IPE cross-section and a round 
steel will be identified by the plausibility check before the calculation starts. 

The internal determination of tapered cross-section values is controlled by the Taper Shape set 
in the Options tab of the New Member dialog box, respectively the table column (see page 148). 

Member rotation 
The member-related coordinate system x,y,z is defined clockwise by right angles. The local axis 
x represents always the centroidal axis of the member, connecting the start node with the end 
node of the line (positive direction). Member axes y and z, respectively u and v for unsymmet-
rical cross-sections, represent the principal axes of the member. 

 
Figure 4.157: Member rotation and local member axes x,y,z (any spatial position) 

The position of the local axes y and z is set automatically. Axis y runs perpendicular to the lon-
gitudinal axis x and parallel to the global plane XY. The position of axis z is determined by the 
right-hand rule. The z' component of the z-axis always shows downwards (which means in di-
rection of the gravity) - irrespective of whether or not the global axis Z is oriented downward 
or upward. 

To check the member position, use the 3D rendering. You can also use the Display navigator or 
the member context menu to display the Member Axis Systems x,y,z. 

 
Figure 4.158: Selecting the local member axis systems in the Display navigator 

 

Tapered member 
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Table column N informs you about the global axis running parallel to the member or indicates 
the plane spanned by the global axes where the member is lying. If there is no entry, the mem-
ber is in an arbitrary spatial position. 

If a member is aligned parallel to the global axis Z, which means in vertical position, the local 
axis z, of course, has no Z-component. In this case, the following rule applies: The local axis y 
will be aligned parallel to the global axis Y. Then, the position of the z-axis is determined by 
the right-hand rule. 

 

Figure 4.159: Vertical member position with different member orientations (β = 0°) 

When a member located in a continuous set of column members is not exactly in vertical posi-
tion (because of minor deviations of the nodal coordinates X or Y), the axes of the member can 
change their orientation: RFEM classifies the position of a member that is slightly inclined as 
"general". If you want to classify members in general position still as vertical, select Regenerate 
Model on the Tools menu (see chapter 7.1.3, page 255). 

Member rotations can be applied in two ways: 

Member rotation via angle β 

You define an Angle β about which the member is rotated. If the rotation angle β is positive, 
axes y and z are rotated clockwise around the longitudinal member axis x. 

Please note that the member rotation angle β and the cross-section rotation angle α' (see 
chapter 4.13, page 120) are summed up. 

In 2D models, only member rotation angles of 0° and 180° are allowed. 

Member rotation via help node 

The member axis system is directed to a particular node. First, select the axis (y or z) that you 
want to be affected by the help node. Accordingly, the help node defines the plane x-y or the 
plane x-z of the member. Then, enter the help node. It is also possible to select it graphically or 
to create a new one. However, make sure that the node does not lie on the straight line that is 
defined by the x-axis of the member. 
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The following example shows columns that are aligned towards the center point. 

 
Figure 4.160: Member rotation via help node 

Changes of the local member axis system may affect the signs of internal forces. The following 
figure illustrates the general sign rule. 

 
Figure 4.161: Positive definition of internal forces 

The bending moment My is positive if tensile stresses occur on the positive member side (in di-
rection of the z-axis). Mz is positive if compressive stresses occur on the positive member side 
(in direction of the y-axis). The sign definition for torsional moments, axial forces and shear 
forces conforms to the usual conventions. These internal forces are positive if they act in a pos-
itive direction. 

Release at member start and member end 
In these two table columns or input fields of the New Member dialog box, you can define re-
leases controlling the transfer of internal forces on nodes. The release numbers refer to the  
entries available in table 1.14 Member End Releases (see chapter 4.14, page 128). 

For some of the member types, entries are not possible because internal releases already exist. 

Member eccentricity 
In this table column or input field of the Options dialog tab (see Figure 4.151), you can assign 
an eccentric connection to the member. The numbers of the eccentricities refer to table 1.15 
Member Eccentricities (see chapter 4.15, page 134). A connection type determines the eccentri-
cities of both the member start and the member end. 
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Member division 
Member divisions control the numerical output of internal forces and deformations along the 
member (see chapter 4.16, page 136). Use the settings in the table column or the input field of 
the Options dialog tab to assign divisions or to create new ones. The numbers of the divisions 
refer to the entries in table 1.16 Member Divisions. 

A member division has neither influence on the determination of extreme values nor on the 
graphical results diagram (RFEM internally uses a more refined partition). As member divisions 
are not required in most cases, the default setting is 'None' or '0'. 

Member elastic foundation 
With this input field of the Options tab (see Figure 4.151) you can assign an elastic foundation 
to the member. The numbers of the elastic foundations are managed in table 1.19 Member 
Elastic Foundations (see chapter 4.19, page 153). 

Member nonlinearity 
This input field in the Options dialog tab (see Figure 4.151, page 138) makes it possible to pro-
vide the member with nonlinear properties. The numbers of the nonlinearities refer to the en-
tries in table 1.20 Member Nonlinearities (see chapter 4.20, page 155). 

Taper shape 
If different cross-sections are defined for the member start and member end, this table column 
or input field in the Options tab offers you the choice between a Linear and a Quadratic taper 
application. In this way, it is possible to describe the taper geometry for the determination of 
the interpolated cross-section values. 

In most cases, a linear taper course is existent: The height of the cross-section is changing 
evenly from the start of the cross-section to its end, the width remains more or less constant. 
However, if also the width of the cross-section is changing distinctly along the member (for 
example taper made of solid sections), it is recommended to use a square function for the  
interpolation of cross-section values. 

Length 
This table column indicates the absolute length of the member as distance between start and 
end node. Eccentricities are taken into account. 

You can read the member length also in the work window: Place the mouse pointer on a mem-
ber and wait a moment until the ScreenTip of the member appears. 

Weight 
The mass of a member is determined from the product of the cross-sectional area A and the 
specific weight of the material. RFEM applies g = 10 m/s2 as gravitational acceleration. 

Position 
Table column N informs you about the global axis running parallel to the member or indicates 
the plane spanned by the global axes where the member is lying. If there is no entry, the mem-
ber is in an arbitrary spatial position. 

When a member located in a continuous set of column members is not exactly in vertical posi-
tion (because of minor deviations of the nodal coordinates X or Y), the axes of the member can 
change their orientation: RFEM classifies the position of a member that is slightly inclined as 
"general". If you want to classify members in general position still as vertical, select Regenerate 
Model on the Tools menu (see chapter 7.1.3, page 255). 
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Effective lengths 
The dialog tab Effective Lengths manages the Effective Length Factors kcr,y and kcr,z. 

 
Figure 4.162: Dialog box Edit Member, tab Effective Lengths 

The effective length factors can be adjusted separately for both member axes. The dialog fields 
to the right show the Effective Lengths resulting from the entered factors and the member 
length. 

Effective length factors are significant for add-on modules like RF-STEEL EC3 where stability 
analyses are performed, but they play a secondary role for RFEM as for example buckling 
lengths for buckling members are determined internally from the boundary conditions, and 
then they are applied exactly. 

In the dialog section Critical Buckling Load, you can decide if the flexural buckling load of the 
member will be checked during the calculation. The check box is ticked by default for truss, 
compression and buckling members. The dialog tab Global Calculation Parameters of the  
Calculation Parameters dialog box (see Figure 7.22, page 271) offers a global setting option  
for this kind of control. 

Member as surface model 
The context menu function Generate Surfaces from Member can be used to convert a member 
(1D elements) into adequate surface elements (2D elements) for detailed designs. The function 
is described in chapter 11.7.1.5 on page 504. 

Double members 
Generally, overlapping members in the model are not desired. So when you define a new 
member on the nodes of an already existing member, RFEM will delete the old member auto-
matically. 

To prevent RFEM from deleting already defined members, select Allow Double Members on the 
Edit menu. RFEM will consider the stiffnesses of both members in the calculation. 
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List button Member 

4.18 Ribs 
General description 

Ribs are a special type of members. To create a rib, a member must already exist. Ribs can be 
used to represent T-beams in the FEA model by defining eccentricities and effective widths. 

Ribs are primarily suited for models with reinforced concrete elements: You can use the rib  
internal forces and cross-sections for design in the add-on module RF-CONCRETE Members. 
However, when you want to model a steel plate with a welded "rib", use a surface with an ec-
centrically connected member. 

You can define a rib directly with the navigator context menu of Ribs or by dialog input. When 
you create a new member and you select the Member Type Rib (see chapter 4.17, page 138), 
you can use the enabled [Edit] button to define the parameters. It is also possible to access the 
dialog box below by using the menu or the context menu in the navigator. 

 
Figure 4.163: Dialog box New Rib (for model type 2D - XY) 

 
Figure 4.164: Table 1.18 Ribs 
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Position of rib 
Generally, a rib is a member that is eccentrically arranged. The eccentricity is determined auto-
matically from half of the surface thickness and half of the member height (table 1.15 Member 
Eccentricities is not affected). You can also define it manually. Due to the eccentricity of the rib 
the rigidity of the model is increased. 

The following arrangement options are available: 

On +/–z-side of surface 

The eccentricity as sum from half of the surface thickness and half of the web height is auto-
matically applied in direction of the positive or negative surface axis z. To display and check 
the surface axes x,y,z in the graphic, use the Display navigator (see Figure 4.115, page 116). 

 
Figure 4.165: Ribs on positive z-side (left) and negative z-side (right) of the surfaces 

Centric 

The rib is modeled without eccentricity. The centroidal axis lies in the center of the surface. 

User-defined via member eccentricity 

You define the member eccentricity manually in the dialog box New Member Eccentricity, re-
spectively in table 1.15 (see chapter 4.15, page 134), and then you assign it to the member. 

You can check the rib position in the rendering mode without problems: In the Display naviga-
tor, select the two display options for solid models: Members → Cross-sections and Surface → 
Filled incl. thickness. 

 

Figure 4.166: Display navigator: Rendering → Model → Solid Model 
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Effective width 
When modeling 3D structures, the effective width has no influence on the stiffness because 
the increased stiffness is already taken into account by the eccentric member. The effective 
width affects only the internal forces. For 2D models (model type 2D - XY), however, the stiff-
ness is controlled by the settings applied to the Stiffness Reduction (see paragraph below). 

If an eccentrically connected beam is used instead of a rib, then the RFEM 4 model assigns in-
ternal forces to both member and slab. But in reinforced concrete design the member and a 
certain part of the surface are considered as a single unit, namely the floor beam (T-beam).  
To determine the internal forces for the floor beam, the bending moment in the member must 
be increased by the product from the axial force in the slab and the eccentricity. To determine 
the axial force in the plate, you have to know the area where the axial forces are summed up. 
Therefore, you have to specify the effective widths as well as the surfaces. 

Connecting surface 

The effective widths of the rib must be defined separately for the left and right side. Often, you 
can keep the Autodetect setting in the Connecting surface list available in the dialog box New 
Rib. Only if more than two surfaces adjoin each other along the line of the rib, you have to de-
termine the connecting surfaces explicitly. 

Effective width 

The Width b1 respectively b2 can be directly entered into the input field or calculated automati-
cally from the member length by selecting the options L/6 and L/8. When confirming the dia-
log box, RFEM determines the effective widths and enters the values. 

Please note: When the member length is modified subsequently, the effective widths will not 
be adjusted automatically! 

After the calculation, the effective components of the surfaces can be considered for the mem-
ber results. In the Display navigator, click Results and select Effective Cooperation Surface/Member. 
The member result diagrams allow for a specific evaluation of the rib internal forces as well (see 
chapter 9.5, page 357). 

Stiffness reduction 
This dialog section respectively these table columns are only shown if the model type 2D - XY 
has been set in the general data (see Figure 12.23, page 554). In comparison to spatially de-
fined models where ribs can be taken into account in the FE analysis as eccentrically arranged 
members anyway, RFEM uses another analysis approach for floor beams. 

Without activity of plate component 

For the calculation RFEM applies a substitute cross-section whose stiffness is determined from 
the member cross-section and the effective plate component of the surfaces. Thus, the stiff-
ness of the plate is determined twice for eccentrically arranged ribs because it is effective in 
the substitute cross-section as well as directly by the surface elements. If the check box With-
out activity of plate component is ticked, the stiffness component of the plate will not be con-
sidered in the substitute cross-section. 

Torsion stiffness activity 

This input field is used to reduce the torsional rigidity of the rib. 
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4.19 Member Elastic Foundations 
General description 
While nodal supports represent a support on both member ends, member elastic foundations 
provide an elastic support of the member along its entire length. Use elastic member founda-
tions to model for example foundation beams considering soil properties. If the elastic founda-
tion is not effective in case of tensile or compressive stresses, it is possible to take into account 
nonlinear effects in the calculation. 

 
Figure 4.167: Dialog box New Member Elastic Foundation 

 
Figure 4.168: Table 1.19 Member Elastic Foundations 

On members 
Member elastic foundations can only be defined for the member type Beam. Enter the number 
of the member into the table column or input field. You can also define it graphically. 

Spring constants 

Translational spring 

You have to specify the parameters of translational springs in direction of the local member 
axes x, y and z. 

The stiffness moduli ES of Table 4.8 serve as reference values. Please note that input in RFEM  
refers to the modulus of subgrade reaction to be determined by taking into account the form 
factor. 
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Member context menu 

Soil type ES (static loading) ES (dynamic loading) 

Sand, compact 40 – 100 200 – 500 

Gravel sand, compact 80 – 150 300 – 800 

Clay, semi-solid to solid 8 – 30 120 – 250 

Clay, stiff-plastic 5 – 20 70 – 150 

Mixed soil, semi-solid to solid 20 – 100 200 – 600 

Table 4.8: Stiffness moduli of selected soil types in [N/mm2] 

The values of Table 4.8 represent area-related characteristic values: They describe the area 
force in [N/mm2] that is required to compress the soil by 1 mm. Thus, the unit would be inter-
preted in a solid-related way as [N/mm3]. 

For foundation beams used for example to model strip foundations, you have to determine 
the spring coefficient taking into account the cross-section width. In this way, you get a trans-
lational spring in [N/mm2] that is related to the member. The spring indicates the member 
force in [N/mm] that is required to compress the soil by 1 mm – therefore the unit [N/mm2] for 
the input. The result must be entered as translational spring C1,z: For strip foundations (mem-
bers in horizontal position) the local z-axis is usually directed downwards. 

The spring stiffnesses are considered as design values. 

Use the Display navigator or the context menu of the member to display the local member  
axes (see Figure 4.158, page 145). 

Shear spring 

Shear springs are used to determine the shear capacity of the soil. The spring constants C2  
are determined from the product of ν · C1,z, with the Poisson’s ratio ν to be assumed between 
0.125 and 0.5 for sand and gravely soil, and between 0.2 and 0.4 for clayey soil. 

Rotational spring 

Enter the constant of a rotational spring into the dialog input field or table column. The con-
stant hinders the member rotating about its longitudinal axis. 

Ineffective foundation 
If the elastic foundation is not effective in case of tensile or compressive stresses, assign the 
nonlinear property Failure to the foundation type. 

Please note that the failure criterion Failure if negative or positive contact stress in z only refers 
to the local member axis z. The nonlinearity does not apply to the translational springs in di-
rection of the local axes x or y! Thus, a biaxially effective failure of foundation members is not 
possible. 

An ineffectivity in case of a negative contact stress has the following meaning: The foundation 
is without effect if a member element moves in opposite direction of the local axis z. 

When failure criteria is applied, it is recommended to check position and orientation of the  
local z-axes (see Figure 4.158, page 145). It might be necessary to rotate members. 

The member division of members with elastic foundations can be adjusted in the dialog tab 
Global Calculation Parameters of the dialog box Calculation Parameters (see chapter 7.3, page 
271). 
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4.20 Member Nonlinearities 
General description 
Member nonlinearities are used to represent nonlinear relations between force (or moment) 
and strain in members. 

Some nonlinear properties can be defined already when specifying the member type. A tension 
member, for example, is a truss for which the strain is increasing proportional to the tension 
force, but whose strain may rise under compression without a verifiable force being required 
for it. 

In principle, member nonlinearities can be assigned to any type of member. Of course, combi-
nations have to make sense. A compression member with the design criterion "Failure under 
compression" would cause problems during the calculation. Therefore, member nonlinearities 
are not allowed for the member types tension, compression, buckling and cable member as 
well as for members with cross-sections of the type Dummy Rigid (see page 118). 

 
Figure 4.169: Dialog box New Member Nonlinearity 

 
Figure 4.170: Table 1.20 Member Nonlinearities 
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Nonlinearity Diagram Description 

Failure under  
tension 

 

The member cannot absorb tensile forces. 

Failure under 
compression 

 

The member cannot absorb compressive forces. 

Failure under ten-
sion with slippage 

 

The member cannot absorb tensile forces. 

Compressive forces are not absorbed until the 
slippage ux is overcome. 

Failure under 
compression with 
slippage 

 

The member cannot absorb compressive forces. 

Tensile forces are not absorbed until the slip-
page ux is overcome. 

Slippage 

 

The member absorbs axial forces only after hav-
ing exceeded a strain or shortening by the value 
ux. 

Please note: A line refinement on a member 
with Slippage causes an internal member divi-
sion into small member parts. The slippage cri-
terion will be applied to each of these partial 
members. 

Tearing under  
tension 

 

The member absorbs compressive forces with-
out limitation but fails if tensile forces exceed 
Nto. 
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Yielding under 
tension 

 

The member absorbs compressive forces with-
out limitation, but only a maximum tensile force 
of Nto. 

If strain increases, tensile force remains constant 
in the member. 

Tearing under 
compression 

 

The member absorbs tensile forces without lim-
itation but fails if compressive forces exceed 
Nfrom. 

Yielding under 
compression 

 

The member absorbs tensile forces without lim-
itation, but only a maximum compressive force 
of Nfrom. 

If strain increases, compressive force remains 
constant in the member. 

Tearing 

 

The member fails when reaching the compres-
sive force Nfrom or the tensile force Nto. 

Yielding 

 

The member starts to yield if the compressive 
force Nfrom or the tensile force Nto are reached:  
If strain increases, force remains constant. 

Plastic hinge 

 

If a plastic design force is reached on a location 
of the member, a plastic hinge is formed there 
for the internal force. 

The internal forces must be entered as absolute 
values. For components of internal forces not 
resulting in plastifications, you have to enter 
high values. 

Table 4.9: Member nonlinearities 



4  Model Data 

 

 

158 Program RFEM © 2013 Dlubal Software GmbH 

 
 

List button Member 

4.21 Sets of Members 
General description 

Sets of members must be understood as combined members. Use a set of members to treat 
several members like a single member as it may be preferable for some locations in the struc-
tural system (for example for lateral-torsional buckling analysis, design of continuous beams, 
load application). 

 
Figure 4.171: Continuous members with trapezoidal load 

The figure above shows a linearly variable load acting on the complete length of a set of 
members. 

 
Figure 4.172: Dialog box New Set of Members 

 
Figure 4.173: Table 1.21 Sets of Members 

Description 
You can enter any name for the set of members. You can also use the list to select a name. 
Manually entered descriptions are saved in the list and are instantly available for selection. 
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Type 
There are two different types of member sets: 

• continuous members 

• group of members 

Continuous members are created by connected members that are not branching out. It would 
be possible to draw them with a pencil without interrupting the continuous line. 

 
Figure 4.174: Continuous members 

A group of members consists of connected members that may branch out. 

 
Figure 4.175: Group of members 

In some add-on modules it is possible to design sets of members. Often, the design can be  
performed only for continuous members because parameters such as buckling lengths must 
be clearly defined. 

Members 
In the input field of the dialog box or the column in the table, enter the numbers of the mem-
bers that form the set of members. You can also use the [] function to select them graphically 
in the work window. Use the button [Reverse Orientation of Members] to change the order of 
member numbers and thus the direction of the member set. 

The quickest way to define a set of members is as follows: Select the relevant members in the 
work window by using the pointer drawing an enclosing window. You can also use the multi-
ple selection by holding down the [Ctrl] key. Then, right-click one of the selected members. 
The context menu of the member opens where you point to Member and select Create Set of 
Members (for member groups) or select Create Set of Members (for continuous members). 
The dialog box New Set of Members opens and presets the numbers of the selected members. 
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Length 
The total length of the set of members is determined from the sum of the individual member 
lengths. 

Weight 
The mass of the set of members is determined from the sum of the individual member masses. 

4.22 Intersections 
General description 

If surfaces intersect and internal forces are transferred on the common line, you have to create 
an intersection. Otherwise, you would have two independent subsystems without any connec-
tion. The following example demonstrates the effect. 

 
Figure 4.176: Deformations due to self-weight without intersection (left) and with intersection (right) 

Each time the model is changed, RFEM must recalculate the intersections. Recalculating data is 
very time-consuming for the graphical representation when complex models are designed. 
The input is slowed down accordingly. 

 
Figure 4.177: Dialog box New Intersection 
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Figure 4.178: Table 1.22 Intersections 

Intersection of two surfaces 
In the input fields or table columns, enter the numbers of the two intersecting surfaces. In the 
dialog box New Intersection, you can select the surfaces from the list. You can also use the [] 
function to select them graphically. 

Intersections (of even more than two surfaces, if needed) can be created quickly in the graphic: 
Select the surfaces by using the pointer drawing an enclosing window. You can also use the 
multiple selection by holding down the [Ctrl] key. Then, right-click one of the selected surfaces. 
The context menu opens where you point to Surface and select Create Intersection. Then, 
RFEM creates the intersection automatically. 

 

Figure 4.179: Context menu Surface → Create Intersection 

Line numbers generated by intersection 
When creating an intersection, RFEM generates a line that is shared by both surfaces ("inter-
section line"). The number of the new line is shown in the dialog field and table column. 

Intersection lines are marked as line type Intersection in table 1.2 Lines. The comment identifies 
them as Generated lines. The dialog box Edit Line can also be used for intersection lines so that 
you can assign member or support properties. 
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Active surface components 
An intersection line divides a surface into components that can be individually set active or in-
active. Inactive surface components are not displayed in the work window. Neither finite ele-
ments are created nor loading is applied. Only active surface components are existent for the 
equation solver. 

Components of intersections can be activated and deactivated as follows: 

• Dialog box Edit Surface 

Double-click the original surface in the Data navigator. When you double-click the surface 
in the work window, use the button [Go to] available in the dialog tab Component (see 
Figure 4.69, page 80) of the dialog box Edit Surface to open the edit dialog box of the orig-
inal surface.  

Open the dialog tab Integrated / Components where the dialog section Active Surface Com-
ponents lists all surface components that have been created during the generation of the 
intersection. 

 
Figure 4.180: Dialog box Edit Surface, tab Integrated / Components 

The surface component marked in the list is highlighted in color in the work window. To 
set a component inactive, clear the corresponding check box. Then, the inactive surface 
component is shown without filling color. 
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• Context menu of surface component in the Data navigator 

Directly right-click the navigator entry Surfaces or the component in the work window. 
Then, use the context menu to activate or deactivate the surface component. 

   
Figure 4.181: Context menu of a surface Component in the navigator and work window 

The context menu provides further helpful functions for editing the component or  
original surface. 

The geometric information of the original surface is kept internally by the program as it is 
needed for recalculating the intersection after modifications. Therefore, inactive surface  
components cannot be deleted but only be hidden. 
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4.23 FE Mesh Refinements 
General description 

If no FE mesh refinements have been defined, the FE mesh is generated with the preset target 
FE length. The global parameters of the FE mesh are described in chapter 7.2.2 on page 258. 

The concept of the FE-mesh generator does not allow subsequent adjustments to the mesh. 
However, you can use FE mesh refinements to influence the mesh generation for specific areas. 
In this way, a user-defined discretization is done, as it may be required for example in nooks, for 
connections of members to surfaces or for a dynamic analysis of members. 

 
Figure 4.182: Dialog box New FE-Mesh Refinement 

 
Figure 4.183: Table 1.23 FE Mesh Refinements 
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FE-mesh refinement applied to 
With the settings in this dialog section or table column, you decide which objects are included 
by the FE mesh refinement and how the refinement is carried out. Different options are availa-
ble for selection. 

Node - circular 

Define a radial refinement area around a node which is extended in all spatial directions. 

 
Figure 4.184: Circular refinement around a node 

Node - rectangular 

Instead of a circular refinement area, you can specify a rectangular zone for refinement. 

 
Figure 4.185: Rectangular refinement around a node 

Refinement on line by FE length 

Define regular spacings of FE nodes on a line. 

 
Figure 4.186: Refinement on line by FE length 
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Refinement on line by division 

The FE mesh of a line can be refined in regular intervals. This type of refinement is especially 
useful for lines with member properties. 

 
Figure 4.187: Refinement on line by division 

Gradually refinement on line 

The finite elements adjoining the line can be subdivided by a defined number of n rows. In this 
way, you can cover for example boundary areas of surfaces with a refinement. This refinement 
type is similar to the generation option FE mesh refinement along lines (see chapter 7.2.2, page 
260) available for 2D plates. 

 
Figure 4.188: Gradual refinement on a line by two rows 

Refinement on surface 

Specify a lateral length of finite elements that is set as target length and mesh size for the en-
tire surface. 

This type of refinement can be used also for surfaces with low significance for the analysis: As 
"refinement" you enter a mesh size that is larger than the global target FE length. 
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Figure 4.189: Refinement on a surface 

Refinement on solid 

FE mesh refinements can also be defined for solids to influence the generation of 3D elements. 

 
Figure 4.190: Refinement on a solid 

Nodes / lines / surfaces / solids 
In the input field of the dialog box, respectively the column of the table, enter the numbers of 
the objects to which you want to apply the refinement of the FE mesh. In the dialog box New 
FE-Mesh Refinement, you can use the [] function to select the objects graphically. 
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Parameters 

Radius 

When you select a circular refinement around a node, you have to specify the Radius of the  
refinement area. In addition, you have to define the Target FE Length in the center (Inner) and 
at the periphery (Outer) of the circle. If the FE length on the boundary of the refinement area 
corresponds to the global mesh size, RFEM refines the mesh gradually from outside to inside. 

If there is a major difference between inner and outer FE length, specify a broader radius. In 
this way, you can avoid to generate acute-angled triangular elements within the refinement 
area. 

Side length 

When you select a rectangular refinement around a node, you have to define the area of re-
finement by its side length. In addition, you have to specify the Target FE length in the center 
(Inner). 

Number of division nodes 

When you select a line refinement by division, you have to define the number of division 
nodes. Then, the defined number of equally spaced FE nodes will be generated on the line. 

Number of rows 

When you select a gradual line refinement, you have to define the number of rows n. Then, 
RFEM divides the finite elements of the surface which are directly adjoining the line into the 
corresponding row number. Thus, a refinement in direction of the line is generated. 

FE length for line / surface / solid 

If the refinement has been selected on a line, surface or solid, the target FE length for the cor-
responding objects must be entered. 
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5. Load Cases and Combinations 
Loads acting on the model are managed in different load cases. It is possible to superimpose 
these load cases, either manually or automatically, in load and result combinations (see chap-
ter 12.2.1, page 556). 

Before you can define loads (see chapter 6), you have to create a load case. 

5.1 Load Cases 
General description 

The loads from a particular action are stored in a load case (LC). Load cases are for example: 
self- weight, snow or live load. 

The loads in the load case should be defined as characteristic actions, that means without fac-
tors. The partial safety factors can be considered later when the load cases are superimposed 
in load or result combinations. 

For each load case you can separately define which calculation method (linear static, second-
order or large deformation analysis), approach and calculation parameters (load increment  
factor, stiffness reduction by partial safety factor of material) you want to use. 

Create a new load case 

There are several possibilities to open the loading dialog box for creating a new load case: 

• On the Insert menu, point to Loads and select New Load Case. 

• Use the toolbar button [New Load Case] shown on the left. 

 
Figure 5.1: Button New Load Case in the toolbar 

• Use the context menu of the navigator entry Load Cases. 

 
Figure 5.2: Context menu of Load Cases in the Data navigator 
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The dialog box Edit Load Cases and Combinations appears. A new load case is preset in the dia-
log tab Load Cases. 

 
Figure 5.3: Dialog box Edit Load Cases and Combinations, tabs Load Cases 

• It is also possible to enter a new load case in an empty row of table 2.1 Load Cases. 

 
Figure 5.4: Table 2.1 Load Cases 

Load case 
The number of the new load case is preset but can be modified in the dialog input field LC No. 
If the entered number has already been assigned, RFEM displays a warning when closing the 
dialog box. 

The creation of load cases should be well organized. Gaps in the numbering are allowed so 
that you can insert additional load cases later. The order of load cases can be changed subse-
quently by means of the [Renumber] dialog button (see Table 5.1 and chapter 11.4.18, page 
479). 
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Load case description 
You can enter any name manually. You can also choose a name from the list to describe the 
load case shortly. 

To solve 
Use the check box to decide if the load case is considered as independent load case in the  
calculation. In this way, it is possible to exclude load cases from the calculation which do not 
occur in isolation (for example wind without considering self-weight) or whose results are not 
relevant for a preliminary design. 

Action type 
Standards mention different action categories controlling the superposition of load cases as 
well as the partial safety factors and combination coefficients. Each load case must be assigned 
to a category. 

The list of the dialog box and table provides several categories for selection. They depend on 
the standard that is set in the dialog box Model - General Data (see chapter 12.2.1, page 556). 

 
Figure 5.5: Action categories according to EN 1990 

These categories are significant for combining load cases manually or automatically. The classi-
fication of the load case determines which factors are applied when creating load and result 
combinations. 

Self-weight 
When you want to take into account the construction's self-weight as load, tick the Active check 
box. The load's direction of action can be defined in one of the three input fields by means of 
the self-weight factor. The default setting is 1.00 in direction Z, respectively -1.00 if the global 
axis Z points upwards. 

When the automatic self-weight is applied in several load cases, you have to consider this for 
the combination of load cases. 

Comment 
Enter a user-defined note or select an entry from the list to describe the load case in detail. 

Calculation parameters 
The tab Calculation Parameters in the loading dialog box offers different options for controlling 
the calculation. Find a detailed description of these parameters in chapter 7.3.1 on page 263. 

 

 
 

Standard settings in dialog box 
Model - General Data 
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Edit general data of a load case 
There are several possibilities to change the general data of an existing load case: 

• On the Edit menu, point to Loads, and then select Load Case - General Data (current 
load case). 

• On the Edit menu, point to Loads, and then select Load Cases (selection from all load 
cases). 

• In the Data navigator, right-click a load case to open its context menu, or double-click the 
load case itself. 

 
Figure 5.6: Context menu of a load case 

• Use the button [Edit load cases] in the toolbar of the loads tables (current load case). 

 
Figure 5.7: Button [Edit load cases and combinations] in the toolbar of the loads tables 
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Buttons 
In the dialog box Edit Load Cases and Combinations, several buttons are available below the 
load case list (see Figure 5.3, page 170). The buttons have the following functions: 

 
Creates a new load case 

 
Creates a new load case as copy of the selected load case (see below) 

 
If several load cases are selected, all contained loads are copied to a new load case 
(see below). 

 
Assigns a new number to the selected load case. Specify the number in a separate 
dialog box. It is not allowed to enter a number that has already been assigned. 

 
Selects all load cases 

 
Cancels the selection in the list 

 
Inverts the selection of load cases 

 
Deletes the selected load case 

Table 5.1: Buttons in the tab Load Cases 

Copy and add load cases 

You can use already existing load cases to create new load cases. 

To copy a load case, select the relevant load case in the list Existing Load Cases. By clicking the 
[Copy] button you create a copy of the load case with the next available free number. Then, 
you can adjust the description of the new load case and the loads. 

When adding load cases RFEM copies the loads of several load cases into a new load case. 
First, select the relevant load cases in the list Existing Load Cases (multiple selection by holding 
down the [Ctrl] key). Use the [Add] button to copy the loads into a new load case. 
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5.2 Actions 
General description 
When using the latest standards, for example EN 1990 or DIN 1055-100 (Germany), it is often 
time-consuming to take into account all load situations coming into question and to select the 
decisive situations for the designs. In the dialog box Model - General Data, you have the possi-
bility to create combinations automatically (see Figure 12.23, page 554). 

The load cases defined in table 2.1 (see previous chapter 5.1) represent the base data for the 
automatic superpositioning. RFEM distinguishes between two load case categories: standard 
load cases and load cases of the type Imperfection. Moreover, for combining load cases it is  
important to know in which action category the standard load cases have been organized. 

Standards provide rules for the combination of independent actions in various design situa-
tions. Actions are independent of each other if they arise out of different origins and if the cor-
relation existing between them may be neglected with regard to the reliability of the structural 
system. 

In accordance with this concept, Actions to which load cases are assigned must be defined for 
the automatic superposition in RFEM. The action type defined for the load cases (see chapter 
5.1, page 171) controls the assignment to action categories conforming to standards. 

 
Figure 5.8: Dialog box Edit Load Cases and Combinations, tabs Actions 

 

 
 

Check box in dialog box 
Model - General Data 
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Figure 5.9: Table 2.2 Actions 

Action 
Actions are created already when defining load cases. They are consecutively numbered. The 
sequence is not important but can be modified, if necessary, by means of the [Renumber] but-
ton available in the dialog box. 

In the table you can add actions manually for example to assign load cases by user-defined 
specifications when huge models are designed. 

Action description 
The description of the action is derived from the action type that has been selected for the 
load cases. The preset description can be changed, if necessary. 

Action category 
Standards mention different action categories controlling the partial safety factors and combi-
nation coefficients (see chapter 5.1, page 171). 

The list of the dialog box and table provides only the categories which have been used for the 
definition of the single load cases. Therefore, in order to create a new category, a new action 
type must be assigned in the general data of a load case. 

Acting 
Two or more load cases can be defined as Simultaneously or Alternative acting. That means that 
these load cases occur either always or never together in a load or result combination. 

For example, load cases with wind from different directions are "alternative" acting. 

Load cases in action 

Load cases are assigned according to the specifications of the LC action type, so assignment is 
largely automatic. 

To remove a load case from an action, select the load case in the dialog section Load Cases in 
Action. Use the [] button or double-click the entry to transfer it to the dialog section Unas-
signed Load Cases. In the table, it is also possible to set a load case inactive: Select the empty 
entry in the list of the relevant table cell. 

Manually removed load cases, taking into account the action type, are transferred to the list 
Unassigned Load Cases. This also means that only load cases of the same action type can be in-
cluded in an action category. It is not possible for example to select load cases of the type "live 
loads" for actions of "snow", neither in the dialog box nor in the list of the table (see picture on 
the left). Therefore, type-different load cases are not visible in the list Existing Actions. Use the 
button [Show Unused] below the dialog section to display load cases of other categories. They 
are shown as locked and cannot be selected. 
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Load cases that not assigned to any action will not be taken into account when generating 
combinations. 

Comment 
Enter a user-defined note or select an entry from the list. 

The buttons in the Actions tab of the dialog box Edit Load Cases and Combinations have the  
following functions: 

 
Creates a new action 

 
Renumbers the selected actions 

 
Selects all actions 

 
Cancels the selection in the list 

 
Assigns unassigned load cases to actions automatically 

 
Deletes the selected actions 

Table 5.2: Buttons in the tab Actions 
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5.3 Combination Expressions 

General description 
Standards describe how to combine actions. For example, EN 1990 requires the design of the 
ultimate and the serviceability limit states. Ultimate limit states for load bearing capacity 
have to be designed in four design situations for which particular combination rules must be 
applied: 

1. Permanent situations involving common conditions of use of a structural system as well as 
temporary situations referring to time-limited stages of the structure (for example construc-
tion stage, repairs) 

As combination rule for permanent and temporary situations (basic combination) you have 
to apply either 

i,ki,0
1i

i,Q1,k1,QkPj,k
1j

j,G QQPG ⋅ψ⋅γ+⋅γ+⋅γ+⋅γ ∑∑
>≥

 

Equation 5.1 

or the more unfavorable combination with Equation 5.2 and Equation 5.3 for the limit states 
STR and GEO. 

i,ki,0
1i

i,Q1,k1,01,QkPj,k
1j

j,G QQPG ⋅ψ⋅γ+⋅ψ⋅γ+⋅γ+⋅γ ∑∑
>≥

 

Equation 5.2 
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Equation 5.3 

2. Extraordinary situations referring to extraordinary actions of the structural system or its  
environment (for example fire, explosion, collision) 
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Equation 5.4 

3. Situations in case of earthquakes 
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Equation 5.5 
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According to EN 1990, you have to design serviceability limit states in three design situations 
for which the following combination rules must be applied. 

1. Characteristic situations with irreversible (lasting) effects on the structural system 
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Equation 5.6 

2. Frequent situations with reversible (non-lasting) effects on the structural system 
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Equation 5.7 

3. Quasi-permanent situations with long-term effects on the structural system 
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Equation 5.8 

 
Figure 5.10: Dialog box Edit Load Cases and Combinations, tab Combination Expressions 

 
Figure 5.11: Table 2.3 Combination Expressions 
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Combination expression 
When you access the dialog box or table, RFEM presets the combination rules of the following 
design situations: 

• STR (ULS) ultimate limit state for permanent or temporary situation 

• S Ch (SLS) serviceability limit state for characteristic situation 

• S Fr (SLS) serviceability limit state for frequent situation 

• S Qp (SLS) serviceability limit state for quasi-permanent situation 

You can create a new combination rule in another table row or in the dialog box by using the 
[New] button. The design situations described below are available for selection. 

Combination rules marked in the dialog list can be deleted with the [Delete] button. 

Description of combination expression 
The brief description of combination rules can be changed subsequently. The list provides 
some suggestions for selection. 

Use 
Use the check box to decide if the selected combination rule is considered when creating re-
sult combinations. In this way, it is possible to reactive or exclude design situations from the 
generation. 

Design situation 
Standards describe the situations for which designs of structural systems must be performed. 
These design situations determine the conditions expected during the construction and use of 
the building. 

The following design situations for EN 1990 are available for selection in the list: 

 
Table 5.12: Design situations according to EN 1990 

For the standards DIN 1055-100, DIN EN 1990 and EN 1990 + DIN EN 1995, RFEM offers addi-
tionally the design situations Accidental - Snow where the factors for the North German Plain 
are taken into account. 

Use the [Info] button to check the combination rule of the current design situation. A dialog 
box opens explaining the equation with relevant parameters (see figure below). 
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Figure 5.13: Dialog box Info About Design Situation 

Favorable permanent actions 
Due to this option, RFEM can distinguish between favorable and unfavorable acting perma-
nent actions during the generation. They are considered with different partial safety factors in 
the superpositioning. Additional combinations are generated. 

Settings of the check box affect only design situations for load bearing capacity. The distinc-
tion between favorable and unfavorable acting permanent actions is done automatically for 
the design situation "static equilibrium", whereas permanent actions for the design situation 
"serviceability" are not differentiated. 

Imperfection load cases 
RFEM distinguishes between two load case categories: standard load cases and load cases of 
the type Imperfection. Due to the special treatment of imperfections, it is possible to form any 
possible load combination once with imperfection and once without. 

Imperfection load cases are taken into account only for generating load combinations. More-
over, settings of the check boxes are globally valid: Imperfections can be considered either 
consistently for all combination rules or not at all. It is not possible to apply imperfections sep-
arately for individual combination expressions. 

When the check box is ticked, the [Settings] button or the button [...] is enabled. Use the but-
tons to access a dialog box with specific settings for imperfection load cases. 
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Figure 5.14: Dialog box Settings with dialog box Select Load Cases for selecting load cases 

The dialog section Use Load Cases of Type 'Imperfection' lists all load cases that have been classi-
fied as action type "imperfection" (see chapter 5.1, page 171). Use the check boxes in the Use 
column to control the load cases in detail and to decide which one is included in the genera-
tion of load combinations. 

The columns Only with Load Cases and Never with Load Cases are shown if the imperfection 
load cases are Subject to specific load cases (see description below). 

With settings in the dialog section Options you determine how imperfection load cases are 
taken into account. When All imperfection load cases act as alternative, RFEM applies only one 
imperfection load case for each load combination.  

If at least one imperfection load case is activated, any possible load combination will be created 
once with imperfection and once without. In case you want to create only load combinations 
with imperfection, tick the check box for Remove co-existence of the same load combination with 
and without imperfection. 

With the option Subject to specific load cases you can further reduce the number of generated 
load combinations. If the option is ticked, the two additional columns Only with Load Cases and 
Never with Load Cases are shown in the dialog section above. Click into a cell to enable the [...] 
button that you can use to access the dialog box Select Load Cases where you can define a rela-
tion between the imperfection load case and one or more belonging respectively alternative 
load cases (see Figure 5.14). 
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Exclusive/inclusive load cases 
To further reduce the number of created load combinations, it is possible to classify load cases 
to be mutually exclusive or occurring only together. 

Ticking the check box enables the dialog button [Settings] or the table button [...] that you can 
use to open a dialog box with detailed settings for the application of load cases. 

 
Figure 5.15: Dialog box Settings, tab Exclusive/Inclusive Load Cases with dialog box Select Load Cases 

First, enter a load case into the column Select Load Cases in the dialog section Exclusive Load 
Cases. You can also use the [...] button to open the dialog box Select Load Cases where you can 
select the case. Then, in the column Not to combine with load cases, define which load case(s) 
you never want to take into account together with the case in the load combination. In this 
way, it is possible to avoid for example the combination of snow with human load cases. 

In the dialog section Inclusive Load Cases, you can specify settings analogously for load cases 
that you want to appear always together in each load combination. However, these relations 
are only effective if the option Reduce number of generated combinations due to Examine results 
(see below) is not activated. 

Specifications in the dialog section Inclusive Load Cases are taken into account only for the 
generation of load combinations, not of result combinations. 
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Reduce number of generated combinations due to 
The complexity of the structural system as well as the number of actions and load cases have a 
significant influence on the number of generated combinations. RFEM offers three possibilities 
for reducing the number of constellations with great effect. The first two procedures are only 
available for the generation of load combinations but not for result combinations. They are de-
scribed in an example to be found on page 186. 

Reduce number of load cases 

With this option you can generally limit the number of load cases occurring in the load combi-
nations. Access to the check box is available in the General tab of the Combination Expressions 
(see Figure 5.10, page 178). RFEM finds out which load cases provide positive respectively neg-
ative internal forces and deformations. Then, all positively acting and all negatively acting load 
cases are combined. Thus, combinations will take into account only those load cases which are 
relevant for the maximum or minimum values. 

The advantage of this method is the possibility to reduce the number of combinations consid-
erably, which has a favorable impact on the speed of calculation as well as the evaluation. A 
disadvantage may be the fact that there is a certain factor of uncertainty for the reduction to 
find the extreme values in case of unfavorable load arrangements and specifications. 

When you tick the check box, an additional dialog tab appears called Reduce - Number of Load 
Cases where you can specify in detail which load cases, internal forces and objects you want to 
be considered for the creation of governing combinations. 

 
Figure 5.16: Dialog tab Reduce - Number of Load Cases for combination expressions 

The load cases can be selected Manually or determined Automatically on the basis of relevance 
criteria. Clicking the button [Determine automatically] starts a calculation to determine the 
maximum and minimum internal forces, deformations and support reactions in the load cases. 
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When the automatic determination is selected, define which Results (deformations, internal 
forces of members and surfaces, support reactions) and Objects (nodes, surfaces, members 
etc.) you want to consider for the evaluation of the load cases. The relevant objects can be  
selected graphically with the [] function as soon as the check box All is clear. Above, you can 
use the check box Assign separately for each object to assign specific result types to objects for 
the analysis. 

The number of load cases contained in a Group after calculating load case data depends on 
settings defined in the dialog section Choice of Load Cases: 

• When the option Maximum number of the most relevant load cases is selected, a 
group provides either the specified maximum number of load cases or only positively  
respectively negatively acting load cases in a smaller number. 

• It is possible to Neglect load cases which have only a very small share in the maximum 
and minimum values. The percentage refers to the internal forces, deformations and  
support forces of the load cases respectively providing the extreme values. 

Imperfection load cases are not considered when the automatic creation of groups is set. 

Examine results 
RFEM creates only the governing load combinations (this option is not available for result 
combinations). 

When ticking the check box, the new tab Reduce - Examine Results is added to the dialog box. 

 
Figure 5.17: Tab Reduce - Examine Results for combination rules 

With the first Reduction Method you can evaluate generated temporary result combinations 
automatically. Temporary result combinations include all load cases created in the model and 
consider all relations existing among them. By means of results available on each FE node, 
RFEM can analyze which of the simultaneously acting load cases produce a maximum or min-
imum on the corresponding locations. The reduction method is based on the assumption that 
only those combinations can be governing which contain exactly these simultaneously acting 
load cases. 
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Alternatively, it is possible to use the results of a user-defined result combination for the results 
reduction. 

In the dialog section Examining Results to the right, you can define which deformations, inter-
nal forces, stresses or support reactions you want to take into account for the determination of 
extreme values. 

The dialog section Examining Results of Objects provides options to restrict the extreme value 
analysis to results of selected members, surfaces and solids. You can use the [] function to  
select objects graphically. 

Select leading variable actions 

The third possibility to reduce the number of generated combinations is to classify only select-
ed actions as leading actions. This option is available for the generation of load and result com-
binations. 

When ticking the check box, the new tab Reduce - Leading Variable Actions is added to the dia-
log box. 

 
Figure 5.18: Tab Reduce - Leading Variable Actions for combination rules 

The list of leading actions contains only variable actions. 

When you remove the check mark of an entry in the column Leading Actions, the corresponding 
action will be superimposed only as accompanying variable action. 

Numbering of generated combinations 
Entering data in this section of the dialog box Edit Load Cases and Combinations (see Figure 5.10, 
page 178) affects the First number of generated Load combinations or Result combinations that 
are created in RFEM. 

Result combinations 
Optionally, you can Generate additionally an Either/Or result combination (results envelopes). This 
result combination superimposes the extreme values of all load or result combinations accord-
ing to the following scheme: 

"CO1/permanent or CO2/permanent or CO3/permanent etc." 

If several combination expressions are specified for the generation, it is possible to Generate 
additionally a separate Either/Or result combination for each combination expression. 

Method of analysis 
Use the list to decide which method of calculation you want to apply to analyze combinations 
(see chapter 7.3.1.1, page 263). RFEM presets the nonlinear calculation according to second-
order analysis (P-Delta) for load combinations. 
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Generated action combinations 
The dialog section, respectively table column, is filled during the generation starting automati-
cally when closing the dialog tab or table. The dialog field shows you a short overview of the 
number of generated combinations. 

With the data entered in the dialog box or table, RFEM creates so-called "action combinations" 
(AC). They are described in the following chapter. You can use the entries shown in the current 
dialog box to estimate the way how combination rules affect the number of combinations. 

In the example shown on the left, a total of 47 action combinations is generated for the four 
specified design situations: 

• ULS (STR/GEO): AC1 to AC13 

• SLS - characteristic: AC14 to AC26 

• SLS - frequent: AC27 to AC39 

• SLS - quasi-permanent: AC40 to AC47 

When jumping to the next tab with the dialog button [], RFEM determines the action com-
binations automatically. The first action combination created with the current combination 
expression is selected in the subsequent dialog tab. 

Comment 
Enter a user-defined note or select an entry from the list. 

Example: Reducing generated combinations 
The target of combining actions is finding the most unfavorable load arrangement for each  
location in the structural system. To reach it, you can 

- either determine all combinations that are mathematically possible 

- or try to find logical relationships before combining the actions to reduce the number of 
possible combinations. 

For example, a symmetrical two-hinged frame has the following load cases: 

 
Figure 5.19: Two-hinged frame with four load cases 
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• Option Reduce number of load cases 
The load cases result in the following axial forces available in the columns: 

Load case Description Effect 
Axial force 
left column 

Axial force 
right column 

1 self-weight permanent compression compression 

2 wind to the right alternative tension compression 

3 wind lifting alternative tension tension 

4 snow alternative compression compression 

Table 5.3: Tensile and compressive forces of columns 

Because LC1 is always acting and the remaining load cases occur alternatively, eight combi-
nations are theoretically possible: 

CO1: LC1 + LC2 + LC3 + LC4 

CO2: LC1 

CO3: LC1 + LC2 

CO4: LC1 + LC3 

CO5: LC1 + LC4 

CO6: LC1 + LC2 + LC3 

CO7: LC1 + LC3 + LC4 

CO8: LC1 + LC2 + LC4 

These eight combinations can be reduced if we want to find for example only the arrange-
ments with the extreme values of the columns' axial forces. It is possible to create a group of 
load cases for each column providing only tensile and compressive forces, considering the 
permanently acting load case 1. 

Group Left column Right column 

tension LC1, LC2, LC3 LC1, LC3 

compression LC1, LC4 LC1, LC2, LC4 

Table 5.4: Groups of load cases 

Thus, the result is no longer eight but only four combinations of load cases. 

This reduction can be done in the dialog box Edit Load Cases and Combinations (see Figure 5.10, 
page 178) by 

- ticking the check box Reduce number of load cases, 

- ticking only the axial forces in the dialog section Examining Results in the tab Reduce - 
Number of Load Cases and 

- entering only the numbers of the column members in the dialog section Examining Results 
of Objects (see figure on the following page). 

After clicking the button [Determine automatically] RFEM performs a short calculation. Then, 
the table in the dialog section Considered Load Cases lists the four groups of load cases that are 
are also shown in Table 5.4. 
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Figure 5.20: Automatic determination of load cases in groups 

• Option Examine results 
With this method a linear result combination is created from the load cases. For each point 
RFEM evaluates the extreme values and the involved load cases so that a max- and a min-
combination of load cases is respectively available. Then, these extreme combinations are 
used for creating the load case combinations. 

The load cases result in the following axial forces occurring in the columns: 

Load case Description Effect 
Axial force 
left column 

Axial force 
right column 

1 self-weight permanent compression (-10 kN) compression (-10 kN) 

2 wind to the right alternative tension (5 kN) compression (-5 kN) 

3 wind lifting alternative tension (3 kN) tension (3 kN) 

4 snow alternative compression (-12 kN) compression (-12 kN) 

Table 5.5: Tensile and compressive forces of columns 

RFEM creates this temporary result combination: LC1/permanent + LC2 + LC3 + LC4 

For the axial forces of the two columns we get the following extreme value results when super-
imposing: 

Group Column left Column right 

Maximum N -2 kN (LC1, LC2, LC3) -7 kN (LC1, LC3) 

Minimum N -22 kN (LC1, LC4) -27 kN (LC1, LC2, LC4) 

Table 5.6: Groups of load cases 

Again, the result is no longer eight but only four combinations of load cases. 

Setting specifications in the tab Reduce - Examine Results is analogous to Figure 5.20. 
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5.4 Action Combinations 
General description 
When you open the dialog tab or table 2.4, actions are superimposed automatically according 
to the combination rules and identified as so-called "action combinations". This overview is 
sorted by actions, and thus corresponds to the way how actions are described in standards. 
Now, you can define which action combinations will finally come into question for the genera-
tion of load or result combinations. 

An action combination includes all possibilities how load cases can be combined in the action. 
Therefore, do not confuse it with a load or result combination representing only a single variant 
of these possibilities. 

 
Figure 5.21: Dialog box Edit Load Cases and Combinations, tab Action Combinations 

 
Figure 5.22: Table 2.4 Action Combinations 

 



5  Load Cases and Combinations 

 

 

190 Program RFEM © 2013 Dlubal Software GmbH 

   

Action combination 
The combinations generated from actions are consecutively numbered. An action combina-
tion includes all possibilities how load cases contained in the action can be considered. These 
possibilities depend on the action category and the combination expressions. 

In the dialog box Edit Load Cases and Combinations below the list Existing Action Combinations, 
it is possible to filter generated combinations by design situation or relevance. 

 
Figure 5.23: Filter option in the dialog box Edit Load Cases and Combinations 

Description of action combination 
RFEM assigns automatically brief descriptions based on the safety factors and symbols of  
actions, expressing combination rules. You can change these descriptions, if necessary. 

Click the dialog button [] to jump to the previous dialog tab where RFEM shows you the 
combination expression by which the current action combination was created. 

Use 
Use the check box to decide if the selected action combination is considered for creating load 
or result combinations. In this way, it is possible to reactive or exclude action combinations 
from the generation. 

If RFEM creates an action combination twice because of special constellations, one of them is 
automatically deactivated. 

Design situation 
The design situation of the current action combination is again indicated so that you can check 
data. Use the [Info] button to look at the combination rule of the design situation. A dialog box 
with explanations opens (see Figure 5.13, page 180). 

Actions in action combinations 
The columns inform you about actions including corresponding partial safety factors and 
combination coefficients. 

If an action is assumed to be Leading in the combination, it is marked accordingly in the dialog 
box. In this case, it is inserted as action Qk,1 in Equation 5.1 to Equation 5.7 (see page 177). 

The values indicated in the table column Factor are based on coefficients depending on the  
selected standard. For EN 1990 they are the partial safety factors γ, the combination factors ψ, 
the reduction factors ξ and, if applicable, the reliability factors KFl of each action resulting from 
design situation and action category. 

Use the buttons [Settings] or [...] to check and, in case of a user-defined standard, adjust the 
partial safety factors and combination coefficients. The factors are organized in several tabs of 
the dialog box Coefficients. The first tab Partial Safety Coefficients is shown in Figure 12.27 on 
page 556. The tab Combination Coefficients manages the factors ψ and ξ. 
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Figure 5.24: Dialog box Coefficients, tab Combination Coefficients 

The dialog section Actions in Action Combination lists the Load Cases contained in the actions 
with all possibilities how they can be taken into account in the action. The possibilities depend 
on the action type and the defined action (simultaneous or alternative). It is precondition that 
all assigned load cases are always used together for the action types "permanent loads" and 
"prestress" unless the relation is defined as "alternative". In case of variable, extraordinary and 
seismic actions, assigned load cases can be superimposed in all relevant combinations. 

Generated load or result combinations 
The dialog section, respectively table column, is filled during the generation starting automati-
cally when closing the dialog tab or table. The dialog field shows you a short overview about 
the number of generated load or result combinations. 

Load and result combinations are described in the following chapters 5.5 and 5.6. 
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Example 
In the example shown on the left, a total of 47 load combinations is generated for the design 
situation ULS. For the action combination AC12 (penultimate row) the four load combinations 
CO40 to CO43 occur with the following background: 

The first action A1 has been categorized as action category "permanent loads" and provided 
with the factor γ = 1.35 in the generated load combinations. The contained load cases 1 and 2 
occur together in all load combinations. 

As second action A2 we have the action category "snow" included in the load combination 
with the factor γ * ψ = 1.50 * 0.50 = 0.75. 

The third action A3 doubles the number of the generated load combinations because the cat-
egory "wind" is available with the two load cases 4 and 5 acting alternatively. This action is 
multiplied with the factor γ * ψ = 1.50 * 0.60 = 0.90 in the load combinations. 

The fourth action A4 is classified as action type "imposed load category B" and provided with 
the factor γ = 1.50 in all four load combinations. This action is a leading action. 

 
Figure 5.25: Actions in action combination AC12 

In addition, we have to take into account the two imperfection load cases 7 and 8 which are 
coupled with the directions of both wind load cases. We want to create load combinations 
once with imperfections and once without. 

With these specifications RFEM forms the following load combinations for AC12: 

• CO40: 1.35*LC1 + 1.35*LC2 + 0.75*LC3 + 0.9*LC4 + 1.5*LC6 

• CO41: 1.35*LC1 + 1.35*LC2 + 0.75*LC3 + 0.9*LC4 + 1.5*LC6 + LC7 

• CO42: 1.35*LC1 + 1.35*LC2 + 0.75*LC3 + 0.9*LC5 + 1.5*LC6 

• CO43: 1.35*LC1 + 1.35*LC2 + 0.75*LC3 + 0.9*LC5 + 1.5*LC6 + LC8 

Click the dialog button [] to jump to dialog the tab Load Combinations where the first com-
bination created from the current action combination is selected. 

Comment 
Enter a user-defined note or select an entry from the list. 
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5.5 Load Combinations 
General description 

Load cases can be superimposed in a load combination (CO) and in a result combination (RC). 

Taking into account partial safety factors, a load combination combines the loads of the con-
tained load cases in "one big load case" that will be calculated. In a result combination (see 
chapter 5.6, page 201) all included load cases are calculated first. Then, results will be super-
imposed, taking into account the partial safety factors. 

Load cases can be combined manually (see chapter 5.5.1) or superimposed automatically by 
RFEM (see chapter 5.5.2), depending on settings in the dialog box Model - General Data (see 
Figure 12.23, page 554). Settings affect also the appearance of the dialog tab Load Combina-
tions in the loading dialog box. 

When you want to calculate combined load cases according to second-order or large defor-
mation analysis, you generally have to create load combinations. The same applies to models 
with nonlinear elements. The following example is used to demonstrate the subject. 

Two load cases act on a slab with elastic foundations. In load case 1, the surface load acts on 
the entire plate. In load case 2, it stresses only one part of the surface. The self-weight is not 
taken into account. The elastic foundation of the slab is ineffective in case of tension. There-
fore, no lifting forces are absorbed. 

 
Figure 5.26: Load and deformation in LC 1 

The foundation in load case 1 is effective for the entire surface. 

 
Figure 5.27: Load and deformation in LC 2 

The foundation in load case 2 is effective only for the right part of the surface. The left part of 
the slab is lifting. 

 

Difference between 

load and result combination 

 
 

Check box in dialog box 
Model - General Data 
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When combining both load cases in a result combination, RFEM will show you a warning be-
cause adding results would be unacceptable due to nonlinear effects: Deformations in both 
load cases are based on different structural systems. For a result combination you would see 
the lifting in the left zone shown in the second case. 

Therefore, it is correct to superimpose the two load cases in a load combination. In the figure 
below, we see that the elastic foundation is effective for the added loads without failure. 

 
Figure 5.28: Load and deformation of the load combination 

5.5.1 User-defined Combinations 

Create a new load combination 
There are several possibilities to open the dialog box Edit Load Cases and Combinations for  
creating a load combination: 

• point to Load Cases and Combinations on the Insert menu, and then select  
Load Combination 

• use the toolbar button [New Load Combination] shown on the left 

 
Figure 5.29: Button New Load Combination in the toolbar 

• context menu of navigator entry Load Combinations 

 
Figure 5.30: Context menu for Load Combinations in the Data navigator 
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The dialog box Edit Load Cases and Combinations appears. A new load combination is preset in 
the dialog tab Load Combinations. 

 
Figure 5.31: Dialog box Edit Load Cases and Combinations, tab Load Combinations 

The following description refers to the tab General. The dialog tab Calculation Parameters is  
described in chapter 7.3.1 on page 263. 

• It is also possible to enter a new load combination in an empty row of table 2.5 Load 
Combinations. 

 
Figure 5.32: Table 2.5 Load Combinations 

Load combination 
The number of the new load combination is preset but can be modified in the dialog input 
field CO No.. The order of load combinations can be adjusted subsequently by means of the 
[Renumber] dialog button (see Table 5.7 and chapter 11.4.18, page 479). 
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Description of load combination 
You can enter any name manually. You can also choose a name from the list to describe the 
load combination shortly. As manually entered descriptions are stored in the list, they are also 
available for other models. 

To solve 
Use the check box to decide if the load combination is considered in the calculation. In this 
way, it is possible to active or exclude load combinations from the calculation. 

Load cases in load combination 
The columns inform you about the load cases together with corresponding factors. 

The values indicated in the table column Factor are based on coefficients depending on the  
selected standard. For EN 1990 they are the partial safety factors γ, the combination factors ψ, 
the reduction factors ξ and, if applicable, the reliability factors KFl of each action resulting from 
design situation and action category. 

To check and adjust the partial safety factors and combination coefficients, use the dialog but-
ton [Combination Coefficients]. The dialog box Coefficients opens where you find various fac-
tors organized in several tabs. The first tab Partial Safety Coefficients for EN 1990 is shown in 
Figure 12.27 on page 556. The tab Combination Coefficients manages the factors ψ and ξ (see 
Figure 5.24, page 191). The reliability factor KFI can be defined in an input field of the dialog tab 
Consequences Class, but you can also enter a user-defined value. 

Combining load cases 

In the dialog box Edit Load Cases and Combinations, you can assimilate load cases in combina-
tions as follows: Select the relevant load cases in the list Existing Load Cases by clicking. You can 
press the [Ctrl] key (as usual in Windows) to apply the multiple selection. Use the button [] to 
transfer selected load cases to the right in the list Load Cases in Load Combination, at the same 
time partial safety factors and combination coefficients are added automatically. 

 
Figure 5.33: Multiple selection of load cases and load combination created according to EN 1990 

The factors are created in accordance with the standard set in the dialog box Model - General 
Data (see chapter 12.2.1, page 556). 

 

 

 

 
 

Standard settings in dialog box 
Model - General Data 
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The preset factors can be checked in the Coefficients dialog box that you open with the button 
[Factors]. Furthermore, you can adjusted them for user-defined standards (see Figure 5.24, 
page 191 and Figure 12.27, page 556). 

To modify the factor of a load case that has been transferred into a load combination, select 
the load case in the list Load Cases in Load Combination. Now, you can enter an appropriate 
factor into the input field below. You can also select the factor from the list. Finally, click the 
button [Set Factor] to apply the new factor to the load case. 

To remove a load case from a load combination, select the load case in the dialog section Load 
Cases in Load Combination. Use the [] button or double-click the entry to return it to the dia-
log section Existing Load Cases. 

Several filter options are available below the list Existing Load Cases. With the help of those op-
tions it is easier to assign load cases sorted by action categories or to select from load cases not 
yet assigned. The buttons are described in Table 5.7 on page 198. 

To define load combinations manually, use the [Edit] button in the bottom right corner of the 
loading dialog box. 

 
Figure 5.34: Dialog box Load Combination for definition via editing field 

A dialog box opens offering the input field Load Cases in Load Combination where load cases 
can be added (or subtracted if necessary) by any factor. However, nesting of input is not per-
mitted. 

Example: LC1 + 0.5*LC3 

  To the simple load of load case 1 half the load of load case 3 is added. 

Use the button [Set Input] to transfer the entry to the list Load Cases in Load Combination of the 
initial dialog box. 

Comment 
Enter a user-defined note or select an entry from the list to describe the load combination in 
detail. 

Calculation parameters 
The tab Calculation Parameters in the loading dialog box offers different options for controlling 
the calculation. Find a detailed description of these parameters in chapter 7.3.1 on page 263. 
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Edit a load combination 
There are several possibilities to change load combinations subsequently: 

• point to Load Cases and Combinations on the Edit menu, and then click  
Load Combinations 

• use the context menu or double-click a load combination in the Data navigator 

 
Figure 5.35: Context menu of a load combination 

In the dialog box Edit Load Cases and Combinations (see Figure 5.31, page 195), select the CO 
by clicking. Then, you can edit the definition criteria. 

Buttons 
In the dialog box Edit Load Cases and Combinations, you see different buttons below the lists 
Existing Load Combinations and Existing Load Cases. The buttons have the following functions: 

 
Creates a new load combination 

 
Creates a new load combination as copy of the selected combination 

 
Assigns a new number to the selected load combination. Specify the number in a 
separate dialog box. It is not allowed to enter a CO number that has already been 
assigned. 

 
Deletes the selected load combination 

 
The list shows only the load cases that are not yet contained in the load combination. 

 
Selects all load cases in the list 

 
Inverts the selection of load cases 

Table 5.7: Buttons in the tab Load Combinations 
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5.5.2 Generated Combinations 
When switching to the dialog tab Load Combinations or to table 2.5, RFEM creates the combi-
nations automatically. As the load cases are not superimposed manually, the General tab looks 
differently (see Figure 5.31, page 195 for user-defined combinations). 

 
Figure 5.36: Dialog box Edit Load Cases and Combinations, tab Load Combinations 

Load combination 
Load combinations generated from action combinations are consecutively numbered. 

You can filter the generated combinations by particular criteria, using the selection field in the 
bottom left corner below the dialog section Existing Load Combinations. 

Description of load combination 
RFEM assigns brief descriptions based on the safety factors and load case numbers, expressing 
combination rules. You can change these descriptions, if necessary. 

Click the dialog button [] to jump back to the dialog tab Action Combinations (see chapter 5.4, 
page 189) where the action combination is selected by which the current load combination has 
been created. 

To solve 
The check box controls the result determination for the selected load combination(s). 

Load cases in load combination 
The columns inform you about the load cases including corresponding partial safety factors and 
combination coefficients. It is not possible to modify the factors of generated combinations. 

If a load case is assumed to be Leading in the combination, it is marked accordingly in the dialog 
box. 
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To check and, if necessary, to adjust the partial safety factors and combination coefficients, use 
the dialog button [Info about Factors]. The dialog box Coefficients is subdivided into several 
tabs (see Figure 12.27, page 556 and Figure 5.24, page 191). 

Add a load combination 
The generated load combinations cannot be edited but only deleted or excluded from the cal-
culation by using the check box To Solve. 

With the [New] button in the left bottom corner below the dialog section Existing Load Combi-
nations you can add a user-defined combination. To enable the manual definition, the dialog 
tab General changes its appearance. 

 
Figure 5.37: Adding a user-defined load combination 

The previous chapter 5.5.1 describes in detail how load combinations can be created manually. 
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5.6 Result Combinations 
General description 

Load cases can be superimposed in a result combination (RC) and in a load combination (CO). 

In a result combination, included load cases are calculated first. Then, the results are super-
imposed, taking into account the partial safety factors. A load combination (see chapter 5.5, 
page 193) combines the loads of contained load cases in "one big load case" first, taking into 
account the partial safety factors. Then, the big case is calculated. 

Load cases can be combined manually (see chapter 5.6.1) or superimposed automatically by 
RFEM (see chapter 5.7), depending on settings in the dialog box Model - General Data (see 
Figure 12.23, page 554). Settings affect also the appearance of the dialog tab Result Combina-
tions in the dialog box Edit Load Cases and Combinations. 

Result combinations are not appropriate for nonlinear calculations because they lead to falsi-
fied results: In most cases, failure of nonlinear elements (for example tension members, foun-
dations) happens unequally in the individual load cases. Redistribution effects occur so that 
the internal forces would be combined from different models (see example in chapter 5.5 on 
page 193). 

In a result combination, you can superimpose the results of load cases and load combinations 
as well as results of other result combinations. 

Usually, the internal forces are summed up. In principle, subtractions are also possible. Please 
note, however, that in this case signs of the internal forces will be reversed: Tensile forces be-
come compressive forces etc. Therefore, as an alternative, it is recommended to copy the load 
case (see chapter 5.1, page 173) and to set the load factor to –1.00 for the load case copy in the 
dialog tab Calculation Parameters. Then, the load case can be added in a result combination. 

5.6.1 User-defined Combinations 

Create a new result combination 

There are several possibilities to open the loading dialog box for creating a result combination: 

• point to Load Cases and Combinations on the Insert menu, and then select  
Result Combination 

• click the button [New Result Combination] in the toolbar 

 
Figure 5.38: Button New Result Combination in the toolbar 

 

Difference between 

result and load combination 

 
 

Check box in dialog box 
Model - General Data 
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• use the context menu of the navigator entry Result Combinations 

 
Figure 5.39: Context menu of Result Combinations in Data navigator 

The dialog box Edit Load Cases and Combinations appears. A new result combination is preset 
in the dialog tab Result Combinations. 

 
Figure 5.40: Dialog box Edit Load Cases and Combinations, tab Result Combinations 

The following description refers to the tab General. The dialog tab Calculation Parameters is  
described in chapter 7.3.2 on page 270. 
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• It is also possible to enter a new result combination in an empty row of table 2.6 Result 
Combinations. 

 
Figure 5.41: Table 2.6 Result Combinations 

Result combination 
The number of the new result combination is preset but can be modified in the dialog input 
field RC No. The order of result combinations can be adjusted also subsequently by means of 
the [Renumber] dialog button (see Table 5.8 and chapter 11.4.18, page 479). 

Description of result combination 
You can enter any name manually. You can also choose a name from the list to describe the  
result combination shortly. As manually entered descriptions are stored in the list, they are also 
available for other models. 

To solve 
Use the check box to decide if the result combination is considered in the calculation. In this 
way, it is possible to reactive or exclude result combinations specifically from the calculation. 

Loading in result combination 
The columns inform you about the load cases, load and result combinations including related 
factors. 

The values indicated in the table column Factor are based amongst others on coefficients that 
depend on the selected standard. For EN 1990 they are the partial safety factors γ, the combi-
nation factors ψ, the reduction factors ξ and, if applicable, the reliability factors KFl of each ac-
tion resulting from design situation and action category. 

To check and adjust the partial safety factors and combination coefficients conforming to 
standards, use the dialog button [Combination Coefficients]. The dialog box Coefficients opens 
where you find various factors organized in several tabs. The tab Partial Safety Coefficients for 
EN 1990 is shown in Figure 12.27 on page 556. The tab Combination Coefficients manages the 
factors ψ and ξ (see Figure 5.24, page 191). The reliability factor KFI can be defined in an input 
field of the dialog tab Consequences Class, but you can also enter a user-defined value. 

Combining loadings 

In the dialog box Edit Load Cases and Combinations, you can superimpose load cases, load and 
result combinations in a combination as follows: Select the relevant entries in the list Existing 
Loading by clicking. You can press the [Ctrl] key (as usual in Windows) to apply the multiple  
selection (see the figure below). Use the dialog buttons [+] and [∞] to transfer the selected 
entries in the list Loading in Result Combination to the right. 
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Figure 5.42: Multiple selection for alternative analysis of two load cases 

The load case factors are applied according to the standard set in the dialog box Model - General 
Data. If required, you can adjust the preset partial safety factors (see chapter 12.2.1, page 556) 
by using the dialog button [Factors]. 

To remove a loading from a result combination, select the relevant entry in the dialog section 
Loading in Result Combination. Use the [] button or double-click the entry to return it to the 
dialog section Existing Loading. 

The load cases, load and result combinations contained in the result combination can be super-
imposed in accordance with their effect: 

• Loading criteria 

Permanent effect 

If you want to apply the loading permanently or unconditionally, the criterion Permanent  
or  /p must be added to the loading. 

Variable effect 

A loading with the criterion Variable is considered in the superposition only if its internal 
forces make an unfavorable contribution to the result. 

• Criteria for superposition 

Additive combination 

The results of loadings are combined additively with the criterion "+". Use the button [+] 
available in the dialog box to transfer the marked load cases, load and result combinations 
to the definition list of the result combination. 

Alternative combination 

For the alternative analysis using the "or" criterion, respectively the abbreviation "o", RFEM 
treats the results of particular loadings as mutually exclusive. RFEM will consider only values 
of the loading making the maximum unfavorable contribution. Use the dialog button [∞] 
to transfer selected loadings to the definition list of the result combination. 

Loadings acting alternatively are marked with the same number in the table column Group. 

The criterion "orto" (or to) combines a list of alternative loadings from the first to the last 
object. Objects lying in between are not listed. 

All loadings listed in the alternative combination group must be marked consistently as 
'Permanent' or 'Variable'. Thus, it is not allowed to enter for example "LC1/p or LC2. 

It is possible to adjust the factors of transferred loadings individually: Select the loading(s) in 
the list Loading in Result Combination, and then enter an appropriate factor into the input field. 
You can also use the list to select a factor. Finally, click the button [Set Factor] to apply the new 
factor to the loading(s). 

 
 

Standard settings in dialog box 
Model - General Data 
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Analogously, you can subsequently change the loading criteria (permanent or variable effect) 
or the group membership of an alternative loading. To assign the new criterion to the selected 
loading, use the dialog button [Set]. 

Several filter options are available below the list Existing Loading. With the help of the options 
it is easier to assign loadings sorted by load cases, load and action combinations as well as  
action categories. In addition, it is possible to restrict the listing to loadings not yet assigned. 
The buttons are described in Table 5.8 on page 206. 

You can define result combinations manually in a separate dialog box. To open it, use the [Edit] 
button in the bottom right corner of the dialog box Edit Load Cases and Combinations. 

 
Figure 5.43: Dialog box Result Combination for definition via string box 

A dialog box opens offering the input field Loading in Result Combination where load cases can 
be added by any factor or combined with the "or" criterion. However, nesting of input is not 
permitted. 

Examples: 

• LC1/p + LC2/p + LC3 

 Load cases 1 and 2 are superimposed as permanent, load case 3 as variable. 

• LC1/p + CO2 + LC3 or LC4 or LC5  (corresponds to LC1/p + CO2 + LC3 orto LC5) 

 Load case 1 is considered as permanent in the superposition, load combination 2 as vari-
able. The most unfavorable case of the load cases 3, 4 or 5 is also superimposed with the 
'variable' criterion (that means only one of them is effective - if it increases the result val-
ues). 

• 1.2*CO1/p + 0.2*RC1 or -0.2*RC1 

 The 1.2-fold of load combination 1 is superimposed as permanent with the most unfavor-
able contribution of the positive or negative 0.2-fold result combination 1. 

• RC1/p o RC2/p o RC3/p o RC4/p  (corresponds to  RC1/p orto RC4/p) 

 Result combinations 1 to 4 are compared among each other as permanent acting. The 
enveloping is determined as the most unfavorable result. 

Use the [Set] button to transfer the entry to the list Loading in Result Combination of the initial 
dialog box. 
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Comment 
Enter a user-defined note or select an entry from the list to describe the result combination in 
detail. 

Calculation parameters 
The tab Calculation Parameters in the loading dialog box offers different options for controlling 
the calculation. Find a detailed description of these parameters in chapter 7.3.1 on page 263. 

Edit a result combination 
There are several possibilities to change result combinations subsequently: 

• point to Load Cases and Combinations on the Edit menu, and then click Result Com-
binations 

• use the context menu or double-click a result combination in the Data navigator 

 
Figure 5.44: Context menu of a result combination 

In the dialog box Edit Load Cases and Combinations (see Figure 5.40, page 202), select the RC by 
clicking. Then, you can edit the definition criteria. 

Buttons 
In the dialog box Edit Load Cases and Combinations, several buttons are available below the lists 
Existing Result Combinations and Existing Loading. The buttons have the following functions: 

 
Creates a new result combination 

 
Creates a new result combination as copy of the selected combination 

 
Assigns a new number to the selected result combination. Specify the number in a 
separate dialog box. It is not allowed to enter a RC number that has already been 
assigned. 

 
Deletes the selected result combination 

 
The list shows only load cases not contained in the result combination. 

 
Selects all load cases in the list 

 
Inverts the selection of load cases 

Table 5.8: Buttons in the tab Result Combinations 
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5.6.2 Generated Combinations 
When switching to the dialog tab Result Combinations or to table 2.6, RFEM creates the combi-
nations automatically. As the load cases are not superimposed manually, the General tab looks 
differently (se Figure 5.40, page 202 for user-defined combinations). 

 
Figure 5.45: Dialog box Edit Load Cases and Combinations, tab Result Combinations 

Result combination 
The result combinations generated from action combinations are consecutively numbered. 

You can filter the generated combinations by different criteria, using the selection field in the 
left dialog corner below the dialog section Existing Result Combinations. 

Description of result combination 
RFEM assigns brief descriptions based on the safety factors and load case numbers, expressing 
combination rules. You can change these descriptions, if necessary. 

Click the dialog button [] to jump back to the dialog tab Action Combinations (see chapter 5.4, 
page 189) where the action combination is selected by which the current result combination 
has been created. 

To solve 
The check box controls the result determination for the result combination(s) selected to the 
left. 
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Load cases in result combination 
The columns inform you about the load cases including corresponding partial safety factors 
and combination coefficients. It is not possible to modify the factors of generated combina-
tions. 

If a load case is assumed to be Leading in the combination, it is marked accordingly in the  
dialog box. 

To check and, if necessary, to adjust the partial safety factors and combination coefficients,  
use the dialog button [Combination Coefficients]. The dialog box Coefficients is subdivided  
into several tabs (see Figure 12.27, page 556 and Figure 5.24, page 191). 

Add a result combination 
The generated result combinations cannot be edited but only deleted or excluded from the 
calculation by using the check box To Solve. 

With the [New] button in the left bottom corner below the dialog section Existing Result Com-
binations you can add a user-defined combination. To enable the manual definition, the dialog 
tab General changes its appearance. 

 
Figure 5.46: Adding a user-defined result combination 

The previous chapter 5.6.1 describes in detail how result combinations can be created manually. 
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5.7 Combination Scheme 
Load case constellations can be saved as combination schemes and reused for similar applica-
tions. To open the corresponding dialog box, 

select Combination Scheme on the Tools menu. 

 
Figure 5.47: Dialog box Combination Schema 

In the dialog section Description, you can select a combination scheme from the list. You can 
also use the [New] button to create a new scheme. 

When load cases have already been defined in the model, they are entered in the dialog sec-
tion Load Cases. Load cases can be added by confirming the last row of the list with the [Enter] 
or [Tab] key. In the dialog column LC Description, you can select predefined descriptions from a 
list. 

The dialog sections Load Combinations and Result Combinations manage the conditions of su-
perpositioning for load combinations (see chapter 5.5) and result combinations (see chapter 
5.6). 

To save the combination scheme, click the [Save] button shown on the left. Confirm the dialog 
box with the [OK] button so that RFEM can create the load cases, load and result combinations. 

Do not forget to enter the loading: The combination scheme generates only a frame of load 
cases, loads and result combinations! 

For models based on the same load scheme you can generate all load cases, load and result 
combinations without entering any more data. Open the scheme dialog box, select the com-
bination scheme from the Description list and import it by clicking [OK].
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6.  Loads 
RFEM offers different possibilities to enter loads: You can define loads in a dialog box, a table 
and often directly in the graphic. 

Open the input dialog box 
You can access the input dialog boxes and the graphical input in different ways. 

Menu Insert 

 

Figure 6.1: Menu Insert → Loads 

Toolbar Insert 

 
Figure 6.2: Toolbar Insert 

Context menu in Data navigator 

 
Figure 6.3: Context menu of load objects in the Data navigator 
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Context menu or double-click in table 

 
Figure 6.4: Context menu in load tables 

The input dialog box can be accessed by means of the context menu (or by double-click) of the 
row number. 

Open the edit dialog box 
RFEM provides different possibilities to open a dialog box for editing a load object. 

Menu Edit 

 

Figure 6.5: Menu Edit → Loads 

The menu option Dialog Box can be accessed only when the load object has been selected  
before. 
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Context menu or double-click in graphic 

 
Figure 6.6: Context menu of a load in work window 

Context menu or double-click in Data navigator 

 
Figure 6.7: Context menu of load objects in the Data navigator 

Context menu or double-click in table 

 
Figure 6.8: Context menu in load tables 

The edit dialog box can be accessed by means of the context menu (or by double-click) of the 
row number. 
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Table input 
Input and modifications carried out in the graphical user interface are immediately shown in 
the tables and vice versa. To access the load tables, use the third button from the left available 
in the table toolbar. 

 
Figure 6.9: Button [Table 3. Loads] 

Input in the form of spreadsheet data entered in tables can be quickly edited and imported 
(see chapter 11.5, page 480). 

In each dialog box and table, it is possible to add a Comment specifying the load. You can also 
use predefined comments (see chapter 11.1.4, page 421). 

To control whether loads are either listed row by row or summarized in the current table, re-
spectively in all tables, select Optimize Load Data on the Table menu. You can also use the 
buttons in the table toolbar shown on the left to activate the settings. You find the buttons to 
the right of the load case list. 
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6.1 Nodal Loads 
General description 

Nodal loads are forces and moments that act on nodes (see chapter 4.1, page 43). 

To apply a nodal load, a node must have been previously defined. 

 
Figure 6.10: Dialog box New Nodal Load 

 
Figure 6.11: Table 3.1 Nodal Loads 

The number of the nodal load is assigned automatically in the dialog box New Nodal Load but 
can be changed in the input field. The numbering order is not important. 

On nodes 
In this input field, define the numbers of the nodes on which the load is acting. In the dialog 
box New Nodal Load, you can select nodes also graphically by using the [] function. 

When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter load data first. After clicking [OK] you can select the relevant 
nodes one after the other in the work window. 

Force PX / PY / PZ 
Nodal forces represent vectors referring to the global coordinate system. If a force does not act 
parallel to one of the global axes, its components X, Y and Z must be determined and entered 
in the corresponding input fields. 

When the model type has been restricted to a planar system in the General Data dialog box, 
you cannot access all three input fields or table columns. 
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Moment MX / MY / MZ 
Nodal moments refer to the global coordinate system X,Y,Z as well. Therefore, a moment act-
ing in a sloping way must be split in its X, Y and Z-components which can then be entered in 
the respective input fields. 

A positive moment acts clockwise about the corresponding positive global axis. Input is made 
clearer by the global axes of coordinates represented in the RFEM graphic. 

In addition to vectors, moments can be represented as arcs. To control the display properties 
(see chapter 11.1.2, page 417), 

point to Display Properties on the Options menu, and select Edit. 

The dialog box Display Properties opens where you set the Category Loads → Nodal Loads → 
Nodal Moments. Then, the display option Arc is available for selection in the tab to the right. 

 

Figure 6.12: Dialog box Display Properties (dialog section): Nodal Moments with display option Arc 

It is also possible to import nodal loads from Excel spreadsheets (see chapter 12.5.2, page 569). 

Often, nodal loads result in singularities because the load is concentrated when introduced in a 
single FE node. To reduce this effect, select Convert Nodal/Line Load to Surface Load on the 
Tools menu. You can also use the context menu of a nodal load shown on the left to access the 
dialog box for converting nodal loads. Open the context menu by a right-click on the object. 

A dialog box opens (see Figure 6.13) where you define the parameters for distributing the 
load. After clicking [OK] the corresponding free rectangular or circular load will be created. 

 

 

 

Context menu of nodal load 
 



6  Loads 

 

 

216 Program RFEM © 2013 Dlubal Software GmbH 

 
Figure 6.13: Dialog box Convert Nodal Load to Surface Load 

6.2 Member Loads 
General description 
Member loads are forces, moments, temperature actions or imposed deformations that act on 
members. 

To apply a member load, a member must have been previously defined. 

 
Figure 6.14: Dialog box New Member Load 
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Figure 6.15: Table 3.2 Member Loads 

The number of the member load is assigned automatically in the dialog box New Member Load 
but can be changed in the input field. The numbering order is not important. 

Reference to 
Define the model elements to which you want to apply the member load. The following options 
can be selected: 

Members 

The load acts on one single member or on each member of several members. 

List of members 

The load acts on the union of members that are defined in the list. Thus, when trapezoidal 
member loads are used, load parameters are not applied to each member individually but as 
total load to all members of the member list. The load effects of a trapezoidal member load on 
single members in contrast to a member list are shown in Figure 6.16. 

Take advantage of a member list to apply loads over all members without defining continuous 
members. Moreover, it is possible to change the load reference to individual members quickly. 

Sets of members 

The load acts on a set of members or on each set of several sets of members. Similar to the 
member list described above, load parameters are applied to the union of members included 
in the member set. 

Sets of members are subdivided into continuous members and groups of members (see chap-
ter 4.21, page 158). Loads on sets of members can be applied to continuous members without 
problems. Member groups, however, need to be handled with care: The reference to a mem-
ber group is usually problematic for trapezoidal loads. 

 

Figure 6.16: Trapezoidal load with reference to members (left) and to a list of members (right) 
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On members 
In the input field, enter the numbers of the members or sets of members on which the load is 
acting. In the dialog box, you can select nodes also graphically by using the [] function. 

When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter load data first. After clicking [OK] you can select the relevant 
members or sets of members one after the other in the work window. 

For trapezoidal or variable loads with load reference to a member list, you can adjust the 
member numbers by using the button [Reverse Orientation of Members] shown on the left. 

Load type 
In this dialog section you define the load type. Depending on your selection, certain parts of 
the dialog box, respectively columns of the table, are disabled. The following load types can be 
selected:  

Load type Short description 

Force Concentrated load, distributed load or trapezoidal load 

Moment Concentrated moment, distributed moment or trapezoidal moment 

Temperature Temperature load uniformly distributed over member cross-section, 
or temperature difference between top and bottom side of member 

Load applied as uniform or trapezoidal over member length or as 
trapezoidal over cross-section. A positive load value means that the 
member or the upper side is heating. 

Axial strain Imposed tensile or compressive strain ε of member 

A positive load value means that the member is extended. Thus, a 
prestress as member contraction must be entered negatively. 

Use the dialog button shown on the left to determine the strain due 
to shrinkage from the parameters for contraction and drying shrink-
age (see Figure 6.24 with description on page 228). 

Axial displacement Imposed tensile or compressive strain ∆l of member 

Precamber Imposed curvature of member 

Initial prestress Prestressing force acting on member before calculation 

A positive load value means that the member is extended. 

End prestress Axial force to be available on member after calculation (not possible 
for rigid members and cables) 

A positive load value means that the member is extended. 

Displacement Displacement about quantity Δ for determination of influence lines 

Rotation Rotation about angle φ for influence lines 

Pipe content - full Uniform load due to complete filling of pipe 

Specify weight density γ of pipe content. 

Pipe content - partial Uniform load due to partial filling of pipe 

In addition to weight density γ of pipe content, specify filling height d. 

Rotary motion Centrifugal force from mass and angular velocity ω on member 

The rotation axis can be defined in a separate dialog box that you 
open with the [Edit] button. 

Table 6.1: Load types 
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The graphic in the right corner of the dialog box shows the selected load type including influ-
ence of signs set for forces and strains. 

Load distribution 
The dialog section Load Distribution offers different options to represent the effect of the load. 
The dialog graphic in the top right corner may help you to understand. 

Distribution Diagram Description 

Concentrated P 

 

Concentrated load, concentrated moment 

In the dialog section Load Parameters, specify 
the size of the concentrated load or moment 
and the distance of the point of load applica-
tion in relation to the member start. 

Concentrated n 
x P 

 

Multiple concentrated loads or moments 

The list offers several arrangement options  
for load pairs or multiple concentrated loads 
such as axle loads. 

The option shown on the left is appropriate 
for single forces that are equal in size and 
acting in a uniform spacing. In the dialog  
section Load Parameters, define the size of the 
concentrated load, the distance between first 
load and member start, and the spacing of 
loads among each other. 

Uniform 

 

Uniformly distributed load, uniformly distrib-
uted moment 

In the dialog section Load Parameters, specify 
the size of the uniform member load or mo-
ment.  

Trapezoidal 

 

Trapezoidal load, trapezoidal moment 

In the dialog section Load Parameters, define 
both load values and distances for a linearly 
variable load distribution as shown in the dia-
log graphic. A triangular load is created by 
setting one load value to zero. 

When the check box Relative distance in % is 
ticked, you can specify the distances relatively 
to the member length. 

Varying 

 

Polygonally distributed load 

Clicking the button [Edit Varying Load] shown 
on the left opens the dialog box shown in 
Figure 6.17 where you can enter or import the 
parameters of the load distribution. 

Table 6.2: Load distributions 

 

 

Multiple loads 
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Figure 6.17: Dialog box Edit Varying Load 

If you want to represent a variable load, you can freely define the x-locations on the member 
with the corresponding load ordinates p. You only have to make sure that the x-locations are 
defined in an ascending order. Use the interactive graphic to check your input immediately. 

The buttons in this dialog box have the following functions: 

Button Function 

 Table export to MS Excel 

 Table import from MS Excel 

 Inserts a blank line above pointer 

 Deletes active row 

 Deletes all entries 

Table 6.3: Buttons of the dialog box Edit Varying Load 

Load direction 
The load can be effective in direction of the global axes X, Y, Z or the local member axes x, y, z 
or u, v (see chapter 4.13, page 120). For the calculation according to linear static analysis it 
does not matter whether a load is defined as local or equivalent global. For geometrically non-
linear calculations, however, differences between locally and globally defined loads are possi-
ble: If the load is defined with a global direction of action, it keeps this direction when finite  
elements start to twist. In case of a local direction of action, however, the load twists on the 
member according to the distortion of elements. 

When the model type has been reduced to a planar system in the General Data dialog box, you 
cannot access all load directions. 

Local 

The orientation of member axes is described in chapter 4.17, paragraph Member rotation on 
page 145. The local axis x represents the longitudinal axis of the member. Axis y represents for 
symmetrical sections the so-called 'strong' axis, axis z accordingly the 'weak' axis of the member 
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cross-section. In case of unsymmetrical sections, loads can be related to the principal axes u 
and v as well as the standard input axes y and z. 

Examples for loads defined as local are wind loads acting on roof structures, temperature loads 
or prestresses. 

Global 

The position of the local member axes is irrelevant for the load input if the load acts in direc-
tion of an axis of the global coordinate system XYZ. 

Examples for loads defined as global are snow loads acting on roof constructions and wind 
loads on wall and gable columns. 

The load impact can be related to different reference lengths: 

• related to true member length 

The load is applied to the entire member length. 

• related to projected member length in X / Y / Z 

The application length of the load is converted to the projection of the member in one of 
the directions of the global coordinate systems. Select this option to define for example a 
snow load on the projected ground-plan area of a roof. 

RFEM applies member loads always in the shear center. An intended torsion originating from 
the cross-sectional geometry (centroid unequal shear center) is not considered. Therefore, 
when unsymmetrical cross-sections are used, a torsion moment determined from load x dis-
tance to the shear center must be applied additionally if loading is introduced for example in 
the centroid. 

Member load parameters 
In this dialog section, respectively table columns, the load values and, if applicable, additional 
parameters are managed. The input fields are labeled and accessible depending on the selec-
tion fields previously activated. 

Load p1 / p2 

Enter load values into the fields. Adjust the signs to the global or local orientations of axes.  
A positive load value for prestresses, temperature changes and axial strains means that the 
member is strained and consequently extended. 

When a trapezoidal load is selected, specify two load values. The dialog graphic in the upper 
right corner shows the load parameters. 

Distance A / B 

In these two fields, enter the distances from the member start for concentrated and trapezoi-
dal loads. It is also possible to define the distances also relative to the member length by tick-
ing the check box Relative distance in % (see below). 

The dialog graphic in the upper right corner helps you when entering parameters. 

Relative distance in % 
Tick this check box if you want to define the distances for concentrated and trapezoidal loads 
relative to the member length. Otherwise, the entries in the input fields for Distance A / B de-
scribed above represent absolute ranges. 

Load over total length of member 
The check box can only be activated for trapezoidal loads. Select this option to arrange the 
application of the linearly variable load from the member start to the member end. The input 
fields Load Parameters A / B are no longer relevant and therefore disabled. 
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Example for member loads 
The input of member loads is shown in the example below where member loads are applied to 
a planar frame structure. It is not necessary to divide members by intermediate nodes to apply 
concentrated loads. 

 
Figure 6.18: Framework with uniform load on upper chord and concentrated loads on diagonals 
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6.3 Line Loads 
General description 

Line loads are forces and moments that act on lines (see chapter 4.2, page 49). 

To apply a line load, a line must have been previously defined. 

Line loads are similar to member loads. For line loads, however, it is not possible to allocate 
material properties (for example temperature loads or axial strains). 

Line loads can act on members because a member is a property of a line. However, to apply a 
line load to a member, the line must belong to a surface. Consequently, line loads cannot be 
applied to members built in models consisting only of members. 

 
Figure 6.19: Dialog box New Line Load 

 
Figure 6.20: Table 3.3 Line Loads 

The number of the line load is assigned automatically in the dialog box New Line Load but can 
be changed in the input field. The numbering order is not important. 

 

 



6  Loads 

 

 

224 Program RFEM © 2013 Dlubal Software GmbH 

Reference to 
Define the objects to which you want to apply the line load. The following options can be  
selected: 

Lines 

The load acts on one single line or on each line of several lines. 

List of lines 

The load acts on the union of lines that are defined in the list. Thus, when trapezoidal line loads 
are used, load parameters are not applied to each line individually but as total load to all lines 
of the line list (cf. Figure 6.16 on page 217). 

On lines 
In the input field, enter the numbers of the lines on which the load is acting. In the dialog box, 
you can select nodes also graphically by using the [] function. 

When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter load data first. After clicking [OK] you can select the relevant 
lines one after the other in the work window. 

Load type 
In this dialog section or table column, you define the type of load. Depending on your selec-
tion, certain parts of the dialog box, respectively columns of the table, are disabled. The follow-
ing load types can be selected:  

Load type Short description 

Force Concentrated, distributed, trapezoidal or variable load 

Moment Concentrated moment, distributed moment or trapezoidal moment 

Table 6.4: Load types 

Load distribution 
The dialog section Load Distribution offers different options to represent the effect of the load. 
The graphic in the dialog corner may help you to understand. 

Load distribution Short description 

Concentrated Concentrated load, concentrated moment 

Uniform Uniformly distributed load, uniformly distributed moment 

Trapezoidal Trapezoidal load, trapezoidal moment 

Varying Polygonally distributed load 

Click the button [Edit Varying Load] shown on the left to open the 
dialog box shown in Figure 6.17 on page 220 where you can enter  
the parameters of the load diagram. 

Table 6.5: Load distributions 

The load distributions of line loads largely correspond to the ones of member loads. The dia-
grams are described in detail in Table 6.2 on page 219. 
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Load direction 
The load can be effective in direction of the global axes X, Y, Z or the local line axes x, y, z. For 
the calculation according to linear static analysis it does not matter whether a load is defined 
as local or equivalent global. For geometrically nonlinear calculations, however, differences 
between locally and globally defined loads are possible: If the load is defined with a global di-
rection of action, it keeps this direction when finite elements start to twist. In case of a local di-
rection of action, however, the load twists on the line according to the distortion of elements. 

Local 
The orientation of line axes is illustrated in Figure 4.96 on page 101. The local axis x represents 
the longitudinal axis of the line. Axis z is usually aligned parallel to the global axis Z. 

Global 
The position of the local line axes is irrelevant for the load input if the load acts in direction of 
an axis of the global coordinate system XYZ. 

The load impact can be related to different reference lengths: 

• related to true line length 

The load is applied to the entire line length. 

• related to projected line length 

The application length of the load is converted to the projection of the line in one of the 
directions of the global coordinate systems. The projection lengths are shown in the dia-
log graphic to the right. 

Line load parameters 
In this dialog section, respectively table columns, the load values and, if applicable, additional 
parameters are managed. The input fields are labeled and accessible depending on the selec-
tion fields previously activated. 

Load P / p / p2 / M / m /m2 

Enter load values into the fields. Adjust the signs to the global or local orientations of axes. 
When a trapezoidal load is selected, specify two load values. The dialog graphic in the upper 
right corner shows the load parameters. 

Distance A / B 
In these two fields, enter the distances from the line start for concentrated and trapezoidal 
loads. You can define them also relatively to the line length by ticking the check box Relative 
distance in % (see below). 

The dialog graphic in the upper right corner helps you when entering parameters. 

Relative distance in % 
Tick this check box to define the distances for concentrated and trapezoidal loads relative to 
the line length. Otherwise, the entries in the input fields for Distance A / B described above  
represent absolute ranges. 

Load over total length of line 
The check box can only be activated for trapezoidal loads. Select this option to arrange the 
application of the linearly variable load from the line start to the line end. The input fields  
Load Parameters A / B are no longer relevant and become unavailable. 
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Often, line loads result in singularities because the load is concentrated when introduced in a 
single line. To reduce this effect, select Convert Nodal/Line Load to Surface Load on the 
Tools menu. The option can be used for straight lines. You can also use the context menu of a 
line load shown on the left to access the dialog box for converting line loads. Open the context 
menu by a right-click on the object. 

 
Figure 6.21: Dialog box Convert Line Load to Surface Load 

A dialog box opens where you define the parameters for distributing the load. After clicking 
[OK], the corresponding free rectangular or polygonal load will be created. 

 

Context menu of line load 
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6.4 Surface Loads 
General description 

Surface loads act on all 2D elements of a surface (see chapter 4.4, page 74). 

To apply a surface load, a surface must have been previously defined. 

If a surface is subdivided into surface components because of an intersection (see chapter 4.22, 
page 162), the surface load is not effective on components that are set inactive. Openings are 
omitted as well. 

 
Figure 6.22: Dialog box New Surface Load 

 
Figure 6.23: Table 3.4 Surface Loads 

The number of the surface load is assigned automatically in the dialog box New Surface Load 
but can be changed in the input field. The numbering order is not important. 

On surfaces 
In this input field, define the numbers of the surfaces on which the load is acting. In the dialog 
box New Surface Load, you can select surfaces also graphically by using the [] function. 
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When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter load data first. After clicking [OK] you can select the relevant 
surfaces one after the other in the work window. 

Load type 
In this dialog section or table column, you define the type of load. Depending on your selection, 
certain parts of the dialog box respectively columns of the table are disabled. The following load 
types can be selected:  

Load type Short description 

Force Uniformly distributed or linearly variable force on surface 

Temperature Temperature load distributed as uniform or linearly variable over thick-
ness of surface 

A positive load value means that the surface or its upper side is heating. 

Axial strain Imposed tensile or compressive strain ε of surface 

A positive load value means that the surface is extended. 

To determine the shrinkage strain, use the button shown on the left.  
The dialog box shown in Figure 6.24 opens where you can enter the 
parameters for shrinkage. 

Precamber Imposed curvature of surface 

Rotary motion Centrifugal force from mass and angular velocity ω on surface. 

The rotation axis can be defined in a separate dialog box that you open 
with the [Edit] button. 

Table 6.6: Load types 

The parameters for surface and member loads due to shrinkage can be defined in a separate 
dialog box. 

 
Figure 6.24: Dialog box Generate Surface Load Due to Shrinkage 
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Shrinkage as a time-dependent change in volume without external load action or effects of 
temperature can be classified in drying shrinkage, autogenous shrinkage, plastic shrinkage 
and carbonation shrinkage. 

On the basis of the essential influencing variables in the shrinkage process (relative humidity RH, 
effective structural thickness h, concrete strength fcm, type of cement ZType, age of concrete at be-
ginning of shrinkage ts) you determine the shrinkage εcs(t,ts) at the moment of the considered 
concrete age t. 

Click [OK] to transfer the value as axial strain ε to the dialog box New Surface Load. 

Load distribution 
The load can act on the surface as Uniform or Linear variable. 

RFEM provides several options for linearly variable loads: 

Linear 

Define load values for three nodes. The nodes are used to define a plane. 

 
Figure 6.25: Linearly variable surface load 

Linear in X / Y / Z 

If the surface load is variable in direction of an axis of the global coordinate system, load values 
of only two nodes are required. They may lie outside of the stressed surface provided that FE 
nodes are generated there (nodes are not allowed to be free). 

 
Figure 6.26: Surface load that is linearly variable in direction Z 
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Load direction 
The load can be effective in direction of the local surface axes x, y, z or the global axes X, Y, Z. 

Local related to true area 

Loads acting perpendicular to the surface are usually defined as local in direction z. Examples 
of application are wind loads acting on roof surfaces or internal pressure on tank shells. 

To display the surface axes, click Model in the Display navigator, select Surfaces and tick the 
check box for Surface Axis Systems x,y,z. You can also use the context menu of the surface 
(see Figure 4.115, page 116). 

Global related to true area 

The orientation of the local surface axes is irrelevant for the calculation according to linear stat-
ic analysis if the load acts in direction of an axis of the global coordinate system XYZ. For non-
linear calculations, however, differences between locally and globally defined loads are possi-
ble: If the load is defined with a global direction of action, it keeps this direction when finite  
elements start to twist. In case of a local direction of action, however, the load twists according 
to the distortion of elements. 

Global related to projected area 

The load is converted to the projection of the surface in one of the directions of the global  
coordinate systems. Select this option to define for example a snow load on the projected 
ground-plan area of a roof. 

The dialog graphic in the lower right corner shows the projected surfaces. 

Surface load parameters 
In this dialog section or table columns, the load values and, if applicable, the assigned nodes 
are managed. The input fields are labeled and accessible depending on the selection fields 
previously activated. 

Load p / p2 / p3 / T / ∆ T / ε / R / ω / α 

Enter load values into the fields. Adjust the signs to the global or local orientations of axes. 

When a linearly variable load is selected, specify several load values. The dialog graphic in the 
upper right corner shows the load parameters. 

Nodes 

When a linearly variable load is selected, specify three nodes on which the load magnitudes 
can be determined. The nodes are used to define a plane. In the dialog box, you can select the 
nodes also graphically by using the [] function. 

Load of multilayer structure 

It is possible to create loads from area weights of materials acting as laminated layers. In this 
way, you can easily determine for example the structure of floorings or floor coverings. 

Find the function in the dialog box New Surface Load (Figure 6.22) for access use the button 
[] to the right of the input field Magnitude). In the context menu, select Multilayer Structure. 

The Multilayer Library opens where you can enter user-defined material layers. 
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Figure 6.27: Dialog box Multilayer Library 

The concept of the multilayer database is similar to the material library (see chapter 4.3, page 
71). Use the library buttons [New] and [Edit] to create or modify multi-layer structures. 

 
Figure 6.28: Dialog box New Multilayer, dialog section Layers 

The Layers can be composed individually. Moreover, you can use the button [...] to access the 
material library (see chapter 4.3, page 71). 

RFEM determines the area weight (table column D) from Thickness and Specific Weight. An arrow 
shown in the dialog graphic indicates the current layer. 

Confirm all dialog boxes with [OK] to import the area weight into the initial dialog box. A green 
triangle appears in the input field (see graphic shown on the left on page 230), indicating the 
parameterized input value. Click the triangle to access again the input parameters for modifi-
cations. 
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6.5 Solid Loads 
General description 

Solid loads act on all 3D elements of a solid (see chapter 4.5, page 85). 

To apply a solid load, a solid must have been previously defined. 

 
Figure 6.29: Dialog box New Solid Load 

 
Figure 6.30: Table 3.5 Solid Loads 

The number of the solid load is assigned automatically in the dialog box New Solid Load but 
can be changed in the input field. 

On solids 
In the input field, enter the numbers of the solids on which the load is acting. In the dialog box 
New Solid Load, you can select solids also graphically by using the [] function. 

When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter load data first. After clicking [OK] you can select the relevant 
solids one after the other in the work window. 
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Load type 
In this dialog section or table column, you define the type of load. The following load types can 
be selected: 

Load type Short description 

Force Solid load acting uniformly in one of global directions 

Temperature Uniformly distributed or linearly variable temperature change in solid. 

A positive load value signifies a heating. 

Strain Imposed tensile or compressive strain of solid that is uniformly distributed 
or linearly variable. 

 A positive load value means that the solid is extended. 

Buoyancy Weight of pushed away material whose density can be entered or selected 
in a [Library]. 

The Environment Density of Air refers to a standard atmosphere of 15°C on 
sea level. 

Rotary motion Centrifugal force from mass and angular velocity ω on solid. 

The rotation axis can be defined in a separate dialog box that you open 
with the [Edit] button. 

Table 6.7: Load types 

More forces can be applied on a solid in the form of surface or line loads. 

Load distribution 
The load can act on the solid as Uniform or Linear variable. It refers to one of the global axis X, Y 
or Z. 

When linearly variable loads are selected, specify the load values of two nodes. Nodes are al-
lowed to lie outside of the stressed solid provided that FE nodes are generated there. 

Load magnitude 
In this dialog section or table columns, the load values and, if applicable, the assigned nodes 
are managed. The input fields are labeled and accessible depending on the selection fields 
previously activated. 

Nodes 

When linearly variable loads are selected, specify two nodes on which RFEM can determine the 
magnitudes. The nodes are used to define a plane. In the dialog box, you can select nodes also 
graphically by using the [] function. 

Magnitude 

For a uniform load distribution, only one numerical value is required. For a linearly variable 
change in temperature or axial strain, specify two load values. 

The graphics in the dialog box New Solid Load are useful when entering load parameters. 
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6.6 Free Concentrated Loads 
General description 

A free concentrated load acts as force or moment on any location of the surface. No FE nodes 
will be generated on the point of load application. 

To apply a free concentrated load, a surface must have been previously defined. 

Nodal support forces that have been imported from another model by using the function  
Import Support Reactions as Load (see Figure 8.14, page 289) are handled as free concentrated 
loads. 

 
Figure 6.31: Dialog box New Free Concentrated Load 

 
Figure 6.32: Table 3.6 Free Concentrated Loads 

On surfaces 
In the input field, enter the numbers of the surfaces on which the load is acting. In the dialog 
box New Free Concentrated Load, you can select surfaces also graphically by using the [] func-
tion. 

Starting from the defined Load Position, an imaginary straight line is "set" perpendicular to the 
projection plane. When the line intersects any of the listed surfaces, the concentrated load is 
applied to the point of intersection. In this way, it is possible to allocate quickly loads of similar 
type to several surfaces. 
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Projection plane 
The load can be projected on one of the global planes XY, YZ or XZ. As described above, an 
imaginary line is generated, starting from the load position and running perpendicular to the 
projection plane. The load is applied wherever the line intersects a surface. 

The projection plane must not be perpendicular to a surface on which the load is acting: There 
is no clear intersection point with the surface. 

 
Figure 6.33: Free concentrated load acting on ceiling: load projection plane XY with impact on ceiling slab and floor slab 

Load type 
Specify whether a single force or concentrated moment is applied. In the dialog input field  
below, you can enter a numerical value of the load. 

Load direction 
The load can act in direction of the global axes X, Y, Z or the local surface axes x, y, z. To display 
the axes, use the context menu (see Figure 4.115, page 116) or the Display navigator where 
you select Model → Surfaces → Surface Axis Systems x,y,z. 

Load position 
Enter the coordinates of the load position into the input fields. In the dialog box, you can select 
the position of the load also graphically by using the [] function. 

Magnitude 
In the table column respectively input field, enter the numerical value of the concentrated 
force or moment. 
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6.7 Free Line Loads 
General description 
A free line load acts as a uniform or linearly variable force along a freely definable line of a sur-
face. No FE nodes will be generated along this line. 

To apply a free line load, a surface must have been previously defined. 

Line support forces that have been imported from another model by using the function Import 
Support Reactions as Load (see Figure 8.14, page 289) are handled as free line loads. 

 
Figure 6.34: Dialog box New Free Line Load 

 
Figure 6.35: Table 3.7 Free Line Loads 

On surfaces 
This input field manages the numbers of surfaces on which the load is acting. In the dialog box 
New Free Line Load, you can select surfaces also graphically by using the [] function. 

Starting from both points defined by the Load Position, two imaginary straight lines are "set" 
perpendicular to the projection plane. When the lines intersect any of the listed surfaces, the 
load is applied to the connecting line of both intersection points. In this way, it is possible to  
allocate quickly loads of similar type to several surfaces. 
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Projection plane 
The load can be projected on one of the global planes XY, YZ or XZ. As described above, two 
imaginary lines are generated, starting from both load positions and running perpendicular to 
the projection plane. The start and end points of the free line load are assumed wherever the 
lines intersect a surface. 

The projection plane must not be perpendicular to a surface on which the load is acting: There 
are no clear intersection points with the surface. 

Load distribution 
Specify whether a uniform or linearly variable force is applied. In the dialog input field below, 
you can enter one or two numerical values. 

Load direction 
The load can act in direction of the local surface axes x, y, z or the global axes X, Y, Z. Loads act-
ing perpendicular to the surface are generally to be defined as local in direction z. 

If a globally acting load is not running perpendicular to the line, the load impact can be related 
to different reference lengths: 

• related to true line length 

The load is applied to the entire line length. 

• related to projected line length 

The application length of the load is converted to the projection of the line in one of the 
directions of the global coordinate systems. The projection lengths are shown in the dia-
log graphic in the lower right corner. 

Load position 
Enter the coordinates of the load position into the input fields. In the dialog box, you can  
select the position of the load also graphically by using the [] function. 

Magnitude 
In the table column respectively input field, enter the numerical value of the line load. 

 

 

  



6  Loads 

 

 

238 Program RFEM © 2013 Dlubal Software GmbH 

6.8 Free Rectangular Loads 
General description 
A free rectangular load acts as a uniform or linearly variable surface load on a rectangular, 
freely definable zone of a surface. 

 
Figure 6.36: Dialog box New Free Rectangular Load 

 
Figure 6.37: Table 3.8 Free Rectangular Loads 

On surfaces 
This input field manages the numbers of surfaces on which the load is acting. In the dialog box 
New Free Rectangular Load, you can select surfaces also graphically by using the [] function. 

Starting from both points defined by the Load Position, two imaginary straight lines are "set" 
perpendicular to the projection plane. When the lines intersect any of the listed surfaces, the 
load is applied to the connecting diagonal of both intersection points. In this way, it is possible 
to allocate quickly loads of similar type to several surfaces. 
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Projection plane 
The load can be projected on one of the global planes XY, YZ or XZ. As described above, two 
imaginary lines are generated, starting from both load positions and running perpendicular to 
the projection plane. The start and end points of the rectangle's diagonal are assumed wher-
ever the lines intersect a surface. 

The projection plane must not be perpendicular to a surface on which the load is acting: There 
are no clear intersection points with the surface. 

Load distribution 
Specify whether a uniform or linearly variable load is applied. In the dialog input field below, 
you can enter one or two numerical values. 

Load direction 
The load can act in direction of the global axes X, Y, Z or the local surface axes x, y, z. 

• Local related to true area 

Loads acting perpendicular to the surface are usually defined as local in direction z. 

• Global related to true area 

The orientation of the local surface axes is irrelevant for the calculation according to linear 
static analysis if the load acts in direction of an axis of the global coordinate system XYZ. 
An example for load reference to the true area is self-weight. 

• Global related to projected area 

The load is converted to the projection of the surface in one of the directions of the global 
coordinate systems. A case for application is for example snow load. The dialog graphic in 
the lower right corner shows the projected surfaces. 

Load position 
Enter the coordinates of the load position into the input fields. In the dialog box, you can  
select the position of the load also graphically by using the [] function. 

Magnitude 
In the table column respectively input field, enter the numerical value of the area load. 
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6.9 Free Circular Loads 
General description 

A free circular load acts as a uniform or linearly variable surface load on a circular, freely defin-
able part of a surface. 

 
Figure 6.38: Dialog box New Free Circular Load 

 
Figure 6.39: Table 3.9 Free Circular Loads 

On surfaces 
This input field manages the numbers of surfaces on which the load is acting. In the dialog box 
New Free Circular Load, you can select surfaces also graphically by using the [] function. 

Starting from the defined Load Position, an imaginary straight line is "set" perpendicular to the 
projection plane. When the line intersects any of the listed surfaces, the circular load is applied 
to the point of intersection representing the circle center with the radius R. In this way, it is 
possible to allocate quickly loads of similar type to several surfaces. 

Projection plane 
The load can be projected on one of the global planes XY, YZ or XZ. As described above, an 
imaginary line is generated, starting from the load position and running perpendicular to the 
projection plane. The center of the circular load is assumed wherever the line intersects a sur-
face. 
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The projection plane must not be perpendicular to a surface on which the load is acting: There 
are no clear intersection points with the surface. 

Load distribution 
Specify whether a uniform or linearly variable load is applied. In the dialog input field below, 
you can enter one or two numerical values. 

Load direction 
The load can act in direction of the global axes X, Y, Z or the local surface axes x, y, z. The load 
directions are described in the previous chapter 6.8 on page 239. 

Load position 
Into the input fields, enter the coordinates of midpoint C of the circle load. In the dialog box, 
you can select the circle center also graphically by using the [] function. 

Radius 
Enter the radius R of the circular area load into the input field or table column. In the dialog 
box, you can select the radius also graphically in the work window by using the [] function. 

Magnitude 
In the table column respectively input field, enter the numerical value of the area load. 

6.10 Free Polygon Loads 
General description 
A free polygon load acts as a uniform or linearly variable surface load on a polygonal, freely  
definable zone of a surface. 

 
Figure 6.40: Dialog box New Free Polygon Load 
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Figure 6.41: Table 3.10 Free Polygon Loads 

On surfaces 
This input field manages the numbers of surfaces on which the load is acting. In the dialog box 
New Free Polygon Load, you can select surfaces also graphically by using the [] function. 

Starting from the corner points defined by the Load Position, imaginary straight lines are "set" 
perpendicular to the projection plane. When they intersect any of the listed surfaces, the line 
connecting the points of intersection represents the boundary of the area load to be applied. 
In this way, it is possible to allocate quickly loads of similar type to several surfaces. 

Load projection 
The load can be projected on one of the global planes XY, YZ or XZ. As described above, two 
imaginary lines are generated, starting from the load positions and running perpendicular to 
the projection plane. The corner points of the polygon load are assumed wherever the lines  
intersect a surface. 

The projection plane must not be perpendicular to a surface on which the load is acting: There 
are no clear intersection points with the surface. 

Load distribution 
Specify whether a uniform or linearly variable area load is applied. In the dialog section Corner 
Point Numbers and Load Magnitudes below, you can enter one (Uniform), two (Linear in X / Y / Z) 
or three (Linear) numerical values. 

Load direction 
The load can act in direction of the global axes X, Y, Z or the local surface axes x, y, z. The load 
directions are described in chapter 6.8 on page 239. 

Load position 
Enter the Corner point coordinates into the input fields. It is recommended to define the poly-
gonal chain graphically by using the dialog function []. In the input field respectively table 
column, enter the point coordinates separated by comma. Coordinate pairs are separated 
from one another by semicolon. 

Example: corner point coordinates X,Y [m]  2,3;1.6,4.7;5,45;6,25;3,2 

The third coordinate component is defined automatically by the plane of load projection. In 
the example, it is the Z-coordinate that can be specified separately in an input field of the dia-
log box. When defining coordinates graphically, the component is irrelevant because the ac-
tive work plane is decisive. 

Corner point numbers 
When defining linearly variable area loads, enter two (Linear in X / Y / Z) or three (Linear) corner 
points with the corresponding load values. You can define or graphically select only those cor-
ner points which are listed in the dialog section Load Position used to define the boundary lines. 
It is not possible to select RFEM nodes. Thus, the numbers of corner points are related to the 
sequence of the Corner point coordinates. 
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Magnitude 
In the table column respectively input field, enter the numerical value of the area load. For a 
linearly variable distribution, two or three values must be entered. 

 

Figure 6.42: Polygon load that is linearly variable in direction Z: load projection plane YZ and local load direction in z 

6.11 Imposed Nodal Deformations 
General description 
An imposed nodal deformation is a displacement or rotation of a supported node, for example 
due to a column settlement. 

Imposed nodal deformations can only be applied to nodes that have a support in the direction 
of the deformation. 

 
Figure 6.43: Dialog box New Imposed Nodal Deformation 
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Figure 6.44: Table 3.3 Imposed Nodal Deformations 

The number of the load is assigned automatically in the dialog box New Imposed Nodal Defor-
mation but can be changed in the input field. 

On nodes 
In this input field, define the numbers of nodes on which the imposed deformation is acting.  
In the dialog box, you can select nodes also graphically by using the [] function. 

When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter the deformations first. After clicking [OK] you can select the 
relevant nodes one after the other in the work window. 

Imposed displacement uX’ / uY’ / uZ’ 
Imposed displacements refer to the global coordinate system. If a displacement of a supported 
node does not act parallel to one of the global axes, its components X, Y and Z must be deter-
mined and entered in the corresponding input fields. 

The graphic in the dialog box explains how displacements and signs are effective. 

Imposed rotation ϕX’ / ϕY’ / ϕZ’ 
Node rotations refer to the global coordinate system X,Y,Z as well. Therefore, a skew imposed 
rotation requires the division in X, Y and Z components. 

A positive imposed rotation acts clockwise about the corresponding positive global axis. 

6.12 Imposed Line Displacements 
General description 
An imposed line displacement is a displacement of a supported line, for example due to a 
foundation settlement. 

Imposed line displacements can only be applied to lines that are supported in the direction of 
the displacement. 
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Figure 6.45: Dialog box New Imposed Line Displacement 

 
Figure 6.46: Table 3.12 Imposed Line Displacements 

The number of the load is assigned automatically in the dialog box New Imposed Line Displace-
ment but can be changed in the input field. 

On lines 
In this input field, define the numbers of lines on which the imposed displacement is acting.  
In the dialog box, you can select nodes also graphically by using the [] function. 

When the graphical input is selected, the input field is disabled and you have to enter the dis-
placements first. After clicking [OK] you can select the relevant lines one after the other in the 
work window. 

Imposed displacement uX / uY / uZ 

Line start 

Imposed displacements refer to the global coordinate system X,Y,Z. Three input fields are pro-
vided for the displacement on the start node of the supported line. 

If a displacement of the supported line does not act parallel to one of the global axes, its X-, Y- 
and Z-components must be determined. 

Line end 

In the input fields, enter the displacement on the end node of the supported line. 

To visualize the line orientation, use the Display navigator: Select Model → Lines → Line  
Orientations (see Figure 4.26, page 50). 
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6.13 Imperfections 
General description 
There are two ways how imperfections can be determined in RFEM: 

• Equivalent loads are applied to members. 

• A pre-deformed equivalent model is used. 

This chapter describes imperfections in the form of equivalent loads. For detailed information 
on how to generate equivalent models using the add-on module RF-IMP, see chapter 7.3.1 on 
page 269. 

To apply an imperfection, a member must have been previously defined. 

Imperfections represent manufacturing deviations in model geometry and material properties. 
In EN 1993-1-1, clause 5.3, the application of imperfections is organized as precamber (deflec-
tion) and inclination (sway). Thus, imperfections are taken into account by equivalent loads. 

 

Figure 6.47: Equivalent loads according to EN 1993-1-1 

Equivalent loads are also taken into account by RFEM when calculations are performed accord-
ing to linear static analysis. Please note, however, that a pure imperfection load case will not 
produce any internal forces. The model must additionally have some “real” loads inducing axial 
forces in the imperfect member. 

It is recommended to manage loads and imperfections in separate load cases. They can be com-
bined with each other appropriately in load combinations. Load cases with pure imperfections 
must be categorized as action type Imperfection in the base data for load cases (see Figure 5.3, 
page 170). Otherwise, the plausibility check would display a message because of missing loads. 

Generally, imperfections must be set affine with the lowest buckling eigenvalue in the most 
unfavorable direction. 
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Figure 6.48: Dialog box New Imperfection 

 
Figure 6.49: Table 3.13 Imperfections 

The number of the imperfection is assigned automatically in the dialog box New Imperfection 
but can be changed in the input field. The numbering order is not important. 

Reference to 
Define the objects to which you want to apply the imperfection. The following options can be 
selected: 

Members 

The imperfection acts on one single member or on each member of several selected members. 

List of members 

The imperfection acts on the union of members that are defined in the list. Thus, pre-
deformations and inclinations are not applied to each member individually but as total imper-
fection to all members of the member list. Load effects of an imperfection on single members 
in contrast to a member list are shown in Figure 6.50. 

Take advantage of a list of members to apply imperfections over all members without defining 
continuous members. 

Sets of members 

The imperfection acts on a set of members or on each set of several sets of members. Similar to 
the member list described above, parameters are applied to the union of members included in 
the member set. 
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Sets of members are subdivided into continuous members and groups of members (see  
chapter 4.21, page 158). Imperfections for sets of members can only be applied to continuous 
members lying on one line. They are not adequate for member groups or continuous mem-
bers which are buckled. 

 
Figure 6.50: Imperfection with reference to members (left) and to a list of members (right) 

On members 
In the input field, enter the numbers of members or sets of members on which the imperfec-
tion is acting. In the dialog box, you can select nodes also graphically by using the [] function. 

When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter all imperfection data first. After clicking [OK] you can select the 
relevant members or sets of members one after the other in the work window. 

For imperfections referring to a list of members it is possible to arrange member numbers ap-
propriately by using the dialog button [Reverse Member Orientation], for example to reverse 
the inclination for the graphic display. However, the sequence is irrelevant for calculations be-
cause of the identical equivalent loads. 

Direction 
The imperfection can only be applied in direction of the local member axes y or z. When un-
symmetrical cross-sections are used, the principal axes u and v are additionally available for  
selection (see chapter 4.13, page 120). It is not possible to define a globally acting inclination 
or precamber. 

The orientation of member axes is described in chapter 4.17, paragraph Member rotation on 
page 145. For symmetrical sections, axis y represents the so-called 'strong' axis, axis z accord-
ingly the 'weak' axis of the member cross-section. 

When the model type for plates or walls was selected in the General Data dialog box, only the 
direction z can be selected. 

Reference 
The values for inclination and precamber can be defined in two ways: 

Relative allows for entering the reciprocal values of ϕ0 and w0 in relation to the member length, 
Absolute allows for specifying geometric dimensions directly. 
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Inclination 1/ϕ0 
ϕ0 indicates the degree of inclination as it is described for example in EN 1993-1-1, clause 5.3.2. 
Enter the reciprocal value of ϕ0, respectively the absolute value, into the input field. An illustra-
tion of parameters can be displayed in the dialog box by using the [Info] button. 

In addition, the dialog box offers you the button [Calculate inclination] to determine inclinations 
according to different standards in a separate dialog box. 

 
Figure 6.51: Dialog box Calculate Value of Inclination 

Depending on the setting selected in the dialog section According to Standard, different input 
fields are available in the dialog section Inclination Parameters. Based on the values entered in 
the dialog input fields, reduction factors and inclinations are calculated conforming to stand-
ards. Click [OK] to transfer the values to the initial dialog box. 

Precamber l/w0 
The precamber w0 or e0,d defines the degree of deflection to be applied according to the stand-
ard (for example DIN 18800 part 2, el. (204) or EN 1993-1-1, clause 5.3.2). The precamber de-
pends on the buckling stress curve of the cross-section and is related to the member length L 
or entered as absolute value. 

Activity criterion 
The following options are available for selection to define how precambers are handled in inter-
action with member inclinations: 

• Always 
Precamber is taken into account in all cases. 

• EN 1993-1-1 (5.8) 
The influence of the precamber e0,d is applied to members with a slenderness λ  deter-
mined according to EN 1993-1-1:2005, clause 5.3.2 (6), eq. (5.8). 

• DIN 18800-2 (207) 
w0 is applied only if the member coefficient ε exceeds a certain value. This regulation  
refers to DIN 18800, part 2, el. (207). 

• Manually 
The activity criterion can be user-defined. 

To display the criteria in the dialog graphic, use the [Info] button. 

To consider w0 not before ε0 

A precamber is considered in addition to inclination if the member coefficient ε is higher than 
the value defined in this input field. DIN 18800-2 el. (207) specifies ε > 1.6 for most cases. 

 

 

 



6  Loads 

 

 

250 Program RFEM © 2013 Dlubal Software GmbH 

6.14 Generated Loads 
RFEM offers several generators that you can use to create loads easily (see chapter 11.8, page 
521 ff.). Generated member or surface loads are reflected in table 3.14 and in the Data naviga-
tor. 

 
Figure 6.52: Data navigator for Generated Loads 

 
Figure 6.53: Table 3.14 Generated Loads 

The original generator dialog boxes are stored as specific load objects which can also be ac-
cessed for modifications: Double-click a navigator item or use the table button [...] to open the 
initial dialog box again (see for example Figure 11.194, page 532) where you can adjust the  
parameters of load generation. 
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7.  Calculation 
 

7.1 Checking the Input Data 
Before you start the calculation, it is recommended to check model and load data as well as 
the modeling. RFEM checks if data for each model and load object is completely available, if 
references of data sets are alright and if the modeling is correct. 

Possible input errors can be corrected quickly as you can directly access the table row with the 
relevant problem (see Figure 7.2). 

7.1.1 Plausibility Check 
You can check model as well as load data for its coherent input. To open the dialog box for the 
plausibility check, 

select Plausibility Check on the Tools menu 

or use the toolbar button shown on the left. 

A dialog box opens where you define the input data that you want to check. 

 
Figure 7.1: Dialog box Plausibility Check 

In the dialog section Type of Check, you can choose between three options: 

• Normal 

The standard option checks the completeness of input parameters and the correctness of 
data records. 

• With warnings 

Select this option to carry out a detailed check of input data, finding also nodes with identi-
cal coordinates or releases with unlimited degrees of freedom. 

When a mismatch is detected, a message appears with detailed information about the 
problem. You can interrupt the check in order to eliminate the mistake. 

 
Figure 7.2: Plausibility check with warning 
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• None, only statistic 

Only a summary of input data is reported (model dimensions, total weight, number of nodes, 
lines, supports, surface and member loads etc.). 

When the check box for Generate FE mesh is ticked below, the FE mesh can be generated during 
the plausibility check. For more detailed information, see chapter 7.2, page 256. 

When the plausibility check was successful, the check result appears showing you a summary 
of input data. 

 
Figure 7.3: Result of plausibility check, tab Model Data 

7.1.2 Model Check 
In addition to the general plausibility check, you can use the model check to search specifically 
for discrepancies produced during the modeling. To open the corresponding dialog box, 

point to Model Check on the Tools menu 

and select one of several check options. 

Identical nodes 
RFEM filters all nodes with identical coordinates. They are combined in groups shown in a  
dialog box. 

 
Figure 7.4: Results of model check for identical nodes 
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In the dialog section What is to happen with Identical nodes?, you can decide how double nodes 
are treated. In the dialog section Apply action to, you define whether your selection applies to 
all groups listed above or only to the selected row. 

In the dialog section Tolerance, a kind of fine tuning is available to define the zone where co-
ordinates are evaluated as identical. This function is especially useful for models imported 
from CAD programs. In this case, lines are often short because of nodes lying closely together. 
If such nodes are filtered with appropriate tolerance and then unified, it is possible to avoid 
numerical problems due to short members or lines. 

Overlapping members 
Use this option to filter all members overlapping partially or entirely in their lengths. 

If overlapping members are detected, they are shown in a dialog box where they are sorted by 
groups. The current group is indicated by an arrow displayed in the work window. After click-
ing the [OK] button you can fix the problem. 

Crossing not connected members 
The check searches for members which are crossing but do not have a common node at the 
point of intersection. 

 
Figure 7.5: Results of model check for crossing members 

The check results are shown in the dialog section Groups of Crossing Not Connected Members. 
The crossing members are listed in groups. The group that is currently selected is indicated by 
an arrow in the graphic. 

In the dialog section What is to happen with, you decide what you want to do with the crossing 
members. The option Connect members is useful for actual possibilities of internal force transfer 
but not for example ordinary diagonal crossings with ties. 

Overlapping lines 
Use this option to filter all lines overlapping partially or entirely in their lengths. 

If overlapping lines are detected, they are shown in a dialog box where they are sorted by 
groups. The current group is indicated by an arrow displayed in the work window. After click-
ing the [OK] button you can fix the problem. 

Crossing not connected lines 
Use this option to search for lines that are crossing without sharing a common node at the 
point of intersection. The results are shown in the dialog section Groups of Crossing Not Con-
nected Lines (see Figure 7.5). The crossing lines are listed in groups. The group that is currently 
selected is indicated by an arrow in the graphic. 

In the dialog section What is to happen with, you decide how to handle the crossing lines. 
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Overlapping surfaces 
Use this option to filter all surfaces overlapping partially or entirely. 

If overlapping surfaces are detected, they are shown in a dialog box where they are sorted by 
groups. The current group is indicated by its selection color shown in the work window. After 
clicking the [OK] button you can fix the problem. 

Minimally curved surfaces 
You can search for surfaces with minor plane deviation. 

 
Figure 7.6: Results of model check for minimally curved surfaces 

If surfaces with minor curvatures are detected, they are shown in a dialog box where they are 
sorted by groups. The current group with a node deviating from the plane is indicated by an 
arrow displayed in the work window. 

The dialog section What is to happen with offers you specific control options how to treat such 
surfaces. In the dialog section Apply action to, you decide whether your settings apply to all 
groups listed above or only to the selected surface. 

In the dialog section Tolerance, a kind of fine tuning is available for the plane definition. Fur-
thermore, it is possible to Check again with other tolerance on curved surfaces in case of modi-
fications. 

Buttons 
The buttons in the dialog boxes of the model check have the following functions: 

 
Applies changes of dialog section What is to happen with 

 
Jumps to RFEM work window to adjust the view 

 
Exports listed objects to Excel table 

 
Creates a new partial view for each object group 

Table 7.1: Buttons in dialog boxes of model check 
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      Menu Tools → Delete Loads 

7.1.3 Regenerate Model 
RFEM revises automatically small inconsistencies existing in the model produced during the 
modeling process or arising from data exchange with CAD programs. To access the corre-
sponding function, 

select Regenerate Model on the Tools menu. 

 
Figure 7.7: Dialog box Regenerate Model 

In the dialog section Unite Close Lying Nodes, define a threshold for the distances of nodes: 
When values fall below the Tolerance, nodes are considered to be identical and will be com-
bined in a single node. As redundant nodes will be deleted, a renumbering of objects may be 
the result. 

In the dialog section Consider Lines/Members as Vertical, you can control the position of local 
line and member axes. The orientation of axes for members in vertical position differs essen-
tially from members in general (inclined) position (see chapter 4.17, page 146). To impose a 
vertical position for a general position, you can use the input field Tolerance. In this way, you 
prevent the member axes from "switching", which is also favorable for load input and output 
of internal forces. 

Use the options in the dialog section Integrate Nodes Automatically in Surfaces for nodes with 
only a very small distance to a surface or boundary line to include them automatically into the 
list of integrated objects of the surface (see page 82). As a result, a manual integration is un-
necessary. Please note that an internal check is carried out before the calculation starts: If the 
nodes' distance to the surface is too large, they will be considered as not belonging to the sur-
face. 

Finally, you can activate a function to Round Node Coordinates automatically. Define the rele-
vant number of decimal places. 

7.1.4 Delete Not Used Loads 
Loads can only be defined on objects existing in the model. However, during the modeling 
process it may happen that members or surfaces with assigned loads are removed from the 
system. Normally, RFEM deletes their loads, too. If the plausibility check still finds loads on non-
existing objects, it is possible to remove them. To find unused loads, 

point to Delete Loads on the Tools menu, and then select Not Used Loads. 

Use the menu shown on the left to select also other load objects for specific removal. 
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7.2 FE Mesh 
With RFEM you can analyze member elements, plates, walls, shells and solids. Before you  
calculate data, the FE mesh must be generated to create the corresponding 1D-, 2D and 3D  
elements. 

The FE analysis requires the division of the structural system into small subsystems represent-
ed by finite elements. For each element equilibrium conditions are set up. A linear system of 
equations is created that has many unknown quantities. The more refined the mesh size of the 
finite elements is, the more precise the results will be. On the other hand, computing time in-
creases enormously due to the amount of data to be calculated, as additional equations must 
be solved for every further FE node. 

The FE mesh is created automatically. However, there are some options that can be used to 
control the mesh generation. 

Useful references concerning discretization and finite element method can be found in [15]. 

7.2.1 Basics of Finite Elements in RFEM 

1D elements 
For member elements, it is assumed that the cross-section remains planar when deforming.  
1D member elements are used to represent beams, trusses, ribs, cables and rigid couplings.  
A 1D member element has in total 12 degrees of freedom: six at the start and six at the end of 
the element. They refer to displacements (ux, uy, uz) and rotations (ϕx, ϕy, ϕz). When calculating 
structural data linearly, tension, compression and torsion are expressed as linear functions of 
the member axis x, independent of bending and shear. They are approximated by a 3rd order 
polynomial in x, including influence of shearing stresses resulting from shear forces Vy and Vz. 
The stiffness matrix KL(12, 12) describes the linear behavior of the 1D elements. The mutual in-
teraction of axial force with bending in case of geometrically nonlinear problems is expressed 
in the stiffness matrix KNL(12, 12). Please find further information in [18] and [19]. 

For calculations according to large deformation analysis it is recommended to use an FE mesh 
refinement of lines (see chapter 4.23, page 166) so that results can be calculated accurately. 

2D elements 
Usually, quadrangle elements are used as 2D elements. The mesh generator adds triangular 
elements, where required. 

The degrees of freedom in corner nodes of quadrangle and triangular elements are the same 
as for 1D elements: degrees of freedom of displacement (ux, uy, uz) and rotation (ϕx, ϕy, ϕz). In 
this way, the compatibility of 1D and 2D elements in nodes is guaranteed. The parameters are 
defined in the planar, local coordinate system of elements and will be converted into the glob-
al coordinate system when creating the global stiffness matrix. 
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Figure 7.8: Shell elements of RFEM (quadrangle) 

The planar shell elements are based on the MINDLIN/REISSNER theory. Figure 7.8 shows the ap-
proaches of elements in graphical representations. To ensure a direct coupling with member 
elements, a square approach in the shell plane (ux, uy) is chosen. By eliminating the intermedi-
ate nodes, a four-node element is created with an additional degree of freedom ϕx. This allows 
for wall elements to be coupled directly with beam elements. Based on a mixed interpolation 
of transversal deformations, cross-section rotations as well as transversal shear strains, the 
MITC4 elements (Mixed Interpolation of Tensorial Components) as presented by BATHE and 
DVORKIN [24] are also applied. 

At the moment, member elements are considered by directly solving the differential equation 
according to second-order analysis. Considering drilling effects is not possible with the Saint-
Venant torsion. 

The analysis of membranes is based on the principles of BERGAN [20], [21], [22]. The basic func-
tions are subdivided, for example for triangular elements into three rigid-body deformations, 
three constant conditions of strain and three special linear gradients of stress and strain. With-
in an element, the deformation field is quadratic and the stress field is linear. The element stiff-
ness matrix KL is then transformed into nine collective parameters of the types ux, uy, ϕz. Com-
ponents of this matrix are then added to the overall stiffness matrix (18, 18) , together with the 
components causing bending and shear effects. This matrix is the result of the LYNN/DHILLON 
concept. Then, so-called MINDLIN plates are applied, which means that plates with distinct 
shear distortion are analyzed according to TIMOSHENKO. Thus, RFEM is able to find the correct 
solution for both thick and thin plates (NAVIER plates). 

In case of geometrically nonlinear problems, it is not possible to split the stress-strain condition 
into a planar state and into bending with shear. The mutual influences of these states are con-
sidered in the matrix KNL. RFEM uses a rather simple, but effective type of the KNL matrix that is 
based on the approaches of ZIENKIEWICZ [23]. The square component ε2 of the GREEN/LAGRANGE 
strain tensor ε = ε1 + ε2 is applied. A linear distribution of uz(x, y) of the planar stress condition 
and linear distributions of ux(x, y) and uy(x, y) of the interaction with bending are assumed. This 
assumption is possible because the main effect of the interaction depends on the first deriva-
tion of the differential equation, and because the influence of components of a higher order 
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decreases quickly with the division into smaller elements. The correctness of this procedure has 
been proved in several numerical analyses. 

To apply shell elements, thickness of elements must be considerably smaller than their dimen-
sion. If this is not the case, it is recommended to model objects as solids. 

3D elements 
The following 3D elements are implemented in RFEM: tetrahedron, pentahedron (prism, pyra-
mid) and hexahedron. For detailed information about applied elements and matrices, please 
see [48]. Corresponding documentation can be requested from DLUBAL SOFTWARE GMBH. 

 

Figure 7.9: Solid element (hexahedron) 

7.2.2 FE Mesh Settings 
To open the dialog box for setting FE mesh parameters,  

select FE Mesh Settings on the Calculate menu. 

 
Figure 7.10: Dialog box FE Mesh Settings 
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General 

The Target length of finite elements controls the global size of the mesh. The finer the mesh is, the 
more precise the results will generally be. However, the amount of data to be calculated as well 
as computing time are increased as well since additional equations must be solved for any fur-
ther FE node. Furthermore, singularity effects occur more frequently in a fine-meshed FE mesh. 

The discretization is important for the FE analysis to be performed. A mesh size that is too fine 
slows down the calculation without improving quality of results significantly. A target length 
that is too long cannot determine boundary conditions in a satisfying way. As a general rule, 
the following recommendation can be made for the appropriate lateral length of finite ele-
ments: Eight to ten finite elements should be generated between the boundary lines of a sur-
face. If possible, avoid to define less than four elements. 

In the second input field of this dialog section, you define the mesh node's allowable distance 
ε from a line. If the distance of a node is larger than the entered value, a new FE node will be 
created for it. 

The Maximum number of mesh nodes is defined with an upper limit in the last input field of the 
dialog section General to restrict the number of generated nodes and thus to ensure the effi-
ciency of program and computer. 

Members 

For cable, foundation and tapered members or members with plastic properties, you can speci-
fy the number of internal divisions, which leads to a real division of the member by intermedi-
ate nodes. However, if a member is arranged on a boundary line of a surface, or if the definition 
line has an FE mesh refinement, the specification has no effect. 

Tick the check box for Activate member divisions for large deformation or post-critical analysis to 
divide also beams by intermediate nodes for the calculation according to large deformation 
analysis so that these members are calculated with higher accuracy. The number of member 
divisions is determined by the input field above. 

If you select Use division also for straight members, which are not integrated in surfaces, FE nodes 
will be generated on all free members and considered for calculations according to linear static 
and second-order analysis. The length of the finite elements is either determined by the global 
target length lFE set in the dialog section General or entered manually. 

With the ticked option Use division for members with nodes lying on them, RFEM generates FE 
nodes on those locations of the member where end nodes of other members are lying, with-
out any connection existing between these members. 

Surfaces 

The most accurate results are determined for elements coming as close as possible to a shape 
of a square. For a square, the ratio of diagonals is D1/D2=1. In the input field Maximum ratio of 
FE rectangle diagonals, enter the limit value ∆D for the diagonal ratio. If the value is set too high, 
there is a risk that elements are generated with very acute or reflex angles. This may result in 
numerical problems. 

 
Figure 7.11: Elements with diagonals D1 and D2 
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Mapped FE mesh 

A curved surface is transformed into planar elements when creating the FE mesh. The value 
entered in the input field Maximum out-of-plane inclination of two finite elements defines the 
maximum allowable inclination angle α: The mesh will be refined automatically on the loca-
tion where the value is exceeded. 

 

Figure 7.12: Inclination angle α between two finite elements 

If the model is defined as plate of type 2D - in XY, you can specify a FE mesh refinement along 
lines to create smaller finite elements on all lines, and thus to approximate better for example 
results along supported lines. The relation ∆b refers to the global mesh size. It describes the 
edge distance of the refinement from the lines. 

 
Figure 7.13: FE mesh refinement along the boundary lines of a 2D slab 

Tick the check box Integrate also unutilized objects into surfaces to generate FE nodes also on 
objects that do not have any specific function for a surface (for example free nodes without 
support or load, constructional lines in surfaces). The function is disabled by default so that 
structurally irrelevant objects do not warp the FE mesh. 

The Shape of finite elements can be determined by the following three options: 

• Triangles and quadrangles: default setting 

• Triangles only: option in case quadrangles cause strong mesh distortions 

• Quadrangles only: option for higher accuracy of results 

The ticked option Mapped mesh preferred tries to align the FE mesh with the boundary lines of 
surfaces. This type of FE mesh generation can be defined for each surface individually (dialog 
box Edit Surface, tab FE Mesh). 

A mapped mesh is exclusively composed of quadrangles. In general, a mapped mesh provides 
"more accurate" results. Since also unknown quantities occur less frequently in the equation 
system, it is recommended for generating the mesh. 

Option 

Tick the check box for Regenerate FE mesh on [OK] if you want to generate a new FE mesh after 
confirming the dialog box. 
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7.2.3 FE Mesh Refinements 
Take advantage of FE mesh refinements to influence the FE mesh generation. You can refine 
the mesh on relevant points, for example in connection zones. Refinements are also used to 
make an appropriate compromise between result accuracy and computing time. 

Basically, there are four types of FE mesh refinements: 

• Refinement around a node 

• Refinement on a line 

• Refinement on a surface 

• Refinement on a solid 

The definition of FE mesh refinements is described in chapter 4.23 on page 164. 

7.2.4 FE Mesh Generation 
To start the FE mesh generation, 

select Generate FE Mesh on the Calculate menu. 

Moreover, the FE mesh is generated automatically when you start the calculation of a load 
case. However, it is strongly recommended to check the generated mesh before starting the 
calculation, and to check whether a sufficient and "harmonic" discretization is available or if  
refinement areas are still needed. 

Conversely, areas of minor relevance for the results evaluation can be covered by a more 
coarse-meshed FE mesh. For example, define a surface "mesh refinement" with a mesh size 
larger than the target length lFE. In this way, it is possible to accelearte the calculation as well  
as the evaluation. 

When the FE mesh generation has been successful, 

select FE Mesh Statistic on the Calculate menu 

to open a dialog box with information about the generated FE mesh.  

 
Figure 7.14: Dialog box FE Mesh Statistic 

The statistics show types and numbers of the generated finite elements, which is helpful for se-
lecting the appropriate equation solving method and to estimate the approximate calculation 
time (see chapter 7.3, page 274). 

The FE mesh is deleted automatically when model data is modified. Besides, it is possible to 
delete the mesh specifically. To activate the corresponding function, 

select Delete FE Mesh on the Calculate menu. 

Please note that all results that may be available will be deleted, too. 
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7.3 Calculation Parameters 
Dialog box Edit Load Cases and Combinations 

When creating a load case or load combination, it is already possible to define calculation pa-
rameters. Settings can be specified in the respective dialog section tab Calculation Parameters 
of the dialog box Edit Load Cases and Combinations. 

 
Figure 7.15: Dialog box Edit Load Cases and Combinations, tabs Load Cases and Calculation Parameters 

In addition to offering an overview about all load cases and combinations, the dialog box  
Edit Load Cases and Combinations controls the calculation parameters for each load case,  
load combination and result combination. 

Dialog box Calculation Parameters 
Moreover, you can access the calculation parameters in a separate dialog box. 

To open the dialog box Calculation Parameters, 

select Calculation Parameters on the Calculate menu 

or use the toolbar button shown on the left. 

 
Figure 7.16: Button [Calculation Parameters] 

The dialog box Calculation Parameters consists of four dialog tabs. The first three tabs manage 
the calculation parameters of each load case, respectively load and result combination. In the 
fourth tab Global Calculation Parameters (see Figure 7.22, page 271), you can check and, if nec-
essary, adjust specifications that are universally valid. 
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7.3.1 Load Cases and Load Combinations 

 
Figure 7.17: Dialog box Calculation Parameters, tab Load Combinations 

The dialog section Existing Load Cases, respectively Existing Load Combinations, lists all available 
load cases and combinations. You can adjust the Calculation Parameters of the selected entry in 
the dialog section to the right.  

The button [Apply settings] assigns the current specifications to all load cases and combina-
tions. 

The dialog tab Load Combinations is subdivided into the dialog section tabs Calculation Param-
eters, Modify Stiffnesses (see page 267) and, if applicable, Extra Options (see page 268). 

7.3.1.1 Dialog Tab Calculation Parameters 

Method of analysis 
In this dialog section, you decide whether the load case/combination is calculated according 
to the linear static, Second-order or Large deformation analysis. Select the option Postcritical 
analysis to carry out a stability analysis according to large deformation analysis with regard to 
postcritical failure of the entire structure. 

RFEM presets the linear calculation according to linear static analysis for load cases, and the 
nonlinear calculation according to second-order analysis for load combinations. 

When the model includes cable members, a large deformation analysis is suggested in all cases. 
Cable members are always calculated according to the large deformation analysis, the remain-
ing members according to the selected analysis method. 

Second order analysis 

The common "structural" second-order analysis is used to determine the equilibrium on the 
deformed system. Deformations are assumed to be small. If axial forces are available in the sys-
tem, they will lead to an increase of bending moments. Thus, the calculation according to sec-
ond-order analysis by TIMOSHENKO [10] has an effect only if axial forces are considerably higher 
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than shear forces. The additional bending moment ∆M results from the axial force N and the 
elastic lever eel. 

eleNM ⋅=∆  

Equation 7.1 

For structural systems subjected to pressure there is an overlinear relation between loading 
and internal forces. Normally, you have to calculate also with γ-fold actions. 

The axial force difference in the iterations represents the break-off criterion. For member ele-
ments, the stiffness-modifying axial force decisive for the second-order analysis is assumed to 
be constant along the entire member. The calculation stops as soon as a certain value of the 
normal force difference falls below. It is possible to influence this break-off limit in the dialog 
section Precision and Tolerance of the dialog tab Global Calculation Parameters. 

For nonlinear calculations according to second-order analysis, assumptions of the linear elastic 
analysis are the same with the following additions: 

• No plastic deformations occur. 

• The external forces stay true to the direction. 

• For members with non-constant axial force (for example columns) the mean value of 
the axial force N is applied for determining the member coefficient ε. 

Large deformation analysis 

The large deformation analysis ("third order theory") takes into account longitudinal and trans-
versal forces during the analysis of internal forces. If the calculation according to this large de-
formation analysis is selected, all surfaces and members will be calculated according to this 
calculation theory. 

The stiffness matrix for the deformed system is created after each iteration step. Please note 
that there are significant differences between loads defined as local and global: For example, 
when a surface load defined as global in Z is acting on a floor, it keeps its direction if finite  
elements are warping. But when the load is effective in direction of the local surface axis z, it 
warps on each element according to the element's warping. 

Post-critical analysis 

A stability analysis with regard to postcritical failure is performed. The method represents a 
modified calculation according to large deformation analysis by NEWTON-RAPHSON where the  
influence of axial forces is considered for changes occurring in shear and bending stiffness. The 
tangential stiffness matrix is saved in each iteration step. In case of singularities (which means 
instability), the stiffness matrix of the previous iteration will be used for new geometric, incre-
mental iterations until the tangential stiffness matrix of the current setting becomes regular 
(stable). 

Method for solving of system of nonlinear equations 
Six methods for solving the nonlinear, algebraic system of equations are available for selection: 

Newton-Raphson 

The approach according to NEWTON-RAPHSON is preset for the large deformation analysis. The 
nonlinear equation system is solved numerically by means of iterative approximations with 
tangents. The tangential stiffness matrix is determined as function of the current state of de-
formation; it is inverted in each cycle of iterations. In the majority of cases, a fast (quadratic) 
convergence is reached. 

You can influence the performance of convergence by the number of load increments set in 
the dialog tab Global Calculation Parameters. 
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Newton-Raphson combined with Picard 

First, the approach according to PICARD is applied (see below). After a few iterations, the pro-
gram changes to the NEWTON-RAPHSON method. The basic idea of this approach is to use the 
relatively strong PICARD method for the first iteration steps to avoid instability messages. This 
initial approximation is followed by the fast method according to NEWTON-RAPHSON to find the 
ultimate state of equilibrium. 

In the dialog section Settings of the dialog tab Global Calculation Parameters, you can define 
the percentage that is used for iterations according to PICARD when the combined method is 
applied (see Figure 7.22, page 271).  

Picard 

The method according to PICARD, also known as secant method, can be understood as finite 
difference approximation of the Newton method. The program takes into account the differ-
ence between the current iteration run and the original iteration run in the current load incre-
ment step. 

Often, converging is slower than in the calculation method according to NEWTON-RAPHSON. But 
the method proves to be stronger with regard to nonlinear problems, making the calculation 
more stable. 

Newton-Raphson with constant stiffness matrix 

This version of the NEWTON-RAPHSON method can be selected for calculations according to large 
deformation analysis. The stiffness matrix is created only once in the first iteration step, and 
then it is used in all subsequent calculation loops. 

Thus, the calculation runs faster but not that stable like calculations according to the normal or 
modified NEWTON-RAPHSON method. 

Modified Newton-Raphson 

This method is used to perform the post-critical analysis (see dialog section Method of Analysis 
above) where a range with instability must be overcome. If an instability is available and the 
stiffness matrix cannot be inverted, the program uses the stiffness matrix of the last stable  
iteration step. The program continues to calculate with this matrix until a stability range is 
reached again. 

Dynamic relaxation 

The final method is appropriate for calculations according to large deformation analysis and 
for solving problems with regard to post-critical analysis. An artificial time parameter is intro-
duced. Taking into account inertia and damping, the failure can be handled as a dynamic 
problem. This approach uses the explicit time-integration method; the stiffness matrix won't 
be inverted. 

No part of the model is allowed to have a specific weight of zero when calculating with dynam-
ic relaxation. 

This method includes the RAYLEIGH damping that can be defined by means of the constants α 
and β according to the following equation with derivations by time: 

fKuuCuM =++   

where M Mass matrix 

  C Damping matrix  C = αM + βK 

  K Stiffness matrix 

  f Vector of external forces 

  u Discretized displacement vector 

Equation 7.2 
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Options 

Modify loading by factor 

After ticking the check box, you can enter a factor into the input field by which all loads con-
tained in the load case or combination will be multiplied. The factor is also reflected in the load 
vectors and values of the graphic. Generally, also negative factors are permitted. 

Older standards claim to multiply loads globally by a certain factor in order to increase effects 
according to second-order analysis for stability designs. On the other hand, design must be 
carried out with the characteristic loads. Both requirements can be fulfilled by entering a factor 
larger than 1.00 and ticking the check box Divide results by loading factor. 

When analyzing structures according to current standards, loading should not be edited with 
any factors. Instead, partial safety factors and combination coefficients must be applied for the 
superposition in the load and result combinations. 

Modify stiffness 

If the check box is ticked, the stiffness factors of the materials (see chapter 4.3, page 61), cross-
sections (see chapter 4.13, page 119) and members (see chapter 4.17, page 142) are considered 
in the calculation. Settings can be defined in detail in the dialog tab Modify Stiffness (see chap-
ter 7.3.1.2, page 267). 

Activate extra options 

When ticking the check box the dialog tab Extra Options becomes available where you can  
activate the initial deformations or forces of a load case as well as the results of an add-on 
module for the calculation (see chapter 7.3.1.3, page 268). 

Consider favorable effects due to tension 

Tensile forces have a favorable effect on pre-deformed structural systems. Thus, the pre-defor-
mation is reduced and the structure is stabilized. 

There are different opinions on how to consider tensile forces acting in a favorable way. Stand-
ards contain regulations according to which relieving actions must be considered with a small-
er partial safety factor than unfavorable effects. 

Partial safety factors that are varying from one member to the other cannot be realized with an 
acceptable computing time. Therefore, RFEM offers you the option to set tensile forces gener-
ally to zero for calculations according to second-order analysis. With this approach you will be 
definitely on the safe side. If you want to use this option, clear the check box. 

On the other hand, one can say that standards refer to actions and not to internal forces. There-
fore, it is necessary to decide for the action as a whole whether it is favorable or unfavorable. 
Thus, if an unfavorable action has a favorable effect in certain zones of the model, it can defi-
nitely be considered. So, if you want to take account of the axial forces without any changes in 
the calculation according to this approach, the check box must be ticked (default setting). 

The favorable effect of tensile forces should be considered in the majority of cases, for example 
for halls with bracings or structural systems affected by bending. But please keep in mind that 
relief due to tension force effects for beams with supporting cables may result in an unwanted 
reduction of deformations and internal forces.  

Refer internal forces to deformed structure 

The option enables output for nonlinear calculations showing axial and shear forces as well as 
bending and torsion moments of members in relation to the rotated coordinate systems of the 
deformed system. There are three check boxes available for the internal force types Normal 
forces, Shear forces and Moments. 

 



7  Calculation 

 267 Program RFEM © 2013 Dlubal Software GmbH 

 

Calculation of kinematic mechanism 

You can try to make an unstable model available for calculation: Internally, small springs are 
applied stabilizing the model for the first iteration. When a stable initial state is reached, springs 
will be removed for the subsequent iterations. 

Separate number of load increments 

You can define an individual number of load increment steps for each load case and each load 
combination. Thus, the number specified in the dialog tab Global Calculation Parameters is no 
longer valid (see 7.3.3, page 272). 

7.3.1.2 Dialog Tab Modify Stiffness 
The dialog tab is displayed only when the check box for Modify stiffness (material, cross-sections, 
members, load combination) is ticked in the previous tab Calculation Parameters. 

 
Figure 7.18: Dialog tab Modify Stiffness 

Settings entered in this dialog tab affect only the load case or load combination that is select-
ed in the list to the left. The button [Apply settings] transfers the current parameters to all load 
cases, respectively combinations. 

Materials and cross-sections / supports / releases 

With specifications defined in the three dialog sections you can decide how stiffnesses of the 
different model parameters are taken into account in the calculation. 

• Multiply all with factor 

Specify a factor by which the stiffness of the materials, cross-sections, supports and  
releases is globally multiplied. 

• Individually 

Use the [Modify] button to open a new dialog box where you can assign a specific stiff-
ness factor to each object.  
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Deactivate 

Use the three input fields to define which Members, Surfaces or Solids are not affected by the 
defined stiffness modifications, that means which are considered with the factor 1.0 in the cal-
culation. You can select objects also graphically by using the [] function. 

7.3.1.3 Dialog Tab Extra Options 
The dialog tab is displayed only when the check box for Activate extra options is ticked in the 
dialog tab Calculation Parameters (see Figure 7.17, page 263). 

 
Figure 7.19: Dialog tab Extra Options 

Initial deformation from other load case/combination 
Select a load case or load combination whose deformations you want to consider as initial 
strain in the calculation. FE nodes are shifted accordingly before the calculation starts. If results 
are not yet available for the selected load case or combination, they will be calculated auto-
matically. 

Specify the factor by which you want to scale the deformations: 

• Multiply all with factor 

Deformations of members, surfaces and solids are globally multiplied by the specified 
factor. 

• Individually 

Use the [Edit] button to open a new dialog box where you can assign a specific scaling 
factor of deformation to each member, surface and solid.  
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Initial forces for geometric stiffness 
You can select a load case or combination whose axial forces you want to use for an initial de-
formation. In this way, you can consider for example the stabilizing effect of another load case 
(than specified above in the dialog section Initial Deformation). 

Access to the dialog section is only available for a calculation according to second-order analy-
sis. 

Stiffness from add-on module RF-CONCRETE 
Stiffnesses of reinforced concrete elements, resulting from reinforcements and crack analysis 
according to nonlinear design method performed in the RF-CONCRETE modules, can be taken 
into account in the calculation. After ticking the check box, specify the analysis case of the add-
on module RF-CONCRETE Members or RF-CONCRETE Surfaces. 

Calculations with stiffnesses from RF-CONCRETE succeed only if design cases have been created 
and if designs are possible without non-designable situations. 

Initial deformation from add-on module RF-IMP 
Imperfections can be considered in the form of a pre-deformed equivalent model created in 
the add-on module RF-IMP. When the program is not licensed, equivalent imperfections for 
members (see chapter 6.13, page 246) or initial deformations of a load case (see above) can be 
applied manually. 

The calculation on the pre-deformed equivalent model is only possible if this model has been 
previously created in the add-on module RF-IMP. The add-on module generates imperfections 
on the basis of eigenvalues from RF-STABILITY, RF-DYNAM or of deformations from an RFEM 
load case that are scaled to a maximum ordinate. 

 
Figure 7.20: Add-on module RF-IMP with type of generation Pre-deformed initial model 

The equivalent model is stored separately without changing the characteristic geometrical da-
ta. Coordinates of FE nodes are aligned with the equivalent model not until load combinations 
are calculated. 

You can use a different equivalent model for each load combination. Select the relevant case 
in the list Case of module RF-IMP. 
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7.3.2 Result Combinations 
For basic information about superpositioning load cases in result combinations, see chapter 
5.6 Result Combinations on page 201. 

 
Figure 7.21: Dialog box Calculation Parameters, tab Result Combinations 

In the dialog section Existing Result Combinations, you find a list of all created or generated re-
sult combinations. You can edit the Calculation Parameters of the selected entry in the dialog 
section to the right. 

Options 
The Quadratic Combination is deactivated by default. Thus, internal forces are superimposed 
by additive superposition: 

n21 A...AAB +++=  

Equation 7.3 

The default setting is appropriate for most application cases. A square addition of internal 
forces is relevant for dynamic analyses, for example when combining load cases due to cen-
trifugal forces. In this case, the Pythagorean sum is created as follows: 

2
n

2
2

2
1 A...AAB +++=  

Equation 7.4 

When the square addition is activated, you can use the Positive/Negative options to decide 
which extreme values of the load cases will be considered in the super combination, and if you 
want to Preserve signs. In this way, the extreme values of the modal internal forces and defor-
mations as well as the results belonging to the governing component can be determined con-
forming to signs. 
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7.3.3 Global Calculation Parameters 
The dialog tab Global Calculation Parameters manages settings generally applied to all load 
cases and load combinations. To open the corresponding dialog box, 

select Calculation Parameters on the Calculate menu 

or use the toolbar button shown on the left. 

 
Figure 7.22: Dialog box Calculation Parameters, tab Global Calculation Parameters 

Settings 

Maximum number of iterations 

When using second-order or large deformation analysis as well as objects that are nonlinearly 
effective, you have to calculate iteratively. The value of the input field defines the highest pos-
sible number of calculation runs. The specification has nothing to do with the iterative method 
set for the system of equations described for the dialog section Options. 

When the calculation reaches the maximum number of iterations without achieving an equi-
librium, RFEM displays a corresponding message. The results can be displayed anyway. 

 
Figure 7.23: Message displayed for convergence problem 
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Number of load increments 

Specifications of this input field take effect only for calculations according to second-order or 
large deformation analyses. Finding an equilibrium is often difficult when large deformations 
are considered. Instabilities can be avoided by applying the load in several steps. 

For example, when two load increments are specified, half of the load will be applied in the 
first step. Iterations will be carried out until the equilibrium is found. Then, in the second step, 
the complete load will be applied to the already deformed system and iterations will be run 
again until the state of equilibrium is reached. 

Please keep in mind that load increments have an unfavorable effect on the computing time. 
Therefore, the value 1 (no gradual load increment) is preset in the input field. 

Moreover, you can define for each load case and combination how many load increments you 
want to apply (see chapter 7.3.1.1, page 267). Then, the global specifications will be ignored. 

Number of divisions of members for result diagrams 

The input field affects the graphical result diagram of members that have no other, distinct FE 
mesh division (for example due to a FE mesh refinement or a connected surface). If a division of 
10 is set, RFEM divides the length of the longest member in the system by 10. With the system-
related division length RFEM determines for each member the graphical result distributions on 
the division points. 

In the dialog box FE Mesh Settings, there is another division option provided for straight mem-
bers that are not integrated in surfaces (see Figure 7.10, page 258). With this option you can 
create FE nodes on all free members whose results are used for the graphical result diagrams. 

Number of divisions of members for special types of members (cable, elastic foun-
dation, taper, nonlinearity) 

In contrast to the previous division option, a real division of the member is now defined by  
internal intermediate nodes. The specification affects cables, foundation members (contact 
stresses), tapered members (interpolation of cross-section values) and members with plastic 
properties (yielding zones) if they have not yet been divided otherwise by FE nodes: This divi-
sion is irrelevant if a member is placed on a boundary line of a surface or if the definition line 
has a FE mesh refinement. 

Number of divisions of members for determination of max/min values 

The value specifies the internal division by which the maximum and minimum internal forces 
of members are determined. Thus, the division (default setting: 12) represents the basis for the 
extreme values shown in the results tables and graphic. The division is also used for calculating 
member internal forces of load combinations. 

Subdivisions of FE mesh for graphical results 

The division controls the accuracy of graphical distributions within the finite elements. The fol-
lowing example compares the results with the divisions of 0 and 3. 

     

Figure 7.24: Graphical result diagram m-x with division 0 (left) and 3 (right) 
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Percentage of iterations of Picard method in combination with Newton-Raphson 

The approach according to PICARD acts on the assumption of secant stiffenings, but the method 
of NEWTON-RAPHSON assumes tangent stiffenings (see chapter 7.3.1, page 264). When the calcu-
lation option Newton-Raphson combined with Picard is selected, secant stiffenings are used in 
the first iterations before tangent stiffenings are applied for the remaining iterations. 

In the input field, you can define the percentage of the first iterations with secant stiffenings. 
Specify the value in relation to the total number of iterations. 

Options 

Activate shear stiffness of members (cross-sectional areas Ay, Az) 

Considering shear stiffnesses leads to an increase of deformations due to shear forces. The 
shear deformation is almost irrelevant for rolled and welded cross-sections. For solid and  
timber cross-sections, however, it is recommended to consider the shear stiffnesses for the  
deformation analysis. 

Shear deformations have an effect only on the end nodes of members. Therefore, a single-
span beam must be divided by intermediate nodes so that the increase becomes effective. 

Activate member divisions for large deformation or post-critical analysis 

Beams can be divided by intermediate nodes for the calculation according to large defor-
mation analysis to calculate such members with a higher accuracy. The number of divisions is 
taken from the input field for cable and foundation members. 

Modify stiffness (material, cross-sections, members, load cases and combinations) 

Use this check box to define globally whether the adjustment factors of the stiffnesses for ma-
terials (see chapter 4.3, page 61), cross-sections (see chapter 4.13, page 119) and members (see 
chapter 4.17, page 142) are considered in the calculation of load cases and load combinations. 
Factors in the member and cross-section dialog boxes are preset each with 1.00. Thus, the 
check mark in the check box usually involves no reduction or increase of the stiffnesses. 

Consider extra options 

If Extra Options have been defined for the calculation parameters of load cases and combina-
tions (see chapter 7.3.1.3, page 268), it is possible to activate or deactivate them by ticking and 
clearing this check box. 

Ignore rotational degrees of freedom 

Usually, six degrees of freedom must be considered in spatial structural systems. To save time, 
the option allows you to calculate models with only three degrees of freedom. The following 
simplifications are applicable: Only displacements are possible, but no rotations. Only axial 
forces are calculated as internal forces, but no bending or torsion moments and no shear  
forces – as if the system consisted only of truss girders, cables or membrane surfaces. 

When this approach is used, the stiffness matrix is reduced to the half of the rows and tables, 
which affects computing time accordingly. 

Check of critical forces of members 

Often, exceeding the critical load already in the first iteration leads to an instability message. 
Use this check box to control if the critical load is checked for trusses, compression and buck-
ling members. The defined effective lengths of members will be taken into account. 
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Method for system of equations 

Both options control the method used for solving equation systems: Direct or Iterative. To pre-
vent misunderstandings: When solving the equation system directly, an iterative calculation is 
performed as well, if nonlinearities are available or data is calculated according to second-order 
and large deformation analysis. Direct and Iterative refer to the data management during the 
calculation. 

The choice of the solver method leading quickly to results depends on the complexity of the 
model as well as the size of the main memory (RAM) that is available: 

• For small and medium size systems, the Direct solver method is more effective. 
• For big and complex systems, the Iterative method is faster for results output. 

When the matrices for the direct method cannot be stored any longer in the main memory, 
Windows starts to swap out parts of the data to the hard disk, which slows down the direct  
calculation. Hard disk activities increase and processor load is reduced, which is visible in the 
Windows Task Manager. By using the iterative ICG (Incomplete Conjugate Gradient) calculation 
method you can avoid this storage problem. 

It is necessary to ensure that the swap file is large enough respectively the file size is assigned 
automatically by Windows. With a swap file that is too small program crashes may occur. 

In the toolbar menu Options, select Program Options, or use the toolbar button shown on 
the left to open the dialog box Program Options. In the dialog tab Help Assistant, you can define 
the number of 2D and 3D elements for which, when it is exceeded, RFEM will show a warning 
of the calculation using the direct method. 

 
Figure 7.25: Dialog box Program Options, tab Help Assistant  

Plate bending theory 

Surfaces can be calculated according to the bending theories of MINDLIN or KIRCHHOFF. The cal-
culation according to MINDLIN includes shear force deformations, in the calculation according 
to KIRCHHOFF they are not considered. Therefore, the Mindlin calculation option is appropriate 
for relatively thick plates and shells used in solid construction. The Kirchhoff option is recom-
mended for surfaces that are relatively thin like metal sheets in steel construction. 
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Solver version 

The direct method for solving the system of equations (see above) is based on an analysis core 
using the extended RAM memory capacities of 64-bit operating systems. In this way, it is pos-
sible to calculate load cases and load combinations all at once even for big structural systems 
so that you can save time, provided that no object nonlinearities become effective. The RAM 
memory must be large enough in order to cover the stiffness matrix and all loading. 

Precision and tolerance 
Only rarely, it is required to adjust the preset convergence and tolerance parameters. Tick the 
check box Change standard settings to enable the input fields below. 

Precision of convergence criteria of nonlinear calculation 

If nonlinear effects are involved, or if the calculation is carried out according to second-order or 
large deformation analysis, you can influence the calculation by means of convergence criteria. 

The change of axial forces of the two last iterations is compared member by member. As soon 
as the change reaches a specific fractional amount of the maximum axial force, the calculation 
stops. It is possible, however, that axial forces are swinging between two values during the it-
eration process instead of converging. With the value entered in this input field, the sensitivity 
can be defined in order to neglect these oscillation effects. 

The accuracy also effects the convergence criterion for deformation changes in calculations 
according to large deformation analysis where geometric nonlinearities are considered. 

The default value is 1.0. The minimum factor is 0.01, the maximum value is 100.0. The higher 
the factor is, the less sensitive the break-off limit will be. 

Tolerance for detection of instability 

There are different approaches by which the stability behavior of a model can be analyzed. 
However, not any of them is able to detect singular stiffness matrices with absolute reliability. 

RFEM uses two procedures to determine the instability: On the one hand, elements on the 
principal diagonal of the stiffness matrix are compared with the same number in the iterations. 
On the other hand, each element of the principal diagonal is analyzed in relation to the adja-
cent number. The tolerance can be adjusted in the input field. The smaller the value is, the less 
‘sensitive’ the analysis is performed. 

Relative setting of time step for dynamic relaxation 

The time parameter controls the calculation by the method of dynamic relaxation (see 7.3.1.1, 
page 265). The smaller the value is, the smaller is the time step and the more accurate the re-
sults will be. 

Convergence diagram 
During the calculation, a diagram showing the developing of displacements and rotations is 
displayed (see Figure 7.31, page 279). The values displayed refer to the node with the maximum 
deformations. 

In the dialog section Convergence Diagram, you have the possibility to define a particular node 
with deformation component whose results will be shown additionally in the dialog box Con-
vergence Diagram (see Figure 8.2, page 281). 
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Nonlinearities 
When nonlinearly acting elements are used in the model, you can deactivate the effect of the 
following elements for the calculation: 

• Failing supports/elastic foundations (�chap. 4.7, p. 97, chap. 4.8, p. 103, chap. 4.9, p. 108) 

• Failing members ( chapter 4.17, p. 140) 

• Member end releases ( chapter 4.14, p. 128) 

• Member nonlinearities ( chapter 4.20, p. 155) 

• Contact solids ( chapter 4.5, p. 89) 

• Material nonlinearities ( chapter 4.3, p. 61) 

It is recommended to not suppress the nonlinear effects but for test purposes, for example for 
finding the cause of an instability. The options in this dialog section help you to find errors: 
Sometimes, inaccurately defined failure criteria is responsible for calculation break-offs. 

Reactivation of failing members 
Settings in this dialog section concern member elements that may fail (for example tension, 
compression or foundation members). Take advantage of the options to solve problems of in-
stability caused by failing members: A model for example is stiffened by ties. Because of post 
shortenings due to vertical loads, the tension members receive small compressive forces in the 
first calculation step. They will be removed from the system. Then, in the second calculation 
run, the model is unstable without the ties. 

Check deformation of failing members and reactivate where appropriate 

When the check box is ticked, RFEM analyzes the nodal displacements in each iteration. If 
member ends of a failed tie move away from each other, the member will be reactivated. 

In some cases, reactivating members may be problematic: A member is removed after the first 
iteration, but reactivated after the second one, removed again after the third iteration etc. The 
calculation would run this loop until reaching the maximum number of iterations without con-
verging. This effect can be avoided by defining a Maximum number of reactivations specifying 
how often a member element is permitted to be reactivated before it will be definitely removed 
from the stiffness matrix. 

Exceptional handling 

After ticking the check box two methods for handling failing members are available for selec-
tion. They can be combined with the reactivation options described above. 

• Failing members to be removed individually during successive iterations 

After the first iteration RFEM does not remove for example all tension members with a com-
pression force but only the tie with the greatest compressive force. Then, in the second itera-
tion, only one member is missing in the stiffness matrix. In the next step, RFEM removes again 
the tie with the greatest compressive force. Often, a better convergence behavior can be 
achieved in this way for the system because of redistributing effects. 

This calculation option requires more time because the program must run through a larger 
number of iterations. Furthermore, you have to make sure that a sufficient number of possible 
iterations is set in the Settings dialog section above. 

• Assign reduced stiffness to failing members 

Members which have failed are not removed from the stiffness matrix. Instead, RFEM assigns a 
very small stiffness to them. Specify it in the input field Reduction factor of stiffness: Factor 1000 
means a reduction of stiffness to 1/1000. 

Please keep in mind for this calculation option that RFEM displays on members small internal 
forces which can actually not be absorbed by the member due to its definition. 
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7.4 Start Calculation 
You can select between several options for the calculation start. Before you start the calculation, 
it is recommended to carry out a short plausibility check of input data (see chapter 7.1.1, page 
251). 

Calculate all 
To start the corresponding function, 

select Calculate All on the Calculate menu 

or use the toolbar button shown on the left. 

 
Figure 7.26: Button [Calculate All] 

The command starts the calculation of all load cases, load combinations and result combina-
tions as well as of all additional modules where input data is available. 

Please use the function [Calculate All] with care: 

• Many load cases cannot occur isolated. Wind loads, for example, act always together with 
the self-weight. For structures with failing supports for tension, instabilities may occur 
during the batch calculation of all single load cases. 

• If many load combinations and module design cases are available, RFEM may need a lot 
of computing time. 

Calculate selected load cases 
To open the dialog box for selecting the load cases which are relevant for calculation, 

select To Calculate on the Calculate menu. 

 
Figure 7.27: Dialog box To Calculate 
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In the dialog section Not Calculated on the left, RFEM lists all load cases, load combinations and 
result combinations as well as analysis cases of add-on modules for which no results exist. Use 
the button [] to transfer the selected entries to the list Selected for Calculation. You can also 
double-click the items. To transfer the complete list to the right, use the button []. 

If result combinations or module cases are selected which require results from load cases, the 
relevant load cases will be calculated automatically. 

Load items can be sorted by filter options available below the list according to the following 
criteria: 

• Load cases 

• Load combinations 

• Result combinations 

• Add-on modules 

The button [Calculation Parameters] shown on the left opens the dialog box Calculation Param-
eters (see chapter 7.3, page 271) where settings can be checked and adjusted for the calculation. 

The dialog tab Result Tables of the To Calculate dialog box controls the availability of tables 
shown after the calculation. 

 
Figure 7.28: Dialog box To Calculate, tab Result Tables 

More filter options are available for some results tables. They are presented in chapter 8 Results 
together with the respective output tables (see for example Figure 8.15, page 290). 

Calculate current load case 
It is possible to start the calculation of an individual load case directly: Select the load case, 
load or result combination in the toolbar list, and then click the button [Show Results]. 

 
Figure 7.29: Calculating the load case directly by using the button [Show Results] 
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The calculation can be started after a message has been displayed that no results have been 
found. 

 
Figure 7.30: Query before calculation 

Calculate selected results 
The toolbar menu Calculate offers you additional options for selecting results to be calculated: 

• RFEM results only 

• Modules results only 

• All results of all open models 

• RFEM results only of all open models 

• Modules results only of all open models 

The calculation starts immediately after calling the corresponding function. 

Calculation process 
The calculation process is shown in the FE-Calculation window. In a diagram showing the con-
vergence process you can observe the graphs of the maximum displacements in addition to 
the calculation steps RFEM is running through. 

 
Figure 7.31: Calculation process 

The green or red vertical bars on the right in the window visualize the convergence behavior 
during the calculation: Each load increment takes a part of the column, for example 4/5 in the 
figure above represents the fourth of five load increments. When the bar is green, deformations 
are in a tolerable zone. A red bar symbolizes oversized displacements or rotations (≥ 0.1 rad). 
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8.  Results 
The numbering of this manual chapter follows the numbering of results tables, which makes it 
easier to find the respective descriptions of the tabs. 

Please note that any FE analysis represents an approximation. Results should be interpreted 
and checked for plausibility with engineering know-how. 

When data has been calculated, the additional tab Results appears in the navigator (see chap-
ter 3.4.3, page 24) for controlling the graphical results display. The results are listed numerically 
in separate tables (see chapter 3.4.4, page 26). 

Colored relation scales in tables 

The result columns of tables are partly highlighted in red or blue (see Figure 8.4, page 282. The 
colored bars represent result values graphically. They are scaled to the extreme values of the 
internal forces or deformations of all objects. Negative values are symbolized by red bars, posi-
tive ones by blue bars. Thus, the table allows also for a visual result evaluation. 

To switch the colored bars on and off, 

select View on the Table menu, and then click Colored Relation Scales 

or use the button in the table toolbar shown on the left. 

Table filter 

The displayed tables depend on the selections set in the dialog tab Result Tables of the dialog 
box To Calculate (see chapter 7.4, page 278).  

8.0 Results Summary 
Table 

Table 4.0 Summary represents a summary of the calculation process, sorted by load cases and 
combinations. 

 
Figure 8.1: Table 4.0 Summary 
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This overview shows you the check sums of loadings and support forces. The deviations in 
each direction should be less than 1 %. If this is not the case, numerical problems have oc-
curred because of considerable differences in stiffness. It may also be possible that the model 
has an insufficient stability, or the calculation has reached the maximum number of iterations 
without convergence. The overview informs you also about the resulting support reactions 
that are effective in an idealized way in the centroid of the model. 

Moreover, the summary shows the maximum displacements and rotations related to the glob-
al axes X, Y and Z as well as the largest total displacement. Due to the check of deformations, 
reliability of results can be evaluated. 

The summary that is listed by load cases is completed by the used calculation parameters. The 
Number of iterations required to obtain the results is of special interest here. 

The table ends with a Summary of selected parameters of the analysis core as well as globally 
valid specifications of calculation (see Figure 7.22, page 271: dialog box Calculation Parameters, 
tab Global Calculation Parameters) 

Convergence diagram 
The deformation developing is represented graphically during the calculation (see Figure 7.31, 
page 279). You can use this iteration diagram also after the calculation for "record" evaluation. 
To open the corresponding dialog box, 

select Iteration Diagrams on the Results menu. 

 
Figure 8.2: Dialog box Convergence Diagram 

The relevant load case can be selected in the list For Load Case / Load Combination. 

In the dialog section For Result Value, the maximum displacements umax and the maximum  
rotations φmax are preset. When a particular node with corresponding deformation has been 
defined among the global calculation parameters (see Figure 7.22, page 271, dialog section 
Convergence Diagram), deformations related to this node are also contained in the list. 
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In the second half of the dialog box, you see the graphs of the deformations activated in the 
dialog section For Result Value. 

With a click into one of the rows available in the dialog section For Result Value, you can update 
the result values of the respective deformation in the table Convergence Data. In this way, a spe-
cific evaluation of the iteration steps, governing nodes and deformation diagrams is possible.  

Furthermore, the iteration diagram makes it possible to take remedial measures for "oscillating" 
(not converging) results. In addition, you can check the diagram of deformation in the iterations 
subsequently in case calculations are time-consuming. 

Based on the convergence diagram, a load-deformation diagram can be created for load in-
crements by copying the result values into the clipboard. 

8.1 Nodes - Support Forces 
With the entries under Support Reactions in the Results navigator you decide which components 
are displayed graphically in the work window. They can be related to the local axes of rotated 
supports or to the global axis system XYZ. Table 4.1 shows the support forces and moments in 
numerical form. 

If the structure is a 2D model, RFEM displays only the table columns of support forces and 
moments that are relevant for a planar structural system. 

 

Figure 8.3: Results navigator: Support Reactions → Nodal Supports 

 
Figure 8.4: Table 4.1 Nodes - Support Forces 

To display the support reactions of a particular load case, select the load case from the list in 
the main toolbar or the toolbar of the table.  
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Support forces PX / PY / PZ 

The support forces are listed in three table columns where they are sorted by nodes. Usually, 
the forces refer to the axes X, Y and Z of the global coordinate system. To display the forces  
related to the local support axes X', Y' and Z' (rotated supports) in the graphic as well as in the 
table, go to the Results navigator and set Support Reactions → Nodal Supports → Local. 

Nodes with support rotations are marked by an asterisk (*) as shown in Figure 8.4. Forces are 
put out in relation to the selected axis system. In the final table column, the support's rotation 
angle is indicated. 

The table shows the forces which are passed into the support. Thus, with regard to signs, the 
table does not show the reaction forces on the part of the support. The signs result from the 
direction of the global axes. If the global axis Z is directed downwards, then the load case self-
weight for example results in a positive support force PZ, and a wind load against the global  
axis X has a negative support force PX. Thus, the support forces shown in the table represent 
foundation loads. 

In contrast, the green vectors displayed in the graphic of the work window show the reaction 
forces on the part of the supports. The components of the support reactions are visualized by 
the size and direction of the vectors. 

You can display the signs of support reactions in the work window. Select Results in the Display 
navigator and tick the check box of the corresponding option. 

 

Figure 8.5: Display navigator, Results → Support Reactions → With sign 

The signs in the graphic refer to the global axis system XYZ or the local axis system X’Y’Z’ 
which is rotated. A positive support reaction acts in direction of the corresponding positive  
axis. For example, a wind load against the global axis X results in a positive support reaction PX. 

It is advisable to display these signs only for testing purposes. They may lead to misinterpreta-
tions because the vectors are already signed. The signs in the graphics are intended to be an 
extra feature of the vector display, indicating the directions for values in relation to the global 
axes. 
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Support moments MX / MY / MZ 
The support moments are listed in three table columns where they are sorted by nodes. Usual-
ly, the moments refer to the axes X, Y and Z of the global coordinate system. Use the Results 
navigator to display the moments related to the local support axes X', Y' and Z' in the graphic 
as well as in the table. 

The table shows the moments which are introduced into the support. With regard to signs, like 
for support forces, the table does not show the reactions on the part of the support. The signs 
result from the direction of the global axes. Thus, the support moments shown in the table 
represent foundation loads. 

In the work window, however, reaction moments are shown on the part of the support. 

Signs for support moments can be displayed in the graphic as well (see Figure 8.5). A positive 
support moment acts clockwise about the corresponding positive global axis. Similar to the 
vectors for support forces, vectors are already signed, and indications of value have to be con-
sidered independently: The signs indicate the directions of the moments in relation to the 
global axes. 

In the graphic, support moments can be represented as vector or arc. To change the type of 
display, 

point to Display Properties on the Options menu, and select Edit. 

 
Figure 8.6: Dialog box Display Properties (dialog section): Nodal Moments with display option Arc 

In the dialog section Category on the left, set Results, Support Reactions and Nodal Moments, 
and then select the Display option Arc to the right. 

Rotated nodal supports 
In the final table column, the rotation angles of rotated nodal supports are shown (see Figure 
8.4, page 282). The corresponding nodes are marked by an asterisk (*). 

Check sums 
For load cases and load combinations RFEM displays check sums of loads and support reactions 
at the end of the table. Differences will occur between the sums of Σ Forces and Σ Loads if the 
model has additional line supports and members or surfaces with elastic foundations. There-
fore, also the Σ Forces available in tables 4.3, 4.7 and 4.20 must be considered for the total sum-
mary. 
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Import support forces as load 
Nodal support forces and moments of another RFEM model can be applied as loads in the 
model your are currently working on. In this way, loads can be transferred by floors to analyze 
2D floor slabs. The function is described in chapter 8.3 on page 289. 

Nodal support forces that have been imported are applied as free concentrated loads. 

Filtering support forces of result combinations 
For result combinations it is possible to adjust the default setting for the extreme values 
shown in the results table. To open the corresponding dialog box, 

select View on the Table menu and click Result Filter 

or use the button in the table toolbar shown on the left. 

 
Figure 8.7: Dialog box Table Filter (dialog section) 

The check boxes in the dialog box Table Filter control the type and amount of numerical out-
put for support forces. 

Resultant of support reactions 
The resultants of support reactions for load cases and load combinations are shown in numeri-
cal form in table 4.0 Summary for each global direction (see Figure 8.1, page 280). Use the Results 
navigator to visualize the resultant forces also on the model. 

 

Figure 8.8: Results navigator: Support Reactions → Resultant 

In addition to the total resultant P, it is possible to display the individual Components that are 
effective in an idealized way in the model's centroid. Thus, you can check the position and size 
of the resulting support forces at a glance. 
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8.2 Nodes - Deformations 
To control the graphical display of nodal displacements and nodal rotations, tick the check box 
for Global Deformations in the Results navigator. Table 4.2 shows the deformations of nodes in 
numerical form. 

 
Figure 8.9: Results navigator: Global Deformations 

 
Figure 8.10: Table 4.2 Nodes - Deformations 

The displacements and rotations are listed by nodes. 

Displacements / Rotations 
The deformations have the following meanings: 

 u Total displacement 

 uX Displacement in direction of the global axis X 

 uY Displacement in direction of the global axis Y 

 uZ Displacement in direction of the global axis Z 

 ϕX Rotation about the global axis X 

 ϕY Rotation about the global axis Y 

 ϕZ Rotation about the global axis Z 

Table 8.1: Nodal deformations 
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8.3 Lines - Support Forces 
With the entries under Support Reactions in the Results navigator you decide which components 
are displayed graphically in the work window. They can be related to the local axes of rotated 
supports or to the global axis system XYZ. Table 4.3 shows the support forces and moments in 
numerical form. 

If the structure is a 2D model, RFEM displays only the table columns of support forces and mo-
ments that are relevant for a planar structural system. 

 

Figure 8.11: Results navigator: Support Reactions → Line Supports 

 
Figure 8.12: Table 4.3 Lines - Support Forces 

To display the support reactions of a particular load case, select the load case from the list in 
the main toolbar or the toolbar of the table. 

Location x 
The support forces are listed by lines. The x-locations shown in the table column represent the 
spacings of FE nodes along the line. They are related to the start node of the line. The surface 
grid is not relevant for line support forces. 
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Context menu of line support 

 

Support forces pX / pY / pZ 
The support forces are listed in three table columns where they are sorted by lines. The forces 
can be related to the global axes X, Y and Z or the local axes X', Y' and Z' of the line supports. 
The axis reference in the table is controlled by settings in the Results navigator (see figure on 
the left). 

The table shows the forces which are passed into the support. Thus, with regard to signs, the 
table does not show the reaction forces on the part of the support. If support forces refer to 
the global coordinate system, the signs result from the directions of the global axes. If the 
global axis Z is directed downwards, then the load case self-weight for example results in a 
positive support force pZ, and a wind load against the global axis X has a negative support 
force pX. Thus, the support forces shown in the table represent foundation loads. 

If the local support forces pX’, pY’ and pZ’ are displayed, forces refer to the axes of the line sup-
ports X', Y' and Z'. Thus, the signs in the table for the introduced forces result from the direc-
tions of the local support axes. Use the Display navigator or the context menu of line supports 
to display these axes. 

 
Figure 8.13: Activating the axis systems of the local line supports in the Display navigator 

In contrast, the green vectors displayed in the graphic of the work window show the reaction 
forces on the part of the supports. The components of the support reactions are visualized by 
the size and direction of the vectors. 

Support moments mX / mY / mZ 
The support moments are listed in three table columns where they are sorted by lines. They 
are related to the global axis system XYZ or the local axis system of the line support X'Y'Z'.  
If you have set the local reference, the support moments are indicated with mX’, mY’ and mZ’. 

The table shows the moments which are introduced into the support. Thus, with regard to 
signs, the table does not show the reactions on the part of the line support. 

In the work window, however, the reaction moments are shown on the part of the support.  
In addition to the vector display, an arc display can be set: Point to Display Properties on the 
Options menu, and select Edit (see Figure 8.6, page 284). 

Check sums 
For load cases and load combinations RFEM displays check sums of loads and support reactions 
at the end of the table. They are always related to the global axis system. Differences will occur 
between the sums of Σ Forces and Σ Loads if the model has additional nodal supports and mem-
bers or surfaces with elastic foundations. Therefore, also the Σ Forces available in these tables 
must be considered for the total summary. 
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Result diagrams 
The result diagrams of line supports can be evaluated specifically in a new window: Right-click 
the (selected) line support(s), and then click the option Result Diagrams in the context menu 
(see figure in the left margin at Figure 8.13). 

For more detailed information about the Result Diagram window, see chapter 9.5 on page 356. 

In the work window, additional information is available for each line support: 

• Σ Sum as resultant force 

• Φ Mean value 

• x Distance of the line's midpoint from line start 

• e Eccentricity of resultant force related to the line's midpoint 

• M Moment due to eccentricity of resultant force 

To display this information, select Results in the Display navigator, double-click Support Reactions, 
and then tick the check box for Info. 

Import support forces as load 
The Z components of nodal and line support forces of another RFEM model can be applied as 
loads to the model your are currently working on. In this way, you can transfer for example 
loads by floors to analyze 2D floor slabs. 

The support forces will be imported into the current load case. Therefore, it might be favorable 
if you first create a load case for the new loads. 

To open the import dialog box, 

select Import Support Reactions as Load on the Tools menu. 

 
Figure 8.14: Dialog box Import Support Reactions As Load 

First, specify the relevant model in the dialog section Import from. The button shown on the 
left helps you to select the right model. Then, RFEM imports the calculated load cases, load 
combinations and result combinations for which you have to make the next decision. When  
a result combination (RC) is set, you also have to define whether you want to import the max-
imum or minimum support forces. 
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If you don't want to import All support forces, you can specify the numbers of the relevant 
nodes, lines and surfaces. It is also possible to select them graphically in the original model by 
using the [] function. 

In the dialog section Apply as Load in Current Model on, enter the numbers of the surfaces for 
which you want to create the loads. It is also possible to select them graphically. 

If the original and target surfaces lie accurately one upon the other, no entry is required in the 
dialog section Offset. Otherwise, you can use the input fields to define the global offsets ∆X 
and ∆Y for the import. They refer to the global axes. 

In the dialog section Line Supports, you can choose whether the support forces are created as 
free line loads with a uniform or a polygonal load distribution. 

Filtering support forces of result combinations 
For result combinations it is possible to adjust the default setting for the extreme values 
shown in the results table. To open the corresponding dialog box, 

select View on the Table menu and click Result Filter 

or use the button in the table toolbar shown on the left. 

 
Figure 8.15: Dialog box Table Filter 

The check boxes in the dialog box Table Filter control the type and amount of numerical output. 
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8.4 Members - Deformations 
To control the graphical display of member displacements and member rotations, tick the 
check box for Members in the Results navigator. When asymmetric cross-sections are used, you 
can select if results refer to the principal axes u and v (see graphic on page 119) or to the 
standard input axes y and z. Table 4.4 shows the members' local deformations in numerical 
form. 

 

Figure 8.16: Results navigator: Members → Local Deformations 

 
Figure 8.17: Table 4.4 Members - Local Deformations 

To display the deformations of a particular load case, select the load case from the list in the 
main toolbar or the toolbar of the table. 

Node no. 
The numbers of the start and end node are displayed for each member in the first two tables 
rows so that you can read the nodal values. In the subsequent rows, you see information about 
the deformation maximum or minimum shown in table columns D to I. 

Location x 
The table lists the deformations of each member on the following locations: 

• Start and end node 

• Division points according to defined member division (see chapter 4.16, page 136) 

• Extreme values (Max/Min) of displacements and rotations 
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Member context menu 

To adjust the default setting of the x-locations shown in the results table, 

select View on the Table menu and click Result Filter 

or use the button in the table toolbar shown on the left. 

 
Figure 8.18: Dialog box Table Filter (dialog section) 

The check boxes in the dialog box Table Filter (see Figure 8.15, page 290) control the type and 
amount of numerical output. 

Displacements / Rotations 
The member deformations have the following meanings: 

u Absolute total displacement (not for result combinations) 

 ux Displacement of member in direction of its longitudinal axis 

uy / uu Displacement of member in direction of local axis y or u (see page 119) 

uz / uv Displacement of member in direction of local axis z or v 

 ϕx Rotation of member about its longitudinal axis 

 ϕy / ϕu Rotation of member about local axis y or u 

 ϕz / ϕv Rotation of member about local axis z or v 

Table 8.2: Member deformations 

To check the position of the local member axes, select Model and Members in the Display navi-
gator and activate Member Axis Systems x,y,z (see Figure 8.24, page 296). You can also use the 
member context menu shown on the left. 

Furthermore, the local member axis system has an impact on the signs of deformations. A  
positive displacement follows the direction of the positive local axis, a positive rotation acts 
clockwise about the positive member axis. 

Cross-section 
The final table column informs you about the cross-sections used in members or about the 
corresponding load cases (for result combinations). 

In the work window, deformations of members can be represented with a two- or multi-color 
display as well as in the rendering mode (see chapter 9.3, page 347). 

Moreover, member deformations can be visualized as animation of the deformation process 
(see chapter 9.10, page 378). 
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8.5 Members - Global Deformations 
To control the graphical display of member displacements and member rotations related to 
the global axes X, Y and Z, tick the check box for Global Deformations in the Results navigator. 
Table 4.5 shows the global deformations of members in numerical form. 

 
Figure 8.19: Results navigator: Global Deformations 

 
Figure 8.20: Table 4.5 Members - Global Deformations 

The table columns Node No. and Location x correspond to the columns of the previous results 
table 4.4 Members - Local Deformations. 

Displacements / Rotations 
The member deformations have the following meanings: 

u Absolute total displacement (not for result combinations) 

uX Displacement of member in direction of global axis X 

uY Displacement of member in direction of global axis Y 

uZ Displacement of member in direction of global axis Z 

 ϕX Rotation of member about global axis X 

 ϕY Rotation of member about global axis Y 

 ϕZ Rotation of member about global axis Z 

Table 8.3: Global member deformations 
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8.6 Members - Internal Forces 
To control the graphical display of member internal forces, tick the check box for Members in 
the Results navigator. Table 4.6 shows the internal forces and moments in numerical form. 

If the structure is a 2D model, RFEM displays only the table columns of internal forces that are 
relevant for a planar structural system. 

 
Figure 8.21: Results navigator: Members → Internal Forces 

 
Figure 8.22: Table 4.6 Members – Internal Forces 

To display the internal forces of a particular load case, select the load case from the list in the 
main toolbar or the toolbar of the tables. 

Location x 
The table lists the internal forces of each member on the following locations: 

• Start and end node 

• Division points according to defined member division (see chapter 4.16, page 136) 

• Extreme values (Max/Min) of internal forces 

To adjust the default setting of the x-locations shown in the results table, 

select View on the Table menu and click Result Filter 

or use the button in the table toolbar shown on the left. 
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Figure 8.23: Dialog box Table Filter (dialog section) 

The check boxes in the dialog box Table Filter control the type and amount of numerical out-
put (see chapter 11.5.5, page 487). 

The diagram graphic for internal forces is based on the result values available in the FE mesh 
nodes or the member divisions that have been defined in the dialog tab Global Calculation  
Parameters of the dialog box Calculation Parameters (see chapter 7.3.3 page 272). 

Forces / moments 
The member internal forces have the following meanings: 

N Axial force in member 

Vy / Vu Shear force in direction of local member axis y or u (see page 119) 

Vz / Vv Shear force in direction of local member axis z or v 

MT Torsional moment 

My / Mu Bending moment about axis y or u 

Mz / Mv Bending moment about axis z or v 

Table 8.4: Internal forces of members 

The local member axes y and z or u and v are the principal axes of the cross-section. Axis y or u 
represents the "strong" axis, the "weak" axis is represented by axis z or v (see chapter 4.17, 
page 145). When asymmetric cross-sections are used, you can select if internal forces refer to 
the principal axes u and v (see graphic on page 119) or to the standard input axes y and z.  
To set the results display, use the Results navigator as shown on the left. This display setting  
affects both the graphical results output and the output of results in the tables. 

When a nonlinear analysis is performed, internal forces can also be related to the deformed 
member axis systems. The reference of the internal forces is set in the dialog section Options  
of the dialog box Calculation Parameters (see chapter 7.3.1, page 266). 

To check the member position, use the 3D rendering. You can also use the Display navigator 
where you select Model and Members, and then tick the check box for Member Axis Systems 
x,y,z (see figure below). 
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Member context menu 

 
Figure 8.24: Selecting the local member axis systems in the Display navigator 

The display of the member axes can also be activated in the member context menu which is 
shown on the left. 

The local member axis system affects the signs of internal forces. 

 
Figure 8.25: Positive definition of internal forces 

The bending moment My is positive if tensile stresses occur on the positive member side (in di-
rection of the z-axis). Mz is positive if compressive stresses occur on the positive member side 
(in direction of the y-axis). The sign definition for torsional moments, axial forces and shear 
forces conforms to the usual conventions. These internal forces are positive if they act in a pos-
itive direction. 

Extreme values 
If the table display of extreme values is activated (see Figure 8.23, page 295), RFEM shows you 
the maximum positive (Max) and the minimum negative (Min) internal forces for each mem-
ber. In the results table, extreme values are highlighted in bold. The values in the remaining 
columns of the respective table row represent the internal forces related to the extreme value 
(see also chapter 11.5.5, page 487). 

Cross-section / corresponding load cases 
The final table column informs you about the cross-sections used in the members. 

Result combinations 
When you look at the results of result combinations, the column is entitled with Corresponding 
Load Cases (see Figure 8.22). The table shows the numbers of the load cases or combinations 
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that have been used to determine the maximum or minimum internal forces of the respective 
table row. Load cases classified as Permanent appear always in this table column. Variable load 
cases are only displayed if their internal forces have an unfavorable effect on the result (see 
chapter 5.6, page 204). 

At the same time, the table is extended by a new table column which is the third column C.  
At the end of the internal force list of a member you can read the maximum positive (Max) and 
the minimum negative (Min) values. 

It is possible to reduce the amount of data in the result combination tables by using specific  
filter functions available in the dialog box Table Filter (see Figure 8.23, page 295). To open the 
dialog box, 

select View on the Table menu and click Result Filter 

or use the button in the table toolbar shown on the left. 

8.7 Members - Contact Forces 
When members with elastic foundations exist in the model (see chapter 4.19, page 153), the 
contact forces and moments are shown numerically in table 4.6. To control the graphical dis-
play of results, tick the check box for Members in the Results navigator. 

 

Figure 8.26: Results navigator: Members → Contact Forces 

 
Figure 8.27: Table 4.7 Members - Contact Forces 
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Node No. 
In the first two table rows, the numbers of the start and end nodes are displayed for each foun-
dation member. The remaining rows inform you about the types of extreme values available for 
contact forces and moments. 

To adjust the default settings for the output of extreme values, 

select View on the Table menu and click Result Filter 

or use the button in the table toolbar shown on the left. 

Location x 
The table lists the contact internal forces of each member on the following locations: 

• Start and end node 

• Division points according to defined member division (see chapter 4.16, page 136) 

• Extreme values (Max/Min) of contact forces and moments 

Contact forces px / py / pz 
Contact forces that are effective in direction of the local member axes x, y and z are shown in 
relation to a standard length. When asymmetric cross-sections are used, you can select if con-
tact forces refer to the principal axes u and v (see graphic on page 119) or to the standard in-
put axes y and z. To set the results display, use the Results navigator. 

To check the position of the local axes, select Model and Members in the Display navigator and 
activate Member Axis Systems x,y,z (see Figure 8.24). The signs comply with the usual definitions 
explained in chapter 8.6 on page 296 describing the internal forces of members. 

When you want to determine soil contact pressures on the basis of the table values, you addi-
tionally have to divide the results by the respective cross-section widths. 

Moments mx 
The contact moments about the longitudinal member axis x also refer to a standard length. 
The contact moments mx are influenced by the rotational spring constant Cϕ. 

Cross-section / corresponding load cases 
The final table column informs you about the cross-sections used in members. When a result 
combination is set, you see the load cases and combinations that have been used to determine 
the maximum or minimum contact forces in the respective table row. 

Check sums 
For load cases and load combinations RFEM displays check sums of loads and support reactions 
at the end of the table. Differences will occur between the sums of Σ Forces and Σ Loads if the 
model has additional nodal and line supports as well as surfaces with elastic foundations. There-
fore, also the Σ Forces available in tables 4.1, 4.3 and 4.20 must be considered for the total sum-
mary. 
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8.8 Members - Member Coefficients for Buckling 
When you calculate member models subjected to pressure according to second-order analysis, 
the member coefficient ε is important (see chapter 7.3.1, page 264). Each member has its own 
member coefficient that is determined from compressive force, member length and member 
stiffness. 

Members with member coefficients higher than 1 have to be analyzed, where applicable, ac-
cording to second-order analysis. Also standards of some countries such as the USA have rules 
where member coefficients must be limited. 

Table 4.8 shows the member coefficients which are governing for buckling. There is no graph-
ical output option. 

 
Figure 8.28: Table 4.8 Members - Coefficients for Buckling 

The listed member coefficients are sorted by member numbers. 

Member type 
The member types are indicated for information (see chapter 4.17, page 139). RFEM determines 
member coefficients only for members that are able to absorb compressive forces. 

Material 
Characteristics of the material affect the member stiffness. 

Cross-section 
The cross-section's second moments of area are required to determine the member stiffnesses. 

Length L 
Table column D shows you the member lengths. 

Axial force N 
The column lists the axial forces used for determining the member coefficient. Here, the forces 
are the axial forces which are available in the member center (x = L/2). 

Member coefficients are determined only for members that have compression forces in at least 
one portion of the member (truss girder) or along the entire member (compression member, 
buckling member etc.). 

Member coefficients εy / εz 
The member coefficient depends on the member length L, the compressive force N and the 
stiffness E · I. 

IE

N
L

⋅
⋅=ε  

Equation 8.1: Member coefficient ε 
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Table columns F and G show the member coefficients referring to the local member axis sys-
tem y and z. When asymmetric cross-sections like angles are used, two more columns appear 
where slendernesses are shown also in relation to the principal axes u and v. 

8.9 Member Slendernesses 
Table 4.9 shows you the slenderness ratios of members. They are significant for the evaluation 
of the buckling behavior of members subjected to pressure. There is no graphical output option. 

 
Figure 8.29: Table 4.9 Member Slendernesses 

The listed member slendernesses are sorted by member numbers. 

Cross-section 
The cross-section's radii of gyration are required to determine the slendernesses. 

Length L 
The member lengths are indicated in table column B. 

Effective length factors kcr,y / kcr,z 
The buckling length coefficients describe the ratio of buckling length and member length. 

L

L
k cr

cr =  

Equation 8.2: Buckling length coefficient kcr 

The buckling length Lcr refers to the buckling behavior perpendicular to the 'strong' member 
axis y, respectively the 'weak' member axis z. If no buckling lengths have been defined manual-
ly (see chapter 4.17, page 149), the EULER buckling mode 2 is assumed: In this case, the buckling 
length is equal to the member length. More accurate analyses can be performed with the add-
on module RF-STABILITY or in Dlubal's design modules such as RF-STEEL EC3. 

Slendernesses λy / λz 
The slenderness ratio represents a pure geometric value. It is determined from the effective 
length factor kcr, the member length L and the radius of gyration i. 

i

Lk cr ⋅=λ  

Equation 8.3: Slenderness λ 
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Table columns E and F show the slendernesses referring to the local member axis system y  
and z. When asymmetric cross-sections like angles are used, two more columns appear where 
slendernesses are shown also in relation to the principal axes u and v. 

8.10 Sets of Members - Internal Forces 
Table 4.10 shows the internal forces sorted by sets of members (see chapter 4.21, page 158). 

 
Figure 8.30: Table 4.10 Set of Members - Internal Forces 

The table's structure is similar to the one of table 4.6 Members – Internal Forces described in 
chapter 8.6. Now, the results are sorted by continuous members or member groups. The de-
scriptions of member sets remain fixed in the top row of the table so it is easier to overview  
results data when scrolling. 

The table includes the member-by-member results of all members contained in the set of mem-
bers. The results list of a set of members ends with the color-highlighted table rows: They show 
the total extremes MAX and MIN of each internal force type in the member set. The extreme 
values are highlighted in bold. The values in the remaining table columns of the respective table 
row represent the internal forces related to the extreme value. 

It is possible to reduce the amount of data in the table by using specific filter functions available 
in the dialog box Table Filter (see chapter 11.5.5, page 487). To open the dialog box, 

select View on the Table menu and click Result Filter 

or use the button in the table toolbar shown on the left. 
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8.11 Cross-sections - Internal Forces 
Table 4.11 shows the internal forces sorted by cross-sections. 

 
Figure 8.31: Table 4.11 Cross-Sections - Internal Forces 

The table's structure is similar to the one of table 4.6 Members - Internal Forces described in 
chapter 8.6. Now, the results are sorted by cross-sections. The descriptions of cross-sections 
remain fixed in the top row of the table so that it is easier to overview results data when scroll-
ing. 

The table includes the member-by-member results of all members that use the relevant cross-
section. The results list for a cross-section ends with the color highlighted table rows: They 
show the total extremes MAX and MIN of each internal force type in the cross-section. The ex-
treme values are highlighted in bold. The values in the remaining table columns of the respec-
tive table row represent the internal forces related to the extreme value. 

It is possible to reduce the amount of data in the table by using specific filter functions available 
in the dialog box Table Filter (see chapter 11.5.5, page 487).  
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8.12 Surfaces - Local Deformations 
To control the graphical display of local surface deformations, tick the check box for Surfaces in 
the Results navigator. Table 4.12 shows the surfaces' local deformations in numerical form. 

For 2D structures RFEM shows only the relevant table columns of deformations. 

 

Figure 8.32: Results navigator: Surfaces → Local Deformations 

 
Figure 8.33: Table 4.12 Surfaces - Local Deformations 

The table shows the displacements and rotations sorted by surfaces. The results are listed in 
reference to the grid points of each surface. 

Grid point 

The numbers of the grid points are listed by surface. They represent the characteristics of any 
surface. Number and arrangement of grid points can be adjusted in the Grid tab of the dialog 
box Edit Surface. 
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Figure 8.34: Dialog box Edit Surface, tab Grid 

In the Grid dialog tab, you can define Grid Type, Grid Parameters and, if necessary, the Grid 
Origin as well as the Direction of Grid Axis 1. The default setting is a Cartesian surface grid with 
uniform Grid distances of 0.5 cm for the grid points in both directions. 

The grid allows for a results output in equidistant, adjustable result points that does not de-
pend on the FE mesh. For small surfaces the grid's standard mesh size of 0.5 m may produce 
only few grid points (or even only one result grid point in the grid origin). Then, count and  
distances of the grid points should be adjusted to the surface size in order to generate more 
grid points. 

When the surface grid is modified, a new calculation of results is not necessary because the 
grid values are interpolated from the result values of the FE nodes. 

The results output in the table is based on the surface results grid. In the work window, both 
the values of FE nodes and grid points can be displayed. To set the display, use the Results nav-
igator: 

 

Figure 8.35: Results navigator: Values on Surfaces → Settings → On grid points or On FE mesh points 
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Context menu of surface 

RFEM numbers the grid points automatically. To display the numbers of grid points in the re-
sults graphics, tick the check box for Numbering in the Results navigator as shown in the figure 
above. 

Grid point coordinates 
Table columns B to D show the coordinates of grid points in the global coordinate system XYZ. 
When you click into a table row, the corresponding grid point is indicated in the work window 
by an arrow. 

Displacements / Rotations 
The deformations have the following meanings: 

u Absolute total displacement (not for result combinations) 

uX Displacement of surface in direction of local axis x 

uY Displacement of surface in direction of local axis y 

uZ Displacement of surface in direction of local axis z 

ϕX Rotation of surface about local axis x 

ϕY Rotation of surface about local axis y 

ϕZ Rotation of surface about local axis z 

Table 8.5: Local surface deformations 

To display the local surface axes, use the context menu or the Display navigator where you  
select Model → Surfaces → Surface Axis Systems x,y,z. 

When you analyze curved surfaces, the surface axes refer to the axes of the finite elements  
(see Figure 8.40, page 308). 
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8.13 Surfaces - Global Deformations 
To control the graphical display of surface displacements and rotations related to the global 
axes X, Y and Z, tick the check box for Global Deformations in the Results navigator. Table 4.13 
shows the global deformations of surfaces in numerical form. 

 
Figure 8.36: Results navigator: Global Deformations 

 
Figure 8.37: Table 4.13 Surfaces - Global Deformations 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
previous results table 4.12 Surfaces - Local Deformations. 

Displacements / Rotations 
The surface deformations have the following meanings: 

u Absolute total displacement (not for result combinations) 

uX Displacement of surface in direction of global axis X 

uY Displacement of surface in direction of global axis Y 

uZ Displacement of surface in direction of global axis Z 

ϕX Rotation of surface about global axis X 

ϕY Rotation of surface about global axis Y 

ϕZ Rotation of surface about global axis Z 

Table 8.6: Global surface deformations 

 



8  Results 

 307 Program RFEM © 2013 Dlubal Software GmbH 

 

8.14 Surfaces - Basic Internal Forces 
To control the graphical display of the basic internal forces, tick the check box for Surfaces in 
the Results navigator, and then select Basic Internal Forces. Table 4.14 shows the basic internal 
forces of surfaces in numerical form. 

 

Figure 8.38: Results navigator: Surfaces → Basic Internal Forces 

 
Figure 8.39: Table 4.14 Surfaces - Basic Internal Forces 

The table shows the basic internal forces sorted by surfaces. The results are listed in reference 
to the grid points of each surface. 

Grid point 
The numbers of the grid points are listed by surface. For more information about grid points, 
see chapter 8.12 on page 304. 

Grid point coordinates 
Table columns B to D show the coordinates of grid points in the global coordinate system XYZ. 
When you click into a table row, the corresponding grid point is indicated in the work window 
by an arrow. 
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Moments / shear forces / axial forces 
In contrast to member internal forces, internal forces of a surface are symbolized by small  
letters. From the integral definition of the bending moments mx and my arises the fact that 
moments are related to the directions of the surface axes where the corresponding normal 
stresses are created. To display the surface axes, use the surface context menu (see Figure 
4.115, page 116). 

When curved surfaces are analyzed, internal forces refer to the local axes of the individual  
finite elements. The axes can be displayed by ticking the corresponding check box in the  
Display navigator: 

 

Figure 8.40: Display navigator: FE Axis Systems x,y,z 

There is a basic difference in understanding internal forces of surfaces and members: A mem-
ber moment My "rotates" about the local member axis y, whereas a surface moment my acts in 
direction of the local surface axis y, that means about the axis x of the surface. 

The following figure explains the definition of basic internal forces of surfaces: 

 

Figure 8.41: Surface internal forces and surface stresses 

Moments as well as shear stresses acting perpendicular to the surface follow a parabolic graph 
across the surface thickness. 
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The signs help you to see on which side of the surface the internal force is available. However, 
signs depend also on the orientation of the global axis Z: If the global Z-axis is directed down-
wards (standard), positive internal forces generate tension stresses on the positive side of the 
surface (that means in direction of the positive surface axis z). They are visualized by blue bars 
in the table. Negative internal forces result in compression stresses on the positive side of the 
surface. They are represented by red bars in the table. 

If the global axis Z is directed upwards, signs of the bending moments and shear forces are in-
verted. 

When the Z-axis is directed downwards, basic internal forces are determined as follows: 

mx 

Bending moment that creates stresses in direction of local axis x 

 

my 

Bending moment that creates stresses in direction of local axis y 

 

mxy 

Torsional moment 

 

vx 

Shear force vx 

 

vy 

Shear force vy 

 

nx 

Axial force in direction of local axis x 

 

ny 

Axial force in direction of local axis y 

 

nxy 

Shear flow 

 

Table 8.7: Basic internal forces 
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8.15 Surfaces - Principal Internal Forces 
To control the graphical display of the principal internal forces, tick the check box for Surfaces 
in the Results navigator, and then select Principal Internal Forces. Table 4.15 shows the principal 
internal forces of surfaces in numerical form. 

 

Figure 8.42: Results navigator: Surfaces → Principal Internal Forces 

 
Figure 8.43: Table 4.15 Surfaces - Principal Internal Forces 

The table shows the principal internal forces sorted by surfaces. The results are listed in refer-
ence to the grid points of each surface. 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
previous results table 4.14 Surfaces - Basic Internal Forces. 

Moments / shear forces / axial forces 
The Basic Internal Forces described in the previous chapter refer to the more or less freely de-
fined coordinate system xyz of a surface. In contrast, Principal Internal Forces represent the  
extreme values of the internal forces in a surface element. For this purpose, the basic internal 
forces are transformed in the directions of both principal axes. The principal axes 1 (maximum 
value) and 2 (minimum value) are arranged orthogonally. 
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The principal internal forces are determined from the basic internal forces: 

m1 

Bending moment in direction of principal axis 1 







 ⋅+−++ 2

xy
2

yxyx m4)mm(mm
2
1

 

m2 

Bending moment in direction of principal axis 2 







 ⋅+−−+ 2

xy
2

yxyx m4)mm(mm
2
1

 

αb 

Angle between local axis x (or y) and principal axis 1 (or 2) 
























−

⋅

yx

xy

mm

m2
arctan

2
1

 

mT,max,b 

Maximum torsional moment 

2

m4)mm( 2
xy

2
yx ⋅+−

 

vmax,b 
Maximum resulting shear force from bending components 

2
y

2
xbmax, vvv +=  

βb 

Angle between principal shear force vmax,b and local axis x 

x

y

v

v
arctan=β  

n1 

Axial force in direction of principal axis 1 







 ⋅+−++ 2

xy
2

yxyx n4)nn(nn
2
1

 

n2 

Axial force in direction of principal axis 2 







 ⋅+−−+ 2

xy
2

yxyx n4)nn(nn
2
1

 

αm 

Angle between axis x and principal axis 1 (for axial force n1) 
























−

⋅

yx

xy
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n2
arctan

2
1

 

vmax,m 

Maximum shear force from membrane components 

2

n4)nn( 2
xy

2
yx ⋅+−

 

Table 8.8: Principal internal forces 
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The directions of the principal axes αb (for bending moments), βb (for shear forces) and αm  
(for axial forces) can be displayed as trajectories in the work window. 

 
Figure 8.44: Trajectories of the principal axes 

In the figure above, the display of angle αb shows also the size of the respective principal mo-
ments because the trajectories are scaled to the values of the moments m1 and m2. 

8.16 Surfaces - Design Internal Forces 
To control the graphical display of the design internal forces, tick the check box for Surfaces in 
the Results navigator, and then select Design Internal Forces. Table 4.16 shows the design inter-
nal forces of surfaces in numerical form. 

 

Figure 8.45: Results navigator: Surfaces → Design Internal Forces 
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Figure 8.46: Table 4.16 Surfaces - Design Internal Forces 

The table shows the design internal forces sorted by surfaces. The results are listed in reference 
to the grid points of each surface. 

Grid point 
The numbers of the grid points are listed by surface. For more information about grid points, 
see chapter 8.12 on page 304. 

Grid point coordinates 
Table columns B to D show the coordinates of grid points in the global coordinate system XYZ. 

Moments / axial forces 
The design moments and axial forces shown in this table are based on the approach described 
in DIN V ENV 1992-1-1, appendix 2, A 2.8 and A 2.9. In this way, RFEM provides users who do 
not have access to the design module RF-CONCRETE Surfaces with a kind of helping tool re-
quired for the manual reinforced concrete design. As the add-on module uses the method by 
BAUMANN, the design internal forces from RFEM are not applied in the module. 

In this context, it is important to keep in mind that the design moments and axial forces of ta-
ble 4.16 must not be combined. As explained in DIN V ENV 1992-1-1, annex 2.8, the moments 
refer exclusively to slab reinforcements. The axial forces are based on the design of wall ele-
ments described in annex 2.9. 



8  Results 

 

 

314 Program RFEM © 2013 Dlubal Software GmbH 

The design internal forces have the following meanings: 

mx,D+ 

Design moment in direction of local axis x on positive side of surface  
(i.e. side in direction of positive surface axis z) 

xyx mm +    for yx mm ≤  and xyx mm −≥  

   for yx mm >  and xyy mm −≥  

0   for yx mm ≤  and xyx mm −<  

y

2
xy

x
m

m
m +    for yx mm >  and xyy mm −<  

my,D+ 

Design moment in direction of local axis y on positive side of surface  
(i.e. side in direction of positive surface axis z) 

xyy mm +    for yx mm ≤  and xyx mm −≥  

   for yx mm >  and xyy mm −≥  

x

2
xy

y m

m
m +    for yx mm ≤  and xyx mm −<  

0   for yx mm >  and xyx mm −<  

mc,D+ 

Design moment for concrete stress design on positive side of surface 

xym2 ⋅−    for yx mm ≤  and xyx mm −≥  

   for yx mm >  and xyy mm −≥  

x

2
xy

x m

m
m −    for yx mm ≤  and xyx mm −<  

y

2
xy

y
m

m
m −   for yx mm >  and xyx mm −<  

mx,D− 

Design moment in direction of axis x on negative side of surface 

xyx mm +−   for yx mm ≤  and xyy mm ≤  

   for yx mm >  and xyx mm ≤  

y

2
xy

x
m

m
m +−   for yx mm ≤  and xyy mm >  

0   for yx mm >  and xyx mm >  
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my,D− 

Design moment in direction of axis y on negative side of surface 

xyy mm +−   for mymx ≤  and xyy mm ≤  

   for yx mm >  and xyx mm ≤  

0   for yx mm ≤  and xyy mm >  

x

2
xy

y m

m
m +−    for yx mm >  and xyx mm >  

mc,D− 

Design moment for concrete stress design on negative side of surface 

xym2 ⋅−    for yx mm ≤  and xyy mm ≤  

   for yx mm >  and xyx mm ≤  

y

2
xy

y
m

m
m −−    for yx mm ≤  and xyy mm >  

x

2
xy

x m

m
m −−   for yx mm >  and xyx mm >  

nx,D 

Design force in direction of local axis x 

xyx nn +   for yx nn ≤  and xyx nn −≥  

   for yx nn >  and xyy nn −≥  

0   for yx nn ≤  and xyx nn −<  

y

2
xy

x
n

n
n +    for yx nn >  and xyy nn −<  

ny,D 

Design force in direction of local axis y 

xyy nn +    for yx nn ≤  and xyx nn −≥  

   for yx nn >  and xyy nn −≥  

x

2
xy

y n

n
n +    for yx nn ≤  and xyx nn −<  

0   for yx nn >  and xyy nn −<  

nc,D 

Design force for concrete stress design 

xyn2 ⋅−   for yx nn ≤  and xyx nn −≥  

   for yx nn >  and xyy nn −≥  

x

2
xy

x n

n
n −−   for yx nn ≤  and xyx nn −<  

y

2
xy

y
n

n
n −−    for yx nn >  and xyy nn −<  

Table 8.9: Design internal forces 
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8.17 Surfaces - Basic Stresses 
To control the graphical display of the basic stresses, tick the check box for Surfaces in the  
Results navigator, and then select Stresses. Table 4.17 shows the basic stresses of surfaces in 
numerical form. 

 

Figure 8.47: Results navigator: Surfaces → Stresses 

 
Figure 8.48: Table 4.17 Surfaces - Basic Stresses 

The table shows the basic stresses sorted by surfaces. The results are listed in reference to the 
grid points of each surface. 
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Context menu of surface 

Grid point 
The numbers of the grid points are listed by surface. For more information about grid points, 
see chapter 8.12 on page 304. 

Grid point coordinates 
Table columns B to D show the coordinates of grid points in the global coordinate system XYZ. 

Basic stresses 
The stresses are related to the directions of the local surface axes. When you analyze curved 
surfaces, they refer to the local axes of the individual finite elements (see Figure 8.40, page 
308). 

The basic stresses are shown in Figure 8.41 on page 308 and have the following meanings: 

σx,+ 

Stress in direction of local axis x on positive side of surface  
(i.e. side in direction of positive surface axis z) 

2
xx

,x
d

m6
d

n ⋅
+=σ +  with  d: thickness of surface 

σy,+ 

Stress in direction of local axis y on positive side of surface  
(i.e. side in direction of positive surface axis z) 

2
yy

,y
d

m6

d

n ⋅
+=σ +  

σx,− 

Stress in direction of axis x on negative side of surface 

2
xx

,x
d

m6

d

n ⋅
−=σ −  

σy,− 

Stress in direction of axis y on negative side of surface 

2
yy

,y
d

m6

d

n ⋅
−=σ −  

τxy,+ 

Torsional stress on positive side of surface 

2
xyxy

,xy
d

m6

d

n ⋅
+=τ +  

τxy,− 

Torsional stress on negative side of surface 

2
xyxy

,xy
d

m6

d

n ⋅
−=τ −  

τxz 

Shear stress orthogonal to surface in direction of axis x 

d2
v3 x

⋅
⋅

   with  d: thickness of surface 

τyz 

Shear stress orthogonal to surface in direction of axis y 

d2

v3 y

⋅

⋅
 

Table 8.10: Basic stresses 
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8.18 Surfaces - Principal Stresses 
To control the graphical display of principal stresses, tick the check box for Surfaces in the  
Results navigator, and then select Stresses (see Figure 8.47, page 316). Table 4.18 shows the 
principal stresses of surfaces in numerical form. 

 
Figure 8.49: Table 4.18 Surfaces - Principal Stresses 

The table shows the principal stresses sorted by surfaces. The results are listed in reference to 
the grid points of each surface. 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the pre-
vious results table 4.17 Surfaces - Basic Stresses. 

Principal stresses 
The basic stresses described in chapter 8.17 refer to the coordinate system xyz of the surface. 
The principal stresses, however, represent the extreme values of the stresses in a surface ele-
ment. The principal axes 1 (maximum value) and 2 (minimum value) are arranged orthogonal-
ly. 

It is possible to display the principal axis orientations α as trajectories in the work window (see 
Figure 8.44, page 312). 
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The principal stresses are determined from the basic stresses: 

σ1,+ 

Stress in direction of principal axis 1 on positive side of surface  
(i.e. side in direction of positive surface axis z) 







 τ⋅+σ−σ+σ+σ=σ ++++++
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,xy
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σ2,+ 

Stress in direction of principal axis 2 on positive side of surface  
(i.e. side in direction of positive surface axis z) 
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α+ 

Angle between local axis x (or y) and principal axis 1 (or 2) for stresses on  
positive side of surface 

( ) ]90,90(,22tana
2
1
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σ1,− 

Stress in direction of principal axis 1 on negative side of surface 







 τ⋅+σ−σ+σ+σ=σ −−−−−−

2
,xy

2
,y,x,y,x,1 4)(
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σ2,− 

Stress in direction of principal axis 2 on negative side of surface 







 τ⋅+σ−σ−σ+σ=σ −−−−−−

2
,xy

2
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2
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α − 

Angle between local axis x (or y) and principal axis 1 (or 2) for stresses on  
negative side of surface 

( ) ]90,90(,22tana
2
1

,y,x,xy °°−∈σ−στ⋅=α −−−−  

σ1,m 

Membrane stress in direction of principal axis 1 







 τ⋅+σ−σ+σ+σ=σ 2

m,xy
2

m,ym,xm,ym,xm,1 4)(
2
1

 

σ2,m 

Membrane stress in direction of principal axis 2 







 τ⋅+σ−σ−σ+σ=σ 2

m,xy
2

m,ym,xm,ym,xm,2 4)(
2
1

 

αm 

Angle between local axis x and principal axis 1 for membrane stresses 

( ) ]90,90(,22tana
2
1

m,ym,xm,xym °°−∈σ−στ⋅=α  

τmax 
Maximum shear stress perpendicular to surface 

2
yz

2
xzmax τ+τ=τ  

Table 8.11: Principal stresses 
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8.19 Surfaces - Other Stresses 
To control the graphical display of stress components due to bending moments and mem-
brane forces, tick the check box for Surfaces in the Results navigator, and then select Stresses 
(see Figure 8.47, page 316). Table 4.19 shows these stresses in numerical form. 

 
Figure 8.50: Table 4.19 Surfaces - Other Stresses 

The table shows the other stresses sorted by surfaces. The results are listed in reference to the 
grid points of each surface. 

Grid point 

The numbers of the grid points are listed by surface. For more information about grid points, 
see chapter 8.12 on page 304. 

Grid point coordinates 
Table columns B to D show the coordinates of grid points in the global coordinate system XYZ. 

Stresses due to bending moments / axial forces 
The stresses are related to the directions of the local surface axes. When you analyze curved 
surfaces, they refer to the axes of the finite elements (see Figure 8.40, page 308). 

The stresses have the following meanings: 

σx,b 

Stress due to bending moment mx 

2
x

b,x
d

m6 ⋅
=σ   with d: thickness of surface 

σy,b 

Stress due to bending moment my 

2
y

b,y
d

m6 ⋅
=σ  

τxy,b 

Stress due to torsional moment mxy 

2
xy

b,xy
d

m6 ⋅
=τ  

σx,m 

Membrane stress due to axial force nx 

d

nx
m,x =σ  
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σy,m 

Membrane stress due to axial force ny 

d

ny
m,y =σ   with d: thickness of surface 

τxy,m 

Membrane stress due to shear flow nxy 

d

nxy
m,xy =τ  

Table 8.12: Other stresses 

8.20 Surfaces - Contact Stresses 
When the model has surface supports (see chapter 4.9, page 104), table 4.20 shows the contact 
stresses ("soil contact pressures") of surfaces in numerical form. To control the graphical display 
of results, tick the check box for Surfaces in the Results navigator, and then select Contact Stresses. 

For 2D-slabs only the table column σz is displayed. 

 

Figure 8.51: Results navigator: Surfaces → Contact Stresses 

 
Figure 8.52: Table 4.20 Surfaces - Contact Stresses 

The table shows the contact stresses sorted by surfaces. The results are listed in reference to 
the grid points of each surface. 
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Context menu of surface 

Grid point 
The numbers of the grid points are listed by surface. For more information about grid points, 
see chapter 8.12 on page 304. 

Grid point coordinates 
Table columns B to D show the coordinates of grid points in the global coordinate system XYZ. 
When you click into a table row, the corresponding grid point is indicated in the work window 
by an arrow, provided that the synchronization of selection is activated (see chapter 11.5.4, 
page 486). 

Contact stresses 
The stresses are related to the directions of the local surface axes. When you analyze curved 
surfaces, they refer to the axes of the finite elements (see Figure 8.40, page 308). 

The contact stresses have the following meanings: 

σz 

Contact stress (“soil pressure”) in direction of surface axis z 

)( yxz σ+σ⋅ν=σ  

  with  σx / σy : stresses in soil 

    ν: Poisson's ratio of soil 

τyz 

Shear stress from surface support 

d2

v3 y
yz ⋅

⋅
=τ   with  d: thickness of surface 

τxz 

Shear stress from surface support 

d2

v3 x
xz ⋅

⋅
=τ  

Table 8.13: Contact stresses 

Positive contact stresses are visualized by blue bars in the table. Accordingly, negative stresses 
are represented by red bars.  

The table shows the stresses as forces per surface passed into the support. Thus, with regard to 
signs, the table does not show the reactions on the part of the support. If the local surface axis 
z is orientated downwards, a load for example acting in direction of the z-axis results in a posi-
tive stress σz. Thus, the signs result from the direction of the surface axis z (see Figure 4.73, 
page 83). 

The orientation of the local surface axis z can be switched quickly for 3D models: Right-click 
the surface to open the surface context menu (see left figure above), and then select the  
option Reverse Local Axis System. Please note, however, that a defined ineffectivity will then 
change the direction of action as well. 
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8.21 Surfaces - Equivalent Stresses - von Mises 
To control the graphical display of equivalent stresses of surfaces, tick the check box for  
Surfaces in the Results navigator, and then select Stresses. Table 4.21 shows the equivalent 
stresses determined according to VON MISES in numerical form. 

 

Figure 8.53: Equivalent stresses in Results navigator: Surfaces → Stresses → σeqv,Mises 

 
Figure 8.54: Table 4.21 Surfaces - Equivalent Stresses - von Mises 

The table shows the equivalent stresses sorted by surfaces. The results are listed in reference  
to the grid points of each surface. 
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Grid point 
The numbers of the grid points are listed by surface. For more information about grid points, 
see chapter 8.12 on page 304. 

Grid point coordinates 
Table columns B to D show the coordinates of grid points in the global coordinate system XYZ. 

Equivalent stresses 
In the Results navigator, four equivalent stress hypotheses for the plane stress condition are 
available for selection. The approach by VON MISES is also called "shape modification hypothesis". 
It is assumed that material fails as soon as the shape modifying energy exceeds a certain limit. 
This energy is the kind of energy that causes distortion or deformation of the object. 

The approach represents the most well-known and frequently used equivalent stress hypothe-
sis. It is appropriate for all materials that are not brittle. Therefore, it is widely used in steel 
building construction. However, the hypothesis is not adequate for hydrostatic stress condi-
tions with equal principal stresses in all directions, as here the equivalent stress is zero. 

The equivalent stresses according to VON MISES for the plane stress conditions have the follow-
ing meanings: 

σeqv,+ 

Equivalent stress on positive side of surface  
(i.e. side in direction of positive surface axis z) 

2
,xy,y,x

2
,y

2
,x,v 3 ++++++ τ⋅+σ⋅σ−σ+σ=σ  

σeqv,− 

Equivalent stress on negative side of surface 

2
,xy,y,x

2
,y

2
,x,v 3 −−−−−− τ⋅+σ⋅σ−σ+σ=σ  

σeqv,m 

Membrane equivalent stress 

2
m,xym,ym,x

2
m,y

2
m,xm,v 3 τ⋅+σ⋅σ−σ+σ=σ  

Table 8.14: Equivalent stresses according to VON MISES 
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8.22 Surfaces - Equivalent Stresses - Tresca 
To control the graphical display of equivalent stresses of surfaces, tick the check box for Sur-
faces in the Results navigator, and then select Stresses (see Figure 8.53, page 323). Table 4.22 
shows the surfaces' equivalent stresses determined according to TRESCA in numerical form. 

 
Figure 8.55: Table 4.22 Surfaces - Equivalent Stresses - Tresca 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
previous results table 4.21 Surfaces - Equivalent Stresses - von Mises. 

The approach by TRESCA is also known as "maximum shear stress theory". It is assumed that 
failure is caused by the maximum shear stress. As this hypothesis is especially applicable for 
brittle materials, it is frequently used in mechanical engineering. 

The equivalent stresses according to TRESCA are determined as follows: 

σeqv,max Maximum of equivalent stress on positive and negative side of surface 

σeqv,+ 

Equivalent stress on positive side of surface 

( )+++++ σσσ−σ=σ ,1,2,2,1,v ;;max
     or 

( ) 





 σστ⋅+σ−σ=σ ++++++ ,1,2

2
,xy

2
,y,x,v ;;4max  

σeqv,− 

Equivalent stress on negative side of surface 

( )−−−−− σσσ−σ=σ ,1,2,2,1,v ;;max
     or 

( ) 





 σστ⋅+σ−σ=σ −−−−−− ,1,2

2
,xy

2
,y,x,v ;;4max  

σeqv,m 

Membrane equivalent stress 

( )m,1m,2m,2m,1m,v ;;max σσσ−σ=σ
    or 

( ) 





 σστ⋅+σ−σ=σ m,1m,2

2
m,xy

2
m,ym,xm,v ;;4max  

Table 8.15: Equivalent stresses according to TRESCA 
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8.23 Surfaces - Equivalent Stresses - Rankine 
To control the graphical display of equivalent stresses of surfaces, tick the check box for Sur-
faces in the Results navigator, and then select Stresses (see Figure 8.53, page 323). Table 4.23 
shows the surfaces' equivalent stresses determined according to RANKINE in numerical form. 

 
Figure 8.56: Table 4.23 Surfaces - Equivalent Stresses - Rankine 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
results table 4.21 Surfaces - Equivalent Stresses - von Mises. 

The equivalent stress hypothesis by RANKINE is also known as "maximum principal stress crite-
rion". It is assumed that failure is caused by the maximum principal stress. 

The equivalent stresses according to RANKINE are determined as follows: 

σeqv,max Maximum of equivalent stress on positive and negative side of surface 

σeqv,+ 

Maximum absolute value of equivalent stress on positive side of surface 

( ) 2
,xy

2
,y,x,y,x,v 4

2
1

2
1

++++++ τ⋅+σ−σ+σ+σ=σ  

σeqv,− 

Maximum absolute value of equivalent stress on negative side of surface 

( ) 2
,xy

2
,y,x,y,x,v 4

2
1

2
1

−−−−−− τ⋅+σ−σ+σ+σ=σ  

σeqv,m 

Maximum absolute value of membrane equivalent stress 

( ) 2
m,xy

2
m,ym,xm,ym,xm,v 4

2
1

2
1

τ⋅+σ−σ+σ+σ=σ  

Table 8.16: Equivalent stresses according to RANKINE 
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8.24 Surfaces - Equivalent Stresses - Bach 
To control the graphical display of equivalent stresses of surfaces, tick the check box for Sur-
faces in the Results navigator, and then select Stresses (see Figure 8.53, page 323). Table 4.24 
shows the surfaces' equivalent stresses determined according to BACH in numerical form. 

 
Figure 8.57: Table 4.24 Surfaces - Equivalent Stresses - Bach 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
results table 4.21 Surfaces - Equivalent Stresses - von Mises. 

The equivalent stress hypothesis by BACH is also called "principal strain criterion". It is assumed 
that the failure occurs in the direction of the greatest strain. The approach is similar to the 
stress determination according to RANKINE described in chapter 8.23. Here, the principal strain 
is used instead of the principal stress. 

The equivalent stresses according to BACH are determined as follows: 

σeqv,max Maximum of equivalent stress on positive and negative side of surface 

σeqv,+ 

Maximum absolute value of equivalent stress on positive side of surface 

( ) 



 σ+σντ⋅+σ−σ

ν+
+σ+σ

ν−
=σ ++++++++ ,y,x

2
,xy

2
,y,x,y,x,v ,4

2
1

2
1

max  

with  ν : Poisson's ratio (see chapter 4.3, page 61) 

σeqv,− 

Maximum absolute value of equivalent stress on negative side of surface 

( ) 



 σ+σντ⋅+σ−σ

ν+
+σ+σ

ν−
=σ −−−−−−−+ ,y,x

2
,xy

2
,y,x,y,x,v ,4

2
1

2
1

max  

σeqv,m 

Maximum absolute value of membrane equivalent stress 

( ) 



 σ+σντ⋅+σ−σ

ν+
+σ+σ

ν−
=σ + m,ym,x

2
m,xy

2
m,ym,xm,ym,x,v ,4

2
1

2
1

max  

Table 8.17: Equivalent stresses according to BACH 
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8.25 Surfaces - Basic Strains 
To control the graphical display of surface strains, tick the check box for Surfaces in the Results 
navigator, and then select Strains. Table 4.25 shows the basic strains of surfaces in numerical 
form. 

 

Figure 8.58: Results navigator: Surfaces → Strains 

 
Figure 8.59: Table 4.25 Surfaces - Basic Strains 
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Context menu of surface 

The table shows the strains sorted by surfaces. The results are listed in reference to the grid 
points of each surface. 

Grid point 
The numbers of the grid points are listed by surface. For more information about grid points, 
see chapter 8.12 on page 304. 

Grid point coordinates 
Table columns B to D show the coordinates of grid points in the global coordinate system XYZ. 

Basic strains 
The strains are related to the directions of the local surface axes. When you analyze curved sur-
faces, they refer to the axes of the finite elements (see Figure 8.40, page 308). 

The basic strains have the following meanings: 

εx,+ 

Strain in direction of local axis x on positive side of surface  
(i.e. side in direction of positive surface axis z) 

x2
d

x
u y

,x ∂

ϕ∂
⋅+

∂
∂

=ε +  with d: thickness of surface 

εy+ 

Strain in direction of local axis y on positive side of surface  
(i.e. side in direction of positive surface axis z) 









∂
ϕ∂

−⋅+
∂
∂

=ε + y2
d

y
v x

,x  

γxy,+ 

Related rotation on positive side of surface 









∂
ϕ∂

−
∂

ϕ∂
⋅+

∂
∂

+
∂
∂

=γ + xy2
d

x
v

y
u xy

,xy  

εx,− 

Strain in direction of axis x on negative side of surface 

x2
d

x
u y

,x ∂

ϕ∂
⋅−

∂
∂

=ε −  

εy,− 

Strain in direction of axis y on negative side of surface 









∂
ϕ∂

−⋅−
∂
∂

=ε − y2
d

y
v x

,x  

γxy,− 

Related rotation on negative side of surface 









∂
ϕ∂

−
∂

ϕ∂
⋅−

∂
∂

+
∂
∂

=γ + xy2
d

x
v

y
u xy

,xy  

Table 8.18: Basic strains 
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8.26 Surfaces - Principal Strains 
To control the graphical display of strains, tick the check box for Surfaces in the Results naviga-
tor, and then select Strains (see Figure 8.58, page 328). Table 4.26 shows the principal strains of 
surfaces in numerical form. 

 
Figure 8.60: Table 4.26 Surfaces - Principal Strains 

The table shows the principal strains sorted by surfaces. The results are listed in reference to 
the grid points of each surface. 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
previous results table 4.25 Surfaces - Basic Strains. 

Principal strains 
The basic strains described in chapter 8.25 refer to the coordinate system xyz of the surface. 
The principal strains, however, represent the extreme values of the strains in a surface element. 
The principal axes 1 (maximum value) and 2 (minimum value) are arranged orthogonally. 

It is possible to display the principal axis orientations α as trajectories in the work window  
(see Figure 8.44, page 312 for principal internal forces). 
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The principal strains have the following meanings: 

ε1,+ 

Strain in direction of principal axis 1 on positive side of surface  
(i.e. side in direction of positive surface axis z) 







 γ+ε−ε+ε+ε=ε ++++++

2
,xy

2
,y,x,y,x,1 )(

2
1

 

ε2+ 

Strain in direction of principal axis 2 on positive side of surface  
(i.e. side in direction of positive surface axis z) 







 γ+ε−ε−ε+ε=ε ++++++

2
,xy

2
,y,x,y,x,2 )(

2
1

 

α+ 

Angle between local axis x (or y) and principal axis 1 (or 2) for strains on  
positive side of surface 


























ε−ε

γ
=α

++

+
+

,y,x

,xyarctan
2
1

 

ε1,− 

Strain in direction of principal axis 1 on negative side of surface 







 γ+ε−ε+ε+ε=ε −−−−−−

2
,xy

2
,y,x,y,x,1 )(

2
1

 

ε2,− 

Strain in direction of principal axis 2 on negative side of surface 







 γ+ε−ε−ε+ε=ε −−−−−−

2
,xy

2
,y,x,y,x,2 )(

2
1

 

α − 

Angle between local axis x (or y) and principal axis 1 (or 2) for stresses on  
negative side of surface 


























ε−ε

γ
=α

−−

−
−

,y,x

,xyarctan
2
1

 

Table 8.19: Principal strains 
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8.27 Surfaces - Maximum Strains 
To control the graphical display for the extreme values of strains, tick the check box for Surfaces 
in the Results navigator, and then select Strains (see Figure 8.58, page 328). Table 4.27 shows 
these strains in numerical form. 

 
Figure 8.61: Table 4.27 Surfaces - Maximum Strains 

The table shows the extreme values of strains sorted by surfaces. The results are listed in refer-
ence to the grid points of each surface. 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
results table 4.25 Surfaces - Basic Strains. 

Maximum strains 
These values represent the extreme values of the strains determined by the equations shown 
in Table 8.19. 

εmax,+ 
Maximum value of strain on positive side of surface (i.e. side in direction of 
positive surface axis z) 

εmin,+ Minimum value of strain on positive side of surface 

|εmax|+ Maximum absolute value of both extreme values on positive side of surface 

εmax,− Maximum value of strain on negative side of surface 

εmin,− Minimum value of strain on negative side of surface 

|εmax|− Maximum absolute value of both extreme values on negative side of surface 

εmax 
Maximum value of strain on positive or negative side of surface  
(columns E and H) 

εmin 
Minimum value of strain on positive or negative side of surface  
(columns F and I) 

|εmax| 
Maximum absolute value of strain on positive or negative side of surface  
(columns K and L) 

Table 8.20: Maximum strains 
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8.28 Surfaces - Strains - von Mises 
To control the graphical display of surface strains available with the equivalent stress hypoth-
esis according to von Mises, tick the check box for Surfaces in the Results navigator, and then 
select Strains. Table 4.28 shows these strains in numerical form. 

 

Figure 8.62: Equivalent strains in the Results navigator: Surfaces → Strains 

 
Figure 8.63: Table 4.28 Surfaces - Strains - von Mises 

The table shows the equivalent strains sorted by surfaces. The results are listed in reference to 
the grid points of each surface. 

Grid point 
The numbers of the grid points are listed by surface. For more information about grid points, 
see chapter 8.12 on page 304. 

Grid point coordinates 
Table columns B to D show the coordinates of grid points in the global coordinate system XYZ. 
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Strains according to VON MISES 
The approaches for the planar condition of strain described in chapters 8.21 to 8.24 are availa-
ble for selection in the Results navigator. The approach by VON MISES is also called "shape modi-
fication hypothesis". It is assumed that material fails as soon as the shape modifying energy 
exceeds a certain limit. This energy is the kind of energy that causes distortion or deformation 
of the object (see chapter 8.21, page 323). 

The strains according to VON MISES for the plane condition of strain have the following meanings: 

ε+,Mises 

Equivalent strain on positive side of surface (i.e. side in direction of positive 
surface axis z) 

( )

( )ν+⋅

γ+








ν−

ε+ε⋅ν
+









ν−

ε⋅ν+ε
+ε−ε

=ε
+

++++
++

+
12

2

3

11
2

,xy

2
,y,x

2
,y,x2

,y,x

 

ε−,Mises 

Equivalent strain on negative side of surface 

( )

( )ν+⋅

γ+








ν−

ε+ε⋅ν
+









ν−

ε⋅ν+ε
+ε−ε

=ε
−

−−−−
−−

−
12

2

3

11
2

,xy

2
,y,x

2
,y,x2

,y,x

 

εMises 
Maximum equivalent strain on positive or negative side of surface  
(columns E and F) 

Table 8.21: Strains according to VON MISES 

8.29 Surfaces - Strains - Tresca 
To control the graphical display of surface strains available with the equivalent stress hypothe-
sis according to TRESCA, tick the check box for Surfaces in the Results navigator, and then select 
Strains (see Figure 8.62, page 333). Table 4.29 shows these strains in numerical form. 

 
Figure 8.64: Table 4.29 Surfaces - Strains - Tresca 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
previous results table 4.28 Surfaces - Strains - von Mises. 

With the approach according to TRESCA it is assumed that failure is caused by the maximum 
shear stress (see chapter 8.22, page 325). 
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The strains according to TRESCA are determined as follows: 

ε+,Tresca 

Equivalent strain on positive side of surface  
(i.e. side in direction of positive surface axis z) 

( )
ν+

γ+ε−ε
=ε

+++
+ 1

2
,xy

2
,y,x  

At the same time, the equivalent strain according to RANKINE is analyzed (see 
following chapter 8.30). If a larger strain is reached with this hypothesis, this 
value is shown in table column E. 

ε−,Tresca 

Equivalent strain on negative side of surface 

( )
ν+

γ+ε−ε
=ε

−−−
− 1

2
,xy

2
,y,x  

If the hypothesis by RANKINE results in a larger equivalent strain, this value is 
shown in column F. 

εTresca 
Maximum equivalent strain on positive or negative side of surface  
(columns E and F) 

Table 8.22: Strains according to TRESCA 

8.30 Surfaces - Strains - Rankine 
To control the graphical display of surface strains available with the equivalent stress hypothe-
sis according to RANKINE, tick the check box for Surfaces in the Results navigator, and then select 
Strains (see Figure 8.62, page 333). Table 4.30 shows these strains in numerical form. 

 
Figure 8.65: Table 4.30 Surfaces - Strains - Rankine 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
results table 4.28 Surfaces - Strains - von Mises. 

With the approach according to RANKINE it is assumed that failure is caused by the maximum 
principal stress (see chapter 8.23, page 326). 
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The strains according to RANKINE are determined as follows: 

ε+,Rankine 

Equivalent strain on positive side of surface (i.e. side in direction of positive 
surface axis z) 

( )
















ν+

γ+ε−ε
+

ν−

ε+ε
=ε

+++++
+ 112

1
2

,xy
2

,y,x,y,x  

ε−,Rankine 

Equivalent strain on negative side of surface 

( )
















ν+

γ+ε−ε
+

ν−

ε+ε
=ε

−−−−−
− 112

1
2

,xy
2

,y,x,y,x  

εRankine 
Maximum equivalent strain on positive or negative side of surface  
(columns E and F) 

Table 8.23: Strains according to RANKINE 

8.31 Surfaces - Strains - Bach 
To control the graphical display of surface strains available with the equivalent stress hypoth-
esis according to BACH, tick the check box for Surfaces in the Results navigator, and then select 
Strains (see Figure 8.62, page 333). Table 4.31 shows these strains in numerical form. 

 
Figure 8.66: Table 4.31 Surfaces - Strains - Bach 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
results table 4.28 Surfaces - Strains - von Mises. 

With the approach according to BACH it is assumed that failure occurs in direction of the maxi-
mum strain (see chapter 8.24, page 327). 

The strains according to BACH are determined as follows: 

ε+,Bach 
Maximum absolute value of principal strain ε1+ or ε2+ on positive side of surface 
(see chapter 8.26, page 331). 

ε−,Bach 
Maximum absolute value of principal strain ε1- or ε2- on negative side of surface 
(i.e. side in opposite direction of positive surface axis z) 

εBach 
Maximum equivalent strain on positive or negative side of surface  
(columns E and F) 

Table 8.24: Strains according to BACH 
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8.32 Solids - Deformations 
To control the graphical display of the deformations for solids, tick the check box for Global  
Deformations in the Results navigator, (see Figure 8.36, page 306). Table 4.32 shows the defor-
mations for the boundary surfaces of solids in numerical form. 

 
Figure 8.67: Table 4.32 Solids - Deformations 

The table shows displacements and rotations for the grid points of the individual boundary 
surfaces. Deformations inside the solid are not shown. 

Grid point 
The numbers of the grid points are listed by surface. For more information about grid points, 
see chapter 8.12 on page 304. 

Grid point coordinates 
Table columns C to E show the coordinates of grid points in the global coordinate system XYZ. 

Displacements / Rotations 
The deformations have the following meanings: 

u Absolute total displacement (not for result combinations) 

uX Displacement of solid in direction of global axis X 

uY Displacement of solid in direction of global axis Y 

uZ Displacement of solid in direction of global axis Z 

ϕX Rotation of solid about global axis X 

ϕY Rotation of solid about global axis Y 

ϕZ Rotation of solid about global axis Z 

Table 8.25: Solid deformations 
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8.33 Solids - Stresses 
To control the graphical display of solid stresses, tick the check box for Solids in the Results nav-
igator. Table 4.33 shows the stresses of solids in numerical form. 

The results in the table refer to the grid points of the boundary surfaces. This means that the 
table does not list any stresses available inside the solid. However, stresses within the solid can 
be represented graphically on the interior FE mesh points: In the Results navigator, tick the 
check box for Values on Surfaces, and then select Settings and On FE mesh points. To display the 
values specifically, use a clipping plane (see chapter 9.9.2, page 375). 

 

Figure 8.68: Results navigator: Solids → Stresses 

 
Figure 8.69: Table 4.33 Solids - Stresses 

The table shows the solid stresses sorted by surfaces. The results are listed in reference to the 
grid points of each surface. 

Grid point 
The numbers of the grid points are listed by surface. For more information about grid points, 
see chapter 8.12 on page 304. 

Grid point coordinates 
Table columns C to E show the coordinates of grid points in the global coordinate system XYZ. 
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Basic stresses / shear stresses / principal stresses 
Unlike surface stresses, solid stresses cannot be described by simple equations. The Basic 
Stresses σx, σy and σz as well as the Shear Stresses τxy, τyz and τxz are determined directly by the 
analysis core. 

If a cube with the edge lengths dx, dy and dz is cut from a 3D object with multiaxial loading, the 
stresses in each cubic surface can be split into normal and shear stresses. If neither spatial force 
nor stress differences on parallel surfaces are considered, the stress condition in the cube's lo-
cal coordinate system can be described by nine stress components. 

 
Figure 8.70: Solid element with stress components 

The matrix of the stress tensor is the following: 



















σττ

τστ

ττσ

=

zzyzx

yzyyx

xzxyx

S  

Equation 8.4: Matrix of stress tensor 

The Principal Stresses σ1, σ2 and σ3 result from the eigenvalues of the tensor according to the 
following formula: 

( ) 0ESdet =σ−  

with E: 3x3 unit matrix 

Equation 8.5: Principal stresses 

The maximum Shear Stress τmax is determined according to Mohr's circle: 

( )31max 2
1

σ−σ=τ  

Equation 8.6: Maximum shear stress 

The trajectories of the principal stresses can be represented graphically by selecting the navi-
gator entry σ123. 



8  Results 

 

 

340 Program RFEM © 2013 Dlubal Software GmbH 

Equivalent stresses 
The Equivalent Stress σeqv according to VON MISES can be expressed by the following homolo-
gous equations:  

( ) ( ) ( )[ ]2
32

2
31

2
21Mises,v 2

1
σ−σ+σ−σ+σ−σ⋅=σ  

Equation 8.7: Equivalent stress from principal stresses according to VON MISES 

( )2
yz

2
xz

2
xyzyzxyx

2
z

2
y

2
xMises,v 3 τ+τ+τ⋅+σσ−σσ−σσ−σ+σ+σ=σ  

Equation 8.8: Equivalent stress from basic stresses according to VON MISES 

For the determination of the Equivalent Stress σeqv according to TRESCA, RFEM analyzes the  
differences from the principal stresses to determine the maximum value out of them. 

( )133221Tresca,v ,,max σ−σσ−σσ−σ=σ  

Equation 8.9: Determination of equivalent stress according to TRESCA 

The Equivalent Stress σeqv according to RANKINE is determined from the maximum absolute  
values of the principal stresses. 

( )321Rankine,v ,,max σσσ=σ  

Equation 8.10: Determination of equivalent stress according to RANKINE 

For the determination of the Equivalent Stress σeqv according to BACH, RFEM analyzes the prin-
cipal stress differences, taking the Poisson's ratio ν into account, to determine the maximum 
value out of them. 

( ) ( ) ( )[ ]213132321Bach,v ,,max σ+σ⋅ν−σσ+σ⋅ν−σσ+σ⋅ν−σ=σ  

Equation 8.11: Determination of equivalent stress according to BACH 
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8.34 Solids - Strains 
To control the graphical display of solid strains, tick the check box for Solids in the Results  
navigator, and then select Strains. Table 4.34 shows these strains in numerical form. 

 

Figure 8.71: Results navigator: Solids → Strains 

 
Figure 8.72: Table 4.34 Solids - Strains 

The table shows the strains sorted by surfaces. The results are listed in reference to the grid 
points of each surface enclosing the solid. 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
previous results table 4.33 Solids - Stresses. 
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Solids - strains 
The strains are directly determined by the analysis core on the basis of the eigenvalues of the 
strain matrix. When the model is analyzed according to linear static or second-order analysis,  
a linear calculation is performed. For a calculation according to large deformation analysis, 
strains are determined by logarithmic approach. 

The equivalent strains are determined according to the four stress hypotheses as follows: 

εMises ( )2
xz

2
yz

2
xyxzzyyx

2
z

2
y

2
xMises 4

3
1

1
γ+γ+γ+εε−εε−εε−ε+ε+ε

ν+
=ε  

εTresca 
Maximum of eigenvalue differences according to matrix R (see Equation 8.12) 

( )133221Tresca RR,RR,RRmax −−−=ε  

εRankine 
Maximum of eigenvalues according to matrix R 

( )321Rankine R,R,Rmax=ε  

εBach 

Maximum of eigenvalue differences by taking into account the Poisson's ratio 
ν according to matrix R 

( ) ( ) ( )[ ]213132321Bach RRR,RRR,RRRmax +⋅ν−+⋅ν−+⋅ν−=ε  

Table 8.26: Equivalent strains 
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Equation 8.12: Matrix R 
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8.35 Solids - Gas Pressure 
To control the graphical display of the gas pressure, tick the check box for Solids in the Results 
navigator, and then select Stresses and Pressure P. Table 4.35 shows the gas pressure of solids in 
numerical form. 

 

Figure 8.73: Results navigator: Solids → Stresses → Pressure P 

 
Figure 8.74: Table 4.35 Solids - Gas Pressure 

The table shows the distribution of pressure sorted by surfaces. The results are listed in refer-
ence to the grid points of each surface enclosing the solid. 

The table columns Grid Point and Grid Point Coordinates correspond to the columns of the  
results table 4.33 Solids - Stresses. 

Gas pressure p 
The gas pressure is a specific type of stress for solids of the type "gas" (see chapter 4.5, page 88). 
It is determined with the functions of state for volume V and temperature T according to the 
following condition: 

const
T
V

p =⋅  

      where  T in [K] related to absolute zero point 

Equation 8.13: State equation for gases 
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9. Results Evaluation 
 

9.1 Available Results 
To open the dialog box showing the available results,  

select Available Results on the Results menu. 

A dialog box with an overview about all calculated load cases and combinations appears. 

 
Figure 9.1: Dialog box Available Results - Settings 

In the list you can see which load cases, load and result combinations were calculated. Any 
reasons for problems that may have occurred during the calculation process are indicated in 
the table column Calculation Errors. To view error details, select the relevant load case and click 
the [Details] button shown on the left. 

To display a particular result in the graphic, select it in the dialog box and click the [Show] but-
ton. You can also double-click the entry. Results that are not required can be deleted by means 
of the button [X]. 

It is also possible to select load cases, load or result combinations in the load case list of the 
main toolbar or the toolbar of the results tables. Results graphic and table display are updated 
automatically if the synchronization of selection is active (see chapter 11.5.4, page 486). 
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9.2 Results Selection 
Use the Results navigator to control the display for deformations, internal forces, stresses, 
strains and/or support reactions as well as sections and smooth ranges, where applicable. 

 
Figure 9.2: Results navigator 

You can also select results by using the Results toolbar. 

 
Figure 9.3: Buttons in the Results toolbar 

To switch the display for the results graphic on and off, use the toolbar button [Show Results] 
shown on the left. To display the result values, use the toolbar button [Show Result Values] to 
the right. 

For results of a result combination (RC) the additional entry Result Combinations is offered in 
the navigator. 

 
Figure 9.4: Results navigator for a result combination 
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You can choose among three options affecting the graphical results display of deformations, 
internal and support forces: The Max- und Min-values can be displayed separately. The option 
Max and Min-values shows both envelopes from all extreme values on the model. 

9.3 Results Display 
The way results are represented is set in the Display navigator. 

 
Figure 9.5: Display navigator: Results 

In the Results navigator, you specify which results are displayed. The Display navigator defines 
the way how results are represented. 
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9.3.1 Member Results 
The internal forces of members are displayed Two-Colored by default. Positive internal forces 
are represented by light blue lines, negative internal forces by red lines. Member deformations 
are shown as single-colored Lines by default. 

The graphical result diagram is controlled by the number entered into the input field Number 
of divisions of members for Result diagrams in the dialog tab Global Calculation Parameters of the 
Calculation Parameters dialog box (see Figure 7.22, page 271). If a division of 10 is set, RFEM di-
vides the length of the longest member in the system by 10. With the system-related division 
length RFEM determines for each member the graphical result distributions on the division 
points. 

If the member internal forces are represented with colors using either the display option With 
Diagram or Without Diagram, the colors for the graphical results are assigned according to the 
spectrum shown in the control panel. Find notes for adjusting value and color spectra in chap-
ter 3.4.6 on page 29. 

The internal forces can also be displayed as Cross-Sections: A photorealistic representation of 
members appears showing color-coordinated diagrams of internal forces on the rendered 
members. 

Analogously, you can display the deformation of Cross-Sections (3D rendering of deformation) 
or Cross-Sections Colored (rendering of deformation with color gradation). 

 
Figure 9.6: Scaled imaging of member deformations in 3D rendering 
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Stresses 
in solids 

9.3.2 Surface and Solid Results 
The results of surfaces and solids are displayed as Isobands by default. The color assignment is 
managed in the control panel (see chapter 3.4.6, page 29). 

Furthermore, the Display navigator offers various display options for surface and solid results 
by selecting Results and Type of Display. 

 

Figure 9.7: Display navigator: Results → Type of Display 

The results of surfaces and solids can be displayed as Isobands or Isolines. Often, isolines prove 
to be useful for output by a monochrome printer. 

The display option Without graphic representation allows for an output of pure result values: 
Isobands or isolines are hidden so that only the result values on the grid or FE mesh points are 
displayed. This setting is also appropriate for printing. 

The display option Differences is only available for stresses. With this setting, you can see the 
stress changes in the finite elements, which makes it possible to draw conclusions concerning 
the quality of the FE mesh: If there are significant differences in adjacent FE elements, you 
should think about a FE mesh refinement on these locations. 

You can select the option Solid FE Nodes to evaluate the stresses inside a solid provided that 
the FE mesh is fine enough. The color assignment of FE nodes follows the spectrum of the con-
trol panel. If you additionally activate Values in the FE mesh points in the Results navigator, you 
can directly see the solid stresses displayed on the model.  

You can control the scaling of deformations and internal forces by settings in the control panel 
tab Factors (middle). The Filter tab (right) is used for a specific selection of members, surfaces  
or solids whose results you want to display (see Figure 9.51, page 378). Both panel tabs are de-
scribed in chapter 3.4.6, page 31. 
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Criteria for nonlinear material properties 

When a material model with nonlinear effects has been selected (see chapter 4.3, page 61), 
you can graphically check which areas are affected by reduced stiffnesses for example when 
reaching the yield strength. Please note that you can use this option only if the add-on module 
RF-MAT NL is licensed. 

The results display option Is nonlinear shows the portion of GAUSS points that were nonlinearly 
analyzed at least once during the analysis. With the Yield Criterion you can for example find out 
which yielding zones are arising above the supports of a plate. 

 

Figure 9.8: Yield criterion of a plate with yielding zones 

Load distribution 

By ticking the check boxes under the navigator entry Distribution of load, you can display the 
forces and moments received by FE Nodes or FE Elements from the entered loads. The forces of 
the finite elements can be represented in relation to the global axis system XYZ or the local 
surface axes xyz. 

 

Figure 9.9: Load distribution with mesh loads for line load (FZ) and surface load (pZ) 
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Using mesh loads makes it possible to check the entered loads. For example for free concen-
trated loads you can check whether the load acts on all surfaces specified in the list On Surfaces 
(see Figure 6.31, page 234). 

9.4 Value Display 
The display of values is managed in the Results navigator (see chapter 3.4.3, page 25). 

9.4.1 Result Values 
The navigator category Values controls the result values displayed in the work window. 

 
Figure 9.10: Results navigator: Values on Surfaces → Values 

Values of results graphic 
The first option (m-1 in the figure above) is aligned with the result type that is displayed in the 
work window. When the selection field is active, RFEM displays the result values of the current 
deformation graphic, stress graphic or graphic of internal forces. 

Values groups 
With the option Groups it is possible to show two result values for each location for the surface 
results. Four groups are preset. The following figure shows the first group with the principal 
moments m1 and m2. The arranged grid values are rotated about the angle αb. 

 
Figure 9.11: Value group of principal moments in the graphic 
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It is also possible to create user-defined groups of values: Right-click the navigator item Groups 
to open the context menu shown on the left. Select New Values Group to open the following 
dialog box. 

 
Figure 9.12: Dialog box New Values Group 

First, define the Group Name that appears as item in the navigator later. In the dialog section 
Values in Group, you can select the result types from the lists 1st Value, 2nd Value and 3rd Value. 
The rotation of the values is specified in the fields Rotated by α. 

Specific result values 
You can use the selection field Specific to determine the result values (deformations, internal 
forces, stresses, strains) you want to display, irrespective of the result type active in the work 
window. Thus, you can display data simultaneously, for example providing the deformations 
of a surface graphically and displaying the values of the principal internal forces m1 and m2 as 
shown on the left. 

9.4.2 Settings 
The display options available under the navigator entry Settings control the design locations of 
the result values and their representation. 

 

Figure 9.13: Results navigator: Values on Surfaces → Settings 
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Extreme values 
If the option Extreme Values is selected, only the respective minima or maxima, depending on 
the setting, are displayed. 

Grid points / FE mesh points 
In addition, result values can be displayed either On grid and user-defined points or On FE mesh 
points. Be careful with using the last mentioned option because importing all FE result values 
takes time for larger models. 

Symbols / numbering / transparent 
The final three check boxes listed under Settings control the type and extent of the labeling. 

• The Symbols of the set result type (u, mx, σz etc.) are shown, too. 

• The Numbering of grid points or FE mesh nodes (G1, M1 etc.) can be displayed additionally. 

• The values can be displayed in Transparent mode, i.e. without frame and background. 

To adjust colors and fonts of the result values, 

point to Display Properties on the Options menu, and then select Edit. 

A dialog box with global settings for Display Properties opens. Select Result Values in the Results 
category, and then click Result Values on Surfaces to specify your settings. 

 

Figure 9.14: Dialog box Display Properties: category Results → Result Values → Result Values on Surfaces 
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9.4.3 User-defined Result Values 

Grid values 
Grid points represent an attribute of the surface. Therefore, number and arrangement of grid 
points can be adjusted in the Grid tab of the dialog box Edit Surface. The results output in tables 
is based on the result grid for surfaces. In the graphic, both the values of FE nodes as well as of 
grid points can be displayed. 

For more information about grid points, see chapter 8.12 on page 304. 

Graphic values 
In the work window, you can set result values on any location of the model. If the results dis-
play is active, you can access the function in the following way: 

Select Set Result Values Manually on the Results menu 

or use the toolbar button shown on the left (see Figure 9.15). 

 
Figure 9.15: Function Set Result Values Manually in the Results toolbar 

When you move the mouse across a surface, result values appear for the current position of 
the mouse pointer. Now, the result values can be placed by mouse click on the relevant loca-
tions. 

A manually placed value can be deleted easily: Select the value by mouse click, and then press 
the [Del] key on your keyboard. For a multiple selection, keep the [Ctrl] key pressed or draw a 
window across the values that you want to select. 

To access the context menu of result values, right-click one of the values. The menu contains 
specific display and filter functions for the graphical evaluation. 

 
Figure 9.16: Context menu of result values 
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With the context menu function Result Values Filter (see figure above) you can define precise 
specifications for the result values to be displayed. To open the corresponding dialog box, 

point to Display Options on the Results menu 

where you select the corresponding entry. The following dialog box for entering filter criteria 
appears. 

 
Figure 9.17: Dialog box Value Display Filter 

In the list Show Values According to Magnitude, you can define limits for the result values in  
the table columns from and to. Values that are beyond these ranges will not be shown in the 
graphics later. 

Search criteria for local extreme values 
To control the output of graphical extreme values for surfaces, 

point to Display Options on the Results menu, and then select Search Criteria for Local 
Extreme Values 

or use the context menu of the Results navigator entry Of All Local Extremal Values. 

 
Figure 9.18: Dialog box Search Criteria for Local Extreme Values 

In the first input field, you specify the percentage by which a result value is considered to be a 
local peak. Then, the difference from global maximum and global minimum of all active sur-
faces is multiplied by the specified value. The lower the threshold is, the more local extreme 
values will be displayed. 

In the second input field, you can define how many finite elements generated around a point 
you want to apply for the analysis of extreme values. The higher the number is, the more local 
extreme values will be displayed. 
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9.4.4 Object Info 
For member and surface results you can access a special output function. To open the corre-
sponding dialog box, 

select Info About Object on the Tools menu 

or use the toolbar button shown on the left. 

 

Figure 9.19: Dialog box Info About Surface 

An Info window appears. When you move the pointer across a surface, a member or a solid, the 
window informs you about the object data (material, thickness, cross-section etc.) as well as 
deformation values, internal forces or stresses on the current pointer position. 

For evaluating surface results we recommend to activate the representation type Solid Trans-
parent. 
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9.5 Result Diagrams 
The result diagram makes it possible to see the result distribution of objects in detail: 

• Section 
• Member 
• Set of members 
• Line 
• Line support 

First, select the object(s) in the work window (multiple selection by holding down the [Ctrl] key). 
Then, to access the corresponding function, 

select Result Diagrams for Selected Sections/Members/Sets of Members/Lines/Line Supports 
on the Results menu 

or use the context menu of the corresponding object. For members and sets of members, the 
toolbar button shown on the left is additionally available. 

A new window opens showing the result diagrams of the selected object. 

 
Figure 9.20: Dialog box Result Diagram in Section 

The Results navigator on the left manages the deformations, internal forces, stresses, strains or 
support forces appearing in the result diagram. Use the list in the toolbar to choose a particular 
load case, load combination or result combination. 

In the result diagrams for members, the numbers of the selected members are listed in the up-
per left corner of the window. It is also possible to enter member numbers manually into the in-
put field Member No. In this way, you can extend, reduce or completely reorganize the selection. 

When you move the mouse along the line or member selected in the result diagram, you can 
see the "moving" result values for the current x-location. The location x is related to the line or 
member start and is indicated in the upper right corner of the window. It is also possible to en-
ter a specific location x manually into the input field. The check box Fixed pins the pointer to 
the indicated location. 

In the right window section, the result values are listed numerically, representing results on 
edge nodes as well as on locations of the extreme values and division points. The latter corre-
spond to the FE mesh nodes or member divisions according to specifications set in the tab 
Global Calculation Parameters of the Calculation Parameters dialog box (see Figure 7.22, page 
271). In case of lines separating two surfaces from each other, the window shows the surface 
results of both sides. 
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The buttons in the toolbar User operations, in particular the smoothing options for support 
forces, lines or sections, help you to evaluate results for civil engineering purposes. 

 
Figure 9.21: Floating toolbar User operations 

The buttons have the following meanings:  

Button Function 

 Prints result diagrams 

 Removes all displayed result diagrams 

 Maximizes result diagrams 

 Minimizes result diagrams 

 Access to control parameters shown in Figure 9.22 

 Saves smoothed result diagrams  

 Opens dialog box Export table (see Figure 11.126, page 489) 

 Shows member results with or without rib components 

 Switches on and off result diagram over column area 

 Reverses direction x of member 

 Switches on and off ordinates with maximum values 

 Switches on and off display of average values 

 Opens dialog box for defining smooth ranges (see Figure 9.36, page 366) 

 Switches on and off display of smooth ranges 

Table 9.1: Buttons of toolbar User operations 

Use the button [Result Diagram Settings] to open a dialog box offering several options to ad-
just the Result Diagram window. 

 
Figure 9.22: Dialog box Result Diagram Settings 
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9.6 Sections 
You can create user-defined sections in RFEM by defining a plane slicing through the model. 
With the help of sections it is possible to evaluate in detail results that are available on the 
plane lines intersecting surfaces and solids. Sections are managed as independent objects in 
the tabs of the Project Navigator. 

To generate a new section, 

select Section on the Insert menu 

or use the corresponding context menu in the Data navigator. 

 
Figure 9.23: Data navigator: context menu of Sections 

A dialog box opens where you can define the section parameters. 

9.6.1 Section Through Surface 

 
Figure 9.24: Dialog box New Section for surface 
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In addition to the No. of the section, you have to enter the Section Name that ensures a reliable 
assignment when evaluating results. All sections are stored under Sections in the Data naviga-
tor where they can be adjusted subsequently. Entering number and name is unnecessary if the 
check box Save section is cleared in the dialog section Options. 

When you create a Section Through a Surface, you can see the surface-specific parameters dis-
played in the dialog sections Section Type and Projection Direction as well as the corresponding 
graphics to the right. 

The Section Type can be created as Plane slicing the model. As an alternative, you can cut with 
the section along any line in the model. The line number can be entered manually or deter-
mined with the [] function in the work window. 

The Edge Points of Section must be specified by the global coordinates XYZ of both points A 
and B. You can also select them graphically by using the [] function. To select free points 
(which means no nodes) in the work plane, adjust the current work plane, where necessary. 

Starting from points A and B, two straight lines are "drawn" in the projection direction. If the 
lines intersect a surface contained in the list On surfaces No., the result diagram will be displayed 
along the connecting line of both intersection points. In case several surfaces are cut by the pro-
jection plane, result diagrams will be displayed for each of these surfaces. 

In addition to the global Projection Directions in X, Y and Z, it is possible to define a vector. With 
the [] function you can select two points in the work window to define the vector. 

The dialog section Show Result Diagram in Plane defines the surface plane in which the section 
will be represented. The setting affects only the work window (see Figure 9.27, page 361) but 
not the dialog box Result Diagram (Figure 9.25). 

The dialog section On surfaces No. lists the numbers of surfaces on which the cutting lines are 
displayed. This option is useful if the section plane intersects with several surfaces. You can se-
lect relevant surfaces also graphically by using the [] function. 

Use the three check boxes in the dialog section Options to decide whether the result diagrams 
are displayed as a dialog box (Figure 9.25) after clicking [OK] and if you want to Save the section. 
When you tick the check box for Show values on isolines, isolines will be labeled automatically in 
the work window. 

When the dialog input is complete, click [OK]. Usually, the Result Diagram dialog box appear 
(see following figure). 
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Figure 9.25: Dialog box Result Diagram in Section 

When you move the mouse in the diagram along the section, you can see the "moving" result 
values for the current x-location. The location x is related to the section start A and indicated in 
the upper right corner of the window. It is also possible to enter a specific location x manually 
into the input field. The check box Fixed pins the pointer to the indicated location. 

Use the list in the toolbar to switch between the individual sections. 

The buttons of the dialog box Result Diagram are described in chapter 9.5 on page 357. 

With the button shown on the left, you can switch on and off the sections in the work window. 
You can also use the Results navigator which additionally allows you to select specific sections 
among the sections that have been saved. 

The Display navigator offers global setting options for representing sections. 

 
Figure 9.26: Display navigator for representation of sections 

 



9  Results Evaluation 

 361 Program RFEM © 2013 Dlubal Software GmbH 

 

The following figure shows a section through a plane and a curved surface that are both cut by 
the section plane. For this graphic display, the Sections option Result Diagrams Filled has been 
ticked in the Display navigator. 

 
Figure 9.27: Section display of axial forces n-2 on RFEM model 

9.6.2 Section Through Solid 

 
Figure 9.28: Dialog box New Section for solid 

Similar to a section through surfaces, enter No. and Section Name if you want to Save the sec-
tion (see dialog section Options). 

When you create a Section Through a Solid, you can see the solid-specific parameters displayed 
in the dialog sections Section Type and Display Result Diagrams as well as the corresponding 
graphics to the right. 
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When the section cuts through a solid, you can generate a section line running through the  
object. Then, results are displayed like for surfaces in the dialog box Result Diagram (see Figure 
9.25, page 360). Alternatively, results can be represented in the work window On the boundary 
surfaces of solid intersected by the plane. The option On sectional area of solid in graphics shows 
the results directly in the section plane. 

The Edge Points of Section must be entered as described for surfaces, but you can select them 
also graphically. 

Starting from points A and B, two straight lines are "drawn" in direction of the Vector. If the 
lines intersect a solid contained in the list On solids No., results will be displayed along the con-
necting line of both intersection points, respectively as section plane between the straight 
lines. In case several solids are cut by the projection plane, result diagrams will be displayed for 
each of these solids. 

The Vector defines the projection direction of the section. With the [] function you can select 
two points in the work window to define the vector. 

9.7 Smoothing Results 
The FE analysis determines the results for each FE mesh node. Usually, a continuous distribu-
tion of the internal force or deformation is preferable for the graphic. For this purpose, it is 
necessary to smooth the results, for example by interpolation. 

The following smoothing options are available for surfaces and solids: 

• Constant on elements 

• Non continuous 

• Continuous within surfaces/solids 

• Continuous total 

In addition, it is possible to define smooth ranges for result diagrams (see Figure 9.36, page 366). 

9.7.1 Work Window 
The Display navigator controls the results smoothing influencing the work window. 

 
Figure 9.29: Display navigator: Results → Surfaces or Solids → Distribution of Internal Forces/Stresses 
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Example 
An example shows you the effects of the different smoothing options. 

A steel plate with the dimensions 3 m · 3 m and a thickness of 3 cm is supported on two lines 
with pinned supports facing each other. The plate is not modeled by one complete surface but 
by two surfaces with the same properties laying side by side. The local z-axes of both surfaces 
are orientated in opposite directions. 

 
Figure 9.30: Steel plate – modeled with two surfaces 

The size of the FE length has been generously set to 1 m. This element size cannot provide  
appropriate results. It is only used to demonstrate the result representations of the different 
smoothing modes. 

The steel surface is stressed only by its self-weight. 

Distribution of internal forces Constant on Elements 

 
Figure 9.31: Distribution of internal forces Constant on Elements (Display nav.), values On FE mesh points (Results nav.) 

The values of the FE nodes are averaged and the result is displayed in the centre of each  
element. The distribution in each finite element is constant. This type of results display is  
recommended for plastic material models (see chapter 4.3, page 61). 
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Distribution of internal forces Non Continuous 

 
Figure 9.32: Distribution of internal forces Non Continuous, values On FE mesh points 

The display shows the FE node values resulting from the displacements and rotations of each 
single element. Therefore, several values are displayed for each FE node. A dotted line on the 
node value indicates the element to which the value belongs. 

For the graphic display, a plane is defined by the corner values of every element. As the results 
of adjacent elements are not taken into account, you see a discontinuous distribution. 

Distribution of internal forces Continuous within Surfaces/Solids 

 
Figure 9.33: Distribution of internal forces Continuous within Surfaces, values On FE mesh points 

The values on the FE nodes are averaged. Averaging stops on the surface boundary which may 
result in discontinuities between adjacent surfaces. However, this is absolutely correct in our 
example. At the boundary line, two FE node values are displayed. 

This smoothing option is set by default because in most cases it provides the best results. 
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Distribution of internal forces Continuous Total 

 
Figure 9.34: Distribution of internal forces Continuous Total, values On FE mesh points 

The average values are determined by considering the FE values beyond the surface bounda-
ries. This leads to a continuous distribution between adjoining surfaces, which is not correct 
for our example. 

The following requirements must be met to apply this results display correctly: 

• The orientation of the surface axis systems is congruent. 
• Only two surfaces concur. 
• The surfaces lie in one single plane. 
• No line release has been defined on the boundary line. 

If one of these conditions is not given, an incorrect distribution of results is displayed. 

Distribution of internal forces Continuously by groups 
In addition, it is possible to smooth results by groups. RFEM provides Generated groups with 
similar material properties. 

Moreover, it is possible to create user-defined groups of surfaces or solids by using the navi-
gator context menu (right-click on User Groups). 

 
Figure 9.35: Create New Averaging Group via the navigator context menu 

Then a dialog box opens where you can define the objects that you want to examine as a group. 
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9.7.2 Result Diagrams 
In the Result Diagram dialog box (see chapter 9.5, page 356), you can create smooth ranges to 
prepare results for civil engineering purposes. To use this function, click the diagram toolbar 
button shown on the left. The following dialog box opens: 

 
Figure 9.36: Dialog box Smooth Ranges of Result Diagrams 

In the table columns on the left, define the Smooth Ranges. Please note that entries for Start, 
End and Length are interactive. Each range can be separately set to Active. In the dialog section 
Use for Results to the right, you decide for which deformations and internal forces you want to 
apply a smoothing.  

The smoothing can be defined as Constant distribution (as shown in the figure above) or as 
Linear for all smooth ranges. 
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9.7.3 Average Region 
It is possible to define a region in the model where the graphical results won't be displayed 
with the actual distributions but as average value. This average region allows for an evaluation 
of the averaged surface internal forces and stresses. Regions are managed as independent ob-
jects in the tabs of the Project Navigator. 

To create an average region, 

select New Average Region on the Results menu 

or use the corresponding context menu in the Data navigator. 

 
Figure 9.37: Data navigator: context menu of Average Regions 

A dialog box opens where you can specify the parameters of the region. 

 
Figure 9.38: Dialog box New Region for Average Results 

In addition to the No. you have to enter the Description of the region, making the selection eas-
ier when you evaluate results. The regions are stored under Average Regions in the Data navi-
gator where they can be adjusted subsequently. 

 



9  Results Evaluation 

 

 

368 Program RFEM © 2013 Dlubal Software GmbH 

The dialog section On Surfaces No. lists the numbers of the surfaces for which you want to av-
erage results. This option is useful if the region's projection intersects with several surfaces. 
You can select relevant surfaces also graphically by using the [] function. 

The Form of the region can be defined as rectangle, circle or ellipse. The respective parameters 
are shown in the dialog graphic to the right. 

In the dialog section Center, specify the center point C of the region. The coordinates can be  
entered manually or selected graphically in the work window by using the [] function. The 
Dimensions describe the shape of the region by means of parameters relevant for your settings. 

In the dialog section Average Results in, you can decide whether you want to average results in 
relation to both surface axes or if averaging refers only to one of the local axes. 

The dialog section Projection in Direction describes the reference of the defined region to the 
surfaces. Generally, the projection is set perpendicular to the selected surfaces, but global pro-
jection directions in X, Y and Z are also possible as well as entering any projection vectors. With 
the [] function you can select two points in the work window to define the vector. 

Finally, the dialog box provides an option to Set result values over the entire region to zero. In 
this way, it is possible to disable the result values in a selected zone of the model. 

In the Results navigator, you can display and hide average regions individually or globally. 

9.8 Multiple Windows View 
On the screen, several windows showing different deformations or internal forces can be dis-
played together. To open the corresponding dialog box, 

select Arrange Results Window on the Results menu 

or use the toolbar button shown on the left. 

A dialog box with a navigator tree opens where you can tick the result types that you want to 
be displayed in the single windows. 

 
Figure 9.39: Dialog box Show Results in Multiple Windows 

The multiple windows display can also be used for the printout (see chapter 10.2.1, page 406). 

 

 

 

 

 
Control of regions 

in Results navigator 
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9.9 Filter Results 
Various filter functions are available which are especially useful in case of complex models for 
evaluating and documenting results. 

9.9.1 Views 
User-defined views (angles of view, zoom settings etc.) make the results evaluation easier. By 
using "visibilities" you can subdivide the model into user-defined and generated partial views 
fulfilling certain criteria. Thus, it is possible to activate for example only the surfaces of a plane 
or members with a particular cross-section for the display. Of course, you can use these possi-
bilities for both evaluation of results and input of model or load data. 

You can access the different functions in an independent navigator (chapter 9.9.1.1) and by 
using list buttons or menu functions (chapter 9.9.1.2). 

9.9.1.1 Views Navigator 
The Views tab of the Project Navigator allows you to create user-defined views of the model 
which you can use for input and evaluation. The tab manages also the visibilities which can be 
user-defined or automatically created. 

 
Figure 9.40: Tab Views of Navigator 
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User-defined views 
In contrast to object-oriented Visibilities (see below), User-defined views allow you to save and 
import particular viewing angles, zoomed views as well as settings in the Display navigator. 

The currently set view will be saved as display setting - no matter which filter specifications are 
effective in the Visibilities list: RFEM uses always the current visibilities settings for the object 
representation of a User-defined view. A user-defined view manages only the viewing angle, 
the zoom factor and the specifications set in the Display navigator. 

Use the [View] buttons to quickly set the following standard angles of view: 

 View against axis X 

 View against axis Y 

 View against axis Z 

     View in direction or against axis U of work plane (see chapter 11.3.1, page 434) 

     View in direction or against axis V of work plane 

     View in direction or against axis W of work plane 

Table 9.2: [View] buttons 

The buttons below the Views list have the following functions: 

 Creates a new User-defined view from current view (see Figure 9.41) 

 Redefines the active User-defined view by current view 

 Restores the active User-defined view after modifications 

 Deletes the entry selected in the list User-defined views 

 Deletes all User-defined views 

Table 9.3: Buttons in the navigator section User-defined views 

Creating user-defined views 

The currently set view can be saved by using the [New] button shown on the left. A dialog box 
appears where you have to enter the Name of the new display setting. 

 
Figure 9.41: Dialog box New User-Defined View 
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Visibilities 
With the so-called "visibilities" it is possible to display partial views of the model or groups of 
objects such as surfaces lying in one plane or columns of a particular story. 

Visibility buttons 

The buttons above the Visibilities list (see Figure 9.40, page 369) allow you to select the objects 
for representation by particular criteria. The buttons have the following functions: 

 Displays objects selected in work window as partial view 

 Hides objects selected in work window 

 Creates a visibility by drawing a window (see page 373) 

 Defines a new visibility by means of object numbers (see page 373) 

 Restores previous visibility 

 Reverses current display (new visibility: hidden objects) 

 Quits visibility mode. All objects are displayed again. 

Table 9.4: Buttons above Visibilities list 

The Visibilities list contains user-defined and generated visibilities. 

User-defined visibilities 

With the graphical or numerical selection of objects (see chapter 11.2, page 430) you can create 
a visibility. 

Use the button [Create New User-Defined Visibility] (below the Visibilities list) to save the cur-
rent partial view. The dialog box New User-Defined Visibility opens where you define a name 
and the Group (see Figure 9.45, page 374). 

The buttons below the Visibilities list have the following functions: 

 The dialog box New User-Defined Visibility appears (see Figure 9.45, page 374). 

 Adds objects selected in work window to group marked in list above (see page 374) 

 
Removes objects selected in work window from group marked in list above  
(see page 374) 

 Reassigns selected objects to group marked above 

 Reverses current display (new visibility: hidden objects) 

 Shows all objects activated in Visibilities list 

 Shows only objects available in each active Visibilities entry 

 Shows objects available in each active Group 

Table 9.5: Buttons below Visibilities list 
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With the check box Add new objects into visibility you can decide how you want to treat new 
nodes, lines, members etc. when you work in a user-defined visibility. If the option is ticked, 
you can define the relevant group in the list below. 

A color symbol is automatically assigned to each user-defined visibility. The colors can be used 
as well in the Display navigator for graphical representation of objects (see chapter 11.1.9, 
page 428). In this way, you can detect the customized visibilities quickly in the model. To set 
the display for groups, use the Views navigator. 

Generated visibilities 

RFEM generates automatically visibilities for surfaces, lines, members etc. according to particu-
lar criteria. 

 
Figure 9.42: Generated visibilities in Views navigator 

These generated visibility types help you to get a quick overview about the model as you can 
take the list to filter objects specifically. In this way, you can easily check both input and results 
in RFEM.  

In addition to the multiple selection of generated views (default), the list allows for creating an 
intersecting set. Use the navigator buttons shown on the left to set the intersection. You find 
them below the list. The functions are described in Table 9.5 above. 

With the check box User-defined / generated on the top of the list you can decide if the filter 
function is effective for the work window. All objects will be displayed again after removing 
the check mark. 
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9.9.1.2 Visibility Buttons and Menu 

To access the different visibility functions, 

point to Visibility on the View menu 

or use the corresponding list button of the pull-down menu in the toolbar. 

 
Figure 9.43: List buttons for Visibility 

Visibility by window 
Partial views can be created graphically by using the mouse and drawing a window. 

When you open the window from the left to the right, the visibility includes only objects that 
are completely contained within the window. When opening the window from the right to the 
left, the visibility additionally includes objects that are cut by the window. 

Visibility by numbering 
Enter the numbers of Nodes, Lines, Members, Surfaces or Solids that are relevant for the visibility 
in a dialog box. 

 
Figure 9.44: Dialog box Visibility by Numbering 

Cancel visibility mode 
Use this function to restore the view of all objects. 
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Create a user-defined visibility 
Before you access the function, select the objects that you want to save as Visibility in the work 
window (see chapter 11.2.1, page 430 and chapter 11.2.2, page 433). The following selection 
function is useful: Point to Select on the Edit menu, and then select Special. 

Only the objects that are selected in the work window will be integrated in a Visibility. There-
fore, when you use the function [Visibility by Hiding Selected Objects], you have to select the 
displayed objects once again by drawing a window across them. 

After a click on the [New] button shown on the left the following dialog box appears. 

 
Figure 9.45: Dialog box New User-Defined Visibility 

Define the Name and Group. If you want to use more visibility groups, click the [New] button to 
create another group. 

 
Figure 9.46: Dialog box New Group for Visibilities 

Click the [OK] button to save the group of objects as new visibility. 

The user-defined visibilities are managed in the Views navigator where they can be switched 
on and off individually (see Figure 9.40, page 369). 

Change objects in visibilities 
Objects can be integrated subsequently into existing visibilities: Quit the visibility mode by 
clicking the button shown on the left. You can also point to Visibility on the View menu where 
you select Cancel Visibility Mode. Now, select the objects that you want to add. 

In the Views navigator, click the relevant entry in the User-defined list . RFEM enables the but-
ton [+] so that you can integrate the selected objects into the user-defined visibility. 

In the same way, you can use the [-] button to remove selected objects from a user-defined  
visibility. 

Click the button [=] to overwrite the objects available in the marked visibility of the Views nav-
igator with the selection in the work window. Thus, existing visibilities can be redefined but 
the name is kept. 
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Transparency for hidden objects 
When you use visibilities, it is possible to display hidden objects with minor intensity in the 
background. The degree of visibility is set individually in the Graphics tab of the dialog box 
Program Options (see Figure 9.52, page 379). 

The display of background objects can be turned on and off in the Display navigator. 

 

Figure 9.47: Display navigator: Option General → Show Hidden Objects in Background 

9.9.2 Clipping Plane 
You can define any section plane cutting through the model. The zone in front of (or behind) 
the plane will be hidden in the display. In this way, it is possible for example to look at the re-
sults in an intersection or in a solid. 

RFEM places the clipping plane through the center of the geometric total dimensions. Thus, 
the plane is related to the model geometry. In the work window, the clipping plane is enclosed 
by a frame. 

It is not possible to save a clipping plane. 

To access the corresponding function, 

select Clipping Plane on the Insert menu. 

The following dialog box appears: 

 
Figure 9.48: Dialog box Clipping Plane 
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You can arrange the Plane parallel to one of the planes spanned by the axes of the global co-
ordinate system XYZ. In addition, you can place the plane into the current work plane. You can 
also select three points in the work window by clicking the [] button shown on the left. 

The value entered into the input field Offset results in a parallel displacement of the plane in 
direction of the positive or negative axis that is perpendicular to the plane. Both directions are 
indicated by gray arrows in the work window. The offset can be entered directly or set with the 
spin box. The input field Step controls the interval of spacings by which the plane is shifted 
every time you click a button of the spin box. 

In the dialog section Options, you have the possibility to change the active side of the clipping 
plane. Moreover, you can switch on and off the result diagrams available on the clipping bor-
ders. 

Furthermore, it is possible to rotate the clipping plane by a Rotation about the angle α (about 
the last named axis of the plane) and angle β (about the first named axis). The graphic is inter-
active with the input. 

When the dialog box Clipping Plane is open, you can use all edit and view functions in the work 
window, but there is no printout option. Quit the function with the [Close] button. 

The following example shows a clipping plane running through a node of a pipe connection. 

 
Figure 9.49: Clipping plane cutting through a pipe connection 
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Settings in Display navigator for 
multi-color member results 

9.9.3 Filter Functions 
The grouping options described in chapter 9.9.1 Views refer to the objects of the model. Addi-
tionally, you can use internal forces, deformations and stresses as filter criteria.  

Filtering results 
Results are filtered by means of the control panel. If the panel is not displayed, 

select Control Panel (Color Scale, Factors, Filter) on the View menu 

or use the toolbar button shown on the left. 

The control panel is described in chapter 3.4.6 on page 29. 

The filter settings for results are defined in the Color Spectrum tab that is shown for the isoband 
and isoline results of surfaces and solids (see Figure 3.17, page 29). As the tab is not available 
for the two-colored display of member internal forces, you have to switch to the Display navi-
gator and set the display options With/Without Diagram or Cross-Sections (see figure shown on 
the left). 

In the panel it is possible to set specific displays, for example member moments displayed only 
if they exceed a particular value, or base internal forces of surfaces using a fine gradation 
shown within the range of ± 30 kNm (see Figure 3.19, page 31). 

The following example represents a floor slab. RFEM displays contact stresses only between  
-120 kN/m2 and -260 kN/m2 on the model. 

 
Figure 9.50: Filtering contact stresses with adjusted color spectrum 

As the model provides also multi-colored member results, the selection field Surfaces is set ac-
tive in the control panel. Furthermore, the color spectrum is modified in such a way that a col-
or range covers exactly -20 kN/m2. No results for surface elements with elastic foundations 
whose contact stresses are beyond the defined range of values are shown. 
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Filtering objects 
In the Filter tab of the control panel, you can enter the numbers of selected members, surfaces 
or solids to display their result diagrams in a filtered display. The function is described in chap-
ter 3.4.6 on page 32. 

In contrast to the visibility function, the model is completely displayed in the graphic. 

The following figure shows the bending moments available in the floor surfaces of a building. 
The walls are shown in the model but displayed without internal forces. 

 
Figure 9.51: Filtering surfaces: bending moments of floors 

The filter settings of the panel also affect the objects in the results tables: When you restrict the 
results display in the panel to for example two members, table 4.6 Members - Internal Forces 
will list only the results of those two members. 

9.10 Animation of Deformations 
Normally, deformations of objects are displayed in their final state. 

But it is also possible to show the deformation process in motion. To open the corresponding 
dialog box, 

select Animation on the Results menu 

or click the corresponding button in the toolbar. To close the animated view, click the button 
again. You can also use the [Esc] key. 

To define detailed settings for the animation process, use the Program Options dialog box. 

Select Program Options on the Options menu, 

and then open the dialog tab Graphics. 

 

 

 

 

 



9  Results Evaluation 

 379 Program RFEM © 2013 Dlubal Software GmbH 

 

   

 

 
Figure 9.52: Dialog box Program Options, tab Graphics 

The animation of deformations can be saved as video file. Set the animated graphic appropri-
ately on the screen, and then select 

Create Video File on the Tools menu. 

You may see a message about OpenGL settings before the corresponding dialog box appears 
where you can define different settings for creating the video file. 

 
Figure 9.53: Dialog box Create Video File 

Click the [Browse] button to define the name of the video file in a separate dialog box. 

The red button [Record] starts the recording, and the blue button [Stop] stops it. 
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10.  Printout 
 

10.1 Printout Report 
Normally, input and results data of RFEM are not sent directly to the printer. Instead, a so-called 
printout report is generated first to which you can add graphics, explanations, scans and other 
elements. In the printout report you define the data that will finally appear in the printout. 

It is possible to create several printout reports for the model. When your structure is quite 
complex, it is recommended to split data into several small reports instead of creating a single 
report that is rather comprehensive. For example, you can create a report for input data, an-
other one for support forces and one for surface results. In this way, you can reduce time of 
waiting. 

It is also possible to create different printout reports in an RFEM model. Depending on the re-
quired data, the test engineer and the design engineer may receive different printout reports. 

A printout report can only be called up if a default printer has been installed in Windows. The 
preview in the printout report uses the printer driver. 

10.1.1 Create or Open Printout Report 
To create a new printout report 

select Open Printout Report on the File menu 

or use the toolbar button shown on the left. You can also use the context menu of the corre-
sponding entry in the Data navigator. 

 
Figure 10.1: Button and context menu of Printout Report 

The following dialog box appears: 

 
Figure 10.2: Dialog box New Printout Report 
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The No. of the report is preset but can be changed. In the input field Description, you can enter 
a name for the report making the selection in the lists easier later. This description does not 
show up in the printout. 

Furthermore, you can select a particular report template from the list in the dialog section 
Printout Report Template (see chapter 10.1.7, page 396). 

The buttons in the dialog box have the following functions: 

 
A new report template can be created. 

 
The selection of the report can be edited ( chapter 10.1.3, page 384). 

Table 10.1: Buttons in the dialog box New Printout Report 

When a printout report is already available, and you select Open Printout Report on the File 
menu, the Printout Report Manager appears. 

 
Figure 10.3: Dialog box Printout Report Manager 

You can select the relevant report from the list. 

The buttons in the dialog box have the following functions: 

 
Creates a new printout report 

 
Deletes selected printout report 

Table 10.2: Buttons in the dialog box Printout Report Manager 
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10.1.2 Working in the Printout Report 

 
Figure 10.4: Printout report with context menu 

When the printout report is open, you see the report navigator on the left. On the right, the 
page view with the preview of the printout is presented. 

The individual chapters of the report can be shifted anywhere in the navigator by using the 
drag-and-drop function. 

Context menu 
The context menu offers additional options for adjusting the printout report. As common for 
Windows applications, multiple selections are possible by using the [Ctrl] or [Shift] key. 

Remove from printout report 

The selected chapter will be deleted. If you want to reinsert it, use the selection: Click Selection 
on the Edit menu to open a dialog box where you can choose data for display in the printout 
report. 

Start with a new page 

The selected chapter starts on a new page. It is marked by a red pin in the navigator (like chap-
ter Results - Summary shown in the figure above). 

Selection 

You have access to the global selection that is described on the following pages. The selected 
chapter is preset. 

Properties 

Some general properties of the selected chapter can be modified. 
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Figure 10.5: Dialog box Properties 

It is possible to change the Title of the chapter and to enter an Additional Explanation which 
will appear in the left margin of the report. The additional text can be enabled and disabled for 
display like the info pictures of the chapter (for example drawings of cross-sections or loading).  

Navigation in the printout report 
To look at a particular section in the printout report, click the corresponding chapter entry in 
the navigator. 

The View menu provides further functions for navigation. You can also use the buttons in the 
report toolbar to access the corresponding function. 

 Go to previous page in the page preview 

 Go to next page 

 Go to first page in the page preview 

 Go to last page 

 Specify the number of a particular page in a dialog box. 

 Zoom in 

 Zoom out 

 List button for Zoom to adjust display size 

 Grab mode: Use the mouse for navigation within the report. 

 Select mode: Select and edit chapters by mouse click. 

Table 10.3: Navigation buttons in the toolbar of the printout report 
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10.1.3 Define Contents of Printout Report 
In the global selection, you can select the chapters that you want to appear in the printout re-
port. To access the corresponding function, 

select Selection on the Edit menu 

or use the toolbar button shown on the left. You can also use the context menu of the Printout 
Report navigator item. 

 
Figure 10.6: Open the global selection via the Printout Report context menu 

The following dialog box appears: 

 
Figure 10.7: Dialog box Printout Report Selection, tab Global Selection 

The list in the dialog section Program / Modules contains all add-on modules where input data 
is available. When a program is selected in the list, you can choose the chapters to be printed 
in the tabs to the right. 

The Global Selection tab manages the main chapters of the report. If you clear the selection of a 
check box, the corresponding detail tab disappears as well. 

Use the three check boxes in the dialog section Display (bottom left) to decide if a Cover sheet, 
a table of Contents and small Info pictures will be displayed in the report margin. 
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10.1.3.1 Selecting Model Data 

 
Figure 10.8: Dialog box Printout Report Selection, tab Model Data 

With the check boxes in the Display column you decide which chapters appear in the printout 
report. 

For some tables you find subchapters. When you click for example into the table field 1.13 
Cross-Sections, the button [...] is enabled and you can open another dialog box where it is pos-
sible to select sections for which also cross-section details will be shown. To define the types 
and amount of details, use the [Details] button shown on the left. 

 
Figure 10.9: Dialog box Printout Report Selection - Cross-Section Details 

The printout report is based on the input tables described in chapter 4. With the check boxes 
in the third column All you decide if all rows of the selected table will be included in the print-
out. When a check box is cleared, you can specify the numbers of selected objects (table rows) 
in the column Number Selection. 
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Again, it is recommended to use the button [...] becoming available at the end of the input 
field because in this way you can select nodes, lines, surfaces, members, sets of members, 
openings and solids graphically in the work window. For the remaining objects a list with table 
rows appears. 

10.1.3.2 Selecting Load Data 

 
Figure 10.10: Dialog box Printout Report Selection, tab Loads 

Tables are selected as described in the previous chapter 10.1.3.1. 

Additional selection options are available in this tab: In the dialog section Load Cases to Display, 
you can decide whether the input data of All or only of particular load cases will appear in the 
printout. When the selection field Selected is activated, you can use the enabled [Details] button 
to open a new dialog box where you can select the load cases. 

 
Figure 10.11: Selection of load cases 
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10.1.3.3 Selecting Results Data  

 
Figure 10.12: Dialog box Printout Report Selection, tab LC/CO Results 

Selecting results data which is usually comprehensive is done in two dialog tabs: The tab 
LC/CO Results manages the selection for load cases and load combinations, the tab RC Results 
controls the printout for the results of result combinations. 

Results data can be prepared like load data (see previous chapter 10.1.3.2): Use the selection 
field Selected to restrict the printout data to results of particular load cases or combinations. In 
the dialog section Tables to Display, you can select the tables and table rows as described in 
chapter 10.1.3.1. The column Number Selection allows you to specify particular objects or to se-
lect objects graphically by means of the button [...] that you can access at the end of the table 
row. 

In the Table column, you see some table rows showing three dots at the end of the row. The 
dots indicate the button [...] that you can activate by clicking into the table row.  Use this but-
ton to access more selection criteria, for example for member internal forces. 

 
Figure 10.13: Dialog box Details - Internal Forces by Member 
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The printout report lists the results of each member on the following locations: 

• Start and end node 

• Division points according to defined member division (see chapter 4.16, page 136) 

• Extreme values (Max/Min) of results (see chapter 8.6, page 296) 

The selection is connected with the Table Filter settings (see Figure 11.122, page 487). 

You can considerably reduce the printout extent by restricting output data to results that are 
indispensable for your documentation. 

10.1.3.4 Selecting Data of Add-on Modules 
All module data for printing is also managed in the RFEM printout report. You can summarize  
it together with the RFEM data in a single report, or you organize it in separate printout reports. 
For complex structural systems with a high number of design cases, it is recommended to split 
data into several printout reports which makes data arrangement clearer. 

 

Figure 10.14: Dialog box Printout Report Selection, tab Global Selection of add-on module RF-CONCRETE Members 

In addition to RFEM, the list in the dialog section Program / Modules contains all additional 
modules where entries have been made. When you select a module in the list, you can choose 
the chapters for printing in the tabs to the right. 

The dialog tab Global Selection manages the main chapters of the add-on module data. When 
you clear a check box, the respective detail tab disappears as well. 

In the dialog section Cases to Display, the option Display all cases is ticked by default. If you 
want to include only particular design cases in the printout report, clear the check box. Now, 
you can move the cases that you do not need from the list Cases to Display to the list Existing 
cases. 

The selection in the detail tabs of input data and results is similar to the selection described in 
chapters 10.1.3.1 Selecting Model Data and 10.1.3.3 Selecting Results Data . 
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10.1.4 Adjust Printout Report Header 
During the program installation a printout report header is created from the customer data.  
To change specifications, 

select Header on the Settings menu in the printout report 

or use the toolbar button in the printout report shown on the left. 

 

Figure 10.15: Button Header Setup 

The following dialog box appears: 

 
Figure 10.16: Dialog box Printout Report Header 

 



10  Printout 

 

 

390 Program RFEM © 2013 Dlubal Software GmbH 

 

Header default setting 
In case several report headers are available, you can select the appropriate header in the list. 

Furthermore, you can use the button [Header Library] to access different report headers. In 
addition, you can create, modify or delete headers in the library. 

 
Figure 10.17: Dialog box Header Library 

The buttons in the Header Library have the following meanings: 

 
A new header is created. Enter the specifications in another dialog box whose 
structure is similar to the one of the Header dialog box (see Figure 10.16). 

 
It is possible to edit the properties of the selected printout report header. 

 
The header that is selected in the list will be deleted. 

Table 10.4: Buttons of the dialog box Header Library 

The headers of the printout report are normally stored in the file DlubalProtocolConfigNew.cfg 
that you find in the general master data folder C:\ProgramData\Dlubal\Global\General Data. The 
file won’t be overwritten during an update. Nevertheless, saving a backup file may be useful. 

Display 
Settings in this dialog section determine the header elements or the page layout shown. 

The option Info row below header activates and deactivates the display of project and model 
data, with or without date (see below). The project description is taken from the project's gen-
eral data filed in the Project Manager (see chapter 12.1.1, page 546). The model description is 
taken from the base data of the model (see chapter 12.2, page 554). It is possible to adjust the 
default specifications for the printout in the dialog sections Change Project Name/Description 
and Change Model Name/Description (see below). 

The Footer can be switched on and off as well as the Black circles in the points of intersection of 
boundary line with header and footer line. 

Date 
RFEM provides automatic default settings and a User-defined specification option for display-
ing the date in the printout report header. 

Page and sheet numbering 
If Page and Sheet have the same initial numbers and the Display check boxes are ticked, there 
is no difference in numbering. But if you want to assign several pages to a sheet, it is possible 
to enter detailed specifications for the numbering by means of the [Settings] button shown on 
the left. 
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Figure 10.18: Dialog box Page and Sheet Numbering 

Use this dialog box to decide if a Prefix is applied in front of the Page numbering. The prefix 
may be an abbreviation that is defined by chapter, indicating for example all model data in the 
numbering by a prefixed "MO". In addition, you can decide if the End number is included, for 
example "Page: MO3/25". 

Use the two check boxes Automatically increasing in the dialog sections to the right to define a 
continuous numbering. Moreover, you can specify the First number for the page and sheet 
numbering. The table column Result shows the result of all specifications dynamically. 

Company address 
This dialog section of the dialog box Printout Report Header contains information from custom-
er data that can be adjusted. A separate input field is available for each of the three rows of the 
report header. Use the [A] button shown on the left to change font and font size. The Align-
ment of rows can also be defined separately. 

The left zone in the header is reserved for the company logo. The image must be available in a 
bitmap file format (MS Paint for example saves graphics as *.bmp). 

To save the modified settings, click the button [Set Header as default] at the bottom of the dia-
log box. The dialog box Header Template Name opens where you have to enter a description. 
Then, the new report header will appear as Header Default on the top of the printout. 

 
Figure 10.19: Dialog box Header Template Name 

Change project/model name/description 
In both dialog sections, the project and the model name including user-defined descriptions 
are preset. To modify the presettings, tick the check boxes in front of the relevant name. In this 
way, the input fields become accessible for new entries that appear in the printout later. 
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10.1.5 Insert RFEM Graphics 
Every picture displayed in the work window can be integrated into the printout report. Fur-
thermore, it is possible to include result diagrams of sections, members and line supports as 
well as cross-section details in the report by using the [Print] button in the respective dialog 
boxes. 

To print the currently displayed graphic,  

select Print Graphic on the File menu 

or use the toolbar button shown on the left. 

 
Figure 10.20: Button Print Graphic in the toolbar of the work window 

 
Figure 10.21: Button Print in the toolbar of the Result Diagram window 

The following dialog box appears: 

 
Figure 10.22: Dialog box Graphic Printout, tab General 

Graphic picture 
In the dialog section Graphic Picture, select the option To a printout report. If several printout 
reports are available, you can select the number of the target report in the list to the right. 
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Options 

Lock graphic picture 

Standard of RFEM is the generation of dynamic graphics: When model or results are modified, 
the graphics in the printout report will be updated automatically. If problems of performance 
occur in the report because of the graphics, you can stop the dynamic adjustment by ticking 
the check box for Lock graphic picture (without update) in the dialog section Options. 

Of course, it is possible to unlock a graphic in the printout report: Right-click the graphic item 
in the report navigator to open its context menu (see Figure 10.4, page 382). Select Properties 
to access again the dialog box Graphic Printout for the picture. You can also mark the graphic 
in the report navigator and select Chapter Properties on the Edit menu. 

The lock buttons in the toolbar of the printout report provide more functions to classify 
graphics as static or dynamic (see Figure 10.4, page 382). The buttons have the following  
functions: 

 Refreshes all graphics 

 Unlocks all graphics which can then be updated dynamically 

 Locks all graphics which are then fixed in the printout report 

Table 10.5: Graphic buttons in the printout report 

Show printout report on [OK] 

Normally, when closing the dialog box with [OK], the printout report opens so that you can 
check the print results. This may be annoying, for example when you want to take several 
graphics one after the other to the printout report. After clearing the check box, it is possible 
to print pictures without waiting time for the creation of the printout report.  

The remaining functions and tabs of the dialog box Graphic Printout are explained in chapter 
10.2 on page 404. 
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10.1.6 Insert Graphics and Texts 
External graphics and texts can be integrated as well into the printout report of RFEM. 

Graphics 
To insert a picture that is not an RFEM graphic, you need to open the graphic file in an image 
editor first (for example MS Paint). Then, copy it to the clipboard with the keyboard keys 
[Ctrl]+[C]. 

To insert the graphic from the clipboard into the printout report, 

select Image from Clipboard on the Insert menu. 

You have to enter a chapter name for the new graphic before it is inserted. 

 
Figure 10.23: Dialog box Insert image from the Clipboard 

The graphic will appear as a single chapter in the printout report. 

Texts 
Short user-defined notes can also be added to the printout report. To open the corresponding 
dialog box, 

select Text Block on the Insert menu. 

 
Figure 10.24: Dialog box Import Text 

Enter the Title and the Text in the dialog box. After clicking [OK] the chapter will be inserted at 
the end of the printout report. Then, you can use the drag-and-drop function to move the 
chapter to an appropriate place in the printout report. 

In the selection mode (see Table 10.3, page 383) you can modify the text subsequently by 
double-click. Alternatively, right-click the header in the report navigator, and then select  
Properties in the context menu. 
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Text and RTF files 
It is possible to integrate text files available in ASCII format as well as formatted RTF files in-
cluding embedded graphics into the printout report. Thus, you can save recurring texts in files 
to use them in the report. 

Moreover, this function allows you to integrate analysis data from other design programs into 
the printout report, provided that the results are available in ASCII or RTF format. 

To insert text and RTF files, 

select Text File on the Insert menu. 

First, the Windows dialog box Open appears where you can select the file. After clicking the 
[Open] button, the chapter will be added to the end of the printout report. Then, you can use 
the drag-and-drop function to move the chapter to an appropriate place in the printout report. 

In the selection mode (see Table 10.3, page 383) you can modify the text subsequently by 
right-click. The dialog box Import Text appears for user-defined adjustments. 

 
Figure 10.25: Dialog box Import Text 
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10.1.7 Printout Report Template 
The selection described in chapter 10.1.3 is rather time-consuming. It is possible to save such  
a selection including graphics as template which you can use also for other models. Creating 
printout reports becomes more efficient on the basis of templates. 

An existing printout report can be saved as template, too. 

Create a new template 
To define a new template, 

point to Printout Report Template on the Settings menu of the printout report,  
and then select New or 

point to Printout Report Template on the Settings menu of the printout report,  
and then select New from Current Printout Report. 

New 

First, the selection dialog box described in chapter 10.1.3 on page 384 opens. 

Use the tabs to select the chapters that you want to print. When the selection is complete,  
click [OK] and enter a Description for the new report template. 

 
Figure 10.26: Dialog box New Printout Report Template 

New from current printout report 

The selection of the currently shown printout report is used for the new template. Enter the 
Description of the new report template in the dialog box (see Figure 10.26). 

Apply a template 
When a printout report is already open, you can apply the selected contents of a template to 
the current report. To open the corresponding dialog box, 

select Printout Report Template on the Settings menu, and then click Select. 

A dialog box opens where you can select the template from the list Available Printout Report 
Templates. 

 
Figure 10.27: Dialog box Printout Report Template 

Details to the buttons in this dialog box can be found in Table 10.6. 

After confirming the dialog box and the subsequent security query, the current selection will 
be overwritten by the template. 
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Now, when you create a new printout report, you can select a template from the list Printout 
Report Template to apply specific settings to the new report. 

 
Figure 10.28: Dialog box New Printout Report with list of templates 

Managing templates 
All templates are managed in the dialog box Printout Report Template. To open the dialog box, 

select Printout Report Template on the Settings menu, and then click Select. 

The dialog box shown in Figure 10.27 appears. The functions of the buttons are enabled only 
for user-defined templates. 

 The name of the selected template can be changed. 

 The selected template will be deleted. 

Table 10.6: Buttons in the dialog box Printout Report Template 

The printout report templates are stored in the file RfemProtocolConfig.cfg that can be found 
in the master data folder for RFEM 5 C:\ ProgramData\Dlubal\RFEM 5.xx\General Data. This file 
won’t be overwritten during an update. Nevertheless, saving a backup file may be useful. 

10.1.8 Adjust Layout 
The layout of a printout report can be adjusted concerning its fonts and font colors as well as 
its margin settings and table design. 

To open the dialog box where you can edit the page layout, 

select Page on the Settings menu in the printout report or 

use the toolbar button in the printout report shown on the left. 

 
Figure 10.29: Dialog box Page Setup 
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The default fonts for table contents and table headers are relatively small. However, you 
should be careful with changing the Arial default settings: Larger fonts do not always fit in  
the columns. 

The layout settings also apply to the printout reports of the RFEM add-on modules. 

10.1.9 Create Cover 
The printout report can be provided with a cover sheet. To open the dialog box where you can 
enter the cover data, 

select Cover on the Settings menu in the printout report or 

use the toolbar button in the printout report shown on the left. 

 
Figure 10.30: Dialog box Cover Sheet 

When the input is complete, click [OK] to create the cover in the report. 
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Figure 10.31: Cover sheet in the printout report 

The contents of the cover sheet can be modified once again by a double-click in the selection 
mode (see Table 10.3, page 383). Alternatively, right-click the cover sheet in the report naviga-
tor and select Properties in the context menu. 
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10.1.10 Print the Printout Report 
To start the printing process, 

select Print on the File menu in the printout report 

or use the button in the printout report toolbar shown on the left. 

 
Figure 10.32: Button Print Printout Report 

The dialog box for the printer set by default in Windows opens. Select the printer and determine 
the pages that you want to print. 

 
Figure 10.33: Dialog box Print 

If you choose another printer than the default printer, the page break and therefore the page 
numbers printed on the paper might be different from the print preview in RFEM. 

When you select the option Print to file, you can create a print file in PRN format that can be 
sent to the printer via the copy command. 

10.1.11 Export Printout Report 
The printout report can be exported in different file formats. It is also possible to export it  
directly to VCmaster. 

RTF export 
All common word processing programs support the RTF file format. To export the printout  
report including graphics as RTF document, 

select Export to RTF on the File menu. 

The Windows dialog box Save As opens: 
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Figure 10.34: Dialog box Save As 

Enter the storage location and the file name. If you tick the check box for Export selected blocks 
only, only the chapter(s) previously selected in the navigator will be exported instead of the 
entire report. 

PDF export 
The PDF print device integrated in RFEM makes it possible to put out report data in a PDF file. 
To open the corresponding dialog box, 

select Export to PDF on the File menu. 

The Windows dialog box Save As opens (see Figure 10.34) where you enter the storage location 
and the file name. In the dialog section Description below, you can enter notes for the PDF file. 

Moreover, the PDF file is created with bookmarks facilitating the navigation in the digital doc-
ument.  

VCmaster export 
VCmaster from the VEIT CHRISTOPH company (formerly BauText) is a word processing program 
with specific extras for structural calculations. 

To start the direct export to VCmaster, 

select Export to RTF on the File menu 

or use the button [Export to VCmaster] in the printout report toolbar shown on the left. 

The dialog box shown in Figure 10.34 appears where you have to tick the check box for Direct 
Export to Program VCmaster. 

It is not necessary to enter a file name, but VCmaster should run in the background. To start the 
import module of VCmaster, click [OK]. 
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10.1.12 Language Settings 
The language in the printout report can be set independently of the language that is used in 
the graphical user interface of RFEM. Thus, you can create for example a German or Italian 
printout report when you are working with the English program version. 

Changing the language for printout 
To change the language used in the printout report, 

select Language on the Settings menu of the printout report. 

A dialog box opens where you can select the report language from the list. 

 
Figure 10.35: Dialog box Languages 

Adding a language to the list 
The expressions used in the printout report are stored in strings. Thus, adding new languages 
is rather easy. 

First, open the dialog box Languages by 

selecting Language on the Settings menu of the printout report. 

In the lower part of the dialog box (Figure 10.35), you see some buttons used to manage the 
languages. 

Create a new language 

Click the button shown on the left to open the dialog box below. Specify the Name of the new 
language and select the Language group from the list so that the character set will be inter-
preted correctly. 

 
Figure 10.36: Dialog box Create New Language 
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Click [OK] to confirm the dialog box. The new language is now available in the list Existing  
Languages. 

 
Figure 10.37: Dialog box Languages, button Edit Selected Language 

Use the [Edit] button to enter the strings of the new language. 

 
Figure 10.38: Dialog box Edit Printout Report Texts 

Only user-defined languages can be edited. 
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Copy a language 

 
Figure 10.39: Dialog box Languages, button Create New Language via Copy 

This function is similar to the creation of a new language. The difference is that you do not  
create an "empty" language column (see Figure 10.38, column Basque) since the terms of the 
selected language are already preset. 

Rename or delete a language 

Use the remaining buttons of the Languages dialog box to rename or delete a language. The 
two functions cannot be accessed for the preset default languages but only for user-defined 
languages. 

10.2 Direct Graphic Printout 
Every graphic of the work window can be printed immediately without embedding it in the 
printout report (see chapter 10.1.5, page 392). Result diagrams of sections, members, sets of 
members, lines and line supports as well as cross-section details can also be sent directly to the 
printer by using the [Print] button offered in the respective windows. 

To print the currently displayed graphic directly, 

select Print Graphic on the File menu 

or use the toolbar button shown on the left. 

 
Figure 10.40: Button Print Graphic in the toolbar of the main window 

 
Figure 10.41: Button Print in the toolbar of the Result Diagram window 

A dialog box with several tabs appears which are described in the following chapters. 
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10.2.1 General 

 
Figure 10.42: Dialog box Graphic Printout, tab General 

Graphic picture 
You have three options for graphical output: You can send the picture 

• directly to a printer 

• to a printout report (see chapter 10.1.5, page 392) 

• to the clipboard. 

The Clipboard makes the graphic available to other programs where it can usually be imported 
by selecting Insert on the Edit menu. 

The option Directly to a printer results in the direct printout. It is possible to adjust the printout 
report header directly by using the button [Edit Printout Header] that opens the dialog box 
Printout Report Header (see chapter 10.1.4, page 389). 

Window to print 
The dialog section Window To Print is used for defining the printout settings of multiple win-
dows views. Select Current only to print the graphic of the window that is currently active (for 
example the right window in Figure 10.43). 

Please note when printing several graphic windows (see chapter 9.8, page 368) that you can 
only print graphics of one and the same model. A cross-model printout is not possible. 
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Figure 10.43: Display with two windows of same model 

Select More to enable the button [Edit Window Arrangement] that opens a dialog box with 
control options for the print arrangement of graphics. 

 
Figure 10.44: Dialog box Window Arrangement 

Select As on Current Screen to arrange the windows on the printout sheet according to the pro-
portions displayed on the screen. Then, the overall picture on the page will usually be wider 
than high − as it is presented on the screen. Select Page Filling to use the entire sheet size for 
the display of the windows. 

With the Mass print option you can transfer default graphics simultaneously to the printout  
report. After selecting this option, a new dialog appears where you can define the parameters 
(see chapter 10.2.4, page 411). 

Graphic size 
The dialog section in the upper right corner of the dialog box Graphic Printout (Figure 10.42) 
manages the image scale of the graphic on the sheet.  

If you want to use the same image size as displayed on the monitor, select As screen view.  
Take advantage of this option to print zoomed areas or special views. 

The option Window filling prints the overall graphic on the sheet. The currently set angle of 
view is used to represent the whole model in the specified graphic picture size (see next dialog 
section). 
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With the option To scale the graphic will be printed with the scale that is selected in the list or 
entered manually into the input field. Again, the currently set angle of view is used. A perspec-
tive view is not suitable for the scale printout. 

Graphic picture size and rotation 
Settings in this dialog section define the size of the graphic on the sheet. 

If the check box for Use whole page width is ticked, the left margin beyond the vertical separa-
tion line is additionally used for the graphic as shown in the figure below. 

 

Figure 10.45: Graphic printout in landscape format: result of options All windows and Use whole page width 

If you don't want to use the complete page size for the graphic, you can define the Height of 
the graphic area in percentage. 

The rotation angle in the input field Rotation rotates the graphic for the printout. 

Options 
This dialog section is irrelevant for the direct printout of a work window graphic. 

When printing result diagrams, you can use the check box for Show results for selected x-location 
in result diagram to decide if values appearing on the position of the vertical line will be printed 
(see Figure 9.20, page 356). 

Header of graphic picture 
When you open the dialog box Graphic Printout, a title is preset for the graphic. It can be modi-
fied in the input field. 
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10.2.2 Options 

 
Figure 10.46: Dialog box Graphic Printout, tab Options 

Script / Symbols 
In most cases, it is not necessary to change the default settings in both dialog sections. For 
printing with plotters using large formats, however, you have to adjust the factors (see chapter 
10.2.5, page 413). 

The size of font and graphic symbols (nodes, supports, lines etc.) depends on the printer driver. 
If you are not satisfied with the printed results, scaling factors can be defined separately for 
Script and Symbols. 

Frame 
The graphic can be printed with or without frame around the graphic. 

Furthermore, you have the option to add a title box to the printout. Click the button [Edit Title 
Box Settings] shown on the left to open the following dialog box where layout and contents of 
the title box can be defined. The lower part of the dialog box shows a preview. 

 



10  Printout 

 409 Program RFEM © 2013 Dlubal Software GmbH 

 

 

 
Figure 10.47: Dialog box Title Box Settings 

Print quality 
In most cases, it is not necessary to change the default settings in the dialog section Print  
Quality (see Figure 10.46). Select Standard to print the graphic as a bitmap file in a size of max-
imum 1000 x 1000 pixels. The Maximum size of up to 5000 x 5000 pixels together with a 32-bit 
color depth results in a data amount of about 100 MB. As this may cause problems for some 
printer drivers, be careful to select such a high resolution. 

Color 
When you direct the printing to a monochrome printer, you can print Texts and lines in black 
instead of gray scales to improve readability. Please note that some elements such as isobands 
and support symbols are not affected by the setting and therefore appear colored in the print-
out. 

The conversion from colored result diagrams to gray scales is always managed by the printer 
driver. Corresponding setting options do not exist in RFEM. 
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10.2.3 Color Spectrum 

 
Figure 10.48: Dialog box Graphic Printout, tab Color Spectrum 

The tab is only available when results are shown in a multicolor display (see chapter 9.3, page 
346). 

Position 
The color spectrum of the control panel is usually printed into the printout. If you don't want 
to print it, tick the check box for No color spectrum. 

When the panel lies In the graphic picture, the color spectrum overlaps a part of the picture.  
It is possible to specify the position of the panel: You can define it either for one of the four 
corners or as User-defined arrangement. 

The option Out of graphic picture cuts off a strip of the graphic window and uses it only for the 
color spectrum. You can define the Spectrum width in the lower part of the dialog box. 

Size 
The size of the color spectrum can be defined either in absolute dimensions or relatively to the 
picture size. 

Multi color spectra 
If member and surface results are displayed together in the work window, it is possible to de-
fine the color spectrum which is relevant for the screen in the control panel (see Figure 9.50, 
page 377). On the sheet, however, two color spectra are displayed in this case. Their arrange-
ment can be specified in this dialog section. 

Options 
The color-value assignment in the work window can be user-defined (see chapter 3.4.6,  
page 30). 

You can determine whether the default color spectrum referring to the extreme values 
(max/min) or the user-defined color spectrum is used for the printout. 
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10.2.4 Mass Print 
The dialog box Mass Print appears if you click the [Settings] button to the right of the Mass 
print option in the dialog tab General (see Figure 10.42, page 405). Three tabs are offered 
which you can use to decide which default graphics of the model, loads and results are inte-
grated automatically into the printout report. 

 
Figure 10.49: Dialog box Mass Print, tab Model 

Seven standard views are available for selection. Additionally, you can activate the 3D Perspec-
tive for the model display. 

 
Figure 10.50: Dialog box Mass Print, tab Loads 

In the dialog section Generate Graphics of, decide if automatic load graphics are created. Then, 
in the dialog section Load Cases / Combinations, specify the relevant load cases. 
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Use the [Select] button shown on the left to define Selected load cases in the dialog box Load 
Cases / Load Combinations (see Figure 10.52). 

Finally, in the dialog section Views, decide which angles of view are used for the default graphics. 

 
Figure 10.51: Dialog box Mass Print, tab Results 

In the dialog section Results, you can select the relevant deformations and internal forces in 
the tree structure by ticking the check boxes. 

With the settings in the dialog sections Generate Graphics of and Load Cases / Combinations, 
you decide if graphics are created with or without load representations and which load cases 
are relevant for the printing. Click the [Select] button shown on the left to define Selected load 
cases in a separate dialog box. 

 
Figure 10.52: Dialog box Load Cases / Load Combinations 

The graphics' angle of view is defined in the dialog section Views. 

It is recommended to check the specified Number of graphics, in particular for the results: A 
small mistake during the selection may lead to a multitude of automatic graphics that slow 
down the creation of the report. 

 

 



10  Printout 

 413 Program RFEM © 2013 Dlubal Software GmbH 

 

 

10.2.5 Notes for Plotting 
Please note the following to achieve best results on the plotter. 

Settings in operating system 
Basically, RFEM uses the print system of Windows. Unlike some CAD programs, RFEM uses no 
special drivers to control the plotter. Therefore, the plotter must be installed as a normal print-
er under Windows. 

Internal checks have shown that the drivers delivered by Windows are unstable and defective. 
Therefore, we recommend to use the original drivers or the current drivers made available on 
the website of the plotter producer. 

When plotting huge amounts of data are processed. It is necessary to ensure that sufficient 
space is available on the system partition of your computer. 

Do not set the plotter as default printer in the system. It is recommended to select the plotter 
not until printing is directly in process. Background: The printout report uses the standard 
printer driver for the print preview. Crashes occurred in the printout report with the tested 
plotter drivers. 

Many plotter drivers offer the option to prepare the graphic in either the plotter or the com-
puter. Generally, preparing graphics in the plotter is faster because it has a specialized proces-
sor. Besides, your work on the computer won't be affected. The problem however is that the 
plotter often provides only a small random access memory. If the memory is not sufficient an-
ymore to record the picture, parts will get lost. When plotting RFEM graphics, you can see the 
loss in the form of missing descriptions or fillings, missing lines etc. In this case, the plotter will 
normally show you a corresponding message. 

In case of doubt, prepare data in your computer. Please note that the default setting is set to 
the preparation in the plotter. In this case, adjust the printer properties accordingly. 

 
Figure 10.53: Dialog box Printout Settings for HP DesignJet under German Windows XP 
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Settings in RFEM 

 
Figure 10.54: Dialog box Graphic Printout, tab General 

It is recommended to select the graphic size To scale in the General tab of the dialog box 
Graphic Printout as the output on a A0 plan is almost always true to scale. Then, select the scale 
from the list or enter it directly into the input field. 

Furthermore, it is recommended to use the complete sheet area for the plotter output: Tick the 
check box for Use whole page width in the dialog section Graphic Picture Size and Rotation. 

 
Figure 10.55: Dialog box Graphic Printout, tab Options 

In the Options tab, you can define settings influencing the output quality. You will surely need 
some test plot printings to find the optimal settings. Unfortunately, it is not possible to give 
global recommendations because the settings' effect depends on the printer driver. The guide 
values shown in the figure above refer to the plotter HP DesignJet 650C with the driver version 
4.62 running under Windows XP. 
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If crashes occur during the plotting process, we recommend to install the current printer driver 
as described above and to select it for the preparation of the graphic In computer (see dialog 
box for print settings). If crashes still occur when plotting, reduce the resolution gradually in 
the dialog section Print Quality in the Options tab of the dialog box Graphic Printout. 

The dialog section Script in the Options tab of the dialog box Graphic Printout controls the scal-
ing of the font size for numberings, dimensions and result values. Good results have been 
achieved for the factor 2 and the setting Constant for the A0 plot on the HP DesignJet 650C. 

The dialog section Symbols does not only affect the size of support symbols, nodes or other el-
ements but also line widths. If lines are too rough, you should reduce the factor. Good results 
have been achieved for the A0 plot on the HP DesignJet 650C when using a factor of 0.2 and 
the setting Proportional. 

The factors set for symbols and script affect all fonts and symbols globally. To influence the 
appearance of particular objects specifically, use the settings in the dialog box Display Proper-
ties (see Figure 11.3, page 417). It is recommended to save adjustments for the plotter as new 
display configuration used for the printout report. For more information, see chapter 11.1.2 on 
page 417. 

After clicking the [OK] button you see the Print dialog box of the operating system. Select the 
plotter from the list of printers. Click [Printer Properties] to open another dialog box where you 
can set page size and alignment. 

 
Figure 10.56: Plotter dialog box Properties for setting the page format 
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11.  Tools 
In the following, you find descriptions of functions for graphical and table input such as CAD 
tools for designing or generating model and load objects, edit options, operations in spread-
sheets or parameterized input. 

11.1 General Functions 
This chapter describes program functions which are generally useful or provided in many  
dialog boxes of RFEM. 

11.1.1 Language Settings 
The language that has already been selected for installation is preset. Materials and cross-
section tables in the libraries have also been set up by country-specific arrangements. 

To change the graphical user interface of RFEM, 

select Program Options on the Options menu 

or use the corresponding button in the toolbar. 

In the dialog tab Program, you can select another Program Language in the list. 

 
Figure 11.1: Changing the Program Language in the dialog box Program Options 

The changed language settings will be effective after restarting the program. 

When you change the language, please note the following: 

• Some characters are only displayed correctly if the corresponding fonts are available in 
the operating system. 

• The new language affects the arrangement of cross-section tables in the libraries. 
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11.1.2 Display Properties 
The display properties determine the way how a graphical object is represented on the screen 
and in the printout. The Display navigator is the place to decide whether an object is represent-
ed or not (see chapter 3.4.3, page 24). 

Adjust the display 
To open the dialog box for adjusting the graphical display, 

point to Display Properties on the Options menu, and then select Edit 

or use the Configuration Manager (see chapter 3.4.10, page 36). 

It is also possible to directly access the display properties of each graphical object (model, load 
or result symbol): Right-click the object to open its context menu and select the menu item 
Display Properties. Now, you can immediately adjust the object's display properties in the dia-
log box Display Properties (Figure 11.3). 

 
Figure 11.2: Context menu of nodal support 

 
Figure 11.3: Dialog box Display Properties (for category Nodal Supports) 

The settings for display on the Screen and in the Printout Report are managed in two dialog tabs. 
In this way, it is possible to define adjustments separately for the monitor graphic (for example 
size of support symbols with black background) and for the printout. 

If you want to define Identical Settings For screen and printout report, use the check box below 
the tabs to synchronize the display properties for screen and printout report. If it is ticked, the 
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settings that are defined subsequently are also enabled in the other dialog tab (Screen or 
Printout Report) of the current category. Settings that have already been defined cannot be 
transferred subsequently with this function. 

The Category navigator shows the graphical objects listed in a directory tree. To change the 
display properties of an object, select the relevant entry. Then, adjust the object-specific dis-
play parameters in the dialog section to the right: color, line display, size in work window, type 
and arrangement of numbering, font, size of load vector etc. 

RFEM offers additional [Details] buttons for some parameters. 

 
Figure 11.4: Dialog box Size for Line Forces 

The buttons are used to open new dialog boxes where you can scale for example the distance 
or size of the object to the dimensions of the total structure. 

The buttons below the parameters have the following functions: 

 
Opens the Font dialog box for changing type, size and color of font 

 Goes to display parameters of axes of current object 

 Returns to base data of object 

 Opens the dialog box Relative Positions (Figure 11.5) for arranging descriptions 

 Restores default settings 

Table 11.1: Buttons in dialog box Display Properties 
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For objects that are relevant for lines and members it is possible to arrange the description or 
symbol by user-defined settings. A dialog box opens where you can define the information's 
position by means of a relative distance to the line or member start. 

 
Figure 11.5: Dialog box Relative Positions of Line/Member Information 

Save display configuration 
The dialog box Display Properties allows you to adjust the display configuration to the given 
requirements. So it is possible, for example, to create different settings for the screen with  
colored background and for the plotter with specific settings. 

However, modifications cannot be saved in the dialog box Display Properties. The Configuration 
Manager described in chapter 3.4.10 on page 36 is responsible for managing display configu-
rations. 

Therefore, proceed as follows when you want to create a new display profile based on your 
modifications: 

• Confirm the modifications in the dialog box Display Properties with [OK]. 

• Open the Configuration Manager (see chapter 3.4.10, page 36). 

• Create a [New] configuration. 

• Enter a description in the dialog box New Configuration, and then confirm with [OK]. 
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11.1.3 Units and Decimal Places 
The units and decimal places for RFEM and all add-on modules are managed in one dialog box. 
The settings can be modified as required for modeling or evaluation. All numerical values will 
be converted or adjusted. 

Changing units and decimal places 
Many dialog boxes provide the button shown on the left which you can use to access the dialog 
box for changing units and decimal places (see Figure 11.4 for dialog box Display Properties). 

To open the dialog box Units and Decimal Places, you can also 

select Units and Decimal Places on the Edit menu. 

 
Figure 11.6: Dialog box Units and Decimal Places 

First, select the module in the dialog section Program / Module for which you want to adjust 
the units or decimal places. Depending on the selection, the right side of the dialog box is 
changing. 

Four dialog tabs are offered for RFEM so that you can specify settings separately for Model, 
Loads and Results data as well as Dimensions. For some add-on modules the right part of the 
dialog box is also subdivided into several tabs. The units and decimal places are summarized in 
groups. 

When the dialog box has been opened from another dialog box (for example the New Member 
box), the relevant units and decimal places are marked with a red triangle on the right as shown 
in the figure above. 

Save and import units as user profile 
The settings in the dialog box Units and Decimal Places can be saved and used in other models. 
Thus, creating specific unit profiles for example for models consisting of steel and reinforced 
concrete is possible. 

The button shown on the left opens a dialog box where you specify the Name of the new units 
user profile. 
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Figure 11.7: Dialog box Save Profile 

To use this profile as default setting for new models, tick the check box Save profile as default. 

A user profile can be imported with the button shown on the left. A dialog box opens where 
several profiles are available for selection. A metric and an imperial (Anglo-american) unit  
profile are preset as default settings. 

 
Figure 11.8: Dialog box Load Profile 

11.1.4 Comments 
This chapter describes the comment fields available in dialog boxes and tables (see for exam-
ple Figure 4.12, page 43). The comments that you can insert graphically are described in chap-
ter 11.3.6 on page 447. 

Using comments 
You can enter any kind of text into the comment fields. With the button [Import Comment] 
shown on the left you can take advantage of predefined text modules which are stored by 
cross-model management. 

A dialog box appears showing a list of stored text modules. 

 
Figure 11.9: Dialog box Import Comment 
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The List of Default Comments contains all comments that are suitable for the category. Click the 
[Import] button to insert the selected comment into the comment field of the dialog box. If the 
comment field already contains a text, it will be overwritten. Then, you may continue to edit 
the comment in the comment field. 

Use the button shown on the left to add the selected comment to a comment field text that is 
already available. 

Creating and managing comments 
In the dialog box Import Comment (Figure 11.9), you can create new text modules by means  
of the button shown on the left. Alternatively, you can use the Comments tab in the Program 
Options dialog box where all comments are managed. To open the dialog box, 

select Program Options on the Options menu 

or use the toolbar button shown on the left. 

 
Figure 11.10: Dialog box Program Options, tab Comments 

In the left dialog section Category, you determine the group (which means input table or input 
dialog box) to which you want to assign the comment text. 

The right dialog section Comments for Default offers four buttons which have the following 
functions: 

Button Description 

 
Creates a new comment within the marked Category. Enter the text in the list. 

 Deletes the comment that is selected in the list. 

 Moves the selected comment upwards. 

 Moves the selected comment downwards. 

Table 11.2: Buttons in the dialog box Program Options, tab Comments 
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When the special selection is used (see chapter 11.2.2, page 433), you can filter data by user-
defined comments. 

 
Figure 11.11: Dialog box Special Selection (dialog section) for Nodes filtered by comment 

11.1.5 Measure Functions 
In order to check entered data, distances and angles can be measured. To access the corre-
sponding function, 

point to Measure on the Tools menu. 

The following measure functions are available for selection: 

• Distance between 2 nodes 

• Angle between 3 nodes 

• Angle between 2 members 

• Angle between 2 surfaces 

• Angle between member and surface 

• Angle between 2 lines 

• Angle between member and line 

• Angle between line and surface 

Click the objects for measurement one after the other in the work window. Then, Distance and 
Deformation of the nodes are shown in a dialog box. 

 
Figure 11.12: Dialog box Distance Between Two Nodes/Points 
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11.1.6 Search Functions 

Selection with table 

To find an object in the graphic, you can use the tables: Click into a table row and you see the 
relevant object highlighted with colors in the work window. Take advantage of this function 
for rather simple models to detect objects fast and easily in the graphic. 

The graphical selection with the table works only if the synchronization of the selection is active 
(see chapter 11.5.4, page 486). 

Searching by object number 
In RFEM you can specifically search for objects, which is especially recommended for large and 
complex models. To access the search function, 

select Find via Number on the Edit menu. 

The following dialog box appears: 

 
Figure 11.13: Dialog box Find Object with Number 

In the dialog section Object, use the list to define the object category for searching: node, line, 
surface, solid, member or finite element. Then, enter the No. of the object directly into the in-
put field to the right, or use the list to select a number. 

Click [OK] to confirm the dialog box. Then, you see a big arrow indicating the object in the 
work window. The arrow will still be displayed when you adjust the area around the object  
appropriately by zooming or rotating the model. The arrow will disappear by a click into the 
workspace. 
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11.1.7 Viewpoint and View Angle 
RFEM offers the standard views [in X/Y/Z] direction and [in Reverse X/Y/Z] direction as well as 
the [Isometric View] that can be selected by means of the buttons shown on the left. More but-
tons for user-defined coordinate systems and angles of view are available in the list button of 
the toolbar and in the Views navigator (see chapter 9.9.1.1, page 370). 

If these views including rotating option (use toolbar button [Move] and hold down [Ctrl] key) 
do not result in the display view that you want to set, you can use the extended options of the 
dialog box Edit Viewpoint. 

To open the dialog box, 

select Viewpoint on the View menu. 

 
Figure 11.14: Dialog box Edit Viewpoint 

Click into the preview windows on the right and move the mouse to set viewpoint and view 
angle. In addition, you can adjust the factor for the Perspective. 
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11.1.8 Determination of Centroid 
The centroid of the overall model is displayed automatically when the FE mesh has been gen-
erated successfully and the corresponding option in the Display navigator under the navigator 
item General is ticked. Color and size can be adjusted in the dialog box Display Properties: Click 
Colors → Other → Center of Gravity (see chapter 11.1.2, page 417).  

Moreover, it is possible to determine the centroid of particular objects: Select the relevant 
members, surfaces and solids for example by multiple selection or by opening a selection  
window (see chapter 11.2, page 430). Activate the context menu shown on the left by right-
clicking one of the objects. Then, click the menu item Centroid and Info to open a dialog box 
with information about the selected objects. 

 
Figure 11.15: Dialog box Centroid and Info About Selected Objects 

The dialog box shows you the Centroid Coordinates in relation to the origin of the global axis 
system XYZ. In the work window, the centroid is indicated by a big arrow. Optionally, you can 
Create a new node in the centroid. 

In addition to the global Envelope Size of the selected objects, the following Additional Info is 
displayed: 

• Area of all surfaces 

• Length of all members 

• Surface area of visible surfaces of all objects 

• Net volume 

• Total mass 
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11.1.9 Rendering 
The model's representation in the work window can be set by user-defined control. Use the list 
button in the toolbar shown on the left to switch quickly between the display types Wireframe, 
Solid and Solid Transparent Display Model. 

Detailed settings for the individual objects can be specified in the Display navigator under the 
navigator item Rendering. 

 
Figure 11.16: Display navigator with options for Rendering of model and load objects 

The Solid Model representation can be adjusted individually for members, surfaces and solids. 
Similar control options are available for the display of supports and loads. 

Textures 
When Textures are activated, RFEM shows the surface textures in the rendered model. To access 
detail settings for the textures, 

point to Display Properties on the Options menu, and select Edit. 

The dialog box Display Properties opens where you select Materials in the category Objects by 
Color. Then, you see the materials listed with assigned colors and textures to the right. Double-
click into a field of the table row to open the dialog box Edit Material Color and Texture. 
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Figure 11.17: Dialog box Edit Material Color and Texture 

Use the dialog box to adjust Color and Texture of the selected material. RFEM provides a color 
palette and a comprehensive library with textures (see dialog buttons). 

Color control 
The Display navigator item Colors in Rendering According to contains several selection fields. 
An activated field controls the assignment of colors for the objects in the rendering. By default, 
RFEM uses the material colors defined for the individual construction materials (see chapter 4.3, 
page 60). With the remaining options it is possible to graphically check also cross-sections and 
types of members, surfaces, solids etc. by means of the assigned colors. 

 
Figure 11.18: Option Colors in Rendering According to Cross-Sections for checking cross-section types 

The option +/- z Surface sides is used for checking the position of surface sides which is im-
portant for defining foundations with failure or for the reinforcement layout. The top side of a 
surface is displayed in red, the bottom side is represented with blue color (standard). 
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11.1.10 Lighting 
Lightness and light effects of the rendered model can be adjusted individually. To manage the 
lighting in the Display navigator, 

select Lighting under Rendering. 

Six different light sources are available for selection: Light 1 to 4 light the model from its side, 
light 5 and 6 from below and above. Each Light can be switched on and off individually. 

Tick the check box for Display light positions to display the light sources in the work window. 
Active lights are represented in gold, inactive lights are shown in gray. 

 
Figure 11.19: Display of light positions using the Display navigator 

It is also possible to apply light effects to the Results. The check box is inactive by default be-
cause lighting often has an unfavorable effect on the visibility of surface and solid results. 
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11.2 Selection 
With the selection functions you can define objects for subsequent editing. Objects are repre-
sented by nodes, lines, surfaces, solids, members, supports, FE mesh refinements etc. But it is 
possible to select also loads and guide objects (dimension lines, comments) graphically. 

To select (or find) an object in the work window, you can also use the tables: Click into a table 
row and you see the corresponding object highlighted with colors in the graphic. However, 
this type of selection works only if the synchronization of the selection is set active (see chap-
ter 11.5.4, page 486). 

Using the Data navigator is another option to select objects: Right-click the relevant navigator 
entry, and then select the menu item Select in the context menu. 

 
Figure 11.20: Context menu in Data navigator 

11.2.1 Selecting Objects Graphically 

Selecting with mouse 
Every object can be selected in the work window by a simple click of your mouse. Once se-
lected, it is highlighted in the graphic with another color. Always, only the last clicked object 
remains selected provided that the default setting New Selection is not changed. 

If you want to select more than one object by clicking, hold down the [Ctrl] key additionally. 
Another possibility is to switch to the setting Add to Selection by using the toolbar button 
shown on the left. You can also point to Select on the Edit menu where objects can be clicked 
separately to select them one after the other. 

The so-called preselection allows you to locate relevant objects before clicking. If selecting 
objects proves to be difficult for complex structural systems, you can exclude non-required 
model objects from the graphical pre-selection in the Display navigator category Preselection. 

Selecting with window 
Use the window selection to mark a lot of objects in one single step: Hold the left mouse but-
ton down and draw a window across the relevant objects. If you open the window from the 
left to the right, all objects that are completely covered by the window are selected. If you 
open the window from the right to the left, you select also those objects that are only cut by 
the window. 

Lines or nodes lying in a surface can be selected without displacing the surface unintentionally: 
Hold down the [Alt] key while you open the window across the objects inside the surface. 
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Selecting with rhomboid 
In the isometric view, it is sometimes difficult to select an object with a rectangular window. 
Then, it is recommended to use the function Selection via Rhomboid. 

Point to Select on the Edit menu, and then click Rhomboid 

or use the toolbar button shown on the left. 

 
Figure 11.21: Button Selection via Rhomboid 

 
Figure 11.22: Selecting with rhomboid 

Selecting with ellipse/circular ring 
The possibilities to select objects by an ellipse or annulus that can be used for example for cir-
cular surfaces represent alternatives to the rhomboid selection. To access the corresponding 
functions, 

point to Select on the Edit menu, and then select Ellipse or Circular Ring 

or use the corresponding toolbar buttons. 

 
Figure 11.23: Buttons Selection via Ellipse or Circular Ring 

The elliptical or annular selection zone can be set by mouse-click defining the center point and 
both radii. 

Selecting with section line 
You can select objects by means of a line running anywhere through the model. To access the 
function, 

point to Select on the Edit menu, and then click Section Line. 

The section line can be defined in the work window as a simple line or as polygon. Click rele-
vant points one after the other by mouse click to define the line. The points are independent 
of the work plane: The selection includes all objects that are cut by the intersection line dis-
played in the current view. 

After setting the endpoint of the section line, click it once again (alternative: double-click the 
last point). Make sure to place this point in an empty area of the work window. 
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Figure 11.24: Selecting all columns with a section line 

Selecting in plane 
Objects lying in one plane (for example roof surfaces) can be selected easily by the selection 
function In Plane. To open the corresponding dialog box, 

point to Select on the Edit menu, and then click In Plane. 

A dialog box appears with detailed settings for selecting the objects and the plane. 

 
Figure 11.25: Dialog box Select In Plane 

After clicking the [OK] button you can define the selection plane graphically: Click 3 Nodes, or 
draw a Polygonal chain freely or with the help of nodes in the work plane. 

Selecting free nodes 
To select nodes that are not used for defining lines or surfaces, 

point to Select on the Edit menu, and then click Free Nodes. 

The easiest way to delete selected free nodes is to use the [Del] key. 

Selecting related objects 
When you select for example a surface by clicking, the nodes and lines belonging to the surface 
are not included in the selection. To select also the components of objects, 

point to Select on the Edit menu, and then click Related Objects. 

Use this function for example to integrate quickly the supports of members or surfaces into the 
selection and to save them as related objects in a user-defined visibility (see chapter 9.9.1.2, 
page 374). 
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11.2.2 Selecting Objects by Criteria 
The function allows you to select objects by particular criteria. Moreover, specific objects can 
be added to or removed from an existing selection. 

To open the dialog box used for the special selection, 

point to Select on the Edit menu, and then click Special 

or use the toolbar button shown on the left. 

 
Figure 11.26: Dialog box Special Selection 

The dialog section Category on the left lists the objects defined in the model. Settings in the 
right part of the dialog box depend on the selected object. Determine a selection criterion and 
specify detailed settings, if necessary. 

Example 

With the settings shown in Figure 11.26 all surfaces that are modeled Parallel to surface 1 (floor 
slab) are selected. You can also use the [] button to define the template surface graphically. 

 

Figure 11.27: Selection of parallel surfaces 
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11.3 Work Window 
Special CAD functions such as work planes, snap options, guidelines and user-defined coordi-
nate systems help you to model graphical objects in the work window. 

11.3.1 Work Planes 
Although a model is defined spatially, it can be displayed only in two dimensions on the screen. 
Therefore, defining objects graphically is a problem because it must be organized in which 
plane objects are created when clicking into the graphic window. The work plane determines 
which coordinate is always "fixed". 

The axes of coordinates of the currently set work plane are represented by two green, orthog-
onal lines. The lines' point of intersection is called “origin of the work plane". 

 
Figure 11.28: Work plane represented in the graphic 

Normally, a work plane runs parallel to one of the global planes XY, YZ or XZ that are spanned 
by two axes of the global coordinate system. But it is also possible to specify a work plane di-
rectly as a plane with any inclination, or to define it by means of line, member and surface axes. 

To open the dialog box Work Plane and Grid/Snap with the parameters of the work plane, 

select Work Plane, Grid/Snap, Object Snap, Guidelines on the Tools menu 

or use the toolbar button shown on the left. 

 
Figure 11.29: Button Settings of Work Plane 

The dialog box shown in Figure 11.34 on page 437 appears. 
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Parallel to global plane XY / YZ / XZ 
The work plane can be aligned parallel with one of the following global planes. 

Plane Selection in Work Plane dialog box Selection in toolbar 

XY 

 

 

YZ 

 

 

XZ 

 

 

Table 11.3: Selection of work plane 

To find more options for defining work planes, 

point to Select Work Plane on the Tools menu 

or use the corresponding toolbar buttons. 

3 points plane 
In the work window, you can select three points defining a new work plane with the axis system 
UVW. The points must not be defined on a straight line. 

Plane with line in X / Y / Z 
The work plane is defined by one of the global axes and a line that you determine graphically 
in the work window. The zero point of the new work plane is placed into the start node of the 
line. The axis U is aligned parallel with the selected global axis. In this way, you can quickly shift 
the work plane for example into a roof area. 

Plane with member axis xy / xz 
The planes of the member axes xy ("weak axis") or xz ("strong axis") are used for defining the 
work plane (see chapter 4.17, page 146). The relevant member must be defined graphically in 
the work window. The zero point of the new work plane is placed into the start node of the 
member. 

 
Figure 11.30: Work plane in roof inclination of member axis xz 
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Plane with surface axis xy 
The work plane is defined by the xy-axes of a surface that you determine graphically in the 
work window (see chapter 4.4, page 84). The axes of the new work plane are called UVW  
(see Figure 11.30). 

Offset of work plane 
Use this function to shift the work plane perpendicular to the current plane. Specify the dis-
tance in the dialog box Offset Workplane. 

 
Figure 11.31: Dialog box Offset Workplane 

The offset remains active until the function is canceled on the menu. 

Zero point of work plane 
The Work Plane dialog box (Figure 11.34) manages the zero point (origin) settings of the work 
plane. Use the [] function to select a node in the work window. Click the [New] button to de-
fine a new node. It is also possible to enter the coordinates of any point directly. 

 
Figure 11.32: Dialog box Work Plane, dialog section Origin of Work Plane 

The zero point of the work plane can also be defined graphically. 

Point to Select Work Plane on the Tools menu, and then select Define Origin 

or use the toolbar button shown on the left. 

 
Figure 11.33: Button Set Origin of Grid/Work Plane 
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11.3.2 Grid 
Grid points are used to help you with the graphical input in the work plane. When nodes are 
defined graphically, the pointer snaps on the grid points. 

The properties of grid points are managed in the dialog box Work Plane and Grid/Snap. To open 
the dialog box, 

select Work Plane, Grid/Snap, Object Snap, Guidelines on the Tools menu 

or use the toolbar button shown on the left (see Figure 11.29, page 434).  

 
Figure 11.34: Dialog box Work Plane and Grid/Snap 

The setting options relevant for the grid are available in the dialog tab Grid/Snap. 

Show 
To display the grid in the work window, tick the Grid check box. The snap function can be 
turned on and off independently of the grid by means of the Snap check box. Thus, the snap 
function on the grid points can be effective while the grid is invisible. 

To switch both functions on and off quickly, use the buttons [SNAP] and [GRID] in the status bar. 

Type 
The grid points can be arranged in the Cartesian or the polar coordinate system. Depending on 
the selection, contents of the displayed dialog sections are changing. 

Alternatively, you can select the coordinate system by means of the buttons [CARTES], [POLAR] 
or [ORTHO] in the status bar. 

Number of grid points 
When the Cartesian grid is set, you can define the number of grid points for both axis directions 
separately. 

When the polar grid is set, you have to specify the number of concentric grid circles. 
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When the option Dynamically according to size of model is ticked, the grid will automatically be 
adjusted to the dimensions of the model. Thus, a sufficient number of grid points will always 
be available around the model. However, the required grid points will be recalculated after 
each input, which may slow down the speed for creating the graphic when you work on com-
plex models. 

Grid point spacing 
When you use the Cartesian grid, you can define the spacing of grid points separately for the 
directions 1 and 2. 

For the polar grid you have to specify the radial spacing R for the grid circles. The angle α con-
trols the spacing of grid points on the circles. 

Optionally, the Cartesian and the polar grid can be rotated about the rotation angle β. 

If needed, the number of pixels controlling the Snap distance can be adjusted. 

11.3.3 Object Snap 
The object snap facilitates the CAD-like modeling when defining lines. In addition to nodes, 
several snap points along the lines can be activated. 

The settings for the object snap are defined as well in the Work Plane dialog box. To open the 
dialog box,  

select Work Plane, Grid/Snap, Object Snap, Guidelines on the Tools menu 

or use the toolbar button shown on the left (see Figure 11.29, page 434).  

 
Figure 11.35: Dialog box Work Plane and Grid/Snap 

The dialog tab Object Snap manages the different snap functions. 

To make the functions of the object snap effective, make sure that the button [OSNAP] is  
activated in the status bar. 
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Nodes 

 
Figure 11.36: Snapping a node 

When defining a new line existing nodes are captured. Snap points are symbolized by squares. 

Perpendicular 

 
Figure 11.37: Connecting a line perpendicularly 

When drawing a line the pointer is snapped when you move it near the perpendicular point. 
The snap point is symbolized by a perpendicular symbol. 

Tangent 

 
Figure 11.38: Connecting a tangent to an arc 

A tangent is created on a circular arc. When drawing a line the pointer is snapped when you 
move it near the tangent point. The snap point is symbolized by a tangent symbol. 
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Centers 

 
Figure 11.39: Connecting a line in center 

When you move the pointer near the center (middle) of a line, it will be snapped. The center 
symbol appears on the snap point. 

Intersections 

 
Figure 11.40: Snapping lines at intersection point 

The pointer snaps on the intersection point of two crossing lines that have no common node. 
The snap point is symbolized by the intersection symbol shown on the left. 

Parallel 

 
Figure 11.41: Snapping a parallel line 

Use this function to set parallel lines: Define the start node of the new line, and then move the 
pointer over a template line. Now, if you move the pointer near a possible end node of the 
new line running parallel to the template, the parallel symbol shown on the left appears on 
both lines. 
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Partition points 

 
Figure 11.42: Snapping a line on partition point (example: 2/3-point) 

In the dialog tab Object Snap of the Work Plane dialog box, you can enter a number of n line  
divisions. When you move the pointer along a line, it will be snapped on the partition points. 
The partition is displayed as fraction on the pointer. 

Distance 

 
Figure 11.43: Connecting a line in a defined distance 

In the dialog tab Object Snap of the Work Plane dialog box, you can enter a distance d for divid-
ing a line. When you move the pointer across a line, it will be snapped at the defined distance 
from the line start and end. The distance symbol appears on the pointer. 

Guidelines 

 
Figure 11.44: Snapping guidelines at intersection point 

When you move the pointer near the intersection point of two guide lines (see chapter 11.3.7, 
page 448), it will be snapped. The intersection symbol appears on the snap point. 
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Background layers 

 
Figure 11.45: Snapping background layers on intersection point 

Use this function to set nodes on intersection points of background layers (see chapter 11.3.7, 
page 448). The intersection symbol appears on the snap point. 

Line grid 

 
Figure 11.46: Snapping points of line grid 

Use this function to place objects into the intersection points of a line grid (see chapter 11.3.8, 
page 452). 

11.3.4 Coordinate Systems 
User-defined coordinate systems make entering inclined parts of a model easier. They have 
nothing to do with the axis systems of lines, surfaces or members. As an alternative, you can 
define work planes graphically by means of points or axes of lines, members and surfaces  
(see chapter 11.3.1, page 435). 

To open the dialog box Coordinate System, 

select Coordinate System on the Tools menu 

or use the toolbar button shown on the left. 

 
Figure 11.47: Button Coordinate System 

You can also use the dialog box Work Plane and Grid/Snap (see Figure 3.15, page 28) where you 
find the [New] button for creating a user-defined system of coordinates. 
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Figure 11.48: Dialog box Coordinate System 

The Standard coordinate system that refers to the global axes X,Y,Z and the origin is preset. 

Create a new coordinate system 
Click the [New] button shown in Figure 11.48 to open the following dialog box. You find the 
same button in the dialog box Work Plane and Grid/Snap (see Figure 3.15, page 28). 

 
Figure 11.49: Dialog box Define New Coordinate System 

Enter a Name for the new coordinate system. Then, define the axis system with the help of 
three parameters in the dialog section UVW Coordinate System Related to XYZ CS: 

• Origin (zero point of new coordinate system) 

• Point on positive U-axis (first axis) 

• Point in positive UW-plane (rotation of plane about axis U) 

Specify three points that you can enter directly or select graphically. The points must not be 
defined on a straight line. 
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You can use the buttons shown on the left to select the three points one after the other in the 
work window (please observe the sequence when defining points 0 to 2). With the left button 
you can select only Nodes, with the right button you can select any Points. The difference be-
comes especially significant when a node representing a definition point of the coordinate  
system is changed. Then, the coordinate system will be adjusted automatically. In case of any 
points, the system of coordinates is fixed. 

If a user-defined work plane is defined with the help of three points (see chapter 11.3.1, page 
435), RFEM creates automatically a new coordinate system with the name Generated. 

Edit or delete a coordinate system 
Only user-defined coordinate systems can be edited or deleted. Use the following two buttons 
available in the Coordinate System dialog box. 

 
Modifies selected coordinate system 

 
Deletes selected coordinate system 

Table 11.4: Buttons in the dialog box Coordinate System 

Example 

In a frame joint, a new coordinate system is defined for the diagonal lying in the plane of the 
roof. The Origin is set in corner node 6.  End node 4 of the diagonal member is selected as 
Point on positive U-Axis. Base node 5 of the column is selected as Point in positive UW-Plane. 

 
Figure 11.50: User-defined coordinate system UVW in a frame joint 

Now, the grid refers to the work planes UV, VW and UW where you can define new objects  
(see chapter 11.3.1, page 434). 
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11.3.5 Dimensions 
It is possible to add user-defined dimension lines to the model. 

To apply dimensioning functions, 

point to Dimensions on the Insert menu 

or use the corresponding toolbar buttons. 

 
Figure 11.51: New Dimension buttons 

The following dimension options can be selected: 

Dimension Dimensioned Objects 

Linear Lengths between two or several nodes 

Arc length Length between nodes of an arc 

Angular Angle between three nodes or two lines 

Radial Diameter or radius of circle and arc 

Slope Inclination angle between a line and a plane 

Height Height level of a node 

Table 11.5: Dimensioning functions 

The dialog box New Dimension opens. The appearance of the dialog box depends on your  
selection. 

 
Figure 11.52: Dialog box New Linear Dimension 
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Use the pointer displayed with a selection symbol and click the objects representing the di-
mensioning's reference points one after the other. In the dialog section Reference, you can  
select the real length or the projection in one of the global axis directions. 

In the dialog section to the right, you determine the Plane where the dimension line is applied. 
The setting refers to the axes of the global coordinate system XYZ, respectively the line axes. If 
you switch the plane and move the pointer in the graphic, you can see the effect of both selec-
tion fields. 

Use the four check boxes in the dialog section Options to define the information appearing on 
the values. When you select Symbol, you can enter a dimensioning symbol. It is also possible to 
select it from the list. Tick Hide value to switch off the measured value so that only the symbol 
appears. 

The Offset determines the distance of the dimension line from the first selected node. The dis-
tance can be defined also graphically by using the mouse pointer. To finally define the dimen-
sion line, click into the work window or use the button [Set Dimension] shown on the left. 

To define a chain dimensioning with equal offset, click the individual nodes one after the other, 
and then specify the offset. 

To set the display of dimension lines, use the Display navigator or the general context menu 
(right-click into an object-free area of the work window). 

 

Figure 11.53: Display navigator (Guide Objects → Dimensions) and general context menu 

When the model geometry is modified, dimensions will be adjusted automatically. 

To open the dialog box Edit Dimension, double-click the relevant dimension. In this way, you 
can subsequently adjust the offset. However, if you want to relate the dimension line to other 
nodes or lines, delete the dimension first. Then you can redefine it. 
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11.3.6 Comments 
There are two types of comments: 

• Comments in dialog boxes and tables (see chapter 11.1.4, page 421) 

• Comments in work window 

This chapter describes how comments are set graphically. 

You can place comments referring to nodes and centers of lines and members. They can also 
be placed anywhere in the current work plane or in a global plane. 

To open the dialog box for applying comments,  

select Comments on the Insert menu 

or use the toolbar button shown on the left. 

 
Figure 11.54: Button New Comment 

The dialog box New Comment opens. 

 
Figure 11.55: Dialog box New Comment 

Enter the comment text into the dialog section Text. The appearance of the comment concern-
ing colors and [Fonts] can be adjusted in the dialog section Options. Optionally, the comment 
is Framed by a rectangle or circle. 

The Rotation of the comment allows you to user-define the comment text arrangement. 

If the check box in the dialog section Offset is ticked, the comment will be arranged in a speci-
fied distance to the object. You can define the distance also graphically: First, click the object 
after entering the comment text. Then, use the pointer to locate the appropriate position 
where you enter the comment text with another mouse click. RFEM displays the current work 
plane so that you can place the comment correctly. If necessary, you can change the work 
plane before placing the comment. 

To set the display of comments, use the Display navigator or the general context menu (right-
click into an object-free area of the work window, see figure below). 
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Figure 11.56: Display navigator (Guide Objects → Comments) and general context menu 

When the model geometry is modified, comments will be adjusted automatically. 

Comment texts including offset can be edited subsequently: Double-click the comment in the 
work window or its entry in the Data navigator. 

You can shift comments by using the drag-and-drop function (for copying: hold down the 
[Ctrl] key). Please note the following: When you "grab" the arrow of the graphical comment at 
its head, you shift the entire comment. When you "grab" it on the text, the arrowhead contin-
ues to point to the object so that the position of the comment text can be adjusted in the work 
plane.  

11.3.7 Guidelines 
Guidelines represent a grid of axes and rows underneath the graphical workspace. The inter-
section points of guidelines are as well snap points for graphical input, provided that the snap 
function for Guidelines-Intersections is active in the object snap (see chapter 11.3.3, page 441). 

Guidelines do not need to be parallel to the axes of the global coordinate system XYZ. Angles 
can be specified freely. You can even define a polar arrangement of guidelines. Also spacings 
among guidelines may be arbitrary. 

 

Figure 11-57: Grid of guidelines 
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Create guidelines 
Dialog input 

To open the dialog box for creating a new guideline, 

point to Guidelines on the Insert menu, and then select Dialog Box 

or use the context menu in the Data navigator. 

 
Figure 11.58: Context menu of Guidelines in Data navigator 

The following dialog box appears: 

 
Figure 11.59: Dialog box New Guideline 

The No. of the guideline is allocated by the program but can be adjusted, if necessary. 

With the options in the dialog section Type you decide how the guideline will be created  
(see table below). 
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Type Explanation 

II to X / Y / Z 
(parallel to global axis X, Y 
or Z) 

The guideline is created parallel to one of the global axes. Specify 
the distances x1 / y1 / z1 of the respective global axes in the dialog 
section Parameters. 

Bias by 2 points In the dialog section Parameters, enter the coordinates of two 
points in the current work plane to define the guideline. 

Bias by angle and point The coordinates of a point and a rotation angle must be specified 
in the Parameters dialog section. The guideline will be created in 
the current work plane. 

Polar In the Parameters dialog section, the center point and the radius 
for the circular guideline must be specified. 

Table 11.6: Types of guidelines 

Enter the individual parameters into the input fields or determine them graphically in the work 
window by using the [] function. 

When the check box Description is ticked, you can enter a description for the guideline into the 
input field. You can also select a description from the list. 

Graphical input 

To define a guideline graphically, 

• point to Guidelines on the Insert menu, and then select Graphically 

• use the button [New Guideline Graphically] shown on the left or 

• grab an axis of the work plane and move it in a parallel direction (only possible if 
guidelines are not locked, see below). 

 
Figure 11.60: Creating a guideline graphically 

The dialog box New Guideline is described above. 

Edit and delete guidelines 
To open the dialog box for editing guidelines, double-click a guideline in the graphic or its entry 
in the Data navigator. 

If the guideline cannot be selected in the graphic, it is locked (see below). Guidelines can be un-
locked quickly in the following way: Right-click in an empty space of the work window and deac-
tivate the option Lock Guidelines in the context menu. 
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Context menu of guidelines 

Another possibility to edit guidelines is to select Work Plane, Grid/Snap, Object Snap, Guidelines 
on the Tools menu, or to use the toolbar button shown on the left. A dialog box opens where 
you can use the Guidelines tab not only for activating the snap but for editing, deleting or hid-
ing and displaying guidelines as well as creating new guidelines. 

 
Figure 11.61: Dialog box Work Plane and Grid/Snap, tab Guidelines 

Guidelines can be deleted in both the work window and the Data navigator: Right-click the 
guideline, and then select Delete or Delete Guideline in the context menu. 

Locking guidelines 
When guidelines are locked, they cannot be selected, edited, moved or deleted. In this way, 
they do not affect the graphical input of objects. Nevertheless, the snap function on the inter-
section points remains active. 

To lock or unlock all guidelines,  

• right-click a guideline and select Lock Guidelines on the context menu 

• point to Guidelines on the Edit menu, and then select Lock or 

• right-click Guidelines in the Data navigator and select Lock Guidelines on the context 
menu.  

Copy and move guidelines 
Guidelines are normal graphical objects for which you can use all common editing functions. 

To move or copy a guideline, select the guideline first. Then, you can apply the function de-
scribed in chapter 11.4.1 on page 459. 

Show guidelines 
The Display navigator controls the graphical representation of guidelines in detail (see the fol-
lowing figure). 
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Figure 11.62: Guideline settings in the Display navigator 

11.3.8 Line Grid 
User-defined line grids help you to model structures consisting of surfaces, girder grillages or 
grids. The intersection points of the grid represent definition points for surfaces, lines and 
members. 

It is possible to use several line grids in one model. 

Create line grid 
To open the dialog box for creating a new line grid, 

select Line Grid on the Insert menu 

or use the context menu in the Data navigator. 

 
Figure 11.63: Context menu of Line Grid in Data navigator 
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The dialog box Line Grid appears where you can define the new grid. 

 
Figure 11.64: Dialog box Line Grid 

The Global Position of Insert Point defines the origin of the line grid. The coordinates can be  
entered or selected in the work window by using the [] function. 

The dialog section Type below the dialog graphic offers the following options to define the 
grid system before entering further data: 

• Cartesian 

• Spherical 

• Inclined (grid that can be rotated for each axis about any rotation angle γ) 

• Cylindrical 

The small graphic to the right is interactive with the type specification. 

In the dialog sections Line Grid in X-/Y-/Z-Direction, enter the distances d and the Number of 
spans for each direction. The Name is preset but can be adjusted. It is also possible to enter the 
Coordinates of the distances or to adjust them subsequently. 

The options Positive and Negative determine in which direction of the global axis the line grid 
will be created. 

With the dialog section Rotation in the right bottom corner you have the possibility to rotate 
the line grid about an axis: First, select the Sequence determining the order of the local grid  
axes X', Y' and Z'. Then, enter the angle of rotation about the global axes X, Y and Z in the input 
fields for Rotated about. You can also use the field buttons [�] to define the support rotation 
graphically. 

A great part of the dialog box is covered by a graphic window where input is immediately rep-
resented graphically. The buttons below the window are familiar, you know them from RFEM. 
They control the display for dimensioning, numbering, axes and view. It is also possible to use 
the mouse control options for the big dialog graphic (see chapter 3.4.9, page 35). 
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Each line grid can be saved as template and reused later. Both buttons shown on the left are 
used to [Save] and [Load] grid data. 

After closing the dialog box, you can set objects on the grid nodes. Make sure that the object 
snap is active (see chapter 11.3.3, page 438). 

11.3.9 Visual Objects 
Visual objects are 3D objects used for example in architectural design programs to represent 
model designs close to reality (for example people, cars, trees, textures etc.). You can also inte-
grate 3D objects into the RFEM model to demonstrate the model's proportions. 

Load visual object 
To open the dialog box for importing a visual object, 

select Visual Object on the Insert menu 

or use the context menu in the Data navigator. 

 

Figure 11.65: Context menu in the Data navigator, Guide Objects → Visual Objects 

The dialog box New Visual Object opens where you have to specify the Description and File 
Name. 

 
Figure 11.66: Dialog box New Visual Object 
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The visual object must be available in the format .3ds. Use the [Browse] button to select the file 
in the Windows dialog box Open. 

Define the Position of the object in the model by entering coordinates. You can also use the [] 
function to define it graphically in the work window. The reference point of the 3D object is in-
dicated by the selection color in the graphic to the right. 

In addition, it is possible to define a Rotation of the object or to Scale the object. 

Click [OK] to insert the object into the model. 

The edit dialog box of a visual object can be accessed by double-clicking the object in the 
graphic or in the Data navigator. 

11.3.10  Background Layers 
A DXF file can be imported as background layer and used for the graphical input of objects. In 
contrast to the DXF import (see chapter 12.5.2, page 571) where the complete model is loaded 
being converted into nodes and lines, background layers represent some sort of transparent 
sheets for specific modeling. 

It is possible to use several background layers in a model. 

Create background layer 
To open the dialog box for creating a new background layer, 

select Background Layer on the Insert menu 

or use the context menu in the Data navigator. 

 
Figure 11.67: Context menu of Background Layers in the Data navigator 

The Windows dialog box Open appears. Enter the directory and the name of the DXF file. 
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Figure 11.68: Dialog box Open 

Click the [Open] button to access the dialog box Background Layer. 

 
Figure 11.69: Dialog box Background Layer 

The No. of the layer is allocated by the program. In the dialog section Background Layer Descrip-
tion, you can enter any name making the assignment easier later. 

Use the [Edit] button shown on the left to access more settings for the DXF import. Details on 
the dialog box can be found in Figure 12.49 on page 571.  

After clicking [OK] RFEM imports the layer which appears gray in the background of the work 
window. In the line model, you can now define nodes, lines and members. 

 

Figure 11.70: Defining members with background layer 
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Make sure that the object snap for background layers is activated so that you can arrange ob-
jects on the points available in the layer. To activate the object snap for DXF points, use the 
[DXF] button in the status bar. Alternatively, select Work Plane, Grid/Snap, Object Snap, Guide-
lines on the Tools menu, or use the toolbar button shown on the left. 

The dialog box Work Plane and Grid/Snap opens. In the dialog tab Background Layers, you can-
not only activate the snap but edit, delete or hide and display layers as well as create new ones. 

 
Figure 11.71: Dialog box Work Plane and Grid/Snap, tab Background Layers (dialog section) 

Edit, delete or copy background layer 
To open the edit dialog box, double-click the background layer or the relevant entry in the  
Data navigator (see Figure 11.67, page 455). You can also use the dialog tab Background Layers 
available in the dialog box for work plane settings (see Figure 11.71): After selecting the layer 
in the list, you can [Edit] it. 

Deleting a background layer is also possible in the Data navigator. 

To move, copy or mirror a background layer, select the layer first. Then, you can apply the  
function described in chapter 11.4.1 on page 459. 

Display of background layers 
The Display navigator controls the representation of background layers in detail. 

 
Figure 11.72: Background layer settings in the Display navigator 
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Buttons of menu item Select View 

11.3.11  Margins and Stretch Factors 
In most cases, it is not required to change the full screen arrangement or the scaling of the 
model in the work window. But if you have to adjust the global display parameters, 

select Display Margins and Stretch Factors on the Options menu 

to open a dialog box managing the default settings. 

 
Figure 11.73: Dialog box Display Margins and Stretch Factors 

Settings in the dialog section Graphic Margins determine the minimum distances that are kept 
for the representation of the model on the four sides of the work window's margins. The values 
are set in percentage and refer to the total height or width of the work window. They have an 
impact when using the buttons of the menu item Select View on the View menu (see figure on 
the left) or the function Show Whole Model [F8] for the window-filling graphical representation. 

To display the model in a distorted view, you can define factors unequal to 1 for the global di-
rections in the dialog section Compress or Stretch Model. However, customizing settings in this 
dialog section may be required only in exceptional cases. They affect only the display of the 
model but not the actual geometry. To scale the model, use the Scale function available on the 
Edit menu (see chapter 11.4.5, page 465). 

11.4 Edit Functions 
Use the graphical editing functions to modify objects previously selected in the graphic. The 
selected objects can be 

• moved 

• copied 

• rotated 

• mirrored 

• projected 

• scaled 

• extruded 

• sheared. 

No selection is needed for the CAD functions described in chapter 11.3. The functions described 
on the following pages help you to model new objects. 

This chapter also describes how to divide lines, place comments or change numberings. 
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Context menu of selected objects 

11.4.1 Move and Copy 
To move or copy selected objects, 

select Move/Copy on the Edit menu 

or use the context menu of the corresponding object. You can also use the toolbar button 
shown on the left. 

 
Figure 11.74: Button Move and/or Copy 

The following dialog box appears: 

 
Figure 11.75: Dialog box Move or Copy - Copy 

When the Number of copies is set to 0, the selected objects will be moved. Otherwise, the en-
tered number of copies will be generated. 

With the options in the dialog section Reference to Coordinate System you decide whether the 
objects are moved or copied in the global coordinate system XYZ or in a user-defined system 
of coordinates UVW (see 11.3.4, page 442). The user-defined coordinate system can be select-
ed in the list or created with the [New] button. 

The Displacement Vector is specified by the distances dX, dY and dZ, or du, dv and dw for a user-
defined coordinate system. The vector can also be determined in the work window by using 
the [] function or by clicking two grid points or nodes. 

If copies are created, you can influence the numbering of new nodes, members, lines, surfaces 
and solids in the dialog section Numbering Increment for. 

Click the [Edit] button shown on the left to open another dialog box offering useful options for 
copying. The same dialog box is used also for other functions such as mirroring, rotating etc. 
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Detail settings 

 
Figure 11.76: Dialog box Detail Settings for Move/Rotate/Mirror 

Connecting 

You can create new Lines and Members between the selected nodes and their copies. In addi-
tion, it is possible to generate Surfaces and Solids between the selected lines or surfaces and 
their copies. 

 
Figure 11.77: Copy with connecting members and connecting surfaces 

When a Template member, Template surface or Template solid is selected in the list or in the 
graphic by using the [] function, its properties are used for the connecting objects.  
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Duplicity 

Double members may be created when copying. Use the check box to decide if overlapping 
members are allowed or merged to be one member. 

Local coordinate systems 

You can adjust the local line and member coordinate systems to the new position when rotat-
ing and mirroring. 

The automatic adjustment of local axes often becomes important when mirroring objects. The 
function proves to be useful as well for rotating a vertical member as its axis y is oriented paral-
lel to the global Y-axis (see chapter 4.17, page 146). 

Moreover, the function adjusts eccentric connections that are defined in direction of the glob-
al axes X, Y and Z. 

Load cases 

If the check box for Copy including loading is ticked, the loads acting on the selected objects 
will be transferred to the copies. Please note that the loads of all load cases will be copied, not 
only the loads of the currently selected load case. 

Nodal loads can be defined only in direction of the global axes X,Y,Z. If you want to influence 
the direction of nodal loads when copying the surfaces or members, use the check box Adjust 
nodal loads when rotating or mirroring. When it is ticked, RFEM will convert the loads like local 
concentrated loads to the new position. In this case, make sure that the members are selected 
together with the nodal loads before rotating or mirroring. If the check box is clear, the global 
load direction will be kept. 

 
Figure 11.78: Adjusted nodal loads when rotating two times about 45° 

Auto connect 

Use the check box to decide if the copies of the lines and members will be connected auto-
matically to the already existing lines and members. When the box is ticked, a node will be 
created in the point of intersection. 
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Context menu of selected objects 

11.4.2 Rotate 
To rotate selected objects about a particular axis,  

select Rotate on the Edit menu, 

use the context menu of the corresponding object or the toolbar button shown on the left. 

 
Figure 11.79: Button Rotate 

The following dialog box appears: 

 
Figure 11.80: Dialog box Rotate - Copy 

When you set the Number of copies to 0, the selected objects will be rotated. Otherwise, the en-
tered number of copies will be generated.  

Enter the rotation angle in the dialog section Rotation. The angle refers to a coordinate system 
that is clockwise-oriented. 

The Axis of Rotation can be defined in two ways: 

• The rotation axis runs parallel to an axis of the global axis system X,Y,Z. In this case, activate 
the first option and select the relevant axis from the list to the right. Then, in the dialog sec-
tion Definition of the Axis of Rotation, specify a point through which the rotation axis is run-
ning. 

• The rotation axis lies anywhere in the work plane. In this case, activate the second option. 
Then, in the dialog section Definition of the Axis of Rotation, specify two points defining the 
rotation axis. 

If copies are created, you can influence the numbering of new objects in the dialog section 
Numbering Increment for. 

Use the [Edit] button shown on the left to open another dialog box with useful options that 
are described in chapter 11.4.1 on page 460. With entries in the dialog box for detail settings 
you can determine if the connecting lines created when copying are generated as straight 
lines or arcs. 
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Context menu of selected objects 

11.4.3 Mirror 
To mirror selected objects on a plane, 

select Mirror on the Edit menu 

or use the context menu of the corresponding object. You can also use the toolbar button 
shown on the left. 

 
Figure 11.81: Button Mirror 

The following dialog box appears: 

 
Figure 11.82: Dialog box Mirror - Copy 

To maintain the original object, tick the check box for Create copy. 

The Mirroring Plane can be defined in two ways: 

• The mirroring plane runs parallel to a plane that is spanned by the axes of the global axis 
system XYZ. In this case, activate the first option and select the relevant plane from the list 
to the right. Then, in the dialog section Mirroring Plane, enter a point lying in the plane set 
above. 

• The mirroring plane lies anywhere in the work plane. In this case, activate the second op-
tion. Then, in the dialog section Mirroring Plane, enter three points that define the plane. 

If a copy is created, you can influence the numbering of new objects in the dialog section 
Numbering Increment for. 

Use the [Edit] button shown on the left to open another dialog box with useful options that 
are described in chapter 11.4.1 on page 460.  
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Context menu of selected objects 

11.4.4 Project 
Use this function to project selected objects on a plane. Thus, you can adjust for example the 
inclination angle of horizontal beams or rafter members. 

Example 

A member is projected in direction X on the plane YZ. 

 
Figure 11.83: Original member and projected copy on plane YZ 

To open the dialog box for entering the projection parameters, 

select Project on the Edit menu 

or use the context menu of the selected objects. 

 
Figure 11.84: Dialog box 3D Project - Copy 
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To maintain the original object, tick the check box for Create copy. 

In the dialog section Projection Direction, you can decide whether the objects will be projected 
in the direction of a global axis (X, Y or Z) or perpendicular to a target plane. 

The Target Plane can be defined in the following three ways: 

• The target plane runs parallel to a plane that is spanned by the axes of the global axis sys-
tem X,Y,Z. In this case, activate the first option and select the relevant plane from the list 
to the right. Then, in the dialog section Point Coordinates of Target Plane, enter a point that 
lies in the plane set above. 

• The target plane runs parallel to a plane that is spanned by the axes of the global axis sys-
tem XYZ but is additionally rotated about one of the axes. In this case, activate the second 
option. In the list to the right, select the relevant plane and specify the axis and angle of 
rotation. Then, in the dialog section Point Coordinates of Target Plane, enter a point that 
lies in the plane set above. 

• The target plane lies anywhere in the work plane. In this case, activate the third option. 
Then, in the dialog section Point Coordinates of Target Plane, define the plane by entering 
three points. 

If a copy is created, you can influence the numbering of new objects in the dialog section  
Increment for Numbering. 

Use the [Edit] button shown on the left to open another dialog box with useful options that 
are described in chapter 11.4.1 on page 460. 

11.4.5 Scale 
Use this function to scale selected objects in relation to a point. 

Example 

A quadrangle surface is equally scaled starting from the origin in all three directions by the  
factor 2. 

 

Figure 11.85: Original surface and scaled copy 

To open the dialog box for entering the scale parameters, 

select Scale on the Edit menu 

or use the context menu of the selected objects (see figure in the margin to the left of Figure 
11.83). 
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Context menu of background layers 

 
Figure 11.86: Dialog box Scale - Copy 

When the Number of copies is set to 0, the selected objects will be scaled. Otherwise, the en-
tered number of copies will be generated. 

The dialog section Scale by manages the scaling factor k (see graphic in the dialog box). 

Three possibilities are available for selection to define the Direction of Scaling: 

Equally in X,Y,Z All object coordinates (X, Y and Z) will be scaled in relation to the 
starting point defined in the dialog section Coordinates. 

In direction: X / Y / Z You define one of the global axis. Only the object's coordinates of 
the selected global axis will be scaled in relation to the starting 
point defined in the Coordinates dialog section. 

In direction, defined by 
two points 

In the dialog section Coordinates, specify a vector by entering two 
points. Objects will be scaled into the vector direction. 

Table 11.7: Dialog section Direction of Scaling 

If a copy is created, you can influence the numbering of new objects in the dialog section 
Numbering Increment for. 

Use the [Edit] button shown on the left to open another dialog box with useful options that 
are described in chapter 11.4.1 on page 460. 

It is also possible to scale background layers. To access the corresponding function, 

point to Background Layers on the Edit menu, and then select Stretch 

or use the context menu of background layers in the Data navigator. 

In the dialog box Select Background layer, specify the relevant layer first. Then, you can define 
the stretch factor in the dialog box Stretch Background Layer. 

 
Figure 11.87: Dialog box Stretch Background Layer 
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Context menu of selected objects 

11.4.6 Shear 
The function rotates objects about an axis and adjusts only the coordinates of one single direc-
tion. You can use the shear function for example to shift horizontal members into the inclination 
plane of a roof. The member lengths will be adjusted, the horizontal components of the coordi-
nates remain unchanged. 

Before you use the function, select the members together with the nodes that belong to them. 

To open the dialog box for entering the shearing parameters, 

select Shear on the Edit menu 

or use the context menu of the selected objects. 

 
Figure 11.88: Dialog box 3D Shearing 

In the dialog section Slope, enter the rotation angle in [°] or [%]. 

The parameters for Shearing can be defined in two ways: 

• The rotation axis runs parallel to a plane that is spanned by the axes of the global axis sys-
tem XYZ. In this case, activate the option About axis and select the relevant axis of rotation 
from the list to the right. Then, in the list In direction, select the global axis that is relevant 
for adjusting the node coordinates. Finally, in the dialog section Starting Plane, enter the 
point of rotation. 

• The rotation axis lies anywhere in the work plane. In this case, activate the second option. 
Then, in the dialog section Starting Plane, define both points of the rotation axis and an-
other point for determining the plane. You can select the points also graphically by using 
the [] buttons. 
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11.4.7 Divide Lines and Members 
Lines and members can be divided quickly: Right-click the object and select Divide Line or  
Divide Member in the context menu. 

 
Figure 11.89: Context menu Divide Line 

The menu item offers three division options. 

Graphically 

 
Figure 11.90: Dialog box Divide Line 

The dialog box Divide Line opens. When you move the pointer along the line, it will be snapped 
at the distances specified in the dialog section Step. Click to define the division point. The Ref-
erence of the division spacings can be set in absolute distances or relatively to the total length. 

It is also possible to enter the Division Spacing directly. Before entering the spacing, specify the 
line that you want to divide and the number of the new line in the input fields Line No. and 
New No. If you want to relate the division spacing to the line end, you can change the line ori-
entation with the check box Reverse orientation. 



11  Tools 

 469 Program RFEM © 2013 Dlubal Software GmbH 

 

n intermediate nodes 

 
Figure 11.91: Dialog box Divide Line Using n Intermediate Nodes 

Use this function to divide the line equally into several line parts. In the dialog section Number 
of, you can define the number of Intermediate nodes for the member division. 

Decide if you want to divide the line into "real" lines by new intermediate nodes, or maintain the 
line while RFEM will create nodes on the line in equal spacings. Usually, the real division is pre-
ferred. However, if you want to change the course of a B-Spline line when dividing the line, the 
second option is the better choice. 

In the dialog section Numbering Starts with, you can influence the numbering of new nodes, 
lines and members. 

Distance 

 
Figure 11.92: Dialog box Divide Line Using Distance 

Use this function to generate a division node on a particular location of the line. 
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The line is either divided into "real" lines by a new intermediate node or maintained while RFEM 
creates a new node on the line. 

Settings in the dialog section Distance Relative to control the reference of the division distance. 
The distance can be referred to the real line length (normal case) or to a projection. 

The Distance Between New Node and start or end node of the line is to be specified as absolute 
value or relatively to the total length. The four input fields are interactive. 

For entering the distance it is important to know the line or member orientation. The orienta-
tions and axis systems of lines and members can be switched on and off in the context menu 
or the Display navigator (see Figure 4.26, page 50 and Figure 4.158, page 145). 

The dialog section Numbering Starts with controls the numbering of new objects. 

11.4.8 Connect Lines and Members 
Use this function to connect lines and members that cross each other but do not have a com-
mon node. 

 
Figure 11.93: Original on the left (intersecting, unconnected lines) and result on the right (connected lines) 

To access the corresponding function, 

select Connect Lines/Members on the Tools menu 

or use the toolbar button shown on the left. 

 
Figure 11.94: Button Connect Lines or Members 

Go into the work window and draw a window across the zone where you want to connect the 
lines or members. It is not necessary to catch the objects completely. 

Furthermore, the function can be used to determine the intersection point of a line piercing a 
surface. 

 
Figure 11.95: Creating an intersection point between line and surface: original (left) and copy with result (right) 

The Auto Connect function is preset for setting new lines or members graphically, as shown in 
the figure below. But connection nodes will only be created when lines/members are connect-
ed to other lines/members, that means when they end on the corresponding object. So, when 
you define crossing diagonals, no intersection node will be generated. 
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In the New Line or New Member dialog box, you can use the [Details] button to determine if 
lines or members are connected automatically when they are generated. 

 
Figure 11.96: Dialog box New Line - Details 

11.4.9 Merge Lines and Members 
Lines or members that are connected with each other can be unified to be one single line or 
member. This function is only available in the context menu of division nodes. Right-click the 
division node to open its context menu. 

 

Figure 11.97: Context menu items Delete Node → Merge Joined Lines/Members with result (on the right) 

The context menu offers extended options for the function Delete Node whereas the [Del] key 
simply deletes the selected node and consequently the joined lines, members and surfaces. 
But these special options are only provided for nodes to which exactly two lines or members 
are connected. 

In case the lines or members do not lie on a straight line, RFEM will create a new line or member 
between the edge nodes when merging. 
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Member context menu 

11.4.10  Extend Lines and Members 
Use this function to adjust the length of a line or member in general, or to extend the line until 
it reaches another line. 

To access the extend function, use the line context menu (see Figure 11.89, page 468) or the 
member context menu shown on the left. 

The dialog box Extend Line or Extend Member opens. 

 
Figure 11.98: Dialog box Extend Member 

The dialog section Extend Method offers three options: 

• Extend to L changes the total length of the line or member to a dimension that you specify 
in the input field. 

• Extend by ∆ extends one member side or both member sides by a specified value, or 
shortens the side(s) if the value in the input field is negative. 

• Select To next member or line to extend the object to the nearest line that will produce an 
intersection with the extended straight line of the line or member. When the check box 
for Divide target member or line is ticked, the objects will be connected automatically. 

Specify the direction of extension in the dialog section below: The option On both ends results 
in an extension at both ends of the member. With this setting you can either refer the total 
length L to the line or member center, or extend the line on both sides by the value ∆ or until 
the next two lines are reached. Alternatively, use the options On Member Start i or On Member 
End j to adjust the length of the member on only one end. 

The display of line or member orientations can be set in the Display navigator (see Figure 4.26 
on page 50). 

11.4.11  Join Members 
Contrary to connecting members (see chapter 11.4.8, page 470), the function does not require 
a common point of intersection. Thus, free members available in a certain distance to a mem-
ber can be joined to the nodes of this member. However, if you want to connect the member 
by extending the member, use the function Extend Member (see chapter 11.4.10). 

To access the corresponding function, 

select Join Members on the Tools menu. 

The following dialog box appears. 
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Figure 11.99: Dialog box Join Members 

In the dialog section Settings, enter the number of the member to whose nodes you want to 
join the free members. You can select the member also graphically with the [] function. The 
input field below specifies the distance, that means the circumference where RFEM looks for 
free member ends. If the check box for Also select other connected members is ticked, RFEM will 
include also members that are connected with an already selected member into the member 
list of the input field above. 

In the dialog section How to Connect Free Member Ends, you decide how RFEM will join the free 
member ends to the selected members: You can either move them to the nodes of the select-
ed members or connect them by eccentric connections. 

11.4.12  Insert a Node 
Use this function to create a new node between any two nodes. In this way, you do not need 
to define a line and divide it by an intermediate node (see chapter 11.4.7, page 468). 

To access the corresponding function, 

point to Model Data on the Insert menu, select Nodes and click Node Between Two Points 

or use the list button [New Node] in the toolbar. 

Select the two points (nodes, grid points, any points) one after the other in the work window. 
Then, the following dialog box appears: 

 
Figure 11.100: Dialog box Node Between Two Points 

The Distance from Point can be defined in absolute or relative values. The work window shows 
you modifications immediately. To create the new node, click [OK]. 
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11.4.13  Insert a Member 
It is possible to define on an existing member a section that has different cross-section proper-
ties. The original member will be divided by two intermediate nodes. 

To access the corresponding function, 

point to Model Data on the Insert menu, then select Members and Graphically and click 
Inserted Member. 

After selecting the relevant member in the work window, the following dialog box appears: 

 
Figure 11.101: Dialog box New Inserted Member 

Define both division points by mouse clicks in the work window. A cross on the pointer posi-
tion indicates the current division point on the member. The distances shown when moving 
the pointer along the member are controlled by the input field Step. 

The x-locations of the start and end node are displayed in the input fields of the dialog section 
Inserted Member where they can be modified, if necessary. The Length of the intermediate 
member appears below. 

With the options in the dialog section Reference you decide whether the division spacings are 
related to the absolute lengths or to the relative distances from the member start. 

The Cross-section can either be accepted or assigned as a new one selected from the list of al-
ready defined cross-sections. With the buttons shown on the left you can create a [New] cross-
section or select a cross-section from the [Library]. 

The dialog section Numbering Starts with controls the numbering of new objects. 
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11.4.14  Assign Member Properties Graphically 
Use this function to transfer the definition criteria of members for cross-section, release and 
eccentricity graphically to already created members. 

To access the corresponding function, 

select Model Data on the Insert menu, point to Members and select  
Assign Member Properties to Members Graphically or 

open the Edit menu, point to Model Data and Members, and then select  
Assign Member Properties to Members Graphically. 

The following dialog box appears: 

 
Figure 11.102: Dialog box Assign Member Properties to Members Graphically 

Select the Cross-Section from the list or use the buttons shown on the left to select the cross-
section from the [Library] or to create a [New] one. If necessary, you can define the Member End 
Release with a list, but it is also possible to create a [New] release type (see chapter 4.14, page 
128). 

You can relate the Member Eccentricity to the local member axis system xyz or the global coor-
dinate system XYZ. If needed, define the eccentricity in the corresponding input fields (see 
chapter 4.15, page 134).  

With the options in the dialog section Status, you decide if a member eccentricity is removed 
(Delete) or assigned as new (Set). Choose Keep original to change only the cross-section and the 
member end release but not any existing eccentricity. 

After clicking [OK] you can see that the members are divided graphically at one-third division 
points (see Figure 4.135, page 129). Now, you can click the member sides to which you want to 
apply the selected properties (for example a release). To assign the release or the eccentricity 
to both member ends, click the member in its center. 
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Surface context menu 

 

11.4.15  Round Corners 
Corners and edges in the model may result in singularity effects. To open the dialog box for 
modeling corners close to reality using fillet radii, 

select Create Round or Angled Corner on the Tools menu. 

It is not necessary to select both lines previously. The following dialog box appears: 

 
Figure 11.103: Dialog box Create Round or Angled Corner 

In the dialog section Corner Type, you decide if the corner zone will be made Round or Angled. 
Depending on the selection, you have to enter the fillet radius r or a reduction by the lengths l1 
and l2 in the dialog section Parameters. 

Then, select both lines by mouse-click in the work window without closing the dialog box. The 
line numbers will be shown in the dialog section Create Between Lines No. 

When the check box for Cut lines is ticked, RFEM deletes the extensions of the original lines 
overlapping in the corner zone after creating the arc or the new line. The option Delete corner 
removes also the node in the corner. 

11.4.16  Split Surface 
Surfaces can be split into surface components if one of the following conditions is fulfilled: 

• The surface is defined by four lines and has no re-entrant corner. The lines are no inter-
secting lines, trajectory curves or similar objects. 

• The surface is a rotated surface with a rotation angle of α < 360°. 

To divide a surface, right-click it and select Split Surface in the context menu. 

A preview appears in the dialog box Split Surface (see Figure 11.104) suggesting a division that 
illustrates the preset parameters. Parameter settings and dialog graphic are interactive: When 
you change the Number of divisions for both boundary line pairs A + C and B + D, the graphic 
shows you the new sub-surfaces immediately. 

It is possible to define a Relative distance for each division line. Irregular splitting patterns can 
be defined as well. 

In the graphic window, you can use the common mouse functions such as zooming or rotating 
to change the view (see chapter 3.4.9, page 35). 
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Figure 11.104: Dialog box Split Surface 

11.4.17  Apply Tangent to Circles 
You can easily create a tangent on an arc or a circle by using the object snap (see chapter 11.3.3, 
page 439). Another special function allows you to find tangents even for two circles or circular 
arcs. To open the corresponding dialog box, 

select Tangent to Two Circles/Arcs on the Tools menu. 

The following dialog box appears: 

 

Figure 11.105: Dialog box Tangent to Circles or Arcs (above) with result (below) 

First, click both circle or arc lines one after the other in the work window. RFEM draws the pos-
sible tangents as gray lines. Now, click the relevant line. RFEM divides the circular or arc line by 
nodes and creates the tangent as a new line. 

By ticking the check box for Trim arcs you can remove overlapping line sections resulting from 
the division (see figure above). 
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11.4.18 Change Numbering 
A regular, structured numbering proves to be useful for modeling as well as evaluations. How-
ever, graphical input and subsequent modifications may rearrange the numbering. 

There are three options for adjusting the order of the numbering subsequently. To access the 
corresponding functions, 

select Renumber on the Tools menu. 

Loads are no problem when changing the numbering because the assigned loading will be 
transferred automatically to the new numbers of the objects. 

Singly 

 
Figure 11.106: Dialog box Renumber - Singly 

In the dialog section Object to Renumber, you decide whether nodes, lines, members or other 
model objects selected from the list will be renumbered. Specify the start number of the new 
numbering as well as the increment in the dialog section Renumbering. 

After closing the dialog box with the [Close] button, you can select the relevant objects one  
after the other in the work window. Please note that RFEM can allocate only free numbers that 
are not yet assigned. 

Automatically 
First, select the nodes, lines and members (see chapter 11.2.1, page 430) whose numbering 
you want to adjust. Then, open the following dialog box. 

 
Figure 11.107: Dialog box Renumber - Automatically for nodes, lines and members 
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Specify the Priority of the global directions X, Y and Z for the new numbering. In addition, you 
have to decide if the ascending numbering will be applied in Direction of the respective posi-
tive or negative axis. 

In the example above, the nodes (as well as lines and members) with the lowest X-coordinates 
receive new numbers first. The nodes are processed in the positive direction X. If two nodes 
have identical X-coordinates, the second priority decides which node will receive the lower 
number: This will be the node with the smaller Y-coordinate. The third priority will be decisive 
in case the Y-coordinates are identical as well. 

The dialog section Objects to Renumber controls which nodes, lines and members will be re-
numbered and which start numbers and increments will be used for the renumbering. Already 
allocated numbers must not be assigned again. However, RFEM allows the use of numbers that 
have been allocated before changing the numbers but will become vacant during the renum-
bering. 

Shift 
First, select the objects whose numbering you want to adjust. Then, open the following dialog 
box by pointing to Renumber on the Tools menu. 

 
Figure 11.108: Dialog box Renumber - Shift 

In the dialog section Selected Objects, define the objects that you want to renumber: Apart from 
nodes, lines and members, you can select other objects of the model in a list (see figure to the 
left). In the Increment column to the right, you can specify a value by which the numbers of the 
selected objects will be upgraded. Use negative increments to degrade the numbering. Make 
sure that no number will be smaller than 1. 

In the dialog section Load Cases and Combinations, you can adjust the numbering of load cases, 
load and result combinations. Specify their numbers in the form of a list entered in the columns 
No. from and No. to. The Increment column to the right controls the value by which the numbers 
of the load objects are respectively upgraded. 

After clicking [OK] the numbers will be shifted. Please note that only free, not yet assigned num-
bers can be allocated to the various model and load objects. 
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11.5 Table Functions 

11.5.1 Editing Functions 

The editing functions are tools making the data input in tables easier (see chapter 3.4.4, page 
26). In contrast to the selection functions described in the following chapter 11.5.2, it is not 
necessary to select cells previously. The editing functions only affect the cell in which the 
pointer is placed. 

To turn the tables on and off, 

select Display on the Table menu 

or use the toolbar button shown on the left. 

Access to editing functions 
To enable the editing functions for the table, place the pointer into a table cell. To access the 
editing functions,  

point to Edit on the Table menu. 

Some editing functions are available in the toolbar of the table. 

 
Figure 11.109: Buttons for several editing functions in the table toolbar 

Alternatively, use the context menu in the table to access the functions. 

 
Figure 11.110: Editing functions in the table context menu 
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Functions and commands 

Function Effect 

Cut [Ctrl+X] Removes content of cell and saves it in clipboard 

Copy [Ctrl+C] Copies cell content to clipboard 

Paste [Ctrl+V] Inserts contents of clipboard into cell 

If the clipboard contents are bigger than the cell, the cells of  
the subsequent table columns and rows will be overwritten.  
A warning is displayed before. 

Copy Row [Ctrl+2] Overwrites subsequent row with contents of current row 

Empty row [Ctrl+Y] 

 

Deletes contents of row without deleting the row itself 

Insert row [Ctrl+I] 

 

Inserts a new, empty row. The subsequent rows will be moved 
downwards. 

Delete row [Ctrl+R] 

 

Deletes the current row. The subsequent rows will be moved 
upwards. 

Find [Ctrl+F] Searches a number or string within the table 

Replace [Ctrl+H] Searches a number or string within the table and replaces it by 
another entry 

Empty table Deletes contents of current table completely without a warning 

Empty all tables Deletes contents of all tables   

Select [F7] Opens a list for selection in cell 

Update graphics 

 

Transfers modifications entered in table to graphic 

Edit in dialog box Opens a dialog box where data of current row can be entered 

Table 11.8: Editing functions 
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11.5.2 Selection Functions 
The selection functions are tools making the data input in tables easier. In contrast to the  
editing functions described in chapter 11.5.1, you have to mark several, connected cells as  
a Selection first. 

 
Figure 11.111: Selection 

It is not important whether the cells are empty or filled with content. A selection function  
modifies the contents of selected cells altogether. 

Access to selection functions 
First, mark a selection as a block of contiguous cells in the table: Move the mouse across sever-
al cells while holding the left mouse button down. A click into a table header (A, B, C ...) selects 
the whole table column. To select the entire table row, click the row number on the left. 

To access the selection functions, 

select Selection on the Table menu. 

Some selection functions are available in the toolbar of the table. 

 
Figure 11.112: Buttons for several selection functions in the table toolbar 

You can also access the functions by means of the context menu in the table. 

 
Figure 11.113: Selection functions in the table context menu 
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Functions and commands 

Function Effect 

Deselect [Ctrl+D] Cancels selection of row or column 

Cut [Ctrl+X] Removes content of selected cells and saves it in clipboard 

Copy [Ctrl+C] Copies content of selection to clipboard 

Paste [Ctrl+V] Inserts content of clipboard into table 

The command is only available when the clipboard contains appropriate 
data (for example from Excel). 

Delete [Ctrl+Del] 

 

Deletes all contents of selected cells 

Add 

 

Adds value to or subtracts value from cells with numerical values 

Multiply 

 

Multiplies cells with numerical values by a factor 

Divide 

 

Divides cells with numerical values by a divisor 

Set Assigns the value of the topmost selected cell to all cells of the entire  
selection. 

Generate [Ctrl+G] Used for cells with numerical values to generate entries between first and 
last selected cell by interpolation of both reference values (see example 
below) 

Save Saves selection as file   

Import Imports selection saved as file 

Table 11.9: Selection functions 

Example: Generating cell values 

Use this function to fill empty cells quickly. The intermediate values are determined by a linear 
interpolation from the start value of the top cell (in example 6.000) and the end value of the 
bottom cell (in example 30.000). 

 
Figure 11.114: Context menu of selection 
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When you apply the Generate option, the intermediate cells are filled with interpolated values. 

 
Figure 11.115: Result 

11.5.3 View Functions 
The table display can be adjusted by different view functions improving the data overview in 
the table. 

Access to view functions 
To access the view functions, 

select View on the Table menu or 

select Optimize Load Data on the Table menu. 

Some of the view functions can be accessed in the toolbar of the table. 

 
Figure 11.116: Buttons for several view functions in the table toolbar 

Functions 

Function Effect 

Only filled rows 

 

Hides all empty table rows 

Marked rows only 

 

Shows only selected rows 

Selected objects only 

 

Shows only objects selected in graphic 

Select related objects 

 

In addition to loads, associated model objects (nodes, surfaces, 
members etc.) are selected in the graphic.  
Only available in loads tables 3. 

Compress data 

 

Summarizes objects with same loads in one single table row in 
loads tables   

Decompress data 

 

Lists loads for each object individually 
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Result filter 

 

Table output can be restricted to particular result types  
(see chapter 11.5.5, page 487). 

Info about cross-section 

 

Shows characteristic values of current cross-section 

Result diagrams 

 

Displays results of selected member graphically in new window 
(see chapter 9.5, page 356) 

Colored relation scales 

 

Switches the display of the red and blue bars in the table on and 
off. 

Title bar Switches title bar on and off 

Toolbar Switches toolbar on and off 

Column bar Switches column headings (A, B, C, ...) on and off 

Status bar Switches status bar of table on and off 

Highlight table row The table row where the pointer is placed is highlighted with 
colors or won't be marked. 

Table 11.10: View functions 

Example: Only filled rows 
A table contains empty rows disturbing the clear table overview. 

 
Figure 11.117: Table with empty rows 

Use the button Only Filled Rows in the table toolbar to hide all empty table rows. 

 
Figure 11.118: Table without empty rows 
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11.5.4 Table Settings 
The font and color settings used in the tables can be adjusted individually. Moreover, it is pos-
sible to synchronize the selection in the graphic with the one in the table. 

Access to table settings 
To select a particular table setting,  

select Settings on the Table menu. 

To activate and deactivate the synchronization of the selection, you can also use the table 
toolbar buttons. 

 
Figure 11.119: Buttons Selection Synchronization 

Functions 

Function Effect 

Colors Opens the dialog box Colors (Figure 11.120). Colors of 
individual table objects can be adjusted separately. 

Fonts Opens the dialog box Font (Figure 11.120). Font, style and 
font size can be modified globally for all table objects. 

Select current object in graphic 

 

Function is set active by default: Object of table row 
where pointer is placed is selected also in work window. 

Show selected object in tables 

 

Function is set active by default: Objects selected in work 
window are highlighted with colors also in table. 

Table 11.11: Table settings 

  
Figure 11.120: Dialog boxes Colors and Font 
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11.5.5 Filter Functions 
Various filter functions allow you to evaluate specifically internal and contact forces as well as 
deformations in the member results tables. In addition, filter options are available for nodal 
and line support forces of result combinations (see chapter 8.1, page 285 and chapter 8.3, 
page 290). 

Access to filter functions 
To access the filter functions, 

select View on the Table menu and click Result Filter 

or use the button in the table toolbar shown on the left. 

 
Figure 11.121: Button Result Filter 

The following dialog box appears: 

 
Figure 11.122: Dialog box Table Filter 

Select the relevant results table in the dialog section Tables to Display. Then, use the dialog tab 
on the right to determine which values will be shown numerically. 

When the table for internal forces of members is set, you can define for Load Cases and Load 
Combinations and Result Combinations separately whether Nodal values (member start and 
member end), Member division values (intermediate points of user-defined member division, 
see chapter 4.16) and Extreme values of members are shown in the table. You have to tick at 
least one of the six check boxes for internal forces. The selected internal forces are shown on 
the locations of the result values that are activated by a check mark above. 

Two result values appear on each location for result combinations – the minimum and the 
maximum internal forces with the corresponding internal forces. 
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Use the buttons shown on the left to transfer the filter criteria from one dialog section to the 
other. 

Example 
A member division with two intermediate points has been defined for member 11 that has a 
length of 6.70 m. The filter settings for result combinations shown in Figure 11.122 result in the 
following results table 4.6 Members - Internal Forces. 

 
Figure 11.123: Results filtered by nodal values, division points and extreme values My 

Table column H shows the maximum and minimum bending moments My on the nodes and 
division points as well as locations of the absolute extreme values in bold. The latter appear 
with a capitalized initial letter as Max My and Min My at the end of the list (see marked cells in 
figure above). The values in the remaining columns represent the corresponding internal  
forces of the respective maximum and minimum values. 

11.5.6 Import and Export of Tables 
A table from MS Excel or Open Office.org Calc can be imported directly into the current RFEM 
input table. The programs involved must be opened. It is also possible to export the current 
RFEM table all or part to Excel or Open Office.org Calc. 

Access to import and export function 
To apply the import or export function, click the button [Export/Import Table] in the table 
toolbar. 

 
Figure 11.124: Button Export/Import Table in the table toolbar 
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Use this button to open the Export table and Import table dialog box. 

 
Figure 11.125: Dialog box Import table 

 
Figure 11.126: Dialog box Export table 

Import table 
The workbook from MS Excel or OpenOffice must have been opened before the import starts. 
If headers exists in the worksheets, tick the check box for Including table header. Then, the 
headers will be ignored during the import. Only the lists will be imported into the RFEM tables. 

In the dialog section Application, you can select between the spreadsheets of Microsoft Excel 
and OpenOffice.org Calc. 

The dialog section Transfer Parameters specifies whether the active workbook or only the ac-
tive worksheet will be imported. When you import a complete workbook, the order and struc-
ture of worksheets must be completely consistent with the RFEM tables. 

In the dialog section Formulas and Parameters, you can decide if formulas stored in Excel or 
OpenOffice will be imported as well when exchanging data. 

Click [OK] to start the import. 

If you want to import only particular parts of the worksheet, the copy function is recommend-
ed: Select the relevant area in the Excel table and copy it to the clipboard with [Ctrl]+[C]. Then, 
place the pointer into the corresponding cell of the RFEM table and insert the contents of the 
clipboard with [Ctrl]+[V]. 
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Export table 
To export RFEM tables, MS Excel or Open Office.org Calc do not need to run in the background. 

In the dialog section Application, you can select between the spreadsheets Microsoft Excel and 
OpenOffice.org Calc. In addition, it is possible to create a file in the general spreadsheet CSV 
(see chapter 4.13, page 127). 

In the dialog section Table Parameters, specify if the headers will be exported, too. When the 
check box for Export table header is ticked, the result in Excel looks like below: 

 
Figure 11.127: Excel table with exported headers 

When you clear the check box, only the table contents will be transferred to Excel. 

With the option Only marked cells, you can export selected table contents (see chapter 11.5.2, 
page 482). 

Use the check box for Only selected objects to export data or results of selected row numbers. 
The selection is made easier by the synchronization of the selection between graphic and ta-
ble (see chapter 11.5.4, page 486). 

The option Only filled rows controls the way how empty rows are treated for the export. 

In the dialog section Transfer Parameters, you can define the target tables where data will be 
written. When the first check box is clear, RFEM will create a new workbook. With the option 
Export table to active worksheet it is possible to use the current worksheet of the spreadsheet.  
If the check box for Rewrite existing worksheet is ticked, RFEM will search in the workbook for a 
table with the same name as in RFEM and will overwrite it then. 

Using the check boxes in the dialog section Formulas and Parameters, you can decide if and 
how formulas saved in RFEM will be exported. 

To start the export of the current RFEM table, click [OK]. 

To transfer several tables all at once to Excel or OpenOffice.org Calc, it is recommended to se-
lect Export on the File menu (see chapter 12.5.2, page 569). Then, you can select the relevant 
tables in a dialog box. 
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11.6 Parameterized Input 

11.6.1 Concept 

The parameterized input for model and load data makes use of variables (for example length, 
width, traffic load etc.) which are called "parameters" and stored in a parameter list. 

The parameters can be used in formulas to determine a numerical value. The formulas are ed-
ited in the Formula Editor. If a parameter is modified in the parameters list, the results of all 
formulas using this parameter will be adjusted. 

The parameterized input is useful for projects where many changes are to be expected. The 
stored formulas are easy to follow and bring more clarity to complex models. The parameter-
controlled input is also quite suitable when editing recurring models that are similar in design: 
Simply open a template file and adjust the parameters. 

11.6.2 Parameter List 
The parameter list manages all parameters required for modeling. 

Access to parameter list 
To access the parameter list, click the [Edit Parameters] button: 

• in the toolbar of an input table 

 
Figure 11.128: Button Edit Parameters in the table toolbar 

• in the Formula Editor. 

 
Figure 11.129: Button Edit Parameters in the Formula Editor 

Description 
The dialog box Edit Parameters appears. 

 



11  Tools 

 

 

492 Program RFEM © 2013 Dlubal Software GmbH 

 
Figure 11.130: Dialog box Edit Parameters 

Each table row manages a Parameter. In column A, enter a name that consists of ASCII signs. 
The name must not contain any spaces. The description is used to refer to the parameter in the 
formulas. Each parameter name can be assigned only once. 

In table column B, define the Unit Type to determine if the parameter represents a length, load, 
density etc. The unit types are predefined. To access the selection list available in the column, 
use the context button [] or the keyboard key [F7]. 

In column C, define the numerical Value of the parameter. 

Specify the Unit in table column D. To access the selection list of units available in the column, 
use the context button [] or the keyboard key [F7]. 

In column E, you can enter a Formula to determine the value of the parameter for table column 
C. In addition to common mathematical operations, IF-THEN statements and max/min functions 
are available. With the $-reference you can refer to a particular table (for example $1.1(A1) uses 
the value of cell A1 from table 1.1). 

Examples 

if(A<B;10;B) If parameter A is smaller than parameter B, the value 10 is applied.  
Otherwise, parameter B will be used. 

max(A;B) The larger value of both parameters A and B will be applied. 

min(max(A;B);C) The larger value of parameters A and B is determined which will then be 
compared to the value of parameter C. The smallest value will finally be 
applied. 

Use the button [...] in table column E to access a List of operators and functions. 
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Figure 11.131: Dialog box List of operators and functions 

In table column F, you can define a Range of Values to control the values of column C. 

Column G is reserved for entering any Comment. 

Input functions 
The parameters can be entered cell by cell. 

Several tools for efficient input are available in the context menu that you open with a click  
of the right mouse button. The editing functions (empty row or insert row, replace etc.) are  
described in chapter 11.5.1 on page 480). 

When several cells are marked as a selection, the following context menu appears. 

 
Figure 11.132: Context menu of a selection in parameter list 

Find a description of the menu functions in chapters 11.5.1 and 11.5.2, page 480. 
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Buttons 
In addition to the default buttons, the following functions are available in the parameter list. 

Button Description 

 
Saves the parameter list in a file. 

 
Loads a saved parameter list 

 
Export of parameter list to MS Excel 

 
Imports data from opened Excel table 

 
Opens calculator and imports its result 

 
Deletes the entire contents of the List of Parameters. 

 
Shows cross-section details of cross-sections used in model 

Table 11.12: Dialog box Edit Parameters: Buttons 

11.6.3 Formula Editor 
The Formula Editor manages the equations of the parameterized input. 

Access to Formula Editor 
To open the Formula Editor, 

• use the button in the table toolbar shown on the left 

 
Figure 11.133: Button Edit Formulas in the table toolbar 

• click the yellow or red corner of the table cell (a red corner indicates an error in the formula) 
or 

 
Figure 11.134: Marked cell corners in table 1.1 Nodes 

• use the function buttons next to the input fields in dialog boxes (see Figure 11.139). 

 
Figure 11.135: Function buttons with context menu in dialog box Edit Node 
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It is also possible to import formulas saved in Excel and to export formulas from RFEM to Excel. 
For more information about the data exchange with Excel, see chapter 12.5.2 on page 569. 

Description 

 
Figure 11.136: Dialog box Edit Formulas 

In the input field Formula, any formula can be entered manually. When you use the calculator, 
its results will be transferred automatically. 

The formula may consist of constant numerical values, parameters or functions. The result of 
the equation appears in the field below. Use the button [] at the end of the Formula line to 
select an entry from the list of already entered formulas. 

Click the button [] to apply the formula to the table cell or input field of the dialog box.  
Delete the formula line with the [] button. In case of misentries, formulas are displayed red  
in the Formula input field. 

Contents of other cells can be used in formulas by means of references. 

 
Figure 11.137: Formula Editor with a reference 

A reference is introduced by an exclamation point (!). The reference cell is set in brackets.  
As shown in the figure above, the content of cell D3 is three times the value of cell D2. 

By means of a prefixed equal sign you can also enter formulas directly in the table cells (for  
example =2.5*PI). If values are used (for example =22.1 + A*H), they are integrated in SI units 
with [m] or [N] into the formula. 
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The following functions are available in the calculator of the Formula Editor: 

Function Description 

 Sine 

 Cosine 

 Tangent 

 Cotangent 

 Square root 

 Power 

 Natural logarithm 

 Logarithm to the base 10 

 Absolute value 

 Integer, for example int(5.638) = 5 

 Clear formula line 

 Inverse, for example inv sqrt(5) means 52 

 Hyperbolic function 

Table 11.13: Calculator functions 

The dialog section List of Parameters in the Formula Editor lists all parameters with the current 
values. To transfer a particular parameter to the Formula line, double-click the entry, or select 
the entry and use the button [Apply Selected Parameter] shown on the left. 

Click the [Edit Parameters] button (see chapter 11.6.2, page 491) to open the parameter list 
where you can modify or complete the parameters. 

Buttons 
The buttons available in the Formula Editor have the following functions: 

Button Description 

 
Applies formula to table cell or dialog field 

 
Deletes formula input 

 
Saves contents of Formula Editor as a file 

 
Loads a saved file 

   Displays or hides calculator and parameter list 

Table 11.14: Dialog box Edit Formulas: Buttons 
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11.6.4 Formulae in Tables and Dialog Boxes 
The equations stored in the Formula Editor can be used in both the cells of tables and the input 
fields of dialog boxes. As tables and dialog boxes are interactive, you can access the formulas in 
both input modes. 

Formulas in tables 
When cells are marked by a yellow or red flag (triangle) in the upper left corner, a formula has 
been linked (see Figure 11.134, page 494). Click the flag to open the Formula Editor. 

To link a "normal" cell with a formula, place the pointer into the cell and open the Formula Edi-
tor by using the button shown on the left. 

 
Figure 11.138: Button Edit Formulas in the table toolbar 

A red flag means that there is an error in the definition of the formula. This flag corresponds to 
the red formula line in the Formula Editor. It is recommended to correct the formula. 

Formulas in dialog boxes 
The parameterized input has been developed primarily for the application in tables. However, 
it is also possible to use formulas in dialog boxes. 

A function button to the right of the input fields in dialog boxes indicates that they can be 
linked with formulas. 

 
Figure 11.139: Dialog box with linked formula and function button 

When the input field has already been linked with a formula, it is marked like a cell by a yellow 
flag (or red flag in case of incorrect input). 

Click the function button to open the context menu shown in Figure 11.135 on page 494 where 
you can access the Formula Editor. 
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11.7  Model Generators 
A variety of tools help you to create models or parts of structural systems. In addition to copy 
and extrude functions, RFEM provides special dialog boxes for generating member and surface 
models. 

11.7.1 Copies and Extrusions 

11.7.1.1 Parallel Offset of Lines and Members 

It is easy to copy selected lines or members graphically: Move the objects to the desired place 
in the workspace by holding down the [Ctrl] key. The function follows the general standards 
for Windows applications. 

If you want to create parallel lines or members, you can enter specific settings in a dialog box. 
To access the corresponding function, 

select Set Parallel Line on the Tools menu or 

select Set Parallel Member on the Tools menu 

or use the context menu of the line or member (see Figure 11.149, page 505). 

 
Figure 11.140: Dialog box New Parallel Line with Offset 

The selected line appears in the List of Lines. If necessary, more lines can be added by clicking 
them in the work window. Please note that all lines of the list must lie in one plane. 

In the dialog section Offset Distance, you specify the copy's distance to the original. 

When several lines are copied by parallel offset, you have several possibilities offered in the  
dialog section Outer Corners to adjust the copied lines or members. The figure above shows 
the copied lines (without axes) extended to the common point of intersection. Moreover, both 
ends are connected with the original lines by the ticked check box Close ends. 

The settings in the dialog section Offset Direction define the side on which the lines will be cop-
ied. The directions +y and -y are directly displayed in the work window. They are especially 
used for this dialog box and do not depend on the currently set work plane. Thus, they do not 
necessarily reflect the line axes. The input field Rotation about x allows for copying objects out 
of the plane. 
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Menu Tools → Extrude 

11.7.1.2 Extrude Lines and Members 

By extruding lines and members you can quickly create surfaces, grids or grillages. But if you 
want to generate an irregular grid using extended specifications, it is recommended to use the 
dialog box Generate Grid (see chapter 11.7.2, page 509). 

To access the extrude functions, 

select Extrude on the Tools menu. 

You can also use the context menu of the relevant line or member. 

Extrude member/line into surface 

 
Figure 11.141: Dialog box Extrude Line into Surface 

The selected line appears in the List of Lines. If necessary, more lines can be added by clicking 
them in the work window. Please note that all lines of the list must lie in one plane. 

Then, enter the material, depth and thickness of the new surface as Surface Parameters. If an 
Offset is defined, the surface will be created in a lateral distance relating to the direction of the 
extrusion. In this case, specify the Side. The modified parameters are shown immediately in the 
graphic of the work window. 

When several lines are extruded, you have different possibilities offered in the dialog section 
Outer Corners to adjust the copied lines. The figure above shows the lines (without axes) ex-
truded with an offset and connected with an arc. 

In the dialog section Extrude in Direction, define the global or local direction of the extrusion.  
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Menu Tools → Extrude 

Extrude member into grid 

 
Figure 11.142: Dialog box Extrude Member into Grid 

The selected member appears in the List of Members. If necessary, more members can be added 
by clicking them in the work window. All members of the list must lie in one plane. 

In the dialog section Parameters of Perpendicular Members, enter the cross-section of the verti-
cal members and the depth as the value for the total height of the grid. Optionally, specify an 
eccentricity in order to connect the members by eccentric connection (see chapter 4.15, page 
134). 

Settings in the dialog section Number of Member Divisions control the division into a uniform 
grid consisting of parallel and vertical members. Furthermore, you have the Option to do with-
out the generation of external vertical members. 

In the dialog section Extrude in Direction, define the global or local direction where grid mem-
bers will be created. The input field Rotation about x allows for copying objects out of the plane. 

11.7.1.3 Extrude Surfaces 

By extruding planar surfaces you can quickly create spatial geometric objects. 

To access the corresponding functions, 

select Extrude on the Tools menu. 

You can also use the context menu of the relevant surface. 



11  Tools 

 501 Program RFEM © 2013 Dlubal Software GmbH 

 

 
Figure 11.143: Surface context menu 

To create extruded objects by shifting the surface parallel in the workspace, select one of the 
following three options in the context menu. 

• Solid: A 3D-solid will be created (see chapter 4.5, page 85). 

• Casing: Only surfaces encasing the spatial object will be generated. 

• Members: Members will be created on the connection lines between the nodes and their 
copies. Optionally, the basic surface will be copied, too. 

Depending on your choice, a new dialog box appears where you have to define the relevant 
parameters. The Depth d can be entered directly or determined graphically with the mouse. 

 
Figure 11.144: Dialog box Extrude Solid 
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11.7.1.4 Generate Solids 

The previous chapter describes how existing surfaces can be used to create solids or casings. 
But if you want to generate a completely new solid, RFEM offers you special functions to create 
3D objects: First, create the surfaces (rectangle with roundings, semi-circle etc.). In a second 
step, extrude the surfaces in relation to a point or a plane. 

Extrude surface in relation to parallel plane 
To access the corresponding function, 

point to Model Data on the Insert menu, select Solids and Graphically, and then click  
Extrude Tapered 

or use the corresponding list button of the menu bar. 

 
Figure 11.145: List button Extrude Surface 

The menu contains a great number of planar surface shapes that can be defined graphically 
and then extruded parallel to the surface plane. 

The functional principle is similar to the graphical input of surfaces (see chapter 4.4, page 75): 
First, define material and stiffness in a dialog box. Then, you can create the surfaces in the work 
window by clicking the definition points. 
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Figure 11.146: Dialog box New Half Annular Surface for graphical definition of surface 

When the base area is set, define the parameters for creating the solid in the Extrude dialog 
box. 

 

Figure 11.147: Dialog box Extrude Half Annulus Tapered with inclined lateral surfaces 

The Depth d can be entered directly in the dialog box or determined graphically with the mouse. 
The projection direction is always right-angled to the plane of the base area. 

By entering a value in the dialog section Tapering it is possible to create a parallel cover or base 
area with inclined sides. The angle β describes the inclination to the projection direction. 

In addition, the Material of the new solid must be specified. 
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Extrude surface in relation to point 
To access the corresponding function, 

point to Model Data on the Insert menu, select Solids and Graphically, and then click  
Extrude to Point. 

The menu contains a great number of planar surface shapes that can be defined graphically 
and then extruded in relation to a point. 

The functional principle is similar to extruding the object in reference to a parallel plane (see 
above): First, define the base area graphically. Then, you can enter the extrusion's projection 
point in the Extrude dialog box. You can define it also graphically. 

 

Figure 11.148: Dialog box Extrude Semi Circle to Point with result 

11.7.1.5 Split Member into Surfaces 

Sometimes, it is necessary to analyze particular zones of the framework model more in detail 
(for example evaluation on supports or frame joint as surface model). It would be possible but 
quite time-consuming to enter a cross-section using surface elements manually. The function 
Generate Surfaces from Members helps you to represent a 1D member element by means of 2D 
surface elements. 

The function is only available if the model type has been defined as 3D (see Figure 12.23, page 
554). 

To split a previously selected member, 

point to Generate Surfaces from Members on the Tools menu, and then select Generate. 

This function is also available in the member context menu. Right-click the member to open its 
context menu. 
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Figure 11.149: Context menu of member 

The information about the member won't be lost: In addition to surfaces, a dummy member 
will be created in the centroidal axis. The dummy contains all member data but will not be 
considered in the calculation. 

To access more options for the function Generate Surfaces from Members, 

point to Generate Surfaces from Members on the Tools menu, and then select Settings. 

 
Figure 11.150: Dialog box Settings - Generate Surfaces from Member 

Use the dialog section Divide Member Arcs to control how many times a member lying on a 
curved line is to be split. If a very rough polygonal chain is created with the default setting  
Automatically, you can customize the splitting and reduce the division angle or the division 
length. 
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The settings in the dialog section Divide Cross-Section Arcs affect the splitting of curved surfaces, 
for example members of the cross-section type "Pipe". Again, the division can be refined by a 
user-defined division angle. 

In the dialog section Created Surfaces, you can define a FE mesh refinement for the generated 
surfaces (see chapter 4.23, page 166). 

In the course of the conversion, Frontal Plates can be additionally created at the member ends. 
Characteristics of generated surfaces can be adjusted subsequently by editing the surfaces 
(see chapter 4.12, page 112). 

11.7.2 Model Generators 
To access the dialog boxes for creating model objects, 

select Generate Model - Members on the Tools menu or 

select Generate Model - Surfaces on the Tools menu. 

 

Figure 11.151: Menu Tools → Generate Model - Members or Surfaces 

In the following, the single generators are presented. However, you won't find a detailed de-
scription of the dialog boxes because the dialog graphics illustrate the parameters adequately. 

Each dialog input can be saved as a template and reused later. Both buttons shown on the left 
are used to save and load the generator data. 
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11.7.2.1 Members 

Continuous beam 

 
Figure 11.152: Dialog box Generate Continuous Beam 

RFEM creates a continuous beam with uniform cross-section, supports and irregular spans.  
Optionally, load cases and result combinations are created, too. 

2D frame 

 
Figure 11.153: Dialog box Generate 2D Frame 

Before you enter geometrical data and cross-section properties, select the Frame Type.  
The columns of the planar frame receive equal support conditions. 
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Tapered 2D frame 

 
Figure 11.154: Dialog box Generate Tapered 2D Frame 

The planar frame must be defined by its Geometry and Cross-Sections. You can create tapers, 
craneway consoles and eccentric connections. Loads can be generated additionally. The  
[Settings] buttons offer you access to the generator parameters. The Frame location is im-
portant for the load determination. 

 
Figure 11.155: Dialog box Settings - Wind Loads 
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2D truss 

 
Figure 11.156: Dialog box Generate 2D Truss 

First, define the Type of the truss and the arrangement of the Diagonals. Then, you can define 
the Parameters, Cross-Sections and Member Types. 

Grid 

 
Figure 11.157: Dialog box Generate Grid 

Use this generator to create models that have a uniform grid (for example gratings). They don't 
need to be designed with right angles as shown in the dialog graphic above. Any kind of spa-
tial quadrangle model with four corner points is possible. To generate a "real" girder grillage, it 
is recommended to set the Type of Model to 2D - in XY in the model's General Data dialog box 
(see chapter 12.2, page 554). 

To generate irregular grids, use the button [Edit Advanced Settings] shown on the left. 
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Column 

 
Figure 11.158: Dialog box Generate Column 

In the dialog section Type, you decide whether a center or corner column will be generated.  
In case you want to generate Loads, you have to specify their Effective Widths and Correction 
Factors. For generating a gable column the Span a is required for the influence range in the 
longitudinal direction of the hall. The factors f1 and f2 are used to scale the geometric widths b1 
and b2 for the static model or to fulfill special code requirements (for example load increment 
factors for individual designs). 

Roof generators 
The menu item Roof provides three roof generators which you can select to generate planar 
roof systems including loads. The [Settings] buttons available in the roof dialog boxes help you 
to determine wind and snow loads (see Figure 11.155, page 508). 
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Roof → Collar Roof 

 
Figure 11.159: Dialog box Generate Collar Roof 

Roof → Rafter Roof 

 
Figure 11.160: Dialog box Generate Rafter Roof 
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Roof → Purlin Roof 

 
Figure 11.161: Dialog box Generate Purlin Roof 

Fish-bellied girder 

 
Figure 11.162: Dialog box Generate Fish-bellied Girder 

For the generation of fish-bellied girders commonly used in timber construction, the rectangu-
lar and ITS section types (symmetric I-beams) can be selected in the Cross-section type list. 
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3D frame 

 
Figure 11.163: Dialog box Generate 3D Frame 

Use this generator to create regular frame models. The columns of the frame receive equal 
support conditions. 

3D hall 

 
Figure 11.164: Dialog box Generate 3D Hall 

This complex generator creates a complete hall including loads. Four dialog tabs are provided: 
Geometry / Supports manages the system geometry, Partitioning / Bracing controls irregular 
grid spacings and the arrangement of bracings. In the remaining two tabs, the Cross-Sections 
and Loads are defined. 



11  Tools 

 

 

514 Program RFEM © 2013 Dlubal Software GmbH 

3D truss 

 
Figure 11.165: Dialog box Generate 3D Truss 

Use this generator to create a spatial load-bearing structure according to the Bernauer system 
(www.raumtragwerke.de). 

3D cell 

 
Figure 11.166: Dialog box Generate 3D Cell 

http://www.raumtragwerke.de/
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The generator creates a spatial cell with several fields. Use the button [Edit grid spacings and 
openings] to open another dialog box where you can define openings as well as the grid ar-
rangement for irregular field spacings. 

Stairway 

 
Figure 11.167: Dialog box Generate Stairway 

In the list, select the Type controlling the remaining parameters. 

Spiral stairway 

 
Figure 11.168: Dialog box Generate Spiral Stairway 
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Straight line 

 
Figure 11.169: Dialog box Generate Straight Line 

This function allows for generating straight lines based on new or already existing nodes.  
It is also possible to create only nodes placed on an imaginary straight line.  

Arc 

 
Figure 11.170: Dialog box Generate Arc 

First, define the Type of Arc: circle, parabola, hyperbola or catenary. Points A and B represent 
both edge nodes of the arc, point C determines its arrangement. The Arch rise defines the sag. 
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The length of a catenary is defined by the parameter L. The heights h1, h2 and h3 are interactive 
values. The Parameter describes the constant a in the following equation of the catenary curve: 

y
x v

a

vx
cosha)x(y +






 −

⋅=  where vx or vy : displacements in x or y 

Equation 11.1 

The larger the Number of members, the more precisely the arc will be modeled as polygonal line. 

Circle 

 
Figure 11.171: Dialog box Generate Circle Arc 

The circle or circle arc is defined by Radius and angles. The object will be created around a  
center point that can be selected anywhere in one of the global planes. 

Sphere 

 
Figure 11.172: Dialog box Generate Sphere 

The larger the Number of planes and meridians, the rounder the shape of the sphere will be.  
Polygonal lines approximate the spherical form, with each member representing a segment. 
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Bracing in cells 

 
Figure 11.173: Dialog box Generate Bracing in Cells 

Cells are defined by four corner nodes, enclosed by members on all sides and placed in one 
plane. In the generator dialog box, specify the Members of Bracing and the Cells for Bracing. You 
can also use the [] function to select them in the work window by clicking the cell crosses. 

Furthermore, Virtual lines make it possible to close cells so that bracings can be created as well 
for example between wall supports. 

 

 



11  Tools 

 519 Program RFEM © 2013 Dlubal Software GmbH 

 

11.7.2.2 Surfaces 

Vaulted head according to DIN 28 011 or DIN 28 013 

 
Figure 11.174: Dialog box Generate Vaulted Head, tab Structure 

For creating a vaulted head, RFEM offers you the standard variants Torispherical head and Semi 
ellipsoidal head. Once the reference point for placing the head is set in the General Data tab, 
you can define material and generator parameters for surface thickness, outer diameter and 
border height in the dialog tab Structure. Moreover, it is possible to specify overpressure as  
surface load for the generation in the dialog tab Loads. 

Barrel roof 

 
Figure 11.175: Dialog box Generate Barrel Roof, tab Loads 

Define the parameters of the barrel roof in the dialog tabs Basis and Structure. In the Loads tab, 
enter the required data for the creation of snow load cases. 
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Domed roof 

 
Figure 11.176: Dialog box Generate Domed Roof, tab Structure 

Define the parameters of the domed roof in the dialog tabs Basis and Structure. In the Loads 
tab, enter the required data for the creation of snow load cases. 

Surfaces from cells 

 
Figure 11.177: Dialog box Create Surfaces from Cells 

Cells consists of at least three corner nodes. They are enclosed by lines or members on all sides 
and placed in one plane. To fill cells with surfaces, define the Material and Thickness of the sur-
face first. Then, select the cells graphically by using the [] function clicking the cell crosses in 
the work window. 
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11.8 Load Generators 
The second group of generators helps you to apply member and area loads: On the one hand, 
it is possible to convert area loads (for example snow, wind) acting on the structural system in-
to member and surface loads. On the other hand, you can convert free line loads and coating 
loads due to frost into member loads. 

To open the dialog boxes for generating member and surface loads, 

select Generate Loads on the Tools menu. 

11.8.1 General Features 

Settings for load generation 
Many generator dialog boxes offer you the [Settings] button (see Figure 11.184, page 524) that 
opens the dialog box Settings for Load Generation used to control the tolerance for the integra-
tion of nodes in the load plane and to correct the generated loads. 

 
Figure 11.178: Dialog box Settings for Load Generation via Plane 

Specifications in the settings dialog box are valid for all member load generators. The Tolerance 
determines the conditions under which members or nodes are considered to be belonging to a 
plane or line. Settings are possible by entering an angle or a distance. If nodes are lying within 
the defined thresholds, RFEM will recognize the cells and generate loads. 

The dialog section Correction of Generated Loads allows for a comparison of the available area 
loads with the determined member loads. The check sums are displayed in the dialog boxes 
appearing after the load generation and before the final conversion into member loads will be 
performed (see Figure 11.188, page 527). In case of minor differences, you should make a cor-
rection of the distribution in accordance with the moment equilibrium. The following applies: 

( ) ∫∫ =+
cellcell SL

correctmember qdSdLqq   Equilibrium of forces 

( ) ∫∫ =+
cellcell SL

correctmember qrdSrdLqq   Moment equilibrium 

where    r = (x, y)   Distance to centroid of cell 
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When correcting generated loads by the moment equilibrium, the moment is formed from the 
area loads to the centroid and then compared with the moment from the member loads to the 
centroid. As a simplification, you may imagine the moment correction to be a recalculation of 
the support forces. This support force will then be applied as line load to the member. Take 
advantage of this correction option to create for example trapezoidal member loads from vari-
able area loads.  

Settings in the dialog section Usage of Non-loaded Members for Cell Generation primarily con-
cern members that lie in an inclined position within the model. In the course of the load gen-
eration, the total area to be loaded will be determined first. Then, RFEM examines the mem-
bers which enclose cells. Next, the cells are subtracted from the total area. When excluding  
a member from the loading (option Remove Influence from members, see below), RFEM will  
relocate its load to the remaining members of the plane or cell. 

Now, the three options are explained by an example of a platform construction. We want to 
apply only traffic loads to members running in direction X. Like the Y-parallel members the 
inclined member is excluded from the load application, but depending on the setting it does 
affect the creation of member loads. 

 
Figure 11.179: Platform construction with cells for load generation 

• Do not use any member: 
The load is applied uniformly to the edge members and the intermediate members. With 
this setting all excluded members are ignored, which means applied internally for load 
distribution. After calculating the cell area, the load is distributed to the allowed members 
of the cell. 

 
Figure 11.180: Result for Do not use any member 
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• Use all members: 
All unloaded members are excluded for the load generation. There is still a small problem 
in the load distribution because of the large, generated cell 2. 

 
Figure 11.181: Result for Use all members 

• Use members parallel to boundary: 
In this way, it is possible to exclude members lying in an inclined position. If the limit angle 
between members φb is restricted to 40.55° in the Settings dialog box (see Figure 11.178, 
page 521), the load will be generated as expected. 

 
Figure 11.182: Result for Use members parallel to boundary 

Modify generated loads subsequently 
After confirming a generator dialog box you find the generated loads transferred to load table 
3.14. The additional entry Generated Loads appears in the Data navigator (see Figure 6.52, page 
250). The generator parameters won't be lost because the original dialog boxes remain acces-
sible as input objects for changes. To open the initial dialog box again, double-click one of the 
entries in the navigator. You can also double-click a generated load in the work window. The 
original dialog box appears where you can adjust the parameters. 

But if you want to treat the generated loads as isolated load objects, you have to release the 
loads from the overall concept and split them into their components. Access to this function is 
available in the load context menu that you open by right-clicking a generated load. Select 
Disconnect Generated Load in the context menu to create the individual loads (see figure be-
low). 
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Figure 11.183: Context menu of generated load 

You can also use the context menu of the generated load in the Data navigator. 

11.8.2 Member/Linear Loads from Area Loads 

11.8.2.1 Member Loads From Area Load via Plane 

 
Figure 11.184: Dialog box Convert Area Loads to Member Loads via Planes 

Area load direction 

Decide whether the load acts perpendicular to the plane or globally related to the real or to 
the projected area. The dialog graphic in the right corner illustrates the selected load direction. 
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Member load direction 

The generated member loads can be set to be global or local loads (see chapter 6.2, page 220). 
The difference is especially significant for non-linear calculations. 

Area of load application 

You have two selection options. Select Full closed plane when a surface exists in the load plane 
between the members (for example wall or roof surface) which is not represented in the RFEM 
model. In this case, RFEM converts the area load that acts on the entire plane to the members. 
But if the construction consists only of members (for example lattice tower), select the option 
Empty, on members only. Then, RFEM charges only the effective or projected area that is pro-
vided by the member cross-sections as "load application surface". The load will be applied in 
consideration of the member orientation. 

Load distribution type 

You decide how the area load components will be assigned to the members. Select Axes of an-
gles for polygons that do not have a reflex angle. The intersection points of the bisecting lines 
will be connected in such a way that application areas are created as shown in the picture on 
the left. In this way, it is possible to distribute the area load clearly to the members without 
ambiguity. 

The angle axes method is not applicable for planes with reflex angles or for polygons. In such 
cases, set the load distribution type to Constant. In addition to the angle bisectors, RFEM will 
also determine the centroid of the plane. If the intersection points of the bisecting lines lie in 
front of the centroid, triangular application areas will be generated. If they lie behind the cen-
troid, a line that is parallel to the member will be drawn through the centroid, forming an ap-
plication area with both angle bisectors. 

 
Figure 11.185: Load distribution type Constant 

Using this method results in the fact that areas are either not taken into account or applied 
twice. The missing or remaining amount will be multiplied by a constant so that the sum of the 
area and member loads is equal. 

The Combined option determines the application areas of triangles, quadrangles and polygons 
according to the angle axes method, where possible. If the method cannot be used, RFEM 
switches automatically to the constant load distribution. Therefore, the combined method is 
set by default; RFEM will select the appropriate method automatically. 

Area load distribution 

The load can act on the area as Uniform or Linear variable load. It is also possible to define area 
loads acting freely Varying in direction of a global axis (for example height-dependent wind 
load). Use the [Edit] button to open a dialog box where you can define the load parameters  
as a function of the height levels. 
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Figure 11.186: Dialog box Varying Area Load 

In the left table column, enter the global ordinates of the Level. Assign the respective values of 
the Area Load to the right. The graphic illustrates the current state of input. 

When freely variable loads are set, you have to select the correction of the distribution accord-
ing to the moment equilibrium in the Settings dialog box (see Figure 11.178, page 521). Other-
wise, constant member loads will be generated. 

Area load magnitude 

When the load acts uniformly on the area, enter the load value into the enabled input field. For 
linearly variable loads specify three node numbers with the respective loads. You can also use 
the [] function to select the nodes graphically in the work window. 

Boundary of area load plane 

The boundary is set by the corner nodes of the plane. Use the [] function and click the rele-
vant nodes one after the other in the work window. The plane will be marked in the selection 
color. The completely entered plane will appear in cyan color. At least three nodes are required 
for defining a plane. The area does not need to be enclosed by lines or members on all sides. 

It is possible to define different planes which appear then in the list Corner nodes. 

If the dialog box is opened repeatedly, the last entered planes may be preset in the Corner 
nodes list. To avoid assigning double loads unintentionally to these planes, it is recommended 
to empty the list in this case with the button [Delete all area load planes]. 

Remove influence from 

In the dialog section Remove Influence from, you can exclude members from the load applica-
tion (for example purlins or bracings). The selection is carried out member by member or by 
entering a member template that is parallel to the load-free members. Again, it is recommend-
ed to use the [] function for graphical selection. 

Click the [Settings] button shown on the left to open the dialog box Settings for Load Generation 
(see Figure 11.178, page 521). Then, you can adjust the tolerance for the integration of nodes in 
the load plane or correct the generated loads. 

Use the button [Assign load correction factors] to scale the loads for particular members. In 
this way, you can consider for example the effects of continuity of a roof sheathing on the 
edge rafters in order to generate reduced member loads there. The following dialog box 
opens. 
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Figure 11.187: Dialog box Assign Correction Factors to Members 

Use the [] buttons to select the members in the work window. Then, you can scale them with 
a Factor. 

Click [OK] to start the generation of member loads. An overview appears with information 
about the cells and loads. 

 
Figure 11.188: Dialog box Info About Conversion of Area Load to Member Loads 

If inadmissible cells are listed, RFEM was not able to assign the loads without ambiguity. Use 
the eye button [Show Current Inadmissible Cell] to highlight the cell in the graphic. To show a 
list of reasons why the cells are invalid, click the [Info] button. Often, removed borders of the 
cell (that means edge members excluded from load application) or crossing members that are 
not connected are responsible for problems occurring when converting loads. 

In the dialog section Total Moment to Origin, the determined member loads are compared with 
the applied area loads. In case of differences, you can use the [Back] button to access the initial 
dialog box where you can change parameters. Specifications are to be adjusted in the dialog 
box Settings for Load Generation (see Figure 11.178, page 521) that you can access by using the 
[Settings] button. 

The buttons at the bottom left in the info window have the following functions: 

Button Description 

 
The dialog box Convert Area Loads to Member Loads opens again for you to adjust 
the generation parameters. 

 
RFEM shows you the work window where you can change the view (view mode). 
To return to the Info window, right-click into the work window or use the [Esc] key. 

Table 11.15: Buttons in info window for converted member loads 
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11.8.2.2 Member Loads From Area Load via Cells 

 
Figure 11.189: Dialog box Convert Area Loads to Member Loads via Cells 

This dialog box is similar to the dialog box Convert Area Loads to Member Loads via Planes de-
scribed on page 524. RFEM already checks the existence of cells in the model when opening 
the dialog box. Available cells are represented by cell crossings. Cells are zones defined by 
three or more corner nodes, enclosed by members on all sides and placed in one plane. 

The load generator via cells cannot be used for wind loads, for example on a hall wall with col-
umns: RFEM does not recognize any cells because members are missing between the footings. 
In such a case, you can create Virtual lines by clicking the start and end node using the [] func-
tion. In this way, cells are closed artificially and can be recognized by the generator. 

The Nodes of cell can be selected with [] one after the other in the graphic. After the generation 
an overview with information about cells and loads appears. 

Click the [Settings] button shown on the left to open the dialog box Settings for Load Generation 
(see Figure 11.178, page 521). Then, you can adjust the tolerance for the integration of nodes in 
the load plane or correct the generated loads. 
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11.8.2.3 Line Loads from Area Loads on Openings 

 
Figure 11.190: Dialog box Convert Area Loads to Openings to Line Loads 

The dialog box resembles the dialog box Convert Area Loads to Member Loads via Planes de-
scribed on page 524. In the upper dialog sections, you can define the different load parame-
ters. 

In the input field of the dialog section Openings with Area Load, enter the numbers of openings. 
You can also select them with the [] function in the work window. 

Click [OK]. An overview with information about the generated loads appears. Then, click [OK] 
to create the line loads on the edges of the opening(s). 
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11.8.3 Other Loads 

11.8.3.1 Member Loads from Free Line Load 

 
Figure 11.191: Dialog box Convert Free Line Load to Member Loads 

Use the generator to define free line loads for pure member models like girder grillages to  
prorate the loads to members. 

The correct load assignment requires specifications for Line Load Direction and Member Load 
Direction, where applicable. These dialog sections as well as the option for Remove Influence 
from is described for the function "Member Loads From Area Load via Plane" on page 524. 

The Line Load Magnitudes can be defined constantly or linearly. The Line Load Position can be 
defined graphically with the [] function by clicking the start and end node. If the line load is 
directed perpendicular to the plane, enter the help node C additionally. 

Click the [Settings] button shown on the left to open the dialog box Settings for Load Generation 
(see Figure 11.178, page 521). 

11.8.3.2 Member Loads from Coating 

 
Figure 11.192: Dialog box Convert Coating Load to Member Loads 
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Members with Coating Load can be entered directly or determined graphically with []. The  
Coating is to be defined by the thickness and the specific weight. 

Use the [Info] button shown on the left to check the coating areas AS of the selected member 
cross-sections to be applied for determining the ice load. The areas are related to the center 
lines of the ice load as shown in the dialog graphic (Figure 11.192). Thus, loads will be deter-
mined correctly even for small cross-sections with many edges. 

11.8.3.3 Loads from Accelerated Movements 

 
Figure 11.193: Dialog box Generate Loads from Movements 

The generator creates loads as a result of an acceleration or rotation acting on particular ob-
jects of the model. The mass is determined from the self-weight. 

In the dialog section Objects with Load, enter the numbers of relevant members, surfaces or 
solids. You can select them also graphically with the [] function. 

Define the Vector of acceleration as acceleration or rotation (angular velocity ω, angular accel-
eration α). Use the [Open] button shown on the left to determine the acceleration from the  
velocities that are available on two points. 

In the dialog section Definition of the vector of acceleration, you decide if the vector is related to 
a global axis or defined by two points. The vector can be defined graphically by using the [] 
buttons. 

Click [OK] to create the loads for the currently set load case. 
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11.8.4 Snow Loads 

11.8.4.1 Flat/Monopitch Roof 

 
Figure 11.194: Dialog box Generate Snow Loads - Flat/Monopitch Roof 

Flat and monopitch roofs are managed together in one dialog box. The shape coefficients for 
flat roofs or roofs with one-sided inclination are taken into account according to EN 1991-1-3 
and DIN 1055-5. 

First, define the standard and, if necessary, the national annex in the dialog section Snow Load 
Parameters. The setting controls the input fields enabled for access. 

Use the [Info] button to open a map where the snow load zone Z can be selected graphically. 
Based on your specifications, RFEM determines the characteristic value of the snow load sk on 
the ground, taking account of the altitude A (see level). 

Use the three check boxes in the dialog section Additional Snow Loads to decide if other snow 
loads are considered: 

• Snow accumulations because of snow drift 
• Snow overhang on eaves 
• Snow loads on snow guards 

Use the [Edit] buttons to define the parameters for snow overhang and snow guard. 

If required, you can adjust the Exposure coefficient Ce (EN 1991-1-3, table 5.1) as well as the 
Thermal coefficient Ct (EN 1991-1-3, clause 5.2 (8)) in the dialog section Coefficients. 

Define the Roof Geometry by means of the roof corner nodes A to D in accordance with the  
dialog graphic. You can also use the [] function to determine them graphically in the work 
window. The plane will be marked in the selection color. At least three nodes are required for 
defining a plane. The area does not need to be enclosed by lines or members on all sides. 

The Position of Drifted Snow Load can be defined by the edge nodes of the roof area. 
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In the dialog sections Load Case to Generate and Load Case for Drifted Snow Load, you specify 
the load case numbers for the load generation. Snow load cases can be created with the [New] 
button. If surfaces are available in the model, you can use the options in the dialog section 
Create Load Type to decide whether member or surface loads will be generated. 

The dialog sections Load Distribution Type and Remove Influence from are described for the 
generator function "Member Loads From Area Load via Plane" on page 525. 

Click the [Settings] button shown on the left to open the dialog box Settings for Load Generation 
(see Figure 11.178, page 521). 

Use the button [Assign load correction factors] to scale the loads for particular members. The 
specifications can be entered in a separate dialog box (see Figure 11.187, page 527). 

After confirming the generator dialog box with [OK], RFEM shows you the results of the load 
generation for all load cases in an overview. Thus, the acting area loads can be compared with 
the converted loads. Before the loads are transferred to RFEM, you can click the [Back] button 
to access the initial dialog box where you can change the parameters of the loads. 

11.8.4.2 Duopitch Roof 

 
Figure 11.195: Dialog box Generate Snow Loads - Duopitch Roof 

First, define the standard and, if necessary, the national annex in the dialog section Snow Load 
Parameters. The setting controls the input fields enabled for access. 

Specify the parameters as described in the previous chapter. The Roof Geometry of a duopitch 
roof is defined by the roof's corner nodes A to F in accordance with the dialog graphic. You can 
also use the [] function to determine the nodes graphically in the work window. 
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In the dialog sections Load Cases to Generate and Load Cases for Drifted Snow Load, you specify 
the load case numbers for the load generation. Alternative load cases will be created when 
additional snow loads (for example DIN 1055-5, figure 4) or shape coefficients (for example  
EN 1991-1-3, figure 5.3) are taken into account. The relevant snow load cases can be created 
with the [New] button. 

11.8.5 Wind Loads 

11.8.5.1 Vertical Walls 

 
Figure 11.196: Dialog box Generate Wind Loads - Vertical Walls (roof geometry: Duopitch roof) 

First, define the standard and, where applicable, the national annex in the dialog section  
Velocity Pressure. The setting controls the input fields enabled for access. 

Wind zone and terrain category can be selected graphically in a map that you open with the 
[Info] button. The structure height h is not taken over automatically from the model but must 
be specified. Based on your settings, RFEM determines the basic value of the fundamental 
wind velocity vb,0. 

Click the [Edit] button shown on the left to access more coefficients used to determine wind 
loads. 
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Figure 11.197: Dialog box Coefficients for Wind Load Generation 

The walls are determined by the Base Geometry (nodes I to L for base area, bottom) and the 
Roof Type and Geometry (nodes A to D or F for roof planes, up). In case of roof overhangs, speci-
fy the upper wall nodes, not the roof nodes. As shown in the dialog graphic, wind loads can be 
generated for building objects closed on all sides with a quadrilateral base area. Please note 
when entering geometry that the start nodes I and A must lie upon each other. Moreover, the 
direction of clicking nodes must be consistent when determining the base and roof area. You 
can also use the [] buttons to define base and roof geometry graphically. 

In the dialog section Load Case to Generate, enter the load case number for the load genera-
tion. With the [New] button you can create a wind load case. 

The wind direction is defined in the dialog section Set Wind on Side. The wind acts perpendic-
ular to the specified line. 

If surfaces are available in the model, you can use the options in the dialog section Create Load 
Type to decide whether member or surface loads will be generated. 

The dialog sections Load Distribution Type and Remove Influence from are described for the gen-
erator function "Member Loads From Area Load via Plane" on page 525. 

Click the [Settings] button shown on the left to open the dialog box Settings for Load Generation 
(see Figure 11.178, page 521). 

After confirming the generator dialog box with [OK], RFEM shows you the results of the load 
generation in an overview. Thus, the acting area loads can be compared with the converted 
loads. Before the loads are transferred to RFEM, you can click the [Back] button to access the 
initial dialog box where you can change the parameters of the loads. 
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11.8.5.2 Flat Roof 

 
Figure 11.198: Dialog box Generate Wind Loads - Flat Roof 

RFEM considers a roof to be a flat roof if the roof inclination is α < 5°. 

First, define the standard and, where applicable, the national annex in the dialog section  
Velocity Pressure. The setting controls the input fields enabled for access.  

Specify the parameters as described in the previous chapter. The dialog section Eaves Type is 
linked to the interactive dialog graphics to the right illustrating the individual settings. 

As described for example in EN 1991-1-4, table 7.2, several load cases must be taken into ac-
count for a flat roof. In the dialog section Load Cases to Generate, specify the load case numbers 
for the load generation. The compression loads are created in the load case LC w+. The suction 
loads are generated in LC w-. The relevant load cases can be created with the [New] button. 

After confirming the generator dialog box with [OK], RFEM shows you the results of the load 
generation for all load cases in an overview (see Figure 11.201, page 539). The dialog tabs rep-
resent an important checking option because you can see for each load case the external pres-
sure coefficient cpe,10 and the external pressure we displayed by zones. 
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11.8.5.3 Monopitch Roof 

 
Figure 11.199: Dialog box Generate Wind Loads - Monopitch Roof 

First, define the standard and, where applicable, the national annex in the dialog section  
Velocity Pressure. The setting controls the input fields enabled for access.  

Specify the parameters as described in chapter 11.8.5.1. The Monopitch Roof Parameters are  
determined automatically from the roof geometry and the side where the wind blows. 

As described for example in EN 1991-1-4, table 7.3a, several load cases must be taken into ac-
count for a monopitch roof. In the dialog section Load Cases to Generate, specify the load case 
numbers for the load generation. The compression loads are created in the load case LC w+. 
The suction loads are generated in LC w-. The relevant load cases can be created with the 
[New] button. 

Use the button [Assign load correction factors] to scale the loads for particular members. In 
this way, you can consider for example the effects of continuity of a roof sheathing on the 
edge rafters in order to generate reduced member loads. The specifications can be entered  
in a separate dialog box (see Figure 11.187, page 527). 
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11.8.5.4 Duopitch/Troughed Roof 

 
Figure 11.200: Dialog box Generate Wind Loads - Duopitch/Troughed Roof 

First, define the standard and, where applicable, the national annex in the dialog section  
Velocity Pressure. The setting controls the input fields enabled for access.  

Specify the parameters as described in chapter 11.8.5.1 on page 534. The Duopitch Roof Pa-
rameters are determined automatically from the roof geometry and the side where the wind 
blows. 

As described for example in EN 1991-1-4, table 7.4a, several load cases must be taken into ac-
count for a duopitch roof. In the dialog section Load Cases to Generate, specify the load case 
numbers for the load generation. The compression loads are created in the load case LC w+. 
The suction loads are generated in LC w-. Combinations (compression on one side of the roof 
and suction on other side) are defined as LC w-/+ and LC w+/-. The relevant load cases can be 
created with the [New] button. 

After confirming the generator dialog box with [OK], RFEM shows you the results of the load 
generation for all load cases in an overview. The dialog tabs represent an important checking 
option because you can see for each load case the external pressure coefficient cpe,10 and the 
external pressure we displayed by zones. 
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Figure 11.201: Dialog box Info About Generation of Wind Loads - Duopitch/Troughed Roof 

Before the loads are transferred to RFEM, you can click the [Back] button to access the initial 
dialog box where you can change the parameters of the loads.  
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11.8.5.5 Vertical Walls with Roof 

 
Figure 11.202: Dialog box Generate Wind Loads - Vertical Walls with Roof (roof geometry: Duopitch roof) 

First, define the standard and, where applicable, the national annex in the dialog section  
Velocity Pressure. The setting controls the input fields enabled for access.  

Specify the parameters as described in chapter 11.8.5.1 on page 534.  

As described for example in EN 1991-1-4, table 7.4a, several load cases must be taken into ac-
count for a duopitch roof. In the dialog section Load Cases to Generate, specify the load case 
numbers for the load generation. The compression loads are created in the load case LC w+. 
The suction loads are generated in LC w-. Combinations (compression on one side of the roof 
and suction on other side) are defined as LC w-/+ and LC w+/-. The relevant load cases can be 
created with the [New] button. 

Use the button [Assign load correction factors] to scale the loads for particular members. The 
specifications can be entered in a separate dialog box (see Figure 11.187, page 527). 

After confirming the generator dialog box with [OK], RFEM shows you the results of the load 
generation for all load cases in an overview (see Figure 11.201, page 539). The dialog tabs rep-
resent an important checking option because you can see for each load case the external pres-
sure coefficient cpe,10 and the external pressure we displayed by zones. 
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12.  File Management 
This chapter explains how data is organized in the Project Manager and how recurring model 
components are managed in blocks. In addition, the chapter describes the data import and 
export with the integrated interfaces for exchanging data with other programs. 

12.1 Project Manager 
In structural analysis, a project is often subdivided into several models. The Project Manager 
helps you to organize data of your Dlubal applications. You can also use it for managing RFEM 
models within the network (see chapter 12.3, page 561). 

The Project Manager can be left open as a stand-alone application when working in RFEM. 

To open the Project Manager, select Project Manager on the File menu, or use the toolbar 
button shown on the left. 

 
Figure 12.1: Button Project Manager in the toolbar 

It is also possible to access the Project Manager in the model's General Data dialog box. 

 
Figure 12.2: Button Project Manager in the dialog box General Data 

When you open the Project Manager, the following multi-part window appears. It has its own 
menu and toolbar. 
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Figure 12.3: Project Manager 

Project navigator 

A navigator listing all projects in a tree structure is displayed on the left. The current project is 
set bold. To select another project, double-click the relevant entry or use the list Current Project 
in the toolbar. The table to the right of the navigator lists the models contained in the selected 
project. 

Table of models 

The models are arranged in several tabs, sorted by Dlubal applications. The RFEM tab lists all 
RFEM models contained in the selected project. The Model Name and Description as well as 
significant model and file information including the name of the user who created and edited 
the model are displayed respectively. 

To adjust the column display, select Manage Register Columns on the View menu of the  
Project Manager, or use the toolbar button shown on the left (see page 551). 

Details 

This part of the window shows all information available for the model that is selected in the 
window section above. 

Preview 

The selected model is displayed in a preview. The size of the preview window can be adjusted 
by moving the upper edge of the window. 

Thumbnails 

The bottom area of the Project Manager offers you a graphical overview about the models 
contained in the selected project. The thumbnail images are interactive with the table above. 

Use the pins to minimize particular window parts. They will be docked as tabs in the footer. 
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12.1.1 Project Management 

Create a new project 
To create a new project, 

• select New on the Project menu of the Project Manager or 

• click the button [New Project] in the toolbar shown on the left. 

 
Figure 12.4: Button New Project 

The dialog box Create New Project opens where you enter the Name of the new project. Then, 
select the Folder in which you want to save the models. Use the [Browse] button shown on the 
left to set the directory. You can also add a short project Description. It will be shown in the 
header of the printout report and has no further relevance. 

 
Figure 12.5: Dialog box Create New Project 

It is also possible to create sub-projects in the Project Manager by selecting a project in the list 
Place project under. The new project will be displayed as sub-project in the navigator. If you do 
not want to use this setting, select the list entry Projects on the top of the list. Then, the project 
will appear as main entry in the navigator. 

After clicking [OK], a new folder with the project name will be created on the local or network 
drive. 

Connect existing folder 
To integrate a folder containing already several RFEM models as a project, 

• select Connect Folder on the Project menu of the Project Manager or 

• use the button [Connect Folder] in the toolbar shown on the left. 

 
Figure 12.6: Button Connect Folder 

It is irrelevant on which local or network drive the folder that you want to connect is located.  
It will be included into the file management and left at its location – similar to the creation of  
a shortcut on the desktop. The information is saved in the ASCII file PRO.DLP in the folder  
Project Manager (see chapter 12.1.4.3, page 553). 

 

 

 

 



12  File Management 

 

 

544 Program RFEM © 2013 Dlubal Software GmbH 

A dialog box opens that is similar to the dialog box shown in Figure 12.5. Enter the Name and 
Description of the project, and use the [Browse] button to set the directory for the relevant 
Folder. If a project is specified in the list Place project under, the connecting folder must be con-
tained within the directory of this project. The folder will then be managed as a sub-project. 
But if you want the folder to appear as an independent project in the Project Manager, select 
Projects on the top of the list. 

Tick the option Connect folder including all subfolders to connect all folders contained in the  
selected folder at once with the management of the Project Manager. 

Disconnect a folder 
To disconnect a folder integrated in the project management, 

• select Disconnect on the Project menu of the Project Manager (project must have been 
previously selected), 

• click the [Disconnect Project] button in the Manager toolbar shown on the left or 

• use the project's context menu in the navigator. 

 
Figure 12.7: Context menu of a project 

The project will be removed only from the internal management. The folder on the hard disk 
and its contents will be kept. 

Delete a project 
To delete a project, 

• select Delete on the Project menu of the Project Manager (project must have been  
previously selected), 

• click the [Delete] button in the Manager toolbar shown on the left or 

• use the Delete entry in the project's context menu in the navigator (see figure above). 

 
Figure 12.8: Button Delete 

The folder including its contents will be completely deleted from the hard disk. 
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If the folder contains also files from other programs, only the files of Dlubal applications will be 
deleted. The folder itself will be preserved. 

To undo the deletion of projects, 

select Restore from Dlubal Recycle Bin on the Edit menu of the Project Manager. 

The Dlubal recycle bin is described in chapter 12.1.4.2 on page 552. 

In case files stored on a network drive are deleted, they are copied via network into the Dlubal 
recycle bin on the hard disk, which is different to the Windows standard where data is irrecov-
erable. In this way, you can restore files, deleted on network drives, from the relevant computer. 
If you don't want the files to be copied into the recycle bin, we recommend only disconnecting 
the project (see above). Then, you can delete the data from the network drive manually. 

Copy a project 
To copy a project, 

• select Copy on the Project menu of the Project Manager (project must have been  
previously selected) or 

• use the Copy entry in the project's context menu in the navigator (see Figure 12.7). 

 
Figure 12.9: Dialog box Copy Project 

Enter the Name, Description and the location of the new project in the Project Manager, and 
define the Folder that will be created by the copy function. 

It is also possible to copy the project with the Windows-Explorer. Then, you can integrate the 
new folder as a connected folder into the management of the Project Manager (see Figure 12.6, 
page 543). 
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Rename a project / change description 
To change the description of a project subsequently, 

• select Properties on the Project menu of the Project Manager (project must have been 
previously selected) or 

• use the Properties entry in the project's context menu in the navigator (see Figure 12.7). 

The dialog box Project Properties opens where you can change the Name and Description of the 
project. The Folder of the project is also displayed. 

 
Figure 12.10: Dialog box Project Properties 

Import a project folder 
After changing the computer, you can restore the complete directory tree of the Project Man-
ager without copying the file PRO.DLP (see chapter 12.3, page 561). All projects included in a 
folder will be entered in the project management (which means that this folder must contain 
projects, not models). In this way, the projects do not need to be connected individually. 

To open the dialog box for importing a project folder, 

select Import Folder on the Project menu of the Project Manager. 

 
Figure 12.11: Dialog box Import folder 

In the list Place projects under, define the way how you want to integrate the project folder into 
the management. If you want the folders to appear as independent projects in the Project 
Manager, select the list entry Projects on the top of the list. Use the [Browse] button shown on 
the left to set the directory for the Folder to be linked. 

Tick the option Connect folders including all subfolders to integrate all subfolders of the folders 
into the management of the Project Manager. 
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12.1.2 Model Management 

Open a model 
To open a model out of the Project Manager, 

• double-click the model name or its thumbnail image, 

• select Open on the Model menu of the Project Manager (model must have been  
previously selected) 

• or use the context menu of the model. 

 
Figure 12.12: Context menu Model 

Use the context menu option Open With shown on the left to select a particular Dlubal applica-
tion with which you want to open the model. 

It is possible to open files from RSTAB directly in RFEM. 

Shift / copy a model 
To copy a model to another project, 

• select Copy on the Model menu (model must have been previously selected), 

• use the Copy entry in the model's context menu (see figure above) or 

• use the drag-and-drop function by holding down the [Ctrl] key. 

 
Figure 12.13: Dialog box Copy Model 
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In the dialog box Copy Model, specify the target project and enter the Name and Description for 
the copy of the model. 

To shift a model, hold the left mouse button down when moving it into another folder. 

Rename a model 
To rename a model, 

• select Properties on the Model menu of the Project Manager (model must have been 
previously selected) or 

• use the Properties entry in the model's context menu in the navigator (see Figure 12.12). 

 
Figure 12.14: Dialog box Model Properties 

In the dialog box Model Properties, you can change the Name and Description of the model.  
The File name and the model's directory are also displayed. 

If the model contains also results and printout reports, you can remove such additional Data 
from the data record by using the [Delete] button. 

Delete a model 
To delete a model, 

• select Delete on the Model menu of the Project Manager (model must have been pre-
viously selected) 

• click the [Delete] button in the toolbar shown on the left 

• use the Delete entry in the model's context menu (see Figure 12.12). 

In the context menu, it is also possible to Delete Results and/or to Delete Printout Reports of the 
model specifically. In both cases, input data remains available. 

To undo the deletion of models, 

select Restore from Dlubal Recycle Bin on the Edit menu of the Project Manager. 

The Dlubal recycle bin is described in chapter 12.1.4.2 on page 552. 

Show the history 
To check the history of a model, 

• select History on the Model menu of the Project Manager (model must have been  
previously selected) or 

• use the History entry in the model's context menu (see Figure 12.12). 
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Figure 12.15: Info window History of Model 

A dialog box appears showing you information about the users who created, opened or modi-
fied the model. The overview includes also the time when the individual actions were carried 
out. 

Remarks listed in the Comment column are based on the model's general data. Corresponding 
entries in the dialog box General Data are managed in the dialog tab History. Take advantage 
of comments to describe the respective structural processing (see chapter 12.2.2, page 560). 

12.1.3 Data Backup 

Archive data 
You can back up selected models or even an entire project folder in a compressed backup file. 
The original models remain available. 

To start the archiving, 

• select Make Archive on the Archive Data menu of the Project Manager (model or  
project must have been previously selected) or 

• use the context menu of the project (see Figure 12.7) or model (see Figure 12.12). 

 
Figure 12.16: Dialog box Archive 
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The backup file can be generated with or without results and printout reports. Further options 
allow for the integration of subprojects and files that are not part of any Dlubal application. 

When you have defined the Name and Folder of the archive file, create the ZIP file by clicking 
[OK]. 

Extract from archive 
To extract data from the archive, 

select Extract Project/Models from Archive on the Archive Data menu of the Project 
Manager. 

The Windows dialog box Open appears where you can select the ZIP backup file. After clicking 
[OK], its contents are displayed. 

 
Figure 12.17: Dialog box Extract Project with Models from Archive 

In the dialog section Select Models to Extract, select the models that you want to restore. They 
can be unpacked with either the original project settings or as new project. In the list Place  
project under, you can define the ranking in the management structure of the Project Manager. 
Alternatively, you can create a new directory by means of the [Browse] button. 
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12.1.4 Settings 

12.1.4.1 View 

Show thumbnails and details 
The window area below the model table can be adjusted according to your preferences. You 
can choose two options for additional windows that can be activated independently of each 
other. 

To set the display options, 

select Pictures Preview of All Models on the View menu and 

select Details of Current Models on the View menu of the Project Manager, 

or use the respective toolbar buttons. 

Button Function 

 
Shows thumbnail images of all models in the project 

 
Shows model details and preview of model 

Table 12.1: Buttons for setting the view 

Sorting models 
The arrangement of models in the table can be adjusted: As usual with Windows applications, 
you can sort the list in an ascending or descending order by clicking into the column titles.  
Alternatively, you can 

select Sort Models on the View menu. 

Adjust columns 
To arrange the columns according to your needs, 

• select Manage Register Columns on the View menu of the Project Manager 

• or use the button [Manage Register Columns] in the Manager toolbar shown on the left. 

 
Figure 12.18: Dialog box Manage Register Columns 

First, define the Register whose columns you want to adjust (for example RFEM). Now you can 
select relevant entries in the list Columns - Available to transfer them to the list Columns - To Dis-
play. Use the arrow buttons [] for the transfer. You can also double-click the items. Columns 
that you don't want to be displayed can be hidden with the [] buttons. 
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The order of columns in the models list can be changed by using the buttons [] and [] in 
the list Columns - To Display. Click them to shift a selected entry up and down. 

To optimize the column widths in the models list, select Arrange Automatically on the View 
menu of the Project Manager. You can also use the toolbar button shown on the left. 

12.1.4.2 Recycle Bin 
To restore deleted projects and models, 

select Restore from Dlubal Recycle Bin on the Edit menu of the Project Manager. 

A dialog box appears where all deleted models are listed by projects. 

 
Figure 12.19: Dialog box Restore Models from Dlubal Recycle Bin 

The models to be restored can be selected by mouse click. With the button [Select all] you can 
tick the entries all at once. Click the button [Restore Selected Models] to insert the deleted 
models into the original project folders. 

To delete objects stored in the Dlubal recycle bin, 

select Empty Dlubal Recycle Bin on the Edit menu of the Project Manager. 

Before the hard delete is performed, a security query is displayed. 

To adjust the settings for the Dlubal recycle bin, 

select Settings for Dlubal Recycle Bin on the Edit menu of the Project Manager. 

A dialog box appears where the settings for storage location and memory size are managed. 

 
Figure 12.20: Dialog box Settings for Dlubal Recycle Bin 
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12.1.4.3 Directories 

The directories of the Project Manager (and Block Manager) can be checked in the Program  
Options. To open the corresponding dialog box, 

select Program Options on the Edit menu of the Project Manager. 

 
Figure 12.21: Dialog box Settings 

The Category manages the settings separately for both the Project and the Block Manager. The 
folder and the file name are displayed in the input field below where they can be adjusted, if 
necessary. The projects are managed in the file PRO.DLP which can normally be found in folder 
C:\ProgramData\Dlubal\Global\Project Manager. The [Browse] button helps you to set another 
path. 

As the Project Manager is network-compatible, it is possible to organize the data management 
for models contained in the Project Manager in a central place: Set the directory for the PRO.DLP 
file on the server (see chapter 12.3, page 561).  

The dialog section Options offers you general settings for handling RFEM files: Usually, a mes-
sage appears when opening a file out of the Explorer, an e-mail program etc. when the related 
folder is not integrated in the management of the Project Manager. The message can be de-
activated. Moreover, you can decide which program version you want to use to create or open 
model files. 
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12.2 Creating a New Model 
To create a model, 

• select New on the File menu of RFEM, 

• click the toolbar button [New Model] shown on the left, 

• point to New With on the Model menu of the Project Manager, and then select RFEM 5. 

 
Figure 12.22: Button New Model 

The dialog box New Model - General Data opens offering two tabs. 

 
Figure 12.23: Dialog box New Model - General Data, tab General 

When you want to edit the model's general data later, 

• point to Model Data on the Edit menu, and then select General Data or 

• use the context menu of the model in the Data navigator. 

 
Figure 12.24: Context menu of model 
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12.2.1 General 
The first dialog tab (see Figure 12.23) manages basic model parameters. 

Model name / description 
Enter a name into the input field for Model Name. At the same time, it is used as the model's file 
name. By entering a Description you can describe the model in detail. It appears in the printout 
report but has no further relevance. 

 

Figure 12.25: Model description in printout report 

Project name / description 
In the Project Name list, you can select the project folder where the model will be created. The 
current project is preset. If required, you can change the presetting in the Project Manager (see 
chapter 12.1, page 541) that you can access with the dialog button to the right. 

The Description and Folder of the selected project are displayed for information. 

Type of model 
For the model's general data, you have to specify if your structure is a spatial or planar model. 
In case of 2D models, the effort for input is reduced due to the limited coordinates and de-
grees of freedom. 

The type 2D - XY is used for planar plate structures such as slabs that are stressed perpendicu-
lar to the surface plane. The model types 2D - XZ and 2D - XY can be used for walls and shells 
provided that loads are only acting in direction of the surface plane. The use of type 2D - XZ is 
recommended for planar frame structures as this option takes into account moments only 
about the strong member axes.  

It is possible to change the selected type of model subsequently. Please note that this modifi-
cation may result in data loss, for example when a 3D model is reduced to a wall. 

Classification of load cases and combinations 
Loading is to be applied by load cases. Load cases may be for example self- weight, snow or 
live load. 

The individual standards define rules for how to combine load cases. Therefore, it is important 
to assign load cases to particular action categories (see chapter 5.1, page 171). Thus, when cre-
ating load and result combinations, RFEM is able to provide the load cases automatically with 
correct partial safety factors and combination coefficients. 

According to standard 

The list According to Standard contains a variety of rules and standards describing the princi-
ples for ultimate limit state, serviceability and resistance of structural systems. With the selec-
tion of the standard the rules for creating load and result combinations in RFEM are defined. 
This specification is especially significant for the automatic creation of combinations by RFEM 
(see chapter 5.2, page 174 to chapter 5.4, page 189). 

When None is set, no combination will be created automatically, which corresponds to the de-
fault setting in RFEM 4. In this case, load cases must be superimposed manually (see chapter 
5.5.1, page 194 and chapter 5.6.1, page 201). 
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When changing the standard subsequently it is required to reclassify the load cases and to  
adjust the combination. A corresponding warning appears. 

 
Figure 12.26: Warning when changing the standard 

National annex 

When the standard EN 1990 is selected, an additional picklist appears: Though combination 
rules are defined in the Eurocode standard, countries are allowed to specify partial safety  
factors and combination coefficients themselves. 

The list offers you a choice among national annexes of different countries. When the option 
CEN is set, the factors recommended by the European Commission are applied. 

Use the dialog button [Edit] to check the partial safety factors and combination coefficients of 
the currently set standard. When a user-defined standard is set, you can even adjust them. 

The factors are organized in several tabs in the dialog box Coefficients. The first tab manages the 
Partial Safety Coefficients γ for the design situations "static equilibrium" and "ultimate limit state". 

 
Figure 12.27: Dialog box Coefficients, tab Partial Safety Coefficients 

The dialog tab Combination Coefficients (see Figure 5.24, page 191) controls the factors ψ and ξ. 
In the tab Consequences Class that is available for EN 1990 you can define the reliability factor KFI. 
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Create combinations automatically 

The check box is clear by default so that both options below are not enabled for access. Thus, 
the required load and result combinations must be created manually like in RFEM 4 (see chap-
ter 5.5.1, page 194 and chapter 5.6.1, page 201). When combining load cases, the specified 
standard ensures that the partial safety and combination factors are assigned automatically. 

As an alternative, you can Create combinations automatically. Then, additional dialog tabs are 
available in the dialog box Edit Load Cases and Combinations as well as separate entries in the 
Data navigator. In addition, tables 2.2. to 2.4 are enabled. Generating combinations is described 
in detail in chapter 5.2, page 174 to chapter 5.4, page 189. 

The automatic superposition is based on the add-on module RF-COMBI for version RFEM 4. 
Find additional information about combinatorics in the module's manual that is still available 
for download at www.dlubal.com. 

During the automatic superpositioning RFEM creates either Load combinations or Result com-
binations. The difference between both combination possibilities is described in chapters 5.5 
on page 193 and 5.6 on page 201. 

Positive orientation of global axis Z 
This dialog section controls the orientation of the global axis Z. In CAD programs, the Z-axis  
is usually directed upwards. In programs used for structural analysis, it is normally directed 
downwards. The specification is irrelevant for the calculation. 

If Z is defined Upward and the self-weight is specified with factor 1.0 in direction Z in the base 
data of the load case, the self-weight acts upwards. In this case, the self-weight factor needs to 
be changed to –1.0. 

If the global Z-axis is directed upward, it is possible to define settings for surfaces and members 
by clicking the [Choose] button shown on the left. The dialog box Orientation of Local z-Axis ap-
pears. 

 
Figure 12.28: Dialog box Orientation of Local z-Axis 

The local z-axis can be oriented Upward or Downward in order to assign for example elastic 
surface foundations or reinforcements of plates appropriately. Then, answer the query (see 
Figure 12.29) appearing when closing the General Data dialog box with No. 

It is possible to change the orientation of the Z-axis subsequently. You also have the possibility 
to adjust the coordinates and global loads so that the view of the model will be kept. When the 
axis direction is modified, a query appears (see following figure). 

 

 

 

http://www.dlubal.com/manuals-for-category-timber-design.aspx
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Figure 12.29: Query when changing the Z direction 

Template 
The model can be created according to a template that has been saved in another model.  
To access the save function, 

select Save As Template on the File menu. 

 
Figure 12.30: Dialog box Save as Template 

In general, the templates are stored in the Dlubal folder for template models called Base.  
Access is also available in the navigator of the Project Manager by selecting Default under 
Templates (see Figure 12.3, page 542). 

After ticking the check box in the dialog box New Model - General Data, you can select the rele-
vant template model from the list. 

Click the button shown on the left to open an overview with preview pictures helping you to 
choose among the templates (see following figure). 
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Figure 12.31: Dialog box Select Template 

Comment 
You can enter a text into the input field or select a text from the list to add a short description 
to the general data. The comment appears in the printout report, too. 

The buttons in the General Data dialog box have the following functions: 

Button Name Explanation 

 Comment  chapter 11.1.4, page 421 

 Units and decimal places  chapter 11.1.3, page 420 

 MS Excel 
Option for additional explanations in the XLS 
file format saved in RFEM file 

 MS Word 
Option for additional explanations in the DOC 
file format saved in RFEM file 

Table 12.2: Dialog box General Data, buttons
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12.2.2 History 
The second dialog tab of the General Data dialog box keeps record of processing in the form of 
a History. 

 
Figure 12.32: Dialog box Edit Model - General Data, tab History 

The table shows information about the point of time when a User has Opened and Saved the 
model. 

In the topmost table row, you can enter a Comment describing the current state of model pro-
cessing. The remark will be effective for the history when saving the model next time. The 
comment appears not only in the History tab but is also available in the Project Manager (see 
Figure 12.15, page 549). 

To delete the history, click the button [X]. In this way, it is possible to remove personal infor-
mation from the file.  
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12.3 Network Management 
When several users are working on the same projects, model management can be organized 
by the Project Manager, provided that the models are stored in a folder that is accessible on 
the network. 

First, connect the network folder to the internal project management. Please find a description 
in chapter 12.1.1 on page 543. Now, you can directly access the models of this folder in the 
Project Manager, which means that you can open or copy the models, check their history or 
provide them with a write protection. 

If another user is already working on the model that you want to open, a warning appears. In 
this case, you can open the model as a copy. 

 
Figure 12.33: Query when opening a write-protected model 

An automatic data synchronization of modifications is not possible. 

Information about the projects registered in the Project Manager is stored in the file PRO.DLP. 
This is an ASCII file which is by default located under C:\ProgramData\Dlubal\Global\Project 
Manager.  

By copying the PRO.DLP file to another computer you can avoid connecting folders project by 
project. In addition, the file can be edited by an editor. This facilitates the import of all relevant 
project folders into the internal file management of the Project Manager, especially after new 
installations. As an alternative, you can use the function Import Folder (see chapter 12.1.1, page 
546). 

Before copying the PRO.DLP file - like before uninstalling Dlubal applications - it is recom-
mended to save the existing file. 

The Project Manager is network-compatible. The file management can be organized in a cen-
tral place so that all users are integrated in one common project management. To define the 
network settings, 

select Program Options on the Edit menu of the Project Manager. 

A dialog box opens where you can define the storage location for the file PRO.DLP (see Figure 
12.21, page 553). 

The Project Manager runs on every local computer, but each is using the central server file 
PRO.DLP. In this way, all users can carry out modifications to the project structure at the same 
time. For write access to the PRO.DLP file, the file is locked only for a short time and is unlocked 
immediately afterwards. 
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12.4 Block Manager 
The Block Manager manages model blocks by cross-project management: Selected objects can 
be saved as blocks and reimported to other models. A multitude of typified elements is prede-
fined in the Block Manager's Catalog. 

To open the Block Manager, select Block Manager on the File menu in RFEM, or use the 
toolbar button shown on the left. 

 
Figure 12.34: Button Block Manager in the toolbar 

When you open the Block Manager, a multi-part window appears. Like the Project Manager 
(see chapter 12.1) it has its own menu and toolbar. 

 
Figure 12.35: Block Manager 

Project navigator 

On the left, you see the navigator with the Catalog of all block categories. The current category 
is set bold. To select another category, double-click the relevant entry or use the list Current 
Category in the Manager toolbar. The table to the right of the navigator lists the objects filed  
in the selected category. Blocks for various member, surface and solid models are available for 
selection. 

Table of blocks 

The blocks of the selected category are listed one by one. The Block Name and Description as 
well as significant object and file information are shown respectively. 

To adjust the displayed columns, select Manage Register Columns on the View menu of the 
Block Manager, or use the toolbar button shown on the left (see chapter 12.1.4.1, page 551).  
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Details 

The window section shows you detailed information about the selected block. 

Preview 

The selected block is displayed in a preview. The size of the preview window can be adjusted 
by moving the upper edge of the window. 

Thumbnails 

The bottom area of the Block Manager offers you a graphical overview about the blocks con-
tained in the selected category. The thumbnail images are interactive with the table above. 

Use the pins to minimize particular window parts. They will be docked as tabs in the footer. 

12.4.1 Create a Block 
To create a block from particular objects, select the relevant objects in the current RFEM model 
in the work window. A multiple selection is possible by drawing a window with the mouse but-
ton. You can also click several elements by holding down the [Ctrl] key. 

To create a new block, 

select Save as Block on the File menu in RFEM. 

The following dialog box opens. 

 
Figure 12.36: Dialog box Save as Block 

Define the Block Name and Category Name under which you want to save the block. The cate-
gory can be selected in the list. The Description is an optional entry used to describe the block 
shortly. 

The directory of the block is indicated in the dialog field Folder. 

In case loads are defined, they can be saved together with the block. In addition, you can use 
the settings in the dialog section Option to decide if all loads or only selected load cases are 
relevant. 
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To create a new block category, use the button [New Category] shown on the left. 

 
Figure 12.37: Dialog box Create New Category 

The creation of a block is similar to the creation of a new project in the Project Manager  
(see chapter 12.1.1, page 543). 

12.4.2 Import a Block 
To import a block into the current RFEM model, open the Block Manager (see Figure 12.34, 
page 562). First, select the category in the catalog. Then, you can select the relevant block by 
mouse-click in the RFEM tab. 

To start the import, 

• select Insert Block on the Block menu or 

• use the context menu of the block. 

 
Figure 12.38: Context menu of block 

You can also double-click the block in the table. The following dialog box opens. 
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Figure 12.39: Dialog box Insert Block 

Specify the Insert Point of Block (the "snap point") and the Global Position of Reference Point in 
the dialog box. The points can also be selected graphically in the block model or RFEM model. 

Geometric Parameters can be modified as well as Material and Cross-Sections. A click into the 
relevant input field enables buttons that you can use to select items from a list or to open li-
braries. 

For user-defined blocks it is even possible to import loads: The Active Load can be selected in 
the list. 

Click the [Edit] button shown on the left to access specific import settings that can be defined 
in another dialog box. 

 
Figure 12.40: Dialog box Detail Settings 
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With the options available in the dialog box Detail Settings you determine how objects will be 
aligned with the existing model elements. Moreover, you can influence the Numbering. 

Click the [Select] button to open a new dialog box where you can select the load cases, load 
and result combinations for the import. 

 
Figure 12.41: Dialog box Select Loading 

12.4.3 Delete a Block 
To delete a block, 

• select Delete on the Block menu of the Block Manager (block must have been  
previously selected) 

• click the [Delete] button in the toolbar shown on the left 

• use the context menu of the block (see Figure 12.38). 

 
Figure 12.42: Button Delete 

After confirming the security query, the block will be put into the Dlubal recycle bin. 
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12.5 Interfaces 
RFEM offers you the possibility to exchange data with other programs. Thus, you can use for 
example CAD templates created in other applications. Furthermore, results of structural calcu-
lations from construction or design software can be made available. 

Exporting the printout report as RTF file and to VCmaster is described in chapter 10.1.11 on 
page 400. 

RFEM can also be run externally using a programmable interface based on COM technology 
(for example Visual Basic). With RF-COM which can be acquired as RFEM add-on module you 
can use customized input macros and follow-up programs. 

12.5.1 Direct Data Exchange 
RFEM provides an interface to software programs developed by the DLUBAL company. Input 
data of all previous versions of RFEM can be imported without problems. Also files of the 
framework program RSTAB can be opened directly in RFEM so that surface or solid elements 
can be added. In the same way, you can open files created with RFEM 5 in RSTAB 8. 

There is a direct connection to CAD programs from Tekla Structures and Autodesk AutoCAD 
(but not for LT versions). In this way, it is possible to take advantage of BIM (Building Informa-
tion Modeling) with RFEM because data models can be exchanged directly for digital planning 
processes. 

To start the direct data exchange, 

select Import or Export on the File menu in RFEM 

or use the toolbar buttons shown on the left. 

The dialog box shown in Figure 12.43 or Figure 12.44 on page 568 opens where you can select 
the relevant CAD program in the dialog section Direct Imports or Direct Exports. 

The buttons in the RFEM toolbar Export/Import have the following functions: 

 
Direct import from Tekla Structures 

 
Direct export to Tekla Structures 

 
Direct import from AutoCAD 

 
Direct export to AutoCAD 

Table 12.3: Buttons of toolbar Export/Import 

Find descriptions for the interfaces with Tekla Structures and Autodesk AutoCAD Revit at 
www.dlubal.com/manuals-for-category-interfaces.aspx. 

• RX-Tekla 

• RX-Revit 

 

http://www.dlubal.com/manuals-for-category-interfaces.aspx
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12.5.2 File Formats for Data Exchange 
If CAD programs or programs for structural analysis can create files of the types *.stp, *.dxf, 
*.fem, *.asf, *.dat, *.cfe or *.ifc, corresponding data can be used as template for RFEM. Vice 
versa, RFEM is able to create files in formats appropriate for other programs. 

To open the dialog box for importing a file, 
select Import on the File menu. 

 
Figure 12.43: Dialog box Import 

When the option Import as background layer is ticked, RFEM will show you only a line model in 
the work window that can be used to set nodes, lines etc. (see chapter 11.3.10, page 455). 

To start the export of an RFEM file, 
select Export on the File menu. 

 
Figure 12.44: Dialog box Export 
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File formats for frameworks 

DSTV format *.stp 

When using the product interface from DSTV (German Steel Construction Association), transfer 
is not performed with framework files reduced to line models but files contain all model and 
load data that is necessary for efficient processing. DLUBAL, like many other software develop-
ers, work on the development of the product interface. So it is possible to exchange data with 
a variety of programs like Bentley ProStructure, Tekla Structures, Intergraph Frameworks, Advance 
Steel, CIS/2 CIMSteel or cadwork. You can select the programs also directly in the import and 
export dialog boxes. 

The interface covers structural and CAD data in general. RFEM, however, supports only the 
structural format with specific “entities” that can be found in a description (PDF download at 
http://www.dlubal.com/download/pss_dstv-E.pdf). 

The interface transfers information of nodes, members and cross-sections including member 
eccentricities and cross-section rotations. Furthermore, nodal supports, load cases, load and 
result combinations with nodal and member loads as well as imperfections are transferred.  
The results of the calculation can be stored in the exchange file as well. 

More settings for data exchange can be defined in the dialog tab DSTV (.stp). 

 
Figure 12.45: Dialog box Export, tab DSTV (.stp) 

File formats for spreadsheet 

MS Excel format *.xls 

RFEM is able to import and create tables as *.xls files. The data exchange with MS Excel has al-
ready been described in chapter 11.5.6 on page 488. However, the described exchange option 
is only available for the active RFEM table. The function described in the following covers data 
of the model all at once. Thus, user-defined external generators for model and load data can 
be used. 

To import an XLS file, open the file in MS Excel first. Then, you can use the option Microsoft  
Excel in the RFEM import dialog box (see Figure 12.43) to open the following dialog box. 

http://www.dlubal.come/download/pss_dstv-E.pdf
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Figure 12.46: Dialog box Import from Microsoft Excel - Settings 

Select the Workbook and Worksheets that you want to import. Descriptions, sequence and struc-
ture of worksheets must match exactly the data in RFEM so that imported data can be written 
correctly into the RFEM tables. If you are not quite sure, try to create a XLS file from the current 
RFEM file for test purposes. 

In the Options tab, specify if worksheets will be imported with or without headers and how 
formulas will be represented in the worksheets.  

When exporting a file, it is not necessary to open MS Excel. The spreadsheet program starts 
automatically.  

 
Figure 12.47: Dialog box Export to Microsoft Excel - Settings 

In the dialog section Export of Tables, select the tables that you want to export. When you acti-
vate the option Only selected tables, RFEM enables the respective [Select] button shown on the 
left. Click the button to open another dialog box for specific settings. 
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Figure 12.48: Dialog box Tables to Export - Results Data 

In the dialog section Formulas and Parameters of the initial export dialog box (Figure 12.47), 
you can decide if stored formulas will also be transferred from RFEM to Excel during the data 
exchange. 

OpenOffice format *.ods 

This interface is only available when OpenOffice.org Calc and RFEM 5  32-bit are installed. 

The import and export options are similar to the data exchange between RFEM and Excel  
described in detail above. 

General file formats for CAD programs 

ASCII format *.dxf 

The DXF format transfers only general information concerning lines used in the model. RFEM is 
able to import a line model created for example in AutoCAD and to create a DXF file from the 
current model. A layer will be used for each cross-section. Nodal supports, loads etc. cannot be 
taken over. 

More settings for data exchange can be defined in the dialog tab ASCII Format DXF (*.dxf). It is 
recommended to check the parameters, especially before the import. 

 
Figure 12.49: Dialog box Import, tab ASCII Format DXF (*.dxf) 

It is also recommended to check the length units of the DXF template. Optionally, you can en-
ter an Offset to place the DXF model in a certain distance to the origin. Select the option Import 
3D FACE as surface to create 3D surfaces from the DXF template automatically as surfaces in 
RFEM. 
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If you want to Import a file from a specific layer, use the button [Select DXF File] shown on the 
left to select the DXF file. Then, the individual layers are available for selection in the list. 

In most CAD programs, the Z-axis is directed upwards. In RFEM, however, it is usually directed 
downwards. Now, when you switch to the second dialog tab Detail Settings in the import dia-
log box, and set Down in the list for the Z axis, weight loads can be entered positively in RFEM. 

 
Figure 12.50: Dialog box Import, tab Detail Settings 

The DXF export includes also values. However, only one value or one group of values is possi-
ble. If several values are specified, always the first value will be exported and a corresponding 
message will be displayed. 

For the DXF export it is also recommended to check the orientation of the Z axis. 

IFC format *.ifc 

The Industry Foundation Classes (IFC) are a global standard of exchanging data for model-based 
approaches in the construction industry. They have been developed by the IAI (International 
Alliance for Interoperability). The IFC are structured in domains (architecture, design, structural 
analysis, electrical engineering etc.). DLUBAL software supports the domain for structural engi-
neering which allows for the transfer of structural data like nodes, members, supports, load 
cases and loads. The IFC are still under development. 

Please find a description of the interface at www.buildingsmart.de. 

When you export an RFEM model as IFC model, an analytical model is created in the version 
IFC 2 x Edition 3. 

Bentley format *.ism.dgn, *.dgn 

The interface makes it possible to exchange data with the CAD product MicroStation. RFEM is 
able to import model data as well as to export RFEM files, using the possibilities of interopera-
bility. Thus, a connection to all Bentley applications such as ProSteel is given on the basis of ISM 
(Integrated Structural Modeling). 

SDNF format *.dat 

The SDNF format (Steel detailing neutral file) is used to exchange geometrical data like nodes, 
cross-sections and members with INTERGRAPH. 

 

 
IAI logo 

http://www.buildingsmart.de/
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File formats for CAD reinforcement programs 

Glaser format *.geo, *.fem 

RFEM provides an interface with the program Glaser by ISB CAD making the exchange of geo-
metrical and reinforcement data possible. 

If you want to export reinforcement results of the add-on module RF-CONCRETE Surfaces, make 
sure that surfaces are defined as plane and horizontal, that means created in the plane XY. 

In the dialog tab Results - Glaser (.fem), you can control the reinforcement results that are rele-
vant for the export. 

 
Figure 12.51: Dialog box Export, tab Results - Glaser (.fem) 

The reinforcements exported to GLASER can be realized graphically in grid points or FE nodes. 
As they are available as values, it is possible to use them in reinforcement drawings. 

Strakon format *.cfe 

The Strakon format supports the exchange of geometrical data like surfaces with the CAD  
program system STRAKON produced by the software developer DICAD. 

In the dialog tab Results of the Export dialog box, you can set the surfaces whose reinforce-
ments you want to export (see Figure 12.52). 

Nemetschek format *.asf 

Data exchange is also possible with the program Allplan by NEMETSCHEK. 

For the export of reinforcement results of the add-on module RF-CONCRETE Surfaces, please 
note that surfaces may be defined in any position but must be plane. During the export, RFEM 
creates a ASF file per plane surface. For example: When the RFEM model has 12 surfaces, 12 
files will be created that can be merged to a 3D model in Allplan. 

In the dialog tab Results of the Export dialog box, you can set the surfaces whose reinforce-
ments you want to export. 

 
Figure 12.52: Dialog box Export, tab Results 



12  File Management 

 

 

574 Program RFEM © 2013 Dlubal Software GmbH 

ESF format *.esf 

This interface has been developed especially for the program CADKON by AB STUDIO. It is possi-
ble to export plane surfaces with constant thicknesses including openings and material infor-
mation. Furthermore, it is possible to export the reinforcements of RFEM surfaces in the format 
*.esf (Engineering Structural Format). 

The import of *.esf files is not possible. You may use the DXF format instead. 

File formats for structural analysis programs 

Ansys format *.ans 

Use the interface with the FE program ANSYS to import files available in the format *.ans. In 
this way, you can use data of this multifunctional program also for analyses performed with 
RFEM. 

Scia format *.xml 

It is also possible to import model data from the structural analysis program Scia by NEMETSCHEK 
to RFEM, provided that data is available in the *.xml format. 

General Dlubal formats *.xml, *.ft5 
To save RFEM files as XML files or templates, 

select Save As on the File menu. 

In the Windows dialog box Save As, use the list to set the relevant file type in the dialog field 
Save as type. 

 
Figure 12.53: Dialog box Save As 

With the FT5 format you save the model as a template which can be imported later when cre-
ating a new file (see Figure 12.23, page 554). 

When you save the model with the file type RFX, tabular data will be converted into an XML for-
mat. The remaining data will be saved in binary format. Data is stored in a compressed file that 
can be opened like a ZIP archive file. In this way, it is possible to create files for CAD programs. 
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12.5.3 RF-LINK Import *.step, *.iges, *.sat 
With the add-on module RF-LINK (not contained in RFEM) it is possible to import data in STEP, 
IGES or ACIS format. The file formats are mainly used in mechanical engineering, allowing for a 
transfer of model geometry in the form of boundary lines and surfaces. 

To import model files available in one of the formats mentioned above, 

select Import on the File menu. 

 
Figure 12.54: Dialog box Import 

In the dialog section Extra Formats of the Import dialog box, you can define the relevant file 
format: 

• Standard for the Exchange of Product Model Data (*.stp, *.step) 

• Initial Graphics Exchange Specification (*.igs, *.iges) 

• Standard Acis Text format (*.sat) 

Access to the options is only available when RF-LINK has been installed. The installation re-
quires a separate installation process. 

In the dialog tab Import (*.sat, *.step, *.iges), you can specify detailed settings for units and the 
treatment of lines and surfaces. 

Export options of RFEM files in the STEP, IGES or SAT format are currently not available.
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